
 

 
 

1 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

  

RELEASE NOTES FOR TRANSLATION WORKSPACE 1.21.34 
AND EARLIER RELEASES 

Contents 
Introduction ...................................................................................................................................................4 

Added and Fixed in Earlier Releases .........................................................................................................5 
New in Translation Workspace Release 1.21.34 ...................................................................................................... 5 
Problems fixed in Release 1.21.34 ............................................................................................................................... 5 
New in Translation Workspace Release 1.21.33 ...................................................................................................... 6 
Problems fixed in Release 1.21.33 ............................................................................................................................... 8 
Problems fixed in Release 1.21.32 ............................................................................................................................... 9 
New in Translation Workspace Release 1.21.31 .................................................................................................... 10 
Problems fixed in Release 1.21.31 ............................................................................................................................. 12 
New in Translation Workspace Release 1.21.30 .................................................................................................... 13 
Problems fixed in Release 1.21.30 ............................................................................................................................. 13 
New in Translation Workspace Release 1.21.29 .................................................................................................... 14 
Problems fixed in Release 1.21.29 ............................................................................................................................. 14 
New in Translation Workspace Release 1.21.28 .................................................................................................... 15 
Problems fixed in Release 1.21.28 ............................................................................................................................. 15 
New in Translation Workspace Release 1.21.27 .................................................................................................... 16 
Problems fixed in Release 1.21.27 ............................................................................................................................. 17 
New in Translation Workspace Release 1.21.26 .................................................................................................... 18 
Problems fixed in Release 1.21.26 ............................................................................................................................. 19 
New in Translation Workspace Release 1.21.25 .................................................................................................... 20 
New in Translation Workspace Release 1.21.24 .................................................................................................... 21 
Problems fixed in Release 1.21.24 ............................................................................................................................. 21 
New in Translation Workspace Release 1.21.23 .................................................................................................... 22 
Problems fixed in Release 1.21.23 ............................................................................................................................. 23 
New in Translation Workspace Release 1.21.22 .................................................................................................... 24 
Problems fixed in Release 1.21.22 ............................................................................................................................. 25 
New in Translation Workspace Release 1.21.21 .................................................................................................... 26 
Problems fixed in Release 1.21.21 ......................................................................................................................... 28 
New in Translation Workspace Release 1.21.20 .................................................................................................... 29 
New in Translation Workspace Release 1.21.19 .................................................................................................... 32 
New in Translation Workspace Release 1.21.18 .................................................................................................... 34 
Problems fixed in Release 1.21.18 ......................................................................................................................... 35 
New in Translation Workspace Release 1.21.17 .................................................................................................... 36 
Problems fixed in Release 1.21.17 ......................................................................................................................... 37 
Problems fixed in Release 1.21.16 ......................................................................................................................... 38 
New in Translation Workspace Release 1.21.15 .................................................................................................... 40 
Problems fixed in Release 1.21.15 ......................................................................................................................... 42 
New in Translation Workspace Release 1.21.14.1 ................................................................................................. 44 
New in Translation Workspace Release 1.21.14 .................................................................................................... 45 
Translation Workspace Release 1.21.12.1 Was a Patch Release ................................................................................. 49 
New in Translation Workspace Release 1.21.12 .................................................................................................... 50 
New in Translation Workspace Release 1.21.11 .................................................................................................... 53 
New in Translation Workspace Release 1.21.10 .................................................................................................... 54 
New in Translation Workspace Release 1.21.9 ...................................................................................................... 56 
New in Translation Workspace Release 1.21.8 ...................................................................................................... 57 
Problems fixed in Release 1.21.8 ........................................................................................................................... 59 
New in Translation Workspace Release 1.21.7 ...................................................................................................... 60 
Problems fixed in Release 1.21.7 ........................................................................................................................... 60 
New in Translation Workspace Release 1.21.6 ...................................................................................................... 61 
Problems fixed in Release 1.21.6 ........................................................................................................................... 61 
New in Translation Workspace Release 1.21.5 ...................................................................................................... 62 
Problems fixed in Release 1.21.5 ........................................................................................................................... 63 
New in Translation Workspace Release 1.21.4 ...................................................................................................... 64 



April 13, 2023  Release Notes for Earlier Releases of Translation Workspace 

 
 

2 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

Translation Workspace Release 1.21.3 included workgroup reorganization only........................................................ 65 
New in Translation Workspace Release 1.21.2 ...................................................................................................... 66 
New in Translation Workspace Release 1.21.1 ...................................................................................................... 67 
New in Translation Workspace Release 1.20.9 ...................................................................................................... 68 
Problems fixed in Release 1.20.9 ........................................................................................................................... 69 
Problems fixed in Release 1.20.8 ........................................................................................................................... 70 
New in Translation Workspace Release 1.20.7 ...................................................................................................... 71 
Problems fixed in Release 1.20.7 ........................................................................................................................... 73 
New in Translation Workspace Release 1.20.6 ...................................................................................................... 74 
New in Translation Workspace Release 1.20.5 ...................................................................................................... 76 
Problems fixed in Release 1.20.5 ........................................................................................................................... 76 
New in Translation Workspace Release 1.20.4 ...................................................................................................... 77 
Problems fixed in Release 1.20.4 ........................................................................................................................... 77 
New in Translation Workspace Release 1.20.3 ...................................................................................................... 78 
Problems fixed in Release 1.20.3 ........................................................................................................................... 78 
New in Translation Workspace Release 1.20.2 ...................................................................................................... 80 
Problems fixed in Release 1.20.2 ........................................................................................................................... 82 
New in Translation Workspace Release 1.20.1 ...................................................................................................... 83 
Problems fixed in Release 1.20.1 ........................................................................................................................... 87 
New in Translation Workspace Release 1.19.9 ...................................................................................................... 88 
Problems fixed in Release 1.19.9 ........................................................................................................................... 89 
New in Translation Workspace Release 1.19.8 ...................................................................................................... 91 
Problems fixed in Release 1.19.8 ........................................................................................................................... 91 
New in Translation Workspace Release 1.19.7 ...................................................................................................... 93 
Problems fixed in Release 1.19.7 ........................................................................................................................... 96 
Translation Workspace Release 1.19.6 was merged to Release 1.19.7. ...................................................................... 96 
New in Translation Workspace Release 1.19.5 ...................................................................................................... 97 
Problems fixed in Release 1.19.5 ........................................................................................................................... 99 
New in Translation Workspace Release 1.19.4 .................................................................................................... 101 
New in Translation Workspace Release 1.19.3 .................................................................................................... 102 
Problems fixed in Release 1.19.3 ......................................................................................................................... 103 
New in Translation Workspace Release 1.19.2 .................................................................................................... 105 
Problems fixed in Release 1.19.2 ......................................................................................................................... 106 
New in Translation Workspace Release 1.19.1 .................................................................................................... 108 
Problems fixed in Release 1.19.1 ......................................................................................................................... 108 
New in Translation Workspace Release 1.18.9 .................................................................................................... 109 
Problems fixed in Release 1.18.9 ......................................................................................................................... 110 
New in Translation Workspace Release 1.18.8 .................................................................................................... 111 
Problems fixed in Release 1.18.8 ......................................................................................................................... 113 
New in Translation Workspace Release 1.18.7 .................................................................................................... 114 
Problems Fixed in Release 1.18.7 ....................................................................................................................... 115 
Problems fixed in Release 1.18.5 ......................................................................................................................... 117 
New in Translation Workspace Release 1.18.4 .................................................................................................... 119 
Problems fixed in Release 1.18.4 ......................................................................................................................... 122 
New in Translation Workspace Release 1.18.3 .................................................................................................... 123 
Problems fixed in Release 1.18.3 ......................................................................................................................... 124 
New in Translation Workspace Release 1.18.2 .................................................................................................... 125 
Problems fixed in Release 1.18.2 ......................................................................................................................... 127 
New in Translation Workspace Release 1.18.1 .................................................................................................... 129 
Problems fixed in Release 1.18.1 ......................................................................................................................... 132 
New in Translation Workspace Release 1.17.9 .................................................................................................... 133 
Problems fixed in Release 1.17.9 ......................................................................................................................... 135 
New in Translation Workspace Release 1.17.8 .................................................................................................... 136 
Problems fixed in Release 1.17.8 ......................................................................................................................... 138 
New in Translation Workspace Release 1.17.7 .................................................................................................... 141 
Problems fixed in Release 1.17.7 ......................................................................................................................... 143 
New in Translation Workspace Release 1.17.6 .................................................................................................... 147 
Problems fixed in Release 1.17.6 ......................................................................................................................... 149 
New in Translation Workspace Release 1.17.5 .................................................................................................... 153 
Problems fixed in Release 1.17.5 ......................................................................................................................... 158 
New in Translation Workspace Release 1.17.4 .................................................................................................... 159 
New in Translation Workspace Release 1.17.3 .................................................................................................... 162 
Problems Fixed in Release 1.17.3: ...................................................................................................................... 165 
New in Translation Workspace Release 1.17.2 .................................................................................................... 167 



April 13, 2023  Release Notes for Earlier Releases of Translation Workspace 

 
 

3 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

Problems Fixed in Release 1.17.2: ...................................................................................................................... 170 
New in Translation Workspace Release 1.17.1 .................................................................................................... 172 
Problems Fixed in Release 1.17.1: ...................................................................................................................... 175 
New in Translation Workspace Release 1.17 ....................................................................................................... 176 
Problems Fixed in Release 1.17 .......................................................................................................................... 177 
New in Translation Workspace Release 1.16.9 .................................................................................................... 179 
Problems Fixed in Release 1.16.9 ....................................................................................................................... 181 
New in Translation Workspace Release 1.16.8 .................................................................................................... 183 
Problems Fixed in Release 1.16.8 ....................................................................................................................... 184 
New in Translation Workspace Release 1.16.7 .................................................................................................... 185 
Problems Fixed in Release 1.16.7 ....................................................................................................................... 186 
New in Translation Workspace Release 1.16.6 .................................................................................................... 187 
New in Translation Workspace Release 1.16.5 .................................................................................................... 189 
New in Translation Workspace Release 1.16.4 .................................................................................................... 190 
Problems Fixed in Release 1.16.4 ....................................................................................................................... 192 
New in Translation Workspace Release 1.16.3 .................................................................................................... 193 
Problems Fixed in Release 1.16.3 ....................................................................................................................... 195 
New in Translation Workspace Release 1.16.2 .................................................................................................... 196 
Problems Fixed in Release 1.16.2 ....................................................................................................................... 198 
New in Translation Workspace Release 1.16 ....................................................................................................... 200 
Problems Fixed in Release 1.16 .......................................................................................................................... 201 
New in Translation Workspace Release 1.15.9 .................................................................................................... 203 
Translation Workspace Problems Fixed in Release 1.15.9 .................................................................................. 204 
New in Translation Workspace Release 1.15.8 .................................................................................................... 206 
Translation Workspace Problems Fixed in Release 1.15.8 .................................................................................. 207 
New in Translation Workspace Release 1.15.7 .................................................................................................... 210 
Translation Workspace Problems Fixed in Release 1.15.7 .................................................................................. 212 
New in Translation Workspace Release 1.15.6 .................................................................................................... 213 
Translation Workspace Problems Fixed in Release 1.15.6 .................................................................................. 214 
New in Translation Workspace Release 1.15.5 .................................................................................................... 215 
Translation Workspace Problems Fixed in Release 1.15.5 .................................................................................. 215 
New in Translation Workspace Release 1.15.4 .................................................................................................... 216 
Translation Workspace Problems Fixed in Release 1.15.4 .................................................................................. 217 
New in Translation Workspace Release 1.15.3 .................................................................................................... 220 
Translation Workspace Problems Fixed in Release 1.15.3 .................................................................................. 221 
New in Translation Workspace Release 1.15.2 .................................................................................................... 222 
Translation Workspace Problems Fixed in Release 1.15.2 .................................................................................. 225 
New in Translation Workspace Release 1.14 ....................................................................................................... 226 
Translation Workspace Problems Fixed in Release 1.14 ..................................................................................... 226 
New in Translation Workspace Release 1.13 ....................................................................................................... 227 
Translation Workspace Problems Fixed in Release 1.13 ..................................................................................... 229 
New in Translation Workspace Release 1.12.3 .................................................................................................... 230 
Translation Workspace Problems Fixed in Release 1.12.3 .................................................................................. 230 
New in Translation Workspace Release 1.12.2 .................................................................................................... 232 
Translation Workspace Problems Fixed in Release 1.12.2 .................................................................................. 232 
New in Translation Workspace Release 1.12.1 .................................................................................................... 234 
Translation Workspace Problems Fixed in Release 1.12.1 .................................................................................. 234 
New in Translation Workspace Release 1.12 ....................................................................................................... 236 
Translation Workspace Problems Fixed in Release 1.12 ..................................................................................... 237 
New in Translation Workspace Release 1.11.3 .................................................................................................... 238 
Translation Workspace Problems Fixed in Release 1.11.3 .................................................................................. 238 
New in Translation Workspace Release 1.11 ....................................................................................................... 239 
Translation Workspace Problems Fixed in Release 1.11 ..................................................................................... 242 
New in Translation Workspace Release 1.10 ....................................................................................................... 243 
Translation Workspace Problems Fixed in Release 1.10 ..................................................................................... 248 
New in Translation Workspace Release 1.9 ......................................................................................................... 253 
Translation Workspace Problems Fixed in Release 1.9 ....................................................................................... 253 
New in Translation Workspace Release 1.8 ......................................................................................................... 254 
Translation Workspace Problems Fixed in Release 1.8 ....................................................................................... 259 
New in Translation Workspace Release 1.7.2 ...................................................................................................... 267 
Translation Workspace Problems Fixed in Release 1.7.2 .................................................................................... 268 
New in Translation Workspace Release 1.7.1 ...................................................................................................... 271 
Translation Workspace Problems Fixed in Release 1.7.1 .................................................................................... 271 
New in Translation Workspace Release 1.7 ......................................................................................................... 272 



April 13, 2023  Release Notes for Earlier Releases of Translation Workspace 

 
 

4 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

Translation Workspace Problems Fixed in Release 1.7 ....................................................................................... 276 
New in Translation Workspace Release 1.6 ......................................................................................................... 279 
Translation Workspace Problems Fixed in Release 1.6 ....................................................................................... 282 
New in Translation Workspace Release 1.5.1 ...................................................................................................... 288 
Translation Workspace Problems Fixed in Release 1.5.1 .................................................................................... 288 
New in Translation Workspace Release 1.5 ......................................................................................................... 290 
Translation Workspace Problems Fixed in Release 1.5 ....................................................................................... 293 
New in Translation Workspace Release 1.4 ......................................................................................................... 296 
Translation Workspace Problems Fixed in Release 1.4 ....................................................................................... 298 
Translation Workspace Release 1.3.3 .................................................................................................................. 300 
New in Translation Workspace Release 1.3 ......................................................................................................... 301 
Translation Workspace Problems Fixed in Release 1.3 ....................................................................................... 303 
New in Translation Workspace Release 1.2.1 ...................................................................................................... 306 
Translation Workspace Problems Fixed in Release 1.2.1 .................................................................................... 306 
New in Translation Workspace Release 1.2 ......................................................................................................... 309 
Translation Workspace Problems Fixed in Release 1.2 ....................................................................................... 312 
New in Translation Workspace Release 1.1 ......................................................................................................... 316 
Translation Workspace Problems Fixed in Release 1.1 ....................................................................................... 320 
New in Translation Workspace Release 1.0.2 ...................................................................................................... 323 
Translation Workspace Problems Fixed in Release 1.0.2 .................................................................................... 323 
Translation Workspace Problems Fixed in Release 1.0.1 .................................................................................... 326 

Training and Documentation .................................................................................................................. 327 

Contacting Technical Support ............................................................................................................... 333 

 

 

 

Introduction 
These release notes are for: 

 the Translation Workspace Web interface (in which you create and configure users, 

workgroups, and linguistic assets—translation memories, glossaries, and review packages) 

 the translation clients—the Microsoft Word Plug-in and the XLIFF Editor (used to do 

translation work) 

For release notes about GeoWorkz, see the Documentation page in the Support area at 

GeoWorkz.com.
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Added and Fixed in Earlier Releases 
 
 

New in Translation Workspace Release 1.21.34 

 

Internal changes only. 

 

 

Problems fixed in Release 1.21.34 

 

|||| Web Interface, Server, Word Client Plug-in and XLIFF Editor 

 

◼ Pretranslation 

 

|||||| Tags were sometimes left out from pre-translated minimum 100% matches. 

The pretranslation of minimum 100% matches sometimes left out the tags from the translation when 

the normal tag replacement process could not succeed: 

This was fixed in Release 1.21.34. 

 

 

|||| XLIFF Editor 

 

◼ Matching 
 

|||| XLIFF Editor did not sometimes display the match existing in the TM. 

XLIFF Editor did not display a match existing in the TM if the date/time stored as the last segment 

update was invalid. 

This was fixed in Release 1.21.34. 
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New in Translation Workspace Release 1.21.33 

Translation Workspace Release 1.21.33 includes the following new features and enhancements. 

 

|||| Web Interface, Server, Word Client Plug-in and XLIFF Editor 

 

◼ Language Support 

 

|||||| New languages and locale codes were added to Translation Workspace. 

The following 40 new languages were added to Translation Workspace: 

Language name Lang code Language name Lang code 

Albanian (Kosovo) sq-xk Malvi mup 

Anuak anu Mandeali mjl 

Arabic (South Sudan) ar-ss Marwari – India rwr 

Dutch (Curaçao) nl-cw Mehri gdg 

Garhwali gbm Mewari mtr 

German (Italy) de-it Mewati wtm 

Godwari gdx Sadri sck 

Northern Gondi gno Shekhawati swv 

Gujari gju Soqotri sqt 

Haroti hoj Spanish (Aruba) es-aw 

Hunsrik hrx Spanish (Belize) es-bz 

Kangri xnr Surgujia sgj 

Eastern Kayah eky Surjapuri sjp 

Khandesi khn Swahili (Tanzania) sw-tz 

Central Konkani knn Swahili (Uganda) sw-ug 

Goan Konkani gom Swedish (Aaland Islands) sv-ax 

Kumaoni kfy Swiss German (Alemannic) gsw 

Laki lki Varhadi-Nagpuri vah 

Lambadi lmn Vasavi vas 

Northern Luri lrc Wagdi wbr 

 

These new languages and locale codes are available as source and target language in all Translation 

Workspace applications. 
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The following existing language names were modified: 

Previous name New name Lang code 

Konkani  Konkani - Macrolanguage kok 

Marwari Marwari - Macrolanguage mwr 

 

The following new Country codes were added: 

Language name Lang code 

Kosovo xk, xkx 

South Sudan ss, ssd 

 

The legacy Albanian was converted to Albanian (Albania). 

 

|||| Word Client Plug-in, TW Tools and XLIFF Editor 

 

◼ System Requirements  

 

|||||| Windows 8 was removed from the system requirements  

As Microsoft no longer supports Windows 8, it was removed from the system requirements of the 

Word Client Plug-in, TW Tools, and XLIFF Editor. The requirements now indicate that only Windows 

10 and 11 are supported. 

When attempting to install on Windows 8, the installer pops up a message that says  

Your Windows version is no longer supported. After April 15, 2023, this installer will no longer 

work on Windows versions 8 or earlier. 

After April 15, 2023, the installers automatically switch to the following blocking message: 

<product> cannot be installed on this version of Windows. Windows 8 and earlier versions are 

not supported. 
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Problems fixed in Release 1.21.33 

 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| The Authoritative User Interface segment count for Changed Translations/Comments is now titled 

Changes/Comments.  

The segment count title Changed Translations/Comments of the Authoritative User Interface was 

renamed as Changes/Comments to indicate that category and severity are changes included in the 

count and not changes only in the target. 

This was fixed in Release 1.33. 

 



January 12, 2023  Release Notes for Earlier Releases of Translation Workspace 

 
 

9 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

Problems fixed in Release 1.21.32 

 

A few bug fixes were included in this release. 
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New in Translation Workspace Release 1.21.31 

Translation Workspace Release 1.21.31 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| A new Marked as locked filter was added to the Authoritative UI.  

A new Marked as locked filter was added to the Authoritative UI Filters panel, which you can use to 

display or hide the segments which are marked as locked. This option is checked by default to display 

the locked segments. The option is for the client only, being independent of the option set at the 

package level. 

 When the option is enabled, the locked segments are displayed in the Authoritative User 

Interface. 

 When the option is disabled, the locked segments are hidden. 

 

You can use this filter in conjunction with all the other filters. 

 

|||||| A vertical scrollbar was added to the Authoritative UI Settings, Filters, and Files menus.  

In the Authoritative User Interface, you can now scroll to the bottom of the Settings, Filter, and Files 

menus if the screen resolution or zoom setting does not display the full height of the menu onscreen. 
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|||||| The Show entries with Changed Translation/Comment options group was divided to two separate 

option groups in the Authoritative User Interface Filters.  

The Changed Translation/Comment Filter options were 

divided to two separate groups in the Authoritative User 

Interface, so that you can separately filter segments with 

changed translations and segments comments. 

The following Show entries options were available in 

previous releases: 

 With and without a changed translation/comment 

 With a changed translation/comment 

 Without a changed translation/comment 

The following two option groups are available now: 

Changed Translation: 

 Show all 

 With changes 

 Without changes 

Comment: 

 Show all 

 With comment 

 Without comment 

 

|||||| The settings set by a user in the Authoritative User Interface are now kept across sessions.  

The settings set by a user in the Settings menu are now saved to a cookie. Resetting the browser 

resets also the cookies. 

Note: A cookie is browser specific and using a second browser for the Authoritative User Interface 

requires that you select your settings with the second browser. Note that different browsers can 

reset or delete cookies for different reasons. 

 

|||||| The Match Percent setting was updated.  

The Match Percent Show | Hide setting was updated to Show 

Always | Show when Selected | Hide setting. When set as Show 

Always, the match percent text which in previous releases was 

appended to the target segment only when the segment was 

selected, is displayed even when the segment is not selected. 
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Problems fixed in Release 1.21.31 

 

A few bug fixes were included in this release. 
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New in Translation Workspace Release 1.21.30 

Translation Workspace Release 1.21.30 includes the following new features and enhancements. 

 

Internal changes only. 

 

 

Problems fixed in Release 1.21.30 

 

A few bug fixes were included in this release. 
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New in Translation Workspace Release 1.21.29 

Translation Workspace Release 1.21.29 includes the following new features and enhancements. 

 

Internal changes only. 

 

 

Problems fixed in Release 1.21.29 

 

A few bug fixes were included in this release. 
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New in Translation Workspace Release 1.21.28 

Translation Workspace Release 1.21.28 includes the following new features and enhancements. 

 

|||| Web Interface, Server, Word Client Plug-in and XLIFF Editor 

 

◼ Language Support 

 

|||||| A new language was added to Translation Workspace. 

The following new language was added to Translation Workspace: 

Language name Lang code 

Arabic (Western Sahara) ar-EH 

 

This new language is available as source and target language in all Translation Workspace 

applications. 

 

 

 

 

Problems fixed in Release 1.21.28 

 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| When you selected a word in the Authoritative User Interface the trailing space was included in the 

highlighted string.  

In previous releases, when you selected a word in the Authoritative User Interface the trailing space 

was included in the highlighted string (just like in the other Online Review user interfaces). 

This was fixed in Release 1.28.  

 

A few bug fixes were included in this release. 
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New in Translation Workspace Release 1.21.27 

Translation Workspace Release 1.21.27 includes the following new features and enhancements. 

 

 

|||| Online Review Client 

 

◼ User Interface 

 

|||||| Browsers no longer ask you to confirm you want to leave the Online Review when you have not 

made any changes on the review page.  

In previous releases, the browser asked you to confirm that you want to leave the Authoritative, the 

Advanced or the Simple User Interface page, although you had not made any changes on that page to 

the review. 

Browsers no longer ask you to confirm that you want to leave the Online Review page when you have 

not made any changes to the review page on the Authoritative, the Advanced and the Simple User 

Interfaces. 

 

 

|||| XLIFF Editor 

 

◼ Error messages 
 

|||| XLIFF Editor now displays a more informative error message for the spell dictionary and target 

segment text encoding discrepancy when the Spell Checker is on. 

In previous releases, the error message for an encoding difference between spell dictionary and target 

segment text was not clear enough. 

XLIFF Editor now displays a more informative error message when the Spell Checker is on and the 

selected spell dictionary encoding, and the open segment target text encoding differ: 

Spell checker error. Check configuration: followed by the original error message. 
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Problems fixed in Release 1.21.27 

 

 

|||| Web Interface 

 

◼ Glossaries 

 

|||||| An unexpected Glossary term content caused the Glossary Statistics tab to display no information. 

After a double quote (“) was added as a part of a term to a glossary by import, all information was 

emptied from the glossary’s Statistics tab. 

This was fixed in Release 1.21.27. 

 

 

Other bug fixes were included in this release. 
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New in Translation Workspace Release 1.21.26 

Translation Workspace Release 1.21.26 includes the following new features and enhancements. 

 

|||| Web Interface, Server, Word Client Plug-in and XLIFF Editor 

 

◼ Language Support 

 

|||||| New languages were added to Translation Workspace. 

The following 11 new languages were added to Translation Workspace: 

Language name Lang code Language name Lang code 

Gan Chinese gan Ibibio ibb 

Gourmanchema gux Krio  kri 

Gun guw Nuer nus 

Hakka Chinese hak Southeastern Dinka dks 

Min Dong Chinese cdo Southwestern Dinka dik 

  Yucatec Maya yua 

 

These new languages are available as source and target languages in all Translation Workspace 

applications. 

 

 

|||| Word Client Plug-in, TW Tools and XLIFF Editor 

 

◼ System Requirements  

 

|||||| System requirements now include Windows 11 

Windows 11 was added to the system requirements listing of the Word Client Plug-in, TW Tools, and 

XLIFF Editor. Since Microsoft changed the Windows 10 2004 support to 64-bit only and for Windows 

11 as well, the requirements now just indicate that the Windows 8, 10, and 11 are supported. 

This was fixed in Release 1.21.26. 
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Problems fixed in Release 1.21.26 

 

|||| Web Interface 

 

◼ Languages 

 

|||||| A wrong language name was displayed when you added the language Kru. 

When you tried in the Manage > Languages tab to add the language Kru (kro) as a source or target 

language, the Kurukh language was added as the source or target language instead. 

This was fixed in Release 1.21.26. 

 

 

|||| Filters 

 

◼ DOCX Filter 

 

||||||| Footnote and endnote contents lost their superscript formatting in back conversion. 

When an XLZ file was converted back to DOXC file format, the formatting of the footnote and endnote 

contents were no longer in superscript as they were in the original DOCX file. 

This was fixed in Release 1.21.26. 

 

 

Other bug fixes were included in this release. 
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New in Translation Workspace Release 1.21.25 

Translation Workspace Release 1.21.25 includes the following new features and enhancements. 

 

|||| Web Interface, Server, Word Client Plug-in and XLIFF Editor 

 

◼ Language Support 

 

|||||| New languages were added to Translation Workspace. 

The following 24 new languages were added to Translation Workspace: 

Language name Lang code Language name Lang code 

Adyghe ady Lombard lmo 

Betawi bew Western Maninkakan mlq 

Cameroon Pidgin wes Mingrelian xmf 

Chhattisgarhi hne Saraiki skr 

Crimean Tatar crh Sicilian scn 

Ekegusii guz Silesian szl 

Kabiye kbp South Azerbaijani azb 

Kalenjin kln Southern Altai alt 

Karachay-Balkar krc Tausug tsg 

Koyra Chiini Songhay khq Udmurt udm 

Latgalian ltg Venetian vec 

Ligurian lij Western Cham cja 

 

These new languages are available as source and target languages in all Translation Workspace 

applications. 

 
 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| Term matches are now highlighted in the Entry Editor view of the Authoritative User Interface.  

Term matches are now highlighted in the current source and target segments in the Entry Editor view of 

the Authoritative User Interface as they are in the Review view entries table before opening an entry to 

the Entry Editor. 
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New in Translation Workspace Release 1.21.24 

Translation Workspace Release 1.21.24 includes the following new features and enhancements. 

 

 

|||| Filters 

 

◼ MIF Filter 

 

||||||| You can now convert MIF 2020 files to XLZ and back to MIF 2020 file format. 

In previous versions, Translation Workspace did not support converting MIF2020 files to XLZ. An error 

message was displayed about an unsupported file format instead. 

Translation Workspace now supports converting MIF 2020 files to XLZ and back to MIF 2020 file 

format.  

This does not add any compatibility for possible new features contained in MIF 2020 files at this point. 

 

 

 

Problems fixed in Release 1.21.24 

 

 

|||| Web Interface and Server 

 

◼ Aliasing 

 

|||||| A discrepancy appeared in extra word separator settings of the original TM and its alias TM. 

The alias Translation Memory word separator settings did not follow the word separator settings of the 

Translation Memory which was aliased. 

For example, although Apostrophe and Hyphen were enabled as extra word separators in the original 

Translation Memory, they were not enabled in its alias Translation Memory. Various other 

discrepancies were also detected between the source Translation Memory and its aliased Translation 

Memory. 

This was fixed in the Release 1.21.24. 
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New in Translation Workspace Release 1.21.23 

Translation Workspace Release 1.21.23 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ User Interface 

 

|||||| You can now sort the lists of files in the Authoritative User Interface.  

Sort control (same style as on the Entry No., Source and Target columns of the main ORT view) was 

added to the File Name column in the Authoritative User Interface Package Summary view. The new 

layout looks as in the image below: 

 

1. The column header remains on top of the page and scroll only affects the file list  

(see segment view) 

2. Sort control was added for each field 

3. Default sort is alpha descending 

4. Sort toggles between ascending and descending order 

5. Initial display is sorted on file names descending (this will change the current display order) 

6. Display performance will be unaffected by the ability to sort 

7. Sorting is case-insensitive 

 

  



June 24, 2021  Release Notes for Earlier Releases of Translation Workspace 

 
 

23 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

|||| XLIFF Editor and TW Tools 

 

◼ Installer 

 

||||||| The TW client application installers now display a message which warns on deprecated versions of 
MS Windows. 

Translation Workspace moves towards blocking the installation of the TW client applications on MS 

Windows 7 and earlier. When you attempt to install XLIFF Editor and TW Tools on MS Windows 7 or 

earlier, the installer displays a dialog with the following message:  

Your Windows version is no longer supported. After September 1, 2021 this 

installer will no longer work on Windows versions 7 or earlier. 

The installation is still performed, until September 1, 2021. 

 

 

 

 

 

Problems fixed in Release 1.21.23 

 

 

|||| Web Interface, Online Review Client, TW Tools, and XLIFF Editor 

 

◼ Various 

 

The release contains several fixes in various interfaces of Translation Workspace. 

 

 

 



April 15, 2021  Release Notes for Earlier Releases of Translation Workspace 

 
 

24 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

New in Translation Workspace Release 1.21.22 

Translation Workspace Release 1.21.22 includes the following new features and enhancements. 

 
 

|||| Web Interface, Server, Word Client Plug-in and XLIFF Editor 

 

◼ Language Support 

 

|||||| One new language with two variants and one new language locale variant were added to Translation 
Workspace. 
The following one new language with two language variants and one new language locale variant 

were added to Translation Workspace: 

Language name Language code 

Montenegrin - Cyrillic cnr 

Montenegrin - Latin cnl 

Tamil (Sri Lanka) ta-lk 

 

The Montenegrin language with two variants, Cyrillic and Latin, was added to Translation Workspace. 

The new Sri Lanka locale variant was added for Tamil to Translation Workspace. 

The new language and variants are available as source and target languages in all Translation 

Workspace applications. 
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Problems fixed in Release 1.21.22 

 

 

|||| XLIFF Editor 

 

◼ Input Method Editor 
 

|||| The Windows IME input method switched to half-width alphanumeric mode after LXE displayed a 

Trailing space or some other warning message. 

When the Windows keyboard was set to Japanese and the input method was set to Windows IME, 

inputting Japanese characters to the target segment, and adding a trailing space switched the input 

method to half-width alphanumeric mode in the next segment after, for example, the following or any 

other warning was displayed: 

Trailing space ADDED in translation 

LXE then prevented the user from inputting Japanese characters and the input mode had to be 

changed manually to enable continuing translating. 
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New in Translation Workspace Release 1.21.21 

Translation Workspace Release 1.21.21 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ User Interface 

 

|||||| The design of the Authoritative User Interface was updated.  

Overall, the new layout looks as in the image below: 

 

The various columns in the Authoritative User Interface are now sorted like the columns in the Online 

Review Classic User Interface. With a new menu option, the users can control the display of the 

columns for Category, Severity, and Status separately for each Review Package. The Category, 

Severity, and Status column headings are non-scrolling.  

If a row is selected when the sort order is changed, the selected row scrolls to the top of the scrollable 

area. Some additional changes were made to enhance the user experience of the user interface. 
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The menu options for display and set are as in the image below: 

 

The new layout provides the following functionality: 

 You can sort and change the sorting order on Entry, Source, and Target columns in the file 

view of the Authoritative User Interface. You can sort only by single column at a time; multiple 

column sorting is not supported. Sorting is case insensitive, and it works immediately across 

the active file, through all its pages. 

 Separately for each Review Package, you can now control how the Category, Severity, and 

Status columns are displayed. 

 Review Package definition for a user can disable the setting of the Category, Severity, and 

Status for the menu options but the user can control the display of the columns. 

 The redesigned user interface removes old dead space and includes color scheme changes 

for buttons when appropriate. Icons for Lock, Changed Translation, Previously Reviewed, 

Approved, Rejected, Glossary, Review Tracking, and Match Percent were moved to a new 

grid layout to the left of the Entry column.  
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◼ Excel Export and Import 

 

|||||| A reviewer can now export to an Excel file for offline review and import it from the Authoritative 

User Interface.  

A reviewer can now export and import an Excel file for offline review from the Authoritative User 

Interface. 

This feature is only available if Allow Excel Export/Import option is Allowed in the Review Package 

Properties tab. The Excel file exported and the handling upon import is the same as for the other Online 

Review user interfaces having this feature. 

The user interface has the same Export to Excel and Import from Excel buttons for this as there is in the 

Advanced User Interface. These buttons are displayed only when the Allow Excel Export/Import option is 

Allowed. 

 

 

 

 

 

Problems fixed in Release 1.21.21 

 
 

|||| XLIFF Editor 

 

◼ User Interface 
 

|||| When Bangla was set as the Regional format in Windows, the XLIFF Editor menus were stretched, 

and the screen was not refreshed. 

When Bangla was set as the Regional format in Windows, the XLIFF Editor menus were stretched, 

and the screen was not refreshed. When not maximized, the LXE window was horizontally stretched in 

an abnormal way to accommodate for the stretched UI items, and you could not resize the window 

back to normal width. 

Additionally, the screen did not always refresh itself properly. Opening a file from recent items list or 

committing a segment made XLIFF Editor seem as being stuck but minimizing it and bringing it back 

afterwards restored it in a working state. 
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New in Translation Workspace Release 1.21.20 

Translation Workspace Release 1.21.20 includes the following new features and enhancements. 

 
 

|||| Web Interface, Server, Word Client Plug-in and XLIFF Editor 

 

◼ System Requirements 

 

|||||| Translation Workspace no longer supports Windows 7 (32 and 64-bit). 

Translation Workspace server, Web Interface and clients no longer support Windows 7 (32 and 64-

bit). References to Windows 7 were removed from the System Requirements of the Download Client 

Applications page on the servers, from the Release Notes, and from the online helps. 

 

◼ Language Support 

 

|||||| Two language variants and one new language were added to Translation Workspace. 

The following two language variants and one new language were added to Translation Workspace: 

Language name Language code 

Sindhi (India) sd-in 

Sindhi (Pakistan) xsd 

Soga xog 

 

Previous releases of Translation Workspace supported Sindhi with no specification of variants 

although Sindhi is written either in Devanagari script for India or in Arabic script for Pakistan. The 

“Sindhi” with the "complex script" property was intended for India.  

To establish separate support for Sindhi (India) and Sindhi (Pakistan), two language variants were 

added to Translation Workspace, “Sindhi (India)” replacing the previous “Sindhi” with no variant 

defined. 

Imports of any previously exported TMs with the original Sindhi – [sd] language setting default to 

Sindhi (India) – [sd-in] and load as they do today, even if the content in the data is Sindhi 

(Pakistan). 

The new language and variants are available as source and target languages in all Translation 

Workspace applications. 
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|||| Online Review Client 

 

◼ User Interface 

 

|||||| The max length and current length of suggested translation is now displayed in the Online Review 

Client Advanced User Interface.  

The max length and current length of suggested translation is now displayed in the Online Review 

Client Advanced User Interface, so that the reviewers can know if a suggestion violates the length 

constraint where a segment has a maximum number of characters specified. 

In the Entry Editor the Width: Max. | Current values under the Edited Translation field display the 

maximum character width and current width for the translation. The Current width value is updated 

when the translation is edited. If no maximum value is defined for the source segment, the Max. value 

is displayed as N/A. 

 

◼ File and segment status values 

 

|||||| Some file and segment status values were removed from the field menu and replaced in the files 

and reports with new values.  

The following file status values were removed from the Status values field menu: 

▪ Completed-Rejected 

▪ Completed-Removed 

The Completed-Approved value was changed to Approved. Any filters in the Online Review Client were 

updated accordingly. 

When you load a pre-existing Review Package containing data set to 

removed values the values are changed to the following: 

▪ Completed-Rejected → Approved 

▪ Completed-Removed → Approved 

▪ Pre-Approved → New 

▪ Pre-Rejected → New 

  

Backup restore Export to Excel, and file export from a Review Package 

also display correct new status values. A report generated for a review 

package contains the content using the new status value defaults instead 

of the removed values and the Review Package status report also contains 

the new corrected default status values. 

 

 

  

File status values 

Segment status values 
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|||| XLIFF Editor, TW Tools, and Microsoft Word Plug-in 

 

◼ Authentication 

 

||||||| The error message displayed, when the login authentication fails for an expired password, was 
updated. 

XLIFF Editor, TW Tools, and Word Plug-in now display a more informative error message dialog when 

the user login authentication is failed for an expired password: 

Your password has expired, please log in to the Translation Workspace  

Web UI in order to reset your password. 
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New in Translation Workspace Release 1.21.19 

Translation Workspace Release 1.21.19 includes the following new features and enhancements. 

 
 

|||| XLIFF Editor, TW Tools, and Microsoft Word Plug-in 

 

◼ Authentication 

 

||||||| XLIFF Editor, TW Tools, and Microsoft Word Plug-in now display an updated error message when 
the login authentication fails. 

XLIFF Editor, TW Tools, and Word Plug-in now display for a failed login authentication a more 

informative error message dialog under the following conditions: 

1. When the user login authentication is failed for an expired password:  

Your password has expired, please log in via the Web in order to reset your 

password. 

2. When the user login is temporarily locked for exceeding the max failed attempts:  

Cannot sign in due to excessive login attempts. 

3. When the user successively attempts login during lockout time, even with valid password: 

Cannot sign in due to excessive login attempts. 

If the authentication fails because of a wrong username, password, or tenancy, the familiar generic 

message is displayed: 

Unknown user, wrong password, or unknown tenancy. 
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|||| Online Review Client 

 

◼ Comments 

 

|||||| Notes attached to translation units in XLZ files are now imported to Review Packages as 

comments on the individual segments.  

During import to a review package, the contents of the <note> elements attached to the <trans-

unit> elements in XLZ files are now converted to review package segment comments. Possible 

hierarchy of comments loaded from XLZ is flattened during import. 

If the From field of a note contains a valid username in Translation Workspace, the username is 

applied to the user details of the comment. If such username does not exist, the username of the 

importing user is applied. 

The notes are imported only from XLZ files and the existing review packages with content imported 

from XLZ files containing notes are not affected. The new comments are appended to exports based 

on current export logic. 

Removing and re-adding the same file resets the comments back to the original file content (all 

comments from the Online Review Client are removed), as happened also before this new feature was 

added. 
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New in Translation Workspace Release 1.21.18 

Translation Workspace Release 1.21.18 includes the following new features and enhancements. 

 
 

|||| Web Interface, Server, and API 

 

◼ Aliasing 

 

|||||| The Include Source [TM / Glossary / Review Package] Name option is now enabled by default in the 

Web UI and API when you create an alias token. 

The name of the aliased source TM, Glossary and Review Package is now included by default in the 

system message (Web UI and API) when you create an alias token. 

 
 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| The default display of tags in Authoritative UI was set to Hidden in the main view and Minimized in 

the Segment Editor.  

The default display of tags in the Authoritative UI was set to Hidden in the main view and Minimized in 

the Segment Editor. When you open the Segment Editor the default tag view is set to Show Minimal 

Segment Tags. This way the display of tags is the least intrusive. 

The latest selected setting is retained for subsequent opened segments and between sessions, until 

the setting is changed. 
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Problems fixed in Release 1.21.18 

 
 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| The Search and Replace operation displayed an error when the number of replacements was large.  

The Search and Replace operation displayed an error when the number of replacements to be made 

relative to the file size was large. You could for example perform over 100 replacements in a review 

package, while for another review package you could replace 50 search result hits. 

This was fixed in Release 1.21.18. 

 

|||||| You could not type characters to the Edited Translation field by using ALT+NumCode 

combinations.  

In all other supported browsers except Microsoft Edge, you could not type characters to the Edited 

Translation field by using the ALT+NumCode combinations. 

When you typed special characters using ALT+0000 codes where 0000 stands for a code number 

typed on the NumPad with Num Lock on to an Edited Translation field, and ALT stands for either the 

left or right Alt key, e.g.: 

ALT + 0132 = „ 

ALT + 0147 = “ 

no character was inserted to the Edited Translation field. 

This was fixed in Release 1.21.18. 
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New in Translation Workspace Release 1.21.17 

Translation Workspace Release 1.21.17 includes the following new features and enhancements. 

 
 

|||| Microsoft Word Plug-in 

 

◼ Installer 

 

||||||| A separate installer was created for the TW Microsoft Word Plug-in. 

A new TW Microsoft Word Plug-in installer (WordClient.exe), separated from the TW Tools Client 

installer (TranslationWorkspace.exe), was created for installing the Microsoft Word TW template 

and related information. Although this installer installs the Microsoft Word Plug-in, it relies on the TW 

Tools Client having first installed the logoport.dll contents. 

Users are no longer asked to install the Microsoft Word Plug-in and related functionality when 

installing the TW Tools Client. Installing the Microsoft Word Plug-in is not possible by using the TW 

Tools installer as the Compact installation option, which installed just the DLL and DOT, was removed 

from the TW Tools installer.  

The TW Download page now includes links also for the Microsoft Word Plug-in installer. Both the 

current and previous version are available like for the existing installers. 
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Problems fixed in Release 1.21.17 

 
 

|||| Web Interface and Server 

 

◼ Lock and Propagate 

 

|||||| The Propagate step processing a translated file with empty target segments caused a system 
error. 

The Propagate step processing a translated file with empty target segments caused a system error. 

The propagate code expected there to be a child of the target and dereferenced it to get a value and 

caused the error. 

This was fixed in Release 1.21.17. 

 

 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| You could not in the MS Internet Explorer and MS Edge browsers type some of the Polish 

characters to the Edited Translation field in the Authoritative User Interface.  

Although you had set your MS Windows keyboard to Polish - Programmers, you could not type the 

Polish characters ą, ę, ć, and ń to the Edited Translation field in the Authoritative User Interface while 

using the MS Internet Explorer or MS Edge browser. You could still type the Polish characters in other 

fields of the Authoritative User Interface, for example in the Comment field. 

This was fixed in Release 1.21.17. 

 

 

|||| XLIFF Editor 

 

◼ Input Method Editor 
 

|||| The MS Input Method Editor was displayed at the upper-left corner of the screen instead of at the 

currently opened segment. 

If you changed the Windows keyboard to Chinese Simplified or Japanese, and tried to type Chinese or 

Japanese characters in the segment, the MS Input Method Editor was displayed at the upper-left 

corner of the screen instead of displaying it at the currently opened segment. 
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Problems fixed in Release 1.21.16 

 

|||| Filters 

 

◼ IDML Filter 

 

||||||| Character formatting was removed from Endnote elements during forward conversion. 

The forward conversion did not create a <cf> tag unless there was text somewhere underneath a 

<CharacterStyleRange> element. The endnote elements, which are often the only child of a 

<CharacterStyleRange> element, have no text but InDesign formats them as text anyway. This 

caused InDesign to display endnotes as other than superscript text. 

This was fixed in Release 1.21.16. 

 

||||||| In a back converted IDML file some of the endnote elements were followed by extra elements. 

After a translated XLZ was back converted to IDML, some of the endnote elements in the IDML file 

followed an empty <CharacterStyleRange> element and the <TextFrame> element that had 

originally followed it in the original IDML file. This caused InDesign to find certain endnotes having 

been moved to the wrong place. Endnotes lacking formatting beyond superscript were affected. 

This was fixed in Release 1.21.16. 

 

 

|||| Online Review Client 

 

◼ Authoritative User Interface 

 

|||||| The preview page was not refreshed based on currently selected segment in the Authoritative User 

Interface.  

When you opened the preview for a review package file with Sitecore ICR or AEM content for the first 

time, also the selected segment was displayed in the preview. When you opened the preview for the 

second time for another segment, the preview included the first segment but not the second one. 

This was fixed in Release 1.21.16. 
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|||||| Clicking on a text search result for "1 matching entry" for the second time did not navigate to the 

entry.  

When you clicked on a search result for "1 matching entry" for the second time the Review View did 

not navigate to the entry, even when the Find field was cleared and the same word was searched 

again. Navigation worked as should when more than one matching entry was returned in the search 

result. 

This was fixed in Release 1.21.16. 

 

 

|||| XLIFF Editor 

 

◼ Accelerators 
 

|||| Changes to default keyboard shortcuts in the Accelerator Settings were reset to default when 

XLIFF Editor was restarted.  

If you changed the default keyboard shortcuts in the Tools > Preferences > Accelerator Settings… > 

Keyboard Accelerator Editor (e.g., Copy Source to Target to <ALT> c) the changes were reset to the 

default settings when you restarted LXE, although the changes to the Accelerator Settings should be 

saved.  

This was fixed in Release 1.21.16. 
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New in Translation Workspace Release 1.21.15 

Translation Workspace Release 1.21.15 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ Authoritative User Interface, Advance User Interface, and Simplified User Interface 

 

|||||| You can now insert links to Review Package instructions, displayed and working as HTML links in 

Authoritative User Interface, Advanced User Interface and Simplified User Interface.  

You can now insert links to review package Properties > 

Instructions field which are displayed and work as HTML links in 

the Authoritative, the Advanced, and the Simplified User 

Interface. Package Information > Instructions field. Clicking such 

HTML link in these User Interfaces opens another browser tab 

or window to display the provided content. 

A Package Information button and dialog were added to the 

Advanced and Simplified User Interfaces file list page, as 

already exists in the Authoritative User Interface. 

You can create a link in the following ways: 

 
A URL must be fully qualified: 

www.lionbridge.com works, but 

lionbridge.com does not. 

 

  

Create text Final link 

[Displayed 
text](http://site) 

The Bridge (e.g.) 

<http://site> or 
<https://site> 

https://thebridge.lionbridge.com/ 

www.lionbridge.com www.lionbridge.com 

https://thebridge.lionbridge.com/
https://thebridge.lionbridge.com/
http://www.lionbridge.com/
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|||| XLIFF Editor 

 

◼ Segment Handling 
 

|||| The XLIFF Editor segment editor now times how long each segment in a DQF enabled file has been 

open.  

The XLIFF Editor segment editor was modified to time how long each segment in a DQF enabled file 

has been open. XLIFF Editor now captures the time you spend working on each segment in such a 

file.  

Time is recorded to the closest second as the duration between open and close of the segment editor 

per segment, even if no target is stored at that time (even if the segment is not "saved"). If time has 

already been recorded on a segment, any subsequent open+close duration is added cumulatively. 

"Close" event is any of the means of closing the segment, via various buttons or hotkeys.  

Find/Replace operations that 'Change all' do not update time. QA check on segment close accumulates 

time until close occurs. Global QA check does not impact time until the segment is opened and uses 

the time only between open+close operations. 
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Problems fixed in Release 1.21.15 

 
 

|||| Web Interface and Server 

 

◼ Wordcount analysis 

 

|||||| The Extended mode analysis word count for Japanese and Thai was always 0. 

The Extended mode analysis word count for Japanese and Thai was always 0. The resulting analysis 

log displayed a metered word count but reported 0 as the count in the Words column. 

This was fixed in Release 1.21.15. 

 

 

|||| Filters 

 

◼ IDML Filter 

 

||||||| In a back converted IDML file some of the endnote references were moved and merged in groups. 

After a translated XLZ was back converted to IDML, some of the endnote references in the IDML file 

were moved and merged as groups in several locations in the file. 

This was fixed in Release 1.21.15. 

 

 

|||| XLIFF Editor 

 

◼ Language support 
 

|||| Adding the North American Indian (Other) language to the TM caused an error being displayed.  

When after connecting to Translation Workspace you selected in the Language selection window the 

North American Indian (other) language and clicked OK, XLIFF Editor displayed the following error 

message: 

TWServer returned error: invalid language code  

When the language was added to the TM in the TW Web Interface, the language was not added, and 

no error was displayed.  

The “(Other)” included in any language name was changed to “- Other” except for “English (Other)”. 

This was fixed in Release 1.21.15. 
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◼ Settings 
 

|||| The Ask Before Closing/Cancel Segment Changes setting and the Ask Before Opening a Locked 

Segment setting were no longer saved in the conf.xml after LXE was relaunched.  

If you disabled the Ask before Closing/Cancel Segment Changes setting and the Ask Before Opening 

a Locked Segment setting in the Translation menu and relaunched XLIFF Editor, the settings were no 

longer disabled. 

This was fixed in Release 1.21.15. 
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New in Translation Workspace Release 1.21.14.1 

Translation Workspace Release 1.21.14.1 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Language Support 

 

|||||| Kazakh and Tamil locales that were recently backed out were re-added. 

The following rolled back new locale changes in a previous release were re-enabled: 

Language name Code Language name Code 

Kazakh (Kazakhstan) kk-kz Tamil (India) ta-in 

Kazakh (Tajikistan) kk-tj Tamil (Malaysia) ta-my 

  
Tamil (Singapore) ta-sg 

 
 

|||| Online Review Client 

 

◼ Glossaries 

 

|||||| A Glossary Search button for opening the Glossary View was added to the left main menu of the 

Online Review Client Authoritative User Interface.  

In previous releases, you could open the Glossary View only by clicking the search icon appearing on 

a segment when a suggested term was found. 

A Glossary Search button was added to the bottom of 

the left main menu of the Online Review Client 

Authoritative User Interface. When you click the button 

the Glossary View > Lookup Terms tab is displayed. 

If the Glossary View is already opened via the left menu and the segment 

selected in the Glossary View gets a term suggestion, selecting the Suggested Terms tab 

displays the resulting content as if it were opened using the Glossary Search button on the 

segment. If the segment does not get any term suggestions or no segment is selected, the 

Suggested Terms tab displays an empty result. 

The new Glossary Search button is always displayed and works independently on selected 

settings. Only the term suggestion match is conditional. 

If no Glossary is associated with the Review Package the lookup behaves as in the Classic 

User Interface. 
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New in Translation Workspace Release 1.21.14 

Translation Workspace Release 1.21.14 includes the following new features and enhancements. 

 
 

|||| Online Review Client 

 

◼ Glossaries 

 

|||||| You can now manually search for terms in the Glossary panel of the Online Review Client 

Authoritative User Interface.  

You can now manually lookup for terms in the Glossary panel of the Online Review Client 

Authoritative User Interface. The glossaries linked to the review package TM are searched 

automatically and suggested terms displayed in the Glossary panel when a segment is opened. By 

clicking the Suggested Terms and Lookup Terms buttons you can toggle between automatic and manual 

search. 

 

Clicking Lookup Terms opens the Lookup Terms view with a search field, the Find button and the Find 

Partial Matches selector. You can perform manual searches in the glossaries by inserting the search 

string into the field and clicking Find. If you want the results to include also partial matches, select the 

Find Partial Matches option next to the Find button. 

Click Find to run the search. The results are displayed in the lower part of the Glossary panel. 
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◼ Find and Replace 

 

|||||| A Replace with functionality was added to the Find panel.  

You can now use a Replace with functionality in the Find panel to replace a string which is not in 

internal (locked) tags with a specific string in all found matches in the target segments. 

 

The Replace With text field and Replace All button are enabled only when the Find in target entries option 

is selected and at least one match is found. Otherwise the replace functionality is disabled. 

If you select Replace All, the following 

warning is displayed, asking for your 

confirmation.  

After a successful replace operation: 

 All find entries are cleared 

and the replace is displayed 

being completed with counts.  

 The segments for the open file are re-loaded with updated text. 

 Locked segments follow the review package configuration. If 'Read and Write' is used, then 

locked segments are replaced. If any other option is set, then locked segments are skipped 

(or may not even be listed in the Find results depending on the option). 

 All occurrences of the found word are replaced in a segment with use of Replace all. 
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|||| XLIFF Editor 

 

◼ Quality Evaluation 
 

|||| A Review UI for Dynamic Quality Framework (DQF) was implemented to XLIFF Editor.  

A Review user interface for Dynamic Quality Framework (DQF) files was implemented to XLIFF Editor. 

DQF provides standardized translation quality evaluation methods in XLIFF Editor. When DQF is 

enabled for an XLZ file you can use the quality evaluation functionalities of XLIFF Editor for the 

segments in the file. 

The Review Translation dialog is 

displayed only when the active 

document is DQF enabled, it is 

in review phase, and you open a 

segment. The dialog is hidden 

when the active document is 

either not DQF enabled, not in 

review phase or no segment is 

open. Correct contents are 

loaded automatically when you 

switch between active 

documents with opened 

segment. 

If you are not already logged in, 

obligatory login is prompted 

when you open a DQF-enabled 

file. Logout is prevented if DQF 

is enabled. You must save and 

close the Review Translation 

dialog before logout prompt. LXE 

saves your unique system 

identity to the segments you 

commit. 

Only the same user working in 

the same phase can modify or 

delete an existing review issue. 

Otherwise, a new issue is 

created. Any change to the 

target segment during a review 

phase adds at least one new 

review issue associated to the 

target segment but a new review 

issue does not require a change 

in the target segment. 

Review issues are saved to the file when you make a commit. No review issues are saved to the file 

when you cancel a commit. 
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Using the Review Translation Dialog 
If you make any change to the translation while in a “review” phase, the Review Translation dialog opens 

and requires you to annotate the change by describing the nature of the issue. 

Note: For each issue, you need to indicate an error type, a severity, and a comment. 

 

1. You select an error type from the list of errors in the Error Category field. 

2. The Definition field displays a standard definition of the error type. 

3. The Example field displays a standard example of the error type. 

4. You select a severity level in the Severity field menu. 

5. You add a comment to the Comment field to explain more details about the error. Since you’ll 

need to state what portion of the existing translation is incorrect, the Insert Target Text button 

provides an easy way to add the original target text at the cursor position within the Comment 

field. Original target is the text from the start of the review phase. 

6. The Error and Severity information and the Comments added to the segment are listed in the 

field at the bottom of the Review Translation dialog. 

7. Click Add to add the error and the severity information and your comment to the segment. It is 

also added to the list in the last field of the dialog. 

8. Select an entry in the bottom field and click Delete to delete an error entry from the segment it 

was added to. 

9. Select an entry in the bottom field and click Modify to modify an error entry for the segment it 

was added to. 
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Translation Workspace Release 1.21.12.1 Was a Patch Release 
Translation Workspace Release 1.21.12.1 was a patch release, which removed the following 

languages released in Translation Workspace 1.21.12: 

Language name Code Language name Code 

Kazakh (Kazakhstan) kk-kz Tamil (India) ta-in 

Kazakh (Tajikistan) kk-tj Tamil (Malaysia) ta-my 

  
Tamil (Singapore) ta-sg 
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New in Translation Workspace Release 1.21.12 

Translation Workspace Release 1.21.12 includes the following new features and enhancements. 

 
 

|||| Web Interface and Server 

 

◼ Language Support 

 

|||||| Language locales were added or edited for 48 languages. 

Language locales were added or edited for 48 languages.  

Language name Code Language name Code 

Arabic (Djibouti) ar-dj Italian (San Marino) it-sm 

Arabic (Eritrea) ar-er Italian (Vatican City) it-va 

Arabic (Comoros) ar-km Iu Mien ium 

Arabic (Mauritania) ar-mr Jamaican Patois (Patwa) jam 

Arabic (Palestinian Authority) ar-ps Kaqchiquel  cak 

Arabic (Somalia) ar-so Kazakh (China) kka-cn 

Catalan (Andorra) ca-ad Kazakh (Kazakhstan) kk-kz 

Danish (Faroe Islands) da-fo Kazakh (Tajikistan) kk-tj 

Dagbani dag Kuna, Border  kvn 

Danish (Greenland) da-gl Kuna, San Blas  cuk 

Davawenyo daw Mam  mam 

Dutch (Suriname) nl-sr Muong mtq 

French (Benin) fr-bj Nivacle cag 

French (Burkina Faso) fr-bf Q'eqchi'  kek 

French (Burundi) fr-bi Russian (Tajikistan) ru-tj 

French (Central African Republic) fr-cf Russian (Turkmenistan) ru-tm 

French (Congo) fr-cg Russian (Uzbekistan) ru-uz 

French (Gabon) fr-ga Spanish (Andorra) es-ad 

French (French Guiana) fr-gf Spanish (Antarctica) es-aq 

French (Guinea) fr-gn Spanish (Equatorial Guinea) es-gq 

French (Guadeloupe) fr-gp Tamil (India) ta-in 

French (Haiti)  fr-ht Tamil (Malaysia) ta-my 

French (Saint Pierre and Miquelon) fr-pm Tamil (Singapore) ta-sg 

Fiji Hindi  hif Turkish (Uzbekistan) tr-uz 

New locales are selectable in all places where language selection options are offered in TW and its 

clients: 

 TM language selection upon login to web UI, LXE, Tools 
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 TM and Glossary properties, statistics, export, import, search in Web UI 

 TM language selection in Tools dialogs (Analysis, Pretranslate, Unknown Segments, QA 

Tools, TM Export, TM Maintenance Editor) 

 TM language selection in LXE dialogs (all batch operations tabs) 

Existing languages Tamil and Kazakh that do not currently have a locale specified are changed to 

Tamil (India) and Kazakh (Kazakhstan) 

New RTL language Kazakh (China) behaves as RTL. 

 
 

|||| Online Review Client 

 

◼ User Interface 

 

|||||| An Authoritative User Interface is now available in the Online Review Client.  

An Authoritative User Interface is now available in the Online Review Client. 

 
 

In the Entry Editor view you can make changes and provide feedback on entries in the opened file. 

You can use two fields for the feedback:  

 The Edited Translation field contains a copy of the current translation which you can edit to 

provide your changes to the translation. 

 The Comment field you can use to provide any comment. 
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The Width: Max. | Current values under the Edited Translation field display the maximum character 

width and current width for the translation. The Current width value is updated when the translation is 

edited. If no maximum value is defined for the source segment, the Max. value is displayed as N/A. 

 
 

|||| XLIFF Editor 

 

◼ Terminology 
 

|||| Source term attributes and their values are now properly displayed below global attributes in the 

Terminology search results.  

In previous releases, the source term attributes, and their values were not displayed in the 

Terminology search results. The source term attributes, and their values are now displayed below 

global attributes in the Terminology search results.  
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New in Translation Workspace Release 1.21.11 

Translation Workspace Release 1.21.11 documentation does not include any updates. 
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New in Translation Workspace Release 1.21.10 

Translation Workspace Release 1.21.10 includes the following new features and enhancements. 

 
 

|||| Web Interface and Server 

 

◼ Review Packages 

 

|||||| Comments associated with the latest revision of a review package target segments are now 
included as notes in the XLZ file exported from the review package. 

In previous releases, the comments added to target segments during the review in the Online Review 

Client were not exported as part of the XLZ file exported from the review packages. 

Comments associated with the latest revision of a review package target segments are now included 

as notes in the XLZ file exported from the review package. Any earlier or previous revisions of a target 

that has an associated comment are ignored when an XLZ file is exported. 

The <note> elements have an attribute for 'from' and 'annotates' corresponding to the 'username' 

and 'target/general' respectively. 

In the <trans-unit> the latest comment is first in the list of <note> entries. Earlier comments or 

<note> elements that were not imported are later in the list of <note> elements (<note> elements are 

currently not imported). Pre-existing <note> elements originally in the XLZ file exist later in the list 

once comments added in the Online Review Client are written out. 

Both the comment and suggested translation are stored as individual <note> elements. The <note> 

written from the Suggested Translation text always starts with the text 'Suggested Translation:' before 

the actual Suggested Translation text, to differentiate the <note> in editors like the LXE and CTE. 

Examples: 

A <note> element written from comment text of the Online Review Client: 

<note from="user1@lionbridge.com"  annotates="target">Revision comment 1</note> 

Multiple <note> elements written from an Advanced ORT where comments and suggested translation 

exists: 

<note from="user1@lionbridge.com"  annotates="target">Suggested Translation: 

Suggested translation</note> 

<note from="user1@lionbridge.com"  annotates="target">Revision comment 1</note> 

 

|||||| New options for Review Report output. 

Two new options were added to a request to output a Review Report: 

 Exclude Tags: Select this to exclude all internal tags from the source and target segments in the 

HTML and XML Review Reports. 

 Include All Segments: Select this to include all the Review Package segments in the HTML and 
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XML Review Reports, rather than only changed segments. 

Checkboxes for these options were added to the Generate Review Report tab of the Web User Interface. 

 
 

|||| Online Review Client 

 

◼ Import 

 

|||||| In Online Review the default status of the segments imported from an XLIFF file is now set as 

"New".  

In previous releases, the default status for segments imported from an XLIFF file was set as Pre-

Approved. The default segment status during import from an XLIFF file is now set as New. 
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New in Translation Workspace Release 1.21.9 

Translation Workspace Release 1.21.9 includes the following new features and enhancements. 

 
 

|||| Web Interface and Server 

 

◼ Analysis 

 

|||||| The Unknown Segments Analysis now skips the translated segments. 

In previous releases, the Unknown Segments Analysis performed a TM lookup for the translated 

segments to check whether a match exist in the TMs. This impacted the servers' performances with 

large batches where almost all the content was already translated. 

Now the Unknown Segments Analysis (using APIs, clients or the web interface) skips the translated 

segments and performs no TM lookup to check for an existing match for them. 

Translated segments are no longer available in the Unknown Segments TM for matches which do not 

exist in the TMs. Such segments are always skipped. 
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New in Translation Workspace Release 1.21.8 

Translation Workspace Release 1.21.8 includes the following new features and enhancements. 

 
 

|||| Web Interface and Server 

 

◼ API 

 

|||||| A new “valuestoreget” API is now available. 

A new JSON1 API valuestoreget, which is like valuestorelist and has the same return structure 

as well as similar permission checks (including a check that the user has HVS_READ permission for the 

object). 

The API has the following parameters: 

 objectid (Required; Type: number) — the object id of the object to inquire. 

 key (Optional; Type: string) — the key of the data item to inquire; max 255 characters. 

 appname (Required; Type: string) — the application name of the data item to inquire. 

When a key is specified, the API only queries for and returns data for this key. Otherwise it returns 

data for all keys of this object. 

 

◼ Workgroups 

 

|||||| You can now store a default LMX file into a Workgroup to use it as a default LMX for forward 
conversions with API. 

You can now associate an LMX file with a TW Workgroup using the Web user interface. Such an LMX 

file is then used as a default for conversion to XLZ and RTF through the API when no LMX is 

specified. API functionality is available for this in the backend (valuestoreupload, 

valuestoredownload, valuestorelist, and valuestoredelete). 

In a workgroup, a new Configuration 

tab under the Manage section 

provides functionalities and 

information on this feature. The 

Configuration tab has Add, Export, 

and Remove buttons for handling 

the LMX file. 

The Configuration tab displays the 

Name and Description fields of the 

uploaded LMX configuration. No 

content is displayed if no LMX has 

been uploaded to the workgroup. 

 The Name field displays always the “defaultlmx" value which is the key used in the value store 

table row. 
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 The Description field displays the original name of the uploaded LMX file.  

Selecting Add displays the Add LMX 

Configuration File dialog, which you can 

use to upload an LMX file to the 

workgroup. If an LMX file is already 

present in the workgroup, the old file is 

replaced by the new one (as also by 

valuestoreupload API). 

When an LMX file is present in the 

workgroup:  

 You can select Export to generate 

a download link for the current 

LMX file.  

 You can select Remove to display 

a prompt for confirmation and by 

confirming remove the LMX file 

from the workgroup. 
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Problems fixed in Release 1.21.8 

 
 

|||| TW Tools 

 

◼ File Conversions 

 

||||||| The XLIFF 2.0 xml:space attribute changed in forward conversion. 

In previous releases, the XLIFF 2.0 xml:space attribute for segments was emptied in forward 

conversion to XLZ. 

This was fixed in Release 1.21.8. 
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New in Translation Workspace Release 1.21.7 

Translation Workspace Release 1.21.7 includes the following new features and enhancements. 

 
 
 

|||| Web Interface and Server 

 

◼ Online Review 

 

|||||| The segment status information is now available in the Online Review Package report XML and 
HTML outputs. 

In previous releases, the segment status was not included in the Online Review Package report. This 

information indicates that the suggested translation has been implemented (Status = Approved) or not 

implemented (Status = Rejected). 

The segment status for the last revision is now available in the Online Review Package report XML 

and HTML formats. In the HTML report, a new Segment Status column is available between the Error 

Severity and Last Comment columns. 

The XML report was updated in a way which allows any tool being used to handle the previous XML 

reports to handle the new XML format correctly. 

 

 

 

Problems fixed in Release 1.21.7 

 
 

|||| Online Review Client 

 

◼ Preview 

 

|||||| In the Simplified and Advanced user interfaces, an extra scrollbar was sometimes displayed in the 

preview.  

In previous releases, the preview in the Simplified and Advanced user interfaces displayed sometimes 

an extra scrollbar. 

This was fixed in Release 1.21.7. 

 



February 5, 2018  Release Notes for Earlier Releases of Translation Workspace 

 
 

61 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

New in Translation Workspace Release 1.21.6 

Translation Workspace Release 1.21.6 includes the following new features and enhancements. 

 
 

|||| Web Interface and Server 

 

◼ Language Support 

 

|||||| New languages were added to Translation Workspace. 

The following new language was added to Translation Workspace: 

Language name Language code 

Bodo brx 

 

The new language is available as source and target language in all Translation Workspace 

applications. 

 
 
 

 
 

 

Problems fixed in Release 1.21.6 

 
 

|||| Web Interface and Server 

 

◼ XLIFF Files Handling 

 

|||||| Adding segments to TM from XLIFF files and pre-translating XLIFF files caused a server error. 

Adding segments to TM from XLIFF files and pre-translating XLIFF files caused a server error. 

The issue was related to the <TU> element containing a <seg-source> node. 

This was fixed in Release 1.21.6. 
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New in Translation Workspace Release 1.21.5 
Translation Workspace Release 1.21.5 includes the following new features and enhancements. 

 

 

|||| Web Interface and Server 

 

◼ Language Support 
 

|||||| New languages were added to Translation Workspace. 

The following new language variant was added to Translation Workspace: 

Language name Language code 

Malay (Singapore) ms-sg 

 

The new variant is available as source and target language in all Translation Workspace applications. 
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Problems fixed in Release 1.21.5 
 
 
 

|||| Online Review Client 

 

◼ Preview 
 

|||||| The OOXML preview using LibreOffice for bi-directional languages was not correct.  

In previous releases, the OOXML preview using LibreOffice for bi-directional languages was not as 

should. Right alignment and right to left rendering were not correct. 

This was fixed in Release 1.21.5. 

 

|||||| The preview for source HTML files using context files was not correct.  

In previous releases, there were problems in displaying correctly the preview of source HTML files 

using context files. Images were not correctly displayed in Internet Explorer and Mozilla Firefox and 

the HTML content was wrapped inside extra <html>, <body> and <pre> tag pairs. 

This was fixed in Release 1.21.5. 

 

|||||| The preview for source HTML files using context files was not correct in the Simplified and Advanced 

previews.  

In previous releases, there were sometimes problems in displaying correctly the preview of source 

HTML files using context files. In the Simplified and Advanced user interfaces the images were 

enlarged, and extra scrollbar was added when using Internet Explorer 11. 

This was fixed in Release 1.21.5. 

 
 

|||| XLIFF Editor 

 

◼ Pre-translation 
 

|||| Sometimes pre-translation and translation of XLZ files created files with corrupted target segments.  

In previous releases, pretranslation and translation of XLZ files sometimes created corrupted target 

segments. XLIFF editor displayed a list index out of range error message. 

This was fixed in Release 1.21.5. 
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New in Translation Workspace Release 1.21.4 
Translation Workspace Release 1.21.4 includes the following new features and enhancements. 

 

 

|||| Web Interface and Server 

 

◼ Review Packages 
 

||||||

| 

The context files existing in a review package are now copied with the package. 

When a review package’s settings are copied in the Translation Workspace web interface, also the 

context files are copied. 

 

◼ Reports 
 

||||||

| 

The Online Review reports were enhanced with new data. 

Additional data was added to the Online Review XML and HTML reports containing information on the 

total number of segments per match category and the number of edited segments per match category. 

The following Edit Summary data is now available on the XML and HTML Online Review reports: 

 Number of segments available for editing in the review package. 
 Number of segments available for editing per match category, considered the following 

categories: 

▪ Context matches (101%) 

▪ Exact matches (100%) 

▪ Fuzzy matches (Between 1% and 99%, both included) 

▪ No matches (0%) 

Note: Segment available for editing means that for the review packages where the option for 

locked segments is Read Only or Hidden, the locked segment is not considered when 

calculating the number of segments. 

 

The new data was added as new parameters of the <info> node keeping backward compatibility with 

the previous XML format so that existing tools can continue to use the XML reports. 
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|||| Filters 

 

◼ MIF Filter 
 

||||||| You can now convert MIF2019 files saved from Frame Maker 15 (v2019) with the MIF filter. 

You can now convert MIF2019 files saved by Frame Maker 15 (v2019) with the MIF filter. 

Use MIF2019 files conversion with care as it is not yet fully tested. 

 
 
 

Translation Workspace Release 1.21.3 included workgroup reorganization only 
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New in Translation Workspace Release 1.21.2 
Translation Workspace Release 1.21.2 includes the following new features and enhancements. 

 
 

|||| Web Interface and Server 

 

◼ Administration 

 

||||||| To comply with GDPR, the personally identifiable information was removed from all user accounts in all 

tenancies. 

For GDPR compliance, the following demographic fields were emptied in all user accounts in all 

tenancies: 

 Address line 1 

 Address line 2 

 Zip/Postal code 

 City 

 State (USA) 

 province/Region (non-US) 

 Country 

 Primary telephone number 

 Secondary telephone number 

 Fax1. 

 
 
 



July 12, 2019  Release Notes for Earlier Releases of Translation Workspace 

 
 

67 
This material contains information that is proprietary and confidential 

to Lionbridge. It cannot be shared with third parties without 

Lionbridge written consent. DO NOT COPY. DO NOT DISTRIBUTE. 

New in Translation Workspace Release 1.21.1 
Translation Workspace Release 1.21.1 includes the following new features and enhancements. 

 
 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| The ORT MS Word preview is now generated as PDF.  

In previous releases, the online review preview for XLZ files created from MS Word files was 

generated in HTML. The preview for XLZ files created from MS Word source documents is now 

generated in PDF instead of HTML. 
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New in Translation Workspace Release 1.20.9 
Translation Workspace Release 1.20.9 includes the following new features and enhancements. 

 
 

|||| Web Interface and Server 

 

◼ Glossaries 

 

||||||| The Language list in the Glossary Search window is now listed alphabetically. 

In previous releases, the Source Languages and Target Languages field menus in the Web interface 

Glossary Search tab listed the languages based on their date of addition or in a random order. 

The contents of the Source languages and Target languages field menus in the Glossary Search tab 

are now sorted alphabetically. 

 
 

|||| XLIFF Editor 

 

◼ Concordance Search 
 

|||| MT matches are no longer returned among the Concordance Search results.  

In previous releases, the Concordance Search results included also non-edited MT matches, 

appearing as 100% matches. Sometimes a user had to scroll extensively to view other matches. 

MT matches are no longer included in the Concordance Search results in all existing concordance 

search APIs (JSON1, JSON2, and DLL), and in the Concordance Search window of the following clients: 

 CTE 

 Word Client 

 XLIFF Editor 

This applies to all kinds of MT matches: 

 Matches coming from a TM having the MT flag 

 Matches with the creator user value set to MT! 

 Matches with the explicit attribute origin=MT! 
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Problems fixed in Release 1.20.9 
 
 
 

|||| TW Tools 

 

◼ Conversions 
 

||||||| DOCX files back converted from XLZ sometimes did not contain all the translated text. 

Sometimes some of the text translated in an XLZ document was not included in the back converted 

DOCX document. 

The issue was related to the support for the <databinding> that was added to TW Tools 3.61. 

This was fixed in Release 1.20.9. 
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Problems fixed in Release 1.20.8 
 
 

|||| Web Interface and Server 

 

◼ Translation Memories 
 

||||||| You could not select and view TM information in Internet Explorer 11 in Windows 7. 

After log in to Translation Workspace web inteface and expanding the navigational tree to locate the 

Transltion Memory, you could not select and view Translation Memory information in Internet Explorer 

11 in Windows 7. 

This was fixed in Release 1.20.8. 
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New in Translation Workspace Release 1.20.7 
Translation Workspace Release 1.20.7 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Language Support 
 

||||||| New languages were added to Translation Workspace. 

The following new language variants were added to Translation Workspace: 

Language name Language code 

Adhola adh 

Teso teo 

 

The new variants are available as source and target languages in all Translation Workspace applications. 

 

 

◼ TM Settings 
 

||||||| Three options were added to the TM settings Extra word separator section. 

To make it possible to match Translation Workspace word count with other CAT tools word count, the Extra 

words separator section was added to TW in the previous release. In the Extra words separator section, you 

can set new characters as extra word separators. In this release the following options were added to the section:  

 Hyphen (enabled by default) 

 Comma (disabled by default) 

 Semicolon (disabled by default). 

 

If Hyphen, Comma or Semicolon is enabled as an extra words separator on the TM, the enabled character 

is managed as a word separator. Words separated by the character without space are counted as several 

words. 
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Examples 
 

Text Option disabled Option enabled 

animal,fish,ocean,tropical 1 word 4 words 

captions;captioning;subtitles;subtitles;subtitle 1 word 5 words  

up-to-date 1 word 3 words  

porte-monnaie 1 word 2 words  

 

 

◼ Online Review 
 

||||||| The 'State' and 'Approved' attribute values are now corrected in the XLZ files exported from review 

packages. 

The <target> ’State’ attribute value and <trans-unit> 'Approved' attribute value are now correct in the XLZ 

files exported from the review packages. This solves an incompatibility issue with some states in CTE and with 

segment locking functionality. 
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Problems fixed in Release 1.20.7 
 
 

|||| Web Interface and Server 

 

◼ Tag Handling 
 

||||||| Tag Replacement created incorrect tag IDs in files when TM segment contained no tags and the current 

segment had a closing tag only. 

When the Tag Replacement was on with penalty set to 0%, incorrect tag IDs were created in files when 

the segment in the translation memory did not contain tags and the current segment had a closing tag 

only. 

This was fixed in Release 1.20.7. 

 

 

|||| Online Review Client 

 

◼ Segment Handling 
 

|||||| Segment focus is lost in the Classic user interface every time when you click on the Save button.  

When you click on Save in the Classic user interface, the top of the page is displayed, and focus on last 

selected segment is lost although the focus should stay on the segment. 

This was fixed in Release 1.20.7. 

 
 

◼ Terminology 
 

|||||| In the Terminology Panel of the Advanced user interface, the Bidi text is not correctly displayed when 

an entry is displayed on several lines.  

In the Terminology Panel of the Advanced user interface, the Bidi text is not correctly displayed when an 

entry is displayed on several lines. 

This was fixed in Release 1.20.7. 
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New in Translation Workspace Release 1.20.6 
Translation Workspace Release 1.20.6 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ TM Settings 
 

||||||| The TM settings were updated with a new section to optionally define some extra word separators. 

To make it possible to match Translation Workspace word count with other CAT tools word count, new Extra 

words separator section was added to TW in which you can set new characters as extra word separators. Currently 

only Apostrophe was added to the section. This option is enabled by default, which is compatible with the 

behavior of previous releases. 

 

If Apostrophe is enabled as an extra words separator on the TM, apostrophe (curly or straight) is 

managed as a word separator. Words separated by an apostrophe without space are counted as 

several words.  

Examples of the behavior when Apostrophe is enabled as an extra words separator: 

Text Option disabled Option enabled 

Don't 1 word 2 words 

l'affiche 1 word 2 words 

quelqu'un 1 word 2 words  

 

A new parameter <ExtraWordSeparator> now exists under the <configuration> 

</configuration> section of the TM export file (below the <stoptSigns> section) when you have 

selected the Standard Export or the Unicode Export File export format. 
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The list of extra word separators enabled on the UI is listed there. 

 

Note:  This TM setting like all the other TM settings are extracted during export only when the Export 

TM settings option is enabled. 

 
When you import a TM export file containing TM settings, if the <ExtraWordSeparator> setting 

exists, the TM settings in the Web Interface are updated. 

 

 

◼ Online Review 
 

||||||| The web UI was updated to enable from CMS extracted AEM files preview in Online Review. 

You can now preview from CMS extracted AEM 

files in the Online Review Client. The Web 

Interface was updated in the following ways. 

In the Preview Option dialog, you can now select 

either the CMS Preview option Sitecore ICR files 

or the CMS Preview option for AEM files 

extracted from CMS. 
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New in Translation Workspace Release 1.20.5 
Translation Workspace Release 1.20.5 includes the following new features and enhancements. 

 

 

|||| Filters and Converters 

 

◼ DOCX Filter 
 

||||||| The <databinding> information and the related text translated in the back converted DOCX file are 

now preserved. 

The text used in the <databinding> information is now exported for translation, and related text 

coming from extra XML files (non-document.XML) is exported and re-imported. 

Translated text is re-inserted during back conversion and the <databinding> information is preserved 

in the back converted DOCX file. 

 

 

 

Problems fixed in Release 1.20.5 
 
 

|||| Web Interface and Server 

 

◼ Online Review Preview 
 

||||||| The 'Sitecore' preview was not updated when a task was submitted from TMS. 

When a task was submitted from TMS, the Sitecore information was not added to the Preview column 

in the Review Package details > Review Files tab. 

This was fixed in Release 1.20.5. 
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New in Translation Workspace Release 1.20.4 
Translation Workspace Release 1.20.4 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ User Interface 
 

||||||| The Resources > Geoworkz Directory link was removed from the Web User Interface. 

As GeoWorkz has removed the Geoworkz Directory application in November, the GeoWorkz Directory 

link available under the Resources menu on the TW Web UI was removed. 

 

 

Problems fixed in Release 1.20.4 
 

 

|||| Web Interface and Server 

 

◼ JSON API 
 

||||||| Invalid JSON API code sent to the server caused memory leaks in the server. 

When the server received invalid JSON API code, the server started to leak memory. 

This was fixed in Release 1.20.4. 

 
 

|||| Online Review Client 

 

◼ Preview 
 

|||||| In the Classic interface, the InDesign PDF preview could fail with a ‘Communication failure’ error.  

In the Classic interface, the InDesign PDF preview could fail. After some time, a Communication 

failure error was displayed, and the PDF preview was not generated. 

This was fixed in Release 1.20.4. 
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New in Translation Workspace Release 1.20.3 
Translation Workspace Release 1.20.3 does not include new features or enhancements. 

 

Problems fixed in Release 1.20.3 
 

 

|||| Web Interface and Server 

 

◼ TM Searches 
 

||||||| A search from Translation Memory could stop prematurely. 

If an exact search finds more matches than the maximum number of matches requested, the search could 

unexpectedly stop. The fuzzy match search could still find better matches.  

This was fixed in Release 1.20.3. 

 
 

|||| Filters 

 

◼ DOCX Filter 
 

||||||| An intermittent problem appeared during back conversion to DOCX. 

The back-conversion task could fail intermittently for the same file, but finally run successfully. 

This was fixed in Release 1.20.3. 

 
 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| In the Simplified and Advanced interfaces, the segments opened for editing were highlighted in blue.  

In the Simplified and Advanced interfaces, the segments opened for editing were highlighted in blue, 

which affected readability. 

This was fixed in Release 1.20.3. 
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|||||| In the Simplified and Advanced interfaces, the RTL language segments were not correctly right aligned.  

In the Simplified and Advanced interfaces, the Right to Left language texts in segments containing 

several text lines were too far right aligned. The Edit button and the text overlapped. 

This was fixed in Release 1.20.3. 

 

|||||| In the Simplified and Advanced interfaces, the Pen icon was no longer displayed for a closed segment, if 

one had added a comment or suggested translation to it.  

In the Simplified and Advanced interfaces, the Pen icon was no longer displayed for a closed segment, 

to which a comment or suggested translation had been added. 

This was fixed in Release 1.20.3. 
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New in Translation Workspace Release 1.20.2 
Translation Workspace Release 1.20.2 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Online Review 
 

||||||| The web UI was updated to enable Sitecore ICR files preview in Online Review. 

You can now preview Sitecore ICR files in the Online Review Client. The Web Interface was updated in the 

following ways. 

The XML Preview Option button was renamed as Preview Option and the Transformation column title was 

renamed as Preview. 

 

In the Preview Option dialog, you can now select either 

the XML Preview option for XML files or the CMS 

Preview option for Sitecore ICR files. 
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|||| Online Review Client 

 

◼ Preview 
 

|||||| You can now preview Sitecore ICR XLZ files in all Online Review Client interfaces.  

You can now preview Sitecore ICR XLZ files in the all Online Review User Interfaces. A new window 

displays the specified ICR preview when previewing a Sitecore ICR XLZ file. 
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Problems fixed in Release 1.20.2 
 
 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| Updated Category and Severity information were not displayed on the Advanced user interface 

Segments view after you had saved the segment.  

If you updated the Category and the Severity values for a segment in the Advanced user interface, the 

updated values were not displayed in the Segments view after you had saved the segment. 

The category and severity were however correctly saved and displayed in the Revision History dialog. 

This was fixed in Release 1.20.2. 

 

|||||| The Edit button was not displayed when you hovered over an editable segment in the Simplified or 

Advanced user interface.  

The Edit button was not displayed when you hovered over an editable segment in the Review view of 

the Simplified or the Advanced user interface, although the Edit button should have been displayed. 

This was fixed in Release 1.20.2. 

 
 

|||| Filters 

 

◼ DOCX Filter 
 

||||||| A number of "<w:dataBinding" tags were missing in a back converted DOCX file. 

A number of "<w:dataBinding" tags were missing in a back converted DOCX file. 

This was fixed in Release 1.20.2. 

 

||||||| A part of the translated text was not re-imported during back conversion to DOCX. 

Sometimes some translated texts were not re-imported in the final DOCX document although the texts 

were correctly extracted and translated in the XLZ file. 

This was fixed in Release 1.20.2. 
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New in Translation Workspace Release 1.20.1 
Translation Workspace Release 1.20.1 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Word Counting 
 

||||||| For Simplified Chinese source languages, the double byte punctuation marks are now counted as one 

word in the word count analysis. 

In previous releases, the punctuation marks were not counted for Chinese in the word counts. 

For Simplified Chinese source languages, each double byte punctuation mark is now counted as one word in the 

word count analysis. This applies to: 

 Chinese (China) – zh-cn 

 Chinese (Singapore) - zh-sg 

 Chinese (Malaysia) - zh-my 

No change was made for Traditional Chinese source languages word counting. 

 

◼ Reports 
 

||||||| The information on whether a segment was locked or not in the original XLZ file imported into a review 

package is now available in the generated XML and HTML Online Review reports. 

The information on whether a segment was locked or not in the original XLZ file imported into a review 

package is now available in the generated XML and HTML Online Review reports. 

For the XML report, information can be extracted as a new attribute 'Locked' in the <segment> node 

with the value 'Yes' or 'No', as in the following node: 

<segment TM_Match="100%" locked= "yes" rev="2" segid="3" user="username"> 

For a HTML report, information is available in the Item Details section, in a new 'Locked' column 

displayed next to the 'TM Match' column. 
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The information on locked segments is available only in review packages created in Translation 

Workspace Release 1.20.1 or newer, not in review packages created in previous releases, for which 

the value 'N/A' is provided. 

For RTF files, 'N/A' value is displayed in the Locked column, as locked segments are not managed for 

RTF files. 

 

◼ XLZ Import 
 

||||||| A new option allows you to choose how locked segments are handled during XLZ files import. 

In previous releases, locked segments were not identified in the Online Review Client. They were 

accessible as any other segments. You can now manage the handling of locked segments in the 

Online Review Client.  

A new Locked Segments (XLZ only) field menu was added to the review package Properties page, which 

you can use to set how locked segments are handled when XLZ files are imported. 

 Read and Write (default option): same as in previous releases. Locked segments are imported 

like other segments. 

 Read Only: locked segments are imported but are displayed as read only on the Online Review 

Client user interface. You cannot edit or comment these segments. 

 Hide: Locked segments are imported but not displayed in the Online Review Client user 

interface. 

This option is ignored when you import RTF files. 

For already existing packages, this option is set by default to Read and Write and you can change the 

setting only if the package is empty. 
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|||| Online Review Client 

 

◼ User Interface 
 

|||||| The Classic Online Review interface now displays locked segments based on the import option selected 

for the review package.  

Based on the new XLZ file import options for locked segments, the Online Review Classic interface 

now either displays locked segments as read only or completely hides locked segments.  

1) When you have selected the Read and Write option for the locked segments at the package 

level, a ‘lock’ icon is added to the ID column (first column on the left). 

2) When you have selected the Read Only option for the locked segments at the package level, 

locked segments are displayed only to provide context. 

 A ‘lock’ icon is added to the ID column (first column on the left). 

 Locked segments are grayed out, and no action is possible. You cannot edit, change the 

category, severity or status of the locked segments or add a comment to them. 

 Batch approving segments does not change the status for locked segments to Approved. 

Their status stays unchanged. 

 You cannot perform a replace operation with search & replace functionality on locked 

segments. A note in the Replace warning dialog (see below) mentions that matches in 

locked segments will not be replaced. 

 

 When you hover over a locked segment the following tooltip is displayed: 

    This segment is locked and cannot be modified.  

3) If you selected the Hide option for the locked segments at the package level, locked segments 

are not displayed. 

When you import RTF files, the selected import option has no impact. 

 

|||||| The Simplified and Advanced Online Review interfaces now display locked segments based on the 

import option selected for the review package.  

Based on the new XLZ file import options for locked segments, the Online Review Simplified and 

Advanced interfaces now either display the locked segments as read only or completely hide locked 

segments. 

1) If you selected Read and Write option for the locked segments at the package level, a ‘lock’ icon 

is added to locked segments (first column on the left). 
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2) If you selected the Read Only option for the locked segments at the package level, locked 

segments are displayed only to provide context. 

 A ‘lock’ icon is added to the entry number column (first column on the left). 

 Locked segments are grayed out, and you cannot add a comment or a suggested 

translation to them. 

 When you hover over a locked segment the following tooltip is displayed: 

    This segment is locked and cannot be edited!  

 The View Revision History link is not displayed for locked segments. 

3) If you selected the Hide option for the locked segments at the package level, locked segments 

are not displayed. 

When you import RTF files, the selected import option has no impact. 

 

|||||| A new Freeway logo is displayed when you open the Online Review Client from Freeway. 211930 

An updated Freeway logo is displayed when you open the Online Review Client from Freeway.  
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Problems fixed in Release 1.20.1 
 
 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| A scroll bar issue appeared in the Glossary panel when you used Internet Explorer 11 browser.  

While using Internet Explorer 11, when you opened the Glossary panel for a segment for which there 

were more than 5 glossary entries and you scrolled down on the Glossary panel, when you arrive to the 

bottom of the Glossary panel, the segment view was scrolled down. 

This did not happen while using other browsers. 

This was fixed in Release 1.20.1. 

 

 

 

|||| XLIFF Editor 

 

◼ Spell Check 
 

|||| The behavior of bilingual spell check in XLZ had changed from using MS Office 2013 to using MS Office 

2016.  

Bilingual spell check in XLZ using MS Word 2016 spell checker did not work the same way as when 

using MS Word 2013 spell checker. 

This was fixed in Release 1.20.1. 
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New in Translation Workspace Release 1.19.9 
Translation Workspace Release 1.19.9 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Language Support 
 

||||||| A new language variant was added to Translation Workspace. 

The following new language variant was added to Translation Workspace: 

Language name Language code 

French (Lebanon) fr-lb 

 

The new variant is available as source and target language in all Translation Workspace applications. 

 

 

|||| Online Review Client 

 

◼ Term Handling 
 

|||||| The term's status and attributes and their values are now displayed in the Term Search panel in the 

Simplified and Advanced user interfaces in the Online Review Client.  

To improve reviewer's experience, the term's status and attributes and their values are displayed in 

the terminology panel in the Simplified and Advanced user interfaces. 

The same information is now displayed for a term in the Term Search panel in the Simplified and 

Advanced interfaces as in the Online Review Editor Classic user interface: 

 Source term 

 Translated term 

 Glossary name 

 Target term status value 

 Target term attributes and attribute values (if any exist) 
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Problems fixed in Release 1.19.9 
 
 

|||| Filters 

 

◼ DOCX Filter 
 

||||||| For some XLZ files, back conversion to DOCX failed with a Fatal Error message. 

For some files, the back conversion to DOCX failed with the error message: 

Fatal Error: Xerces SAX2XMLReader::parseNext() reads nothing! 

(…) 

The attribute 'w:type' is already used in element 'br' at (…) 

Expect end of root: document 

Fail to build! 

The error was in the forward conversion, which created tags that contained elements with duplicate 

attributes, which is invalid XML. The back-conversion attempted to process these elements and the 

XML parser failed. 

This was fixed in Release 1.19.9. 

 

 

|||| XLIFF Editor 

 

◼ Segment handling 
 

|||| A wrong State Qualifier value was displayed after you had clicked on the Get previous match from 

Translation Workspace TM option.  

A wrong State Qualifier value was displayed after you had selected Get previous match from 

Translation Workspace TM for a previously saved, reopened fuzzy match segment. 

This was fixed in Release 1.19.9. 
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◼ Tag handling 
 

|||| Sometimes tag substitution failed in pre-translation and interactive translation in XLIFF Editor.  

Segments with a pair of tags starting and ending the segment were not pre-translated or did not 

interactively behave as expected if the TM contained an identical segment without the tags. These 

segments were counted as exact (100% or 101%) matches in analysis and shown as exact matches 

including the substituted tags from the server in XLIFF Editor, but the translation inserted to the target 

field did not contain the tags. 

This was fixed in Release 1.19.9. 
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New in Translation Workspace Release 1.19.8 
Translation Workspace Release 1.19.8 does not include new features or enhancements. 

 

Problems fixed in Release 1.19.8 
 

|||| Web Interface and Server 

 

◼ User Interface 
 

||||||| The language name for ‘Sotho, Northern’ in the Select Language(s) to Add dialog was corrected. 

The language name for ‘Sotho, Northern’ in the [Manage > Languages > Add >] Select Language(s) to Add 

dialog contained a typo. 

This was fixed in Release 1.19.8. 

 
 

|||| Online Review Client 

 

◼ Review Package Settings 
 

|||||| A Review package created using an API did not keep the original template settings.  

If you created a Review package from a template by using an API, the new Review package did not have 

the same settings as the original Review package template. 

This was fixed in Release 1.19.8. 

 

◼ Reports 
 

|||||| Sometimes the Online Review HTML report was not generated.  

If you created a Review package report, sometimes the HTML report was not available although the XML 

report was generated. This was caused by vertical tab characters added to the Suggested translation text. 

This was fixed in Release 1.19.8. 
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◼ User Interface 
 

|||||| The Review view was being masked when a segment was edited with Without a suggested 

translation/comment filter applied.  

If you created a Review package and selected the option Without a suggested translation/comment, editing 

and saving a segment caused the Review view being masked (grayed out). The user could then not click 

anywhere on the page and had to close the current tab. 

This was fixed in Release 1.19.8. 

 

 

|||| XLIFF Editor 

 

◼ Matching 
 

|||| Too many warnings were displayed when you closed a non-edited fuzzy match.  

When you opened a fuzzy match in the XLIFF Editor and closed the segment without editing the 

target, altogether three warning message dialogs were displayed if you selected Yes in the first two 

warning dialogs, although the third warning dialog, QA Check (current segment), should be displayed only 

when you are using the Run QA Check function. 

This was fixed in Release 1.19.8. 

 

◼ Segment handling 
 

|||| The State Qualifier value of a non-edited fuzzy match segment was not reset to fuzzy-match when the 

segment was edited against a TM not providing a 100% match.  

The State Qualifier value of a non-edited fuzzy match segment was not reset to fuzzy-match when 

the segment was edited against a TM which did not provide a 100% match. 

This was fixed in Release 1.19.8. 
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New in Translation Workspace Release 1.19.7 
Translation Workspace Release 1.19.7 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Word counting 
 

||||||| The word counting for Chinese source files was updated. 

The metered word counting for Chinese source segments used in previous releases differs from the 

way other CAT tools are currently working. 

The word counting now counts each ideograph as one word for any variant of Chinese source text. 

Any word which is not composed with ideographs (Latin, Cyrillic, Greek, etc.) is counted as when 

analyzing these languages as source. 

When the source language is any variant of Chinese, the Standard mode and the Extended mode 

analysis results now display: 

 In the Words column, the number of ideographs + the number of non-ideograph words in all 

categories. 

When the source language is any variant of Chinese, the Extended mode analysis results now display:  

 In the Metered column, the number of ideographs + the number of non-ideograph words in all 

categories. 

 The value of the Characters/Word relation is calculated as when the source language is 

English. 

 

 

|||| Online Review Client 

 

◼ Tag Handling 
 

|||||| The markup tags are now displayed in the ‘Suggested Translation’ field of the Simplified and Advanced 

user interfaces (when the option to display the tags is enabled).  

To improve reviewer's experience and translator's implementation of reviewer's feedback, the markup 

tags are now displayed in the Suggested Translation field of the Simplified and Advanced user 

interfaces when the Formatting Tags option is set to Show. The tags are displayed as plain text tags 

and they can be edited. 
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|||| XLIFF Editor 

 

◼ Plugins 
 

|||| You can now create XLZ files by typing or pasting plain text to a dialog in XLIFF Editor.  

A new plug-in lets you create an XLZ file by typing or pasting plain text to a dialog in XLIFF Editor and 

saving it as an XLZ file. 

A new File > New menu command was added just below the File > Open command. When you launch 

this function, a Create New File dialog opens, containing: 

 A Unicode plain text editor to which user can type or paste any text (plain text) 

 A Save As button (grayed out until some text is added to the editor field). 

 A Cancel button. 

Clicking the Save As button opens a Save As dialog where user can choose where to store the XLZ file 

and provide a name to the file 

When you click Save on the Save As dialog, the TEXT Filter is used in background to convert the text 

added in the Create New File dialog into XLZ (using the Plain Text profile of the Default.lmx file). 

An XLZ file is then created into the selected path with the provided name.  

The created file is opened in the XLIFF Editor and the Set Target Language For dialog is displayed. 

 

◼ Segment handling 
 

|||| Non-edited fuzzy match segments now have a specific State Qualifier value in the XLIFF Editor.  

In previous releases, when a fuzzy-match provided by a TM was inserted as a target text into a 

segment and the segment was closed with or without editing it, XLIFF Editor gave it the fuzzy-match 

State Qualifier value. A segment with a fuzzy-match target which is not edited, is now given the x-

fuzzy-match-unedited State Qualifier value in the XLIFF Editor when the segment is closed. 

If a segment with the x-fuzzy-match-unedited State Qualifier value is edited, its State Qualifier value 

is changed to fuzzy-match in the XLIFF Editor, when the segment is closed. 
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◼ Quality Assurance 
 

|||| A new QA check was implemented, which lists all the non-edited fuzzy matches in the XLIFF Editor.  

To separate all non-edited fuzzy matches from edited fuzzy matches, if a fuzzy match provided by a 

TM is inserted as a target text into a segment and the segment is closed without editing, XLIFF Editor 

now sets its State Qualifier value to x-fuzzy-match-unedited. A new QA Check is now available in 

XLIFF Editor, which can be used to detect and report all such segments which have the x-fuzzy-

match-unedited State Qualifier value in the files.  

 

When the Non-edited fuzzy matches option is enabled in the new Matches check category, the QA Check 

contains in the report a warning for each segment which has the x-fuzzy-match-unedited State 

Qualifier value. 
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Problems fixed in Release 1.19.7 
 
 

|||| Filters and Converters 

 

◼ XLIFF 2.0 Converter 
 

||||||| Nested XLIFF 2.0 <mrk> tags were not correctly handled in generated XLZ files. 

The nested XLIFF 2.0 <mrk> tags in generated XLZ files were handled in a way which prevented 

some text form being translated in such files. 

This was fixed in Release 1.19.7. 

 
 

|||| Online Review Client 

 

◼ File Handling 
 

|||||| XLZ file containing a Line Separator character could not be opened in the Online Review Classic User 

Interface.  

You could not open an XLZ file in the Classic User Interface due to a line separator character (U+ 

u8232) in a target segment. The character existed already in the original Idiom XLIFF File. 

This was fixed in Release 1.19.7. 

 

 

|||| XLIFF Editor 

 

◼ Matching 
 

|||| An MT match was displayed as a 101% match when prefetch was ON.  

When prefetch was ON, an MT match was displayed as a 101% match, even when penalized. 

This was fixed in Release 1.19.7. 

 

Translation Workspace Release 1.19.6 was merged to Release 1.19.7. 
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New in Translation Workspace Release 1.19.5 
Translation Workspace Release 1.19.5 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Language support 
 

||||||| A new language variant was added to Translation Workspace. 

The following new language variant was added to Translation Workspace: 

Language name Language code 

Chinese (Malaysia) zh-my 

 

The new variant is available as source and target language everywhere in Translation Workspace. 

 
 

|||| XLIFF Editor 

 

◼ Tools 
 

|||| The default URLs for the XLIFF Editor Web Lookup feature were updated.  

The default URLs for the Web Lookup were replaced with the following ones: 

Name URL 

Wikipedia http://en.wikipedia.org/wiki/Special:Search/%s  

EN>FR – Google Trans http://translate.google.com/translate_t?text=%s&sl=en&tl=fr  

EN>DE – Google Trans http://translate.google.com/translate_t?text=%s&sl=en&tl=de  

EN>ES – Google Trans http://translate.google.com/translate_t?text=%s&sl=en&tl=es  

EN>ZH-CN – Google Trans http://translate.google.com/translate_t?text=%s&sl=en&tl=zh-CN  

EN>JA – Google Trans http://translate.google.com/translate_t?text=%s&sl=en&tl=ja  

EN>FR – Bing Trans http://www.bing.com/translator/?text=%s&from=en&to=fr  

EN>DE – Bing Trans http://www.bing.com/translator/?text=%s&from=en&to=de  

EN>ES– Bing Trans http://www.bing.com/translator/?text=%s&from=en&to=es  

EN>ZH-CN – Bing Trans http://www.bing.com/translator/?text=%s&from=en&to=zh-chs  

EN JA – Bing Trans http://www.bing.com/translator/?text=%s&from=en&to=ja  

 

The URLs list is updated when installing XLIFF Editor on a computer without a previous installation of 

XLIFF Editor, or with XLIFF Editor installed having the previous default list of URLs. 

http://en.wikipedia.org/wiki/Special:Search/%25s
http://translate.google.com/translate_t?text=%25s&sl=en&tl=fr
http://translate.google.com/translate_t?text=%25s&sl=en&tl=de
http://translate.google.com/translate_t?text=%25s&sl=en&tl=es
http://translate.google.com/translate_t?text=%25s&sl=en&tl=zh-CN
http://translate.google.com/translate_t?text=%25s&sl=en&tl=ja
http://www.bing.com/translator/?text=%25s&from=en&to=fr
http://www.bing.com/translator/?text=%25s&from=en&to=de
http://www.bing.com/translator/?text=%25s&from=en&to=es
http://www.bing.com/translator/?text=%25s&from=en&to=zh-chs
http://www.bing.com/translator/?text=%25s&from=en&to=ja
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If the computer has a previous installation of XLIFF Editor without the previous default list of URLs, the 

list is not updated. 

 

|||| A user can now Add, Remove, and Edit URLs for the web lookup feature directly in the XLIFF Editor UI.  

In previous releases, you could not add new entries for the web lookup feature in Tools > Web 

Lookup in XLIFF Editor, except by editing manually the conf.xml file in a text editor. 

In the Tools > Web Lookup > Configure dialog, a user can now: 

▪ Add new URLs 

▪ Remove existing URLs 

▪ Edit existing URLs 

▪ Select a URL for the Web Lookup. 

Any changes done in the Configure dialog are stored in the conf.xml file, which persists across 

sessions. Opening, closing, or updating XLIFF Editor does not reset this file. 

When you use the Tools > Web Lookup > Lookup feature, the URL set in the Tools > Web Lookup 

> Configure dialog is used.
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Problems fixed in Release 1.19.5 
 

 

|||| Filters 

 

◼ MIF Filter 
 

||||||| You could not convert and back-convert MIF2015 files with the MIF filter. 

You could not convert and back-convert MIF2015 files with the MIF filter. 

Other MIF versions files were converted correctly. 

This was fixed in Release 1.19.5. 

 

 

|||| Online Review Client 

 

◼ File Handling 
 

|||||| File import to a Review Package replaced curly brackets with underscores in the XLZ file names.  

An XLZ file import to a Review Package replaces curly brackets with underscores in the XLZ file name 

in the Review Package. 

Also, you could not import an XLZ file with curly brackets in the name without adding it into a ZIP 

package. 

This was fixed in Release 1.19.5. 

 

|||||| Importing an Excel export file to a Review Package did not work when you used the Online Review 

Client Classic User Interface with Chrome browser.  

Importing an Excel export file to a Review Package did not work when you used the Online Review 

Client Classic User Interface with Chrome browser. 

The import process ran endlessly without any result. 

This was fixed in Release 1.19.5. 
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◼ Preview 
 

|||||| In-Context Preview failed when there was a ‘&’ character in the context files path.  

In-Context Preview failed for files which had a ‘&’ character in the context files path. 

This was fixed in Release 1.19.5. 

 

|||| XLIFF Editor 

 

◼ Matching 
 

|||| A search for an existing match was not performed after expanding a segment.  

When you expanded a segment in the XLIFF Editor, the new expanded source was correctly 

displayed in the source field, but the Translation Memory was not searched for an existing match 

corresponding to the new expanded source segment.  

The user had to close and re-open the segment to see whether a match exists, or search for a 

concordance. 

This was fixed in Release 1.19.5. 
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New in Translation Workspace Release 1.19.4 
Translation Workspace Release 1.19.4 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Access Handling 
 

||||||| A new automatic reference counting permission system was implemented. 

A new reference counting permission system can now automatically grant and remove access to 

Translation Workspace assets. 

The TW Administrator role now has a new permission for removing reference counted user 

permissions. This permission can also be assigned to other roles or removed from them manually in 

the Web Interface. 

After the expiration date, Translation Workspace removes reference-counted users only from 

permissions. These users are then no longer visible on the TW Web Interface. When a reference 

count user is removed from an asset manually by a user, the reference counter is reset to '0'. 

If a user account is removed, its associated permissions are also removed. 

 

||||||| The Web Interface was updated for the automatic grant and removal of access to the TW assets.  

The reference count users are displayed as a new row on the User Assignment table, with blue color, 

to separate them from manually assigned users (black) and users assigned to parent objects (gray). 

The value of the counter is displayed in between square brackets, for example [2]. 

When selecting a reference count user, the Remove button is available only for users with the new 

permission for removing reference counted user permissions. 

Clicking on the Hide System Users button hides now both, users assigned to parent objects and 

permission count users from the User Assignment > Members list. 

 

 

|||| Filters 

 

◼ MIF Filter 
 

||||||| You can now convert MIF2017 files saved from Frame Maker 14 (v2017) with the MIF filter. 

You can now convert MIF2017 files saved from Frame Maker 14 (v2017) with the MIF filter. 

Use MIF14 (v2017) files conversion with care as it is not yet fully tested. 
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New in Translation Workspace Release 1.19.3 
Translation Workspace Release 1.19.3 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| Moving between the Text and the Preview views in the Simplified and Advanced interfaces now 

preserves the user’s position on the Text view.  

In previous releases the focus was moved to the top of the Text view when returning from the Preview 

view in the Simplified and Advanced interfaces. 

Moving between the Text and the Preview views in the Simplified and Advanced interfaces now 

preserves the user’s position on the Text view. 

 

|||||| In the Simplified and Advanced interfaces, the Text view now returns the focus to that position in a file 

where you previously stopped working.  

In previous releases the Text view in the Simplified and Advanced interfaces did not record the position 

where you stopped working and could not return the focus back there in the next session. 

A bookmark mechanism was added which returns you back to that position where you stopped 

working with a file in the Text view of the Simplified and Advanced interfaces.  

The bookmark is saved per file and preserved between sessions. 

The cookie which records the position expires after six months of inactivity. 

 

 

|||| XLIFF Editor 

 

◼ Spell-check 
 

|||| The Enchant spell checker was removed from XLIFF Editor.  

The Enchant spell checker is no longer available in XLIFF Editor. 

The MS Word and Hunspell spell checking functionalities are not affected by this. 
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Problems fixed in Release 1.19.3 
 

 

|||| Filters 

 

◼ Lock and Propagate 
 

||||||| Tag alignment error messages returned by the Lock process stopped the respective job in TMS. 

The Lock process returned tag alignment related Error messages, which stopped the respective job in 

TMS, even when the option to treat warnings as errors was disabled in TMS. 

This was fixed in Release 1.19.3. 

 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| Tags disappeared when a segment with terminology entries from the linked glossary was selected.  

When you selected a segment with terminology entries from the linked glossary, the tags in the 

segment disappeared, although they were displayed while the segment was not selected for editing. 

This was fixed in Release 1.19.3. 
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|||| XLIFF Editor 

 

◼ File Conversions 
 

|||| The back conversion failed for files with the XML extension parsed with a Text Filter.  

The back conversion failed for files with the XML extension parsed with a Text Filter. 

The following error messages were displayed when converting XLZ files that were parsed from XML 

files using the Text Filter: 

Missing original file, and  

Translation Workspace XLZ to XML conversion failed. DLL return value: -10 

The Back conversion for such files now works correctly by using the Save Target As command and 

using the Batch Operations dialog. 

This was fixed in Release 1.19.3. 

 

◼ Tag Handling 
 

|||| Sometimes XLIFF Editor did not provide the available match but returned the error “Not Valid TMX. 

TMX tag has no “I” or “x” attribute”.  

Sometimes XLIFF Editor did not provide the available match but returned the error message: 

Not Valid TMX. TMX tag has no “I” or “x” attribute. 

This was fixed in Release 1.19.3. 

 

◼ User Interface 
 

|||| An error was displayed when editing a note (local variable 'node' referenced before assignment).  

When you edited a note, the following error message was displayed in the status bar: 

local variable 'node' referenced before assignment. 

The text you added to the note was not preserved. 

This was fixed in Release 1.19.3. 
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New in Translation Workspace Release 1.19.2 
Translation Workspace Release 1.19.1 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| You can now scroll the glossary list in Simplified and Advanced views.  

In previous releases, a long glossary list appeared truncated (depending of screen resolution) in 

Simplified and Advanced views.  

A vertical scroll-bar was added to the glossary list in Simplified and Advanced views. 

Five first entries are displayed without having to scroll the list. 

 

 

|||| XLIFF Editor 

 

◼ Preview 
 

|||| You can now preview source XLZ files generated from the TEXT filter in XLIFF Editor.  

In previous releases, it was not possible to preview XLZ files generated by the TEXT filter in LXE 

using the web browser preview, although the preview worked in Online Review Client. 

You can now preview source XLZ files generated by the TEXT filter in XLIFF Editor. 

The back converted file is displayed in the web browser. The result is similar as when you open the 

back converted file locally in the web browser. You can also select an external program to preview the 

files. 

All options available for the preview work as for other formats. 

 

◼ Spell-check 
 

|||| Hunspell was implemented to LXE as the third option to already existing Enchant speller and MS Word 

speller.  

You can now use Hunspell dictionaries as the third option for the spell check in XLIFF Editor. 
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Problems fixed in Release 1.19.2 
 

|||| Filters 

 

◼ PPTX Filter 
 

||||||| The text from the slide layout was not extracted even when the option was selected. 

The text from the slide layout was not extracted even when the Extract slide layouts option on the PPTX 

Filter configuration dialog was selected. 

This was fixed in Release 1.19.2. 

 

 

|||| Online Review Client 

 

◼ Glossaries 
 

|||||| Straight apostrophe was displayed as an entity (&apos;) in glossary results in Simplified and Advanced 

views.  

When a glossary entry contained a straight apostrophe, in the Online Review Simplified and Advanced 

views, the glossary result displayed the apostrophe as its entity (&apos;). 

This was fixed in Release 1.19.2. 

 

 

◼ Review Packages 
 

|||||| Sometimes a review package could not be opened in Simplified and Advanced views.  

Sometimes a review package could not be opened in Simplified and Advanced views. An error message 

was displayed instead: undefined. 

This was fixed in Release 1.19.2. 
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|||| XLIFF Editor 

 

◼ Preview 
 

|||| Preview Current File returned the message 'too many values to unpack' when the name of the file 

contained an additional period, i.e., filename.anyext_or_text.docx.  

While Use Associated Application was selected in the Preview Settings Preview Application section, using 

the Preview Current File command returned the message 'too many values to unpack' when the 

name of the file contained an additional period, as in filename.anyext_or_text.docx. 

The preview worked as expected when the Default Preview Options was selected in the Preview Settings. 

This was fixed in Release 1.19.2. 
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New in Translation Workspace Release 1.19.1 
Translation Workspace Release 1.18.9 includes the following new features and enhancements. 

 

 

|||| Web Interface and Server 

 

◼ Tag Handling 
 

||||||| An enhanced tag aligner was implemented to Translation Workspace. 

A new, enhanced tag aligner was implemented to Translation Workspace to ensure that the 

penalization and substitution of tags works as should in all situations. This enhances the processing of 

tags on the server and all clients. 

 

 

 

Problems fixed in Release 1.19.1 
 

 

|||| Filters 

 

◼ Back Conversion 
 

||||||| Converting files back to .lspkg in a ZIP archive returned invalid files with additional extension .lcl. 

Converting files back to .lspkg in a ZIP archive returned invalid files with additional extension .lcl. 

The resulting files had the extension .lspkg.lcl. 

This was fixed in Release 1.19.1. 
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New in Translation Workspace Release 1.18.9 
Translation Workspace Release 1.18.9 includes the following new features and enhancements. 

 

 

|||| XLIFF Editor 

 

◼ Preferences 
 

|||| You can now disable the warning message about the language selected in the TM not matching the one 

set in a file.  

You can now disable the warning message about the language selected in the TM not matching the 

one set in a file.  

A new Warn of XLIFF/TM Language Mismatch option was added into the Tools > Preferences 

submenu allowing you to enable and disable the check for a language mismatch. 

The option is enabled by default. 
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Problems fixed in Release 1.18.9 
 

 

|||| Web Interface and Server 

 

◼ TM Management 
 

||||||| The Calendar was not displayed correctly when you selected a date to the Export Records Created from 

field for TM export. 

The Calendar was not displayed correctly when you selected a date for the Export Records Created 

from field for TM export. 

This happened especially when the both dates in the From fields were identical as well as both the 

values in the To fields. 

This was fixed in Release 1.18.9. 

 

 

 

|||| XLIFF Editor 

 

◼ Interactive translation 
 

|||| Blank Searched source was displayed for Different tag in source & reorder tags in TM target.  

Blank Searched source was displayed for Different tag in source & reorder tags in TM target while 

interactive translation. 

The issue occurred with prefetch = on, but not with prefetch = off. 

This was fixed in Release 1.18.9. 
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New in Translation Workspace Release 1.18.8 
Translation Workspace Release 1.18.8 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ Language support 
 

||||||| New language variants were added to Translation Workspace. 

The following eight new language variants were added to Translation Workspace: 

Language name Language code 

Chinese (Cantonese) zh-xy 

Croatian (Bosnia and Herzegovina) hr-ba 

Russian (Estonia)   ru-ee 

Russian (Israel) ru-il 

Russian (Kyrgyzstan) ru-kg 

Russian (Latvia)  ru-lv 

Russian (Lithuania)   ru-lt 

Turkish (Cyprus) tr-cy 

 
The new variants are available as source and target languages everywhere in Translation Workspace. 

 

◼ TM Management 
 

||||||| You can now export a TM based on selected criteria (date, user). 

Translation Workspace TM Export function now supports exporting the data in the TMs based on 

selected criteria. This applies exporting using APIs and on all TM Export functionality in the user 

interface. 

When using the TM export function from the TW web UI, user has the possibility to select the following 

criteria for the export: 

Date: all segments created or changed within a defined timeframe 

▪ Define only one the end or start date to export all before or after the date 

User: all segments created or modified by a user (free text field) 

If one or several above options are used, only the corresponding Translation Units are exported.  
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|||| Online Review Client 

 

◼ User Interface 

 

|||||| The status, attributes and values for terms are now displayed in the Online Review Client Classic User 

Interface terminology window.  

The Classic Online Review Client user interface now displays the same terminology information as the 

XLIFF Editor does.  

The following details were displayed already in previous releases: 

 Source term 

 Translated term 

 Glossary name 

 The following is additionally displayed now: 

 Glossary: before the glossary name 

 Target term Status: value 

 Target term attributes and attributes' value (if any exists) 
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Problems fixed in Release 1.18.8 
 

 

|||| Web Interface and Server 

 

◼ Word counting 
 

||||||| Machine Translated word counts were not reported in the Word count report. 

Although translation of MT matches was performed, Machine Translated word counts were not 

reported in the Word count report, in at least the following cases: 

 The MT memory was linked as a background memory with a penalty, although it worked fine 

with no penalty. 

 Word counts came from segments marked with the machine translation creator user: 

<CrU>MT! 

This was fixed in Release 1.18.8. 

 

 

|||| Online Review Client 

 

◼ Reports 
 

|||||| Sometimes the Online Review Client generated an empty Review Report.  

Sometimes, after changes were made to a Review Package created by TMS, the Review Report 

generated from the package was empty. The review was performed on the Simplified or the Advanced 

User Interface and the corrections implemented using the Classic User Interface. 

This was fixed in Release 1.18.8. 

 

◼ Import from Excel 
 

|||||| Importing an updated Excel sheet added extra symbols to the Review package segments.  

Importing an updated Excel sheet added extra Katakana symbols (pronunciation hints) for Japanese 

target language to the Review package segments. 

This was fixed in Release 1.18.8. 
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New in Translation Workspace Release 1.18.7 
Translation Workspace Release 1.18.7 includes the following new features and enhancements. 

 

 

|||| Web Interface and Server 

 

◼ Utilities 
 

||||||| Translation Workspace now supports, in input and output, ZIP files containing more than 65,535 files. 

Previous releases prevented analyzing all the files in a ZIP package containing more than 65,535 files. 

Translation Workspace can now, in input and output, handle ZIP files containing more than 65,535 

files, if the size of each file in the ZIP, and the size of the ZIP archive itself, is maximum 2 GB. 

 

◼ Reports 
 

||||||| Machine Translation word count is now listed separately in the Web Interface > Reports > Word 

Counts reports. 

The Machine Translation word count is now reported separately in the TW Web Interface > Reports 

> Word Counts reports. 

MT word count is reported for XLZ files only (not for RTF files). 

A Machine Translated column was added to the Word Count reports. 

In XML reports, a new tag <w_mt> was added for storing MT word count. (For legacy data, no <w_mt> 

tag will be included.) 

In HTML reports, an optional <td></td> tag pair for MT word count was appended at the end of each 

table row. 

Text format word count report uses tabs to separate data field columns. To ensure that existing tools 

can continue to consume both legacy and new reports, the extra MT field is appended at the end of 

each row. 

 

 

  



August 8, 2016  Translation Workspace Release Notes 

August 8, 2016 Copyright Lionbridge, Inc. 2016 115 

Problems Fixed in Release 1.18.7 
 

 

|||| Online Review Client 

 

◼ Import from Excel 
 

|||||| Importing in the Advanced user interface an updated Excel sheet containing LF characters did not work.  

Importing in the Advanced user interface an updated Excel sheet containing LF characters did not 

work, because Excel replaced the LF character with the CRLF character sequence in the updated 

Excel file. 

The following message was displayed: 

The read only data of the spreadsheet has been changed. (Code: ACVEX10) 

This was fixed in Release 1.18.7. 

 

 

|||| XLIFF Editor 

 

◼ Batch operations 

 

|||| Arabic text was incorrectly aligned due to missing dir="rtl" after running back conversion or the Save 

Target function from XLIFF Editor (for format not using the dll).  

Arabic text was incorrectly aligned due to missing dir="rtl" after running back conversion or the Save 

Target function from XLIFF Editor (for format not using the dll). 

This was fixed in Release 1.18.7. 

 

◼ Interactive translation 

 

|||| XLIFF Editor placed the cursor to an incorrect position after canceling a paste operation during 

interactive translation.  

When you pasted a word into the target segment and then canceled the operation pressing CTRL+Z, 

the cursor was not placed back onto the word which was edited just before. 

This was fixed in Release 1.18.7. 
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|||| XLIFF Editor did not provide a translation when you opened a segment by using the command 

Translate to Next Non 100% Match.  

XLIFF Editor did not provide a translation proposition in the open segment when it was opened by 

using the command Translate to Next Non 100% Match. The translation proposition field was not 

displayed. 

The issue did not appear when a segment was opened by using the Open Segment command. 

This was fixed in Release 1.18.7. 

 

◼ Plugins 

 

|||| You could not save a file which was, by opening it with XLIFF Editor, converted with the SDLXLIFF 

plugin to XLZ.  

After you had opened an SDLXLIFF file and XLIFF Editor had converted it to XLZ, you could not save 

it with the Save or the Save As command after making a few changes to it. 

In the status bar at the bottom of the window XLIFF Editor displayed only a red ribbon without any 

error message. 

This was fixed in Release 1.18.7. 

 

◼ Preview 

 

|||| After installing XLIFF Editor and TW Tools or Word Client (DLL) for the first time, the preview failed 

displaying the 'Use Associated Application' error.  

After you had installed XLIFF Editor and TW Tools or Word Client or both for the first time, the preview 

failed and XLIFF displayed the Use Associated Application error. 

This was fixed in Release 1.18.7. 
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Problems fixed in Release 1.18.5 
 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| On each page, the last segment of the page was not automatically fully displayed while it was edited in 

the Simplified and Advanced user interfaces.  

On each page, in the Advanced and the Simplified user interfaces, when you opened the last 

segment, it was only partially displayed until you scrolled to see it completely. 

This was fixed in Release 1.18.5. 

 

|||||| The validation message was displayed briefly or not at all when you clicked on Mark as Reviewed or 

Submit package feedback in the Simplified and Advanced user interfaces.  

When you were not at the top of file, the validation message was displayed briefly or not at all when 

you clicked on Mark as Reviewed or Submit package feedback in the Simplified and Advanced user 

interfaces. 

This was fixed in Release 1.18.5. 

 

 

|||| XLIFF Editor 

 

◼ Interactive translation 

 

|||| XLIFF Editor displayed a blank retrieved source during interactive translation.  

When the source segment tags differed, and target tags were reordered, XLIFF Editor displayed a 

blank retrieved source during interactive translation. 

This happened only while the prefetch function was on. 

This was fixed in Release 1.18.5. 
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◼ Preview 

 

|||| The file preview failed when the file name included a non-ASCII character.  

The file preview in XLIFF Editor failed when the file name included a non-ASCII character. 

For Office Open XML files, XLIFF Editor displayed a Cannot create file: error instead. 

This was fixed in Release 1.18.5. 

 

|||| Trying to preview a TXT file failed and an error message was displayed instead.  

The file preview in XLIFF Editor failed when you tried to preview a file generated by XLIFF Editor by 

opening a TXT file. 

XLIFF Editor displayed a local variable ‘xslpath’ referenced before assignment error 

instead. 

This was fixed in Release 1.18.5. 
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New in Translation Workspace Release 1.18.4 
Translation Workspace Release 1.18.4 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ API 
 

||||||| The Lock and Propagate APIs (DLL and JSON) now process also ZIP packages containing an embedded 

folder structure. 

In previous releases, ZIP packages with an embedded folder structure were neither read nor created 

by Translation Workspace. 

The Lock and Propagate APIs now read and create also ZIP packages with an embedded folder 

structure. 

 

◼ User Interface 
 

||||||| Translation Workspace login page “Sign in with Lionbridge account” button was relabeled. 

On the Translation Workspace login page, the label of the ”Sign in with Lionbridge account” button was 

relabeled as ”Sign in with your corporate credentials”. 
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|||| Online Review Client 

 

◼ User Interface 
 

|||||| The file status Submitted was renamed as Reviewed in the Simplified and Advanced user interfaces.  

To highlight the difference between completing a file review and submitting a package, the file status 

terminology was changed in the Advanced and the Simplified user interfaces. 

The Submit File operation was renamed as Mark as Reviewed. 

The old file status Submitted has been renamed to Reviewed everywhere in the product: 

 In the file status column on the Package summary page file list available on the Review 

page 

 Under the number of Reviewed files on the top right of the Package summary page 

 In the message displayed when you click on Mark as Reviewed (previously Submit File) 

function 

 In the dialog title and message text displayed when you submit a package with all the files 

not marked as Reviewed (previously Submitted). 

 

|||| XLIFF Editor 

 

◼ User Interface 

 

|||| XLIFF Editor now displays the XLIFF 2.0 translation candidate matches in the TW XLZ files.  

Translation Candidates matches from XLIFF 2.0 files converted into TW XLZ files are now displayed on 

the XLIFF Editor Information panel when you select or open a segment for translation. The following 

information is displayed: 

▪ Similarity 

▪ Type 

▪ Origin 

▪ Source 

▪ Target 

If a Translation Candidate and an Alt-trans exist for a segment, they are both displayed in the XLIFF 

Editor Information panel. 



May 5, 2016  Translation Workspace Release Notes 

May 5, 2016 Copyright Lionbridge, Inc. 2016 121 
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Problems fixed in Release 1.18.4 
 

 

|||| Web Interface and Server 

 

◼ Reporting 
 

||||||| The value returned on the Number of segments column of the Review Package Quality Statistics Report 

was incorrect. 

The value returned on the Number of segments column of the Review Package Quality Statistics 

Report was incorrect. 

Instead of reporting the number of all segments in the package, it displayed the number of segments 

for which a category or severity, or both, was defined. 

This was fixed in Release 1. 18.4. 

 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| Previews for Target and for Source were not displayed properly for a XML file in the Advanced and 

Simplified user interfaces. 

In some cases, when you selected Preview > Source or Preview > Target in the Advanced and the 

Simplified user interfaces, some content was not displayed in the generated preview. 

This was fixed in Release 1. 18.4. 
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New in Translation Workspace Release 1.18.3 
Translation Workspace Release 1.18.3 includes the following new features and enhancements.  

 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| Pagination is now available in the Simplified and Advanced user interfaces.  

The Review view is now paginated for files with more than 400 entries. 

You can select the number of entries included in a page with the Entries per page selector menu at 

the bottom left corner of the Review view. You can select to have 100, 200 (default), 400, or 600 

entries per page.

 

You can navigate between pages by clicking the page number buttons or the Next Page and Previous 

Page buttons (one arrow). You can also use the First Page and Last Page buttons (two arrows). 

 

|||||| The date and time of change is now displayed in the Simplified and Advanced user interface segment 

tooltips.  

The date and time of change was previously removed from the Simplified and Advanced user interface 

tooltips. 

The date and the time of change is now displayed in the Simplified and Advanced user interface 

segment tooltips without affecting performance. 
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Problems fixed in Release 1.18.3 
 

 

|||| Filters 

 

◼ Back Conversion 
 

||||||| Back conversion did not handle the source file and the translated file properly. 

After back conversion the source file and the translated file were not handled properly. 

▪ The .bak extension was not inserted into the source file name. 

▪ A .localized extension was inserted into the translated file name. 

This was fixed in Release 1.18.3. 
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New in Translation Workspace Release 1.18.2 
Translation Workspace Release 1.18.2 includes the following new features and enhancements.  

 

 

|||| Web Interface and Server 

 

◼ Language support 
 

||||||| Translation Workspace now supports new Azerbaijani language variants. 

The .Azerbaijani language was named as Azerbaijani - Latin. 

The following two new language variants were added: 

Language name Language code 

Azerbaijani - Cyrillic azc 

Azerbaijani Arabic aza 

 
These new languages are available as source and target languages everywhere in Translation 

Workspace. 

Azerbaijani - Arabic is managed as a right to left language. 

These changes were implemented in the 1.18.1. Patch release. 

 

 

|||| Online Review Client 

 

◼ Export 
 

|||||| The TM match percent value is now extracted into the MS Excel export from a Review Package.  

When you generate the Excel export for a review package: 

 A new column TM % Match is available in between the Segment ID and Source columns 

 The TM % Match value is extracted for each segment (the value is displayed on the Classic 

and Advanced Online Review User Interface)  

 The column is read-only and grayed out 

Excel export file with this new column is also supported for import. 
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|||| XLIFF Editor 

 

◼ User Interface 

 

|||| The character count of the current target segment is now displayed real time in the status bar.  

XLIFF Editor now always displays the total character count of the currently open target segment real 

time in the status bar. Tags in markup style are included in the count. 

 

The value is identical with the one reported by the Segment/Group Length check of the QA Check 

functionality. Internal markup style tags are considered when the Count text in internal option on the QA 

Check Configuration > Length Check dialog is selected. 

 

|||| The Save Target command was replaced with a Save Target As command.  

The File > Save Target command available in previous XLIFF Editor Releases was replaced with a File 

> Save Target As command. 

Giving this command opens a 

dialog which can be used for 

saving the target file into a 

different path than where the 

current XLZ file exists in and 

giving a different name for the 

target file. 

By default, the name is identical 

with the source file name, and 

the path the one where the XLZ 

file was stored. 

If a file with the same name 

exists at the supplied path, a 

dialog with a warning message is 

displayed which lets you select 

whether to replace the existing 

file or not. 
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Problems fixed in Release 1.18.2 
 

 

|||| Online Review Client 

 

◼ File handling 
 

|||||| Handling large files in the Simplified and Advanced interfaces was not fast enough.  

When handling large files in the Simplified and the Advanced interfaces, slowness was detected while 

scrolling and navigating the document, while opening and saving a segment, and while inserting 

comments. 

This was fixed in Release 1.18.2. 

 

◼ Import from Excel 
 

|||||| Import from Excel displayed an error with Excel files which included extra data.  

Import from Excel failed with the error 'The import file is not a review package export'. This happened 

for Excel files which, for example, contained an extra sheet or some custom XML. 

This was fixed in Release 1.18.2. 
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|||| XLIFF Editor 

 

◼ User Interface 

 

|||| The “Document opened” message in the Status bar was falsely displayed with red highlight. 

When you opened a file in XLIFF Editor, the “Document opened” message in the Status bar was 

falsely displayed with red highlight. 

This was fixed in Release 1.18.2.  

 

◼ Plugins 

 

|||| Setting the maxwidth / maxbyte value to ‘0’ caused a misleading Length Check Error being displayed by 

the Length Checker plugin. 

After the maxwidth / maxbyte value was set to ‘0’ for a segment, a misleading Length Check Error was 

displayed by the Length Checker plugin, for example:  

Segment length limit exceeded. Size = 3 Limit = 0 

Continue anyway? 

 
There is now an option available in the Length Checker plugin to select whether the value ‘0’ needs to 

be treated as a ‘0’ (which is the case for XLIFF 2.0 files), or as ‘no limit’. By default, the value = ‘0’ is 

set to ‘no limit’. 

The value of the option is stored the same way as the values of other options. 

When applicable, the error message now reflects the fact that the limit set on ‘0’ is not valid and has to 

be corrected. 

This was fixed in Release 1.18.2. 
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New in Translation Workspace Release 1.18.1 
Translation Workspace Release 1.18.1 includes the following new features and enhancements. 

 

|||| Web Interface and Server 

 

◼ API 
 

||||||| You can now add to TM the Translation Candidates information (converted from XLIFF 2.0) from XLIFF 

1.2 files. 

Translation Workspace now supports the XLIFF 2.0 – Translation Candidates Module (XLIFF 2.0 

specification, 5.1 Translation Candidates Module) in the XLIFF 2.0 converter. Once the data is 

available on the TW XLZ file, you can add it to the TM and display it in the XLIFF Editor. 

When using the AddToTM APIs (JSON and DLL), with the option 'use_alttrans' enabled: 

 Existing Alt-Trans units are saved to the TM instead of Trans unit segments, as in 

previous releases 

 Translation candidate matches from XLIFF 2.0 are saved to the TM instead of Trans unit 

segments, the same way that happens for the Alt-Trans units. 

 If both, Trans units and Alt-Trans units exist for a file, both sets of information are saved to 

the TM (translation candidate first). 

 

◼ User Management 
 

||||||| Change on TW login username. 

Due to changes in ID Management the User Principal Name (UPN) is now used instead of previous 

username (the left part of UPN, before '@') for all users. 

Users on the Lionbridge tenancy will have to use UPN for login. 

For Translation Workplace, this impacts login name for all clients (Word Client, TW Tools, XLIFF 

Editor, and API). Login to the Web Interface still supports also the shorter form of the username 

familiar from the previous releases. 

The change does not disrupt the service. 

 The change has no impact on consumer of the TW APIs on the Lionbridge tenancy 

 The changes for login impacts also all internal tools for Lionbridge tenancy 

 

 

  

http://docs.oasis-open.org/xliff/xliff-core/v2.0/xliff-core-v2.0.html#candidates
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|||| Filters and Converters 

 

◼ XLIFF 2.0 Converter 
 

||||||| The XLIFF 2.0 Translation Candidates module is now supported in the current XLIFF 2.0 Converter. 

XLIFF 2.0 Converter now supports the XLIFF 2.0 – Translation Candidates Module (XLIFF 2.0 

specification, 5.1 Translation Candidates Module). Once the data is available on the TW XLZ file, you 

can add it to the TM and display it in the XLIFF Editor. 

There is an example of a translation candidate module (mtc) below: 

<unit id="1"> 

  <mtc:matches> 

    <mtc:match ref="#m1"> 

      <source>He is my friend.</source> 

      <target>Il est mon ami.</target> 

    </mtc:match> 

    <mtc:match ref="#m1"> 

      <source>He is my best friend.</source> 

      <target>Il est mon meilleur ami.</target> 

    </mtc:match> 

  </mtc:matches> 

  <segment> 

    <source><mrk id="m1" type="mtc:match">He is my 

friend.</mrk></source> 

  </segment> 

  <segment> 

    <source>Yet, I barely see him.</source> 

  </segment> 

</unit> 

 

Conversion from XLIFF 2.0 to TW XLZ generates XLIFF 1.2 files which are valid and can be opened in 

the XLIFF Editor without any issues. 

 Match candidate information available on the <unit> in XLIFF 2.0 is extracted to the 

corresponding <group> node in XLIFF 1.2 

 Tags in match candidate module are converted from XLIFF 2.0 to XLIFF 1.2 if needed 

 Reference between the match candidate and the source segment (<mrk> tag) in XLIFF 2.0 is 

preserved in a way which enables to link the translation candidate data extracted at the 

<group> level and the corresponding <trans-unit>. 

Back conversion from TW XLIFF creates valid XLIFF 2.0 files with translation candidate modules 

preserved as identical to those in the source XLIFF 2.0 file. 

 

|||| TW Tools 

https://webportal.lionbridge.com/f5-w-687474703a2f2f646f63732e6f617369732d6f70656e2e6f7267$$/xliff/xliff-core/v2.0/xliff-core-v2.0.html#candidates
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◼ User Interface 
 

||||||| The upper limit for the content of the Username field of the server login dialog was increased to 300 

bytes UTF-8. 

In previous releases you could insert maximum 40 characters to the Username field of the Translation 

Workspace Server Login dialog of the TW Tools and the Word Client. 

The upper limit for the content of the Username field of the login dialog of the TW Tools and the Word 

Client was increased to 300 bytes UTF-8. 

 

◼ Document Cleanup 
 

||||||| The Store XLIFF Alt-Trans instead of segment option in the Document Cleanup dialog was renamed as 

Store XLIFF Translation Candidate/Alt-Trans instead of segments. 

The Store XLIFF Alt-Trans instead of segment option in the Document Cleanup dialog was renamed as Store 

XLIFF Translation Candidate/Alt-Trans instead of segments. 

If the option is enabled, not the usual Trans segments, but the available XLIFF Alt-Trans or 

‘Translation candidate’ matches are stored to the TM. 

If the Store Translations to TM option is disabled, the Store XLIFF Translation Candidate/Alt-Trans instead of 

segments option is grayed out. 

 

 

|||| XLIFF Editor 

 

◼ User Interface 

 

|||| The upper limit for the content of the Username field of the server login dialog was increased to 300 

bytes UTF-8.  

In previous releases you could insert maximum 40 characters to the Username field of the XLIFF 

Editor. 

The upper limit for the content of the Username field of the login dialog of the XLIFF Editor was 

increased to 300 bytes UTF-8. 

Only the users on the Lionbridge tenancy will have to use UPN for login. 

For TW, this impacts login name for all clients and API, web login should still support both (UPN & 

username). 
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Problems fixed in Release 1.18.1 
 

 

|||| Filters and Converters 

 

◼ XLIFF 2.0 Converter 
 

||||||| The logoport namespace was left out from the <meta> tags in the generated TW XLIFF 1.2 files. 

The logoport prefix/namespace was missing from the <meta> tags in the generated TW XLIFF 1.2 

files. 

This was fixed in Release 1.18.1. 
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New in Translation Workspace Release 1.17.9 
Translation Workspace Release 1.17.9 includes the following new features and enhancements. 

 

|||| Web Interface 

 

 

◼ Review Packages 
 

||||||| Importing files without any segments into a review package is now possible. 

In previous releases, it was not possible to import files without segments into a review package. 

You can now add XLZ and RTF files with no segments to the review packages from the APIs and Web 

Interface. 

No warning messages are displayed in Web Interface or returned for APIs. 

 

 

◼ Glossaries 
 

||||||| You can now directly access the Search tab when selecting a glossary on the Web UI. 

In previous releases, when you opened a glossary on the Web Interface, the glossary’s Properties tab 

was displayed by default. 

When selecting a glossary on the tree view of the TW web UI, the glossary with the Search tab is 

displayed by default. 

 

||||||| 'English (United States)' is now selected as the default source language on the Glossary search page if 

the language exists in the glossary. 

In previous releases, the default value of the Source Language panel on the Search panel was: 

 --Select one -- 

To avoid extra clicks, the English (United States) language is now selected as the Source Language by 

default if the language exists in the glossary. 
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If this language does not exist in the glossary, --Select one -- is used as the default value. 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| A more accurate error message is now displayed in case of a timeout. 

In case of timeout in any Online Review Client interface, a user friendly error message is now returned 

explaining what has happened: 

Session probably timed-out 

Please re-connect to continue your review 

 

|||||| A warning message is now displayed when you open a file without segments. 

In previous releases, importing files without translatable content (no segments) in a review package 

was not possible. In such situations the API returned success=false and a warning message. 

In any Online Review Client interface (Simplified, Advanced and Classic), a warning message is now 

displayed while opening such file, informing that the file does not contain any segments. After that the 

file opens without segments displayed. 
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Problems fixed in Release 1.17.9 
 

 

|||| Web Interface 

 

◼ Review Packages 
 

||||||| An error message was displayed when you tried, by clicking Save in the XLIFF Editor, to locally save an 

XLZ file which you just had added to a review package in the Web Interface. 

After adding an XLZ file to a review package in the Web Interface, when you tried to save the same 

file in XLIFF Editor by clicking Save on the toolbar, an error message was displayed: 

[17] Cannot create a file when that file already exists: None 

 
Closing the dialogue by clicking the  button released the file. 

A temporary file was simultaneously created to the same folder as the XLZ file was located. 

Trying to reopen the file in XLIFF Editor displayed a "No such file" message and the file did not 

open. 

Logging out from the Web Interface deleted the local XLZ file.  

This was fixed in Release 1.17.9. 

 

||||||| The QA model was corrupted when added to a copy of a review package by using the Copy settings 

functionality. 

After opening a new review package created by using the Copy Settings functionality and importing a 

new QA model to it, while trying to export the QA model an error message was displayed: 

Error exporting: no QA model selected 

 
If you imported files to the review package and opened the files in the Classic user interface, the 

Category and the Severity drop-down lists were empty. In the Simplified and Advanced user interfaces, 

the following error was displayed: 

We apologize, but an error occurred and your 
request could not be completed. 

Please try again later. 
no model id supplied 

 
Also, errors were caused while generating Online Review reports. 

This was fixed in Release 1.17.9.
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New in Translation Workspace Release 1.17.8 
Translation Workspace Release 1.17.8 includes the following new features and enhancements. 

 

|||| XLIFF Editor 

 

◼ Plugins 

 

|||| A plugin which warns if the XLZ file languages and TM languages do not match is now included in the 

XLIFF Editor build.  

A new check_lang_mismatch plugin is now installed by default with the XLIFF Editor. The plugin is 

listed in the Help > Plugin Info window. 

When opening a file while you are connected to a TM and language pair, the plugin verifies that the 

source and target language defined in the XLZ file match the ones selected in the TM. In case of a 

mismatch, a warning is displayed. 

If user is not connected to a TM and has a file open, when connecting to the TM, the plugin verifies 

that the source and target language defined in the XLZ file match the ones selected in the TM. In case 

of a mismatch, a warning is displayed. 

 

|||| The XLIFF Editor length check plugin was updated with a new version to support also the maxbyte 

attribute.  

The existing XLIFF Editor Length Check plug-in was updated. With the updated plugin it is possible to 

check <trans-unit> or <group> length based on: 

A number of characters, using the maxwidth attribute. (As in earlier releases.) 

A number of bytes using the maxbytes attribute. 

Warnings and errors displayed for the maxbytes length check is consistent with what is returned when 

checking the maxwidth. 

The available Length Check options (Count text in internal, Ignore inter-segment spaces, and Ignore skeleton 

(external) content) work for the maxwidth and maxbytes attributes check. 
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◼ Spellcheck 

 

|||| An interactive spell check now checks spelling while you type the target segment text in XLIFF Editor.  

You can now select in the Spell Check Configuration dialog whether an interactive spell check is 

performed (enabled by default). The interactive spell check uses the spell checker configured in the 

Spell Check Configuration dialog and it works for all the languages with all the available options. 

The spell check is performed while you type text in the target segment underlining words with typos in 

red the same way as in MS Office. 

A right-click on a word reported with an error by the spell checker displays a menu listing: 

All the suggestions provided by the spell checker 

An option to ignore the current occurrence of the error reported by the spell checker 

When you select one of the words from the suggestions list of the spell checker, the word in the text is 

replaced. 

If you click on Ignore once, the spell check issue is ignored, and the word is no longer marked as a 

spell check error in the segment. Other occurrences of the same error in the file are reported. 

 

◼ Notes 

 

|||| The <group> level notes in XLIFF 1.2 files are now displayed in the Notes panel of the XLIFF Editor.  

In previous releases, only the notes at the <trans-unit> level was displayed on the Notes panel. 

Notes available at the <group> and <trans-unit> level in XLIFF 1.2 are now both displayed on the 

Notes panel at the bottom of the XLIFF Editor.  

Notes available at the <group> level is displayed for each <trans-unit> of the <group>. 

Notes created manually from the XLIFF Editor Notes panel are always created at the <trans-unit> 

level. 
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Problems fixed in Release 1.17.8 
 

|||| Web Interface 

 

◼ TM Import 
 

||||||| TM Import has been enhanced to prevent the server becoming out of memory and the related 

preventive restarts. 

Over the past year, there has been many server crashes since the TW server memory usage has 

extended up to a critical limit. 

For several months now, preventive restarts have been performed before the server reaches the 

critical limit, but every time it has required someone to validate that everything is as should after 

restart. 

Importing a large amount of small TMX files in one batch is known to have caused extensive memory 

usage. 

This was fixed in Release 1.17.8. 

 

◼ Reports 
 

||||||| The Online Review Quality Statistic Report was not available in XML format for download if a warning 

note is displayed on the Task Wait dialog. 

When a warning note was displayed on the Task Wait dialog the link for downloading the XML report 

was not available in the dialog, although the generated report was available on the Task List in the 

user interface. 

The error message read: 

 Note: Cannot get error statistics for package NN, error: no QA Model. 

This was fixed in Release 1.17.8. 

 

||||||| If the Online Review Quality Statistic Report did not contain any data, clicking 'Show Report' caused 

paging bar refreshing button to spin continuously. 

If the Quality Statistic Report did not contain any data, clicking Show Report caused paging bar 

refreshing button to spin continuously. 

This was fixed in Release 1.17.8. 

 

||||||| Generating the Online Review Quality Statistic Report displayed warnings for packages the user could 

not access. 

When you generated the Online Review Quality Statistic Report, “No access…” messages were 

displayed for packages listed in the navigation area the user had no access to. 

The warning message now says that the user has not necessary rights to generate a report for such 

packages. 
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This was fixed in Release 1.17.8. 

 

||||||| The created Online Review Quality Statistic Report was empty. 

If a user with the Project Manager role created an Online Review Quality Statistic Report, an empty 

report was generated even when reportable data was available, as the Project Manager role did not 

provide required system permissions. 

This was fixed in Release 1.17.8. 

 

 

|||| Online Review Client 

 

◼ Export and Import 
 

|||||| Import from an exported MS Excel file failed if all the rows did not have a category/severity defined in 

the Excel file when the Force QA model option was enabled in the package properties. 

Importing content from an exported MS Excel file failed when all the Excel file rows did not have a 

category/severity value. An error message was displayed instead: 

 Invalid category value in row <n> (Code ACVEX10) 

This was fixed in Release 1.17.8. 

 

◼ User Interface 
 

|||||| In some cases, while using Internet Explorer, the vertical scrollbar of the Preview pane was not active in 

the Simplified and Advanced user interfaces. 

After clicking Preview in the Simplified and in the Advanced user interface, the vertical scrollbar on the 

Preview panel frame was grayed out in Internet Explorer and it was impossible to scroll the preview.  

This was fixed in Release 1.17.8. 

 

|||||| The TW glossary name was not completely displayed in the Glossary dialog in the Simplified and 

Advanced user interfaces. 

In the Simplified and in the Advanced user interface, the TW glossary name in the Glossary dialog was 

not completely displayed. 

This was fixed in Release 1.17.8. 
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|||| XLIFF Editor 

 

◼ Plugins 

 

|||| The Modified source check QA checker was listed twice on the QA Check Configuration dialog.  

The Modified source check QA checker was listed twice on the QA Check Configuration dialog. 

It should be only available under the 'segment-closing-event' option. 

This was fixed in Release 1.17.8. 
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New in Translation Workspace Release 1.17.7 
Translation Workspace Release 1.17.7 includes the following new features and enhancements. 

 

|||| Web Interface 

 

◼ Reports 
 

||||||| It is now possible to run a new Quality Statistics Status report based on selected Online Review 

packages ID with the possibility to display the result and download it as an XML file. 

You can now run a new Quality Statistics Status report based on selected Online Review packages ID 

from the Reports menu or by right-clicking an Online Review Package on the asset tree pane and 

selecting Open Report From Here > Review Package Quality Statistic in the context menu. 

A new tab is displayed, where you can select the options for the report. You can select to show the 

result in the Web Interface and download the report as an XML file. 

You can export the report based on a source or a target language, or both. 

The report contains the following information: 

▪ Workgroup and Workgroup ID 

▪ Package name and package ID 

▪ QA model associated to the package 

▪ Number of files in the packages 

▪ Number of segments in the package 

▪ Source language 

▪ Target Language 

▪ Number of errors for each severity defined in the QA model by category defined in the QA 

model 

N/A is exported if no data exists for a specific category & severity on the QA model. 

 

||||||| Some changes were made to the Online Review Report XML and HTML outputs. 

The Suggested translation and Comment provided by the reviewer are now displayed in the Online 

Review Package report, each in a separate column. 

Three columns were renamed in the following way: 

▪ The Existing Translation column was renamed as Original Translation 

▪ The Proposed Translation column was renamed as Current Translation 

▪ The Comments column was renamed as Last Comment. 

A new Suggested translation column was added next to the Current Translation column, displaying the 

following information related to the last revision with ‘Revised’ status:  
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▪ Suggested translation if any exists 

▪ Comment if any exists 

▪ Username of the user who entered the comment and (or) suggested translation 

If no revision with ‘Revised’ status exists, the Suggested Translation column is left empty. 

The Last comment column displays only the last comment of the last revision and username of the 

user who entered it. 

If the last comment from the last revision comment is the comment from the last revision marked as 

‘Revised’, the comment is not displayed. 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| A warning message is now displayed when you close the Simplified and the Advanced interface. 

When you close the Simplified and Advanced Online Review Client interfaces by closing the browser 

tab or the browser, a warning message dialog now asks you to accept or cancel the closing of the 

page. 

 

|||||| A horizontal scroll bar is now displayed at the top of the preview window in the Simplified and the 

Advanced interfaces. 

A horizontal scroll bar is now displayed at the top of the Preview window in the Simplified and 

Advanced interfaces, when the preview does not fully fit into the window, the same way as at the 

bottom of the Preview window. 

 

|||| XLIFF Editor 

 

◼ Segment Handling 

 

|||| The Expand/Shrink functions are now disabled in XLIFF Editor for master/repetitions segments.  

In XLIFF Editor, it is no longer possible to expand or shrink segments having the master/repetition 

information coming from the Lock & Propagate functionality. 

A warning is disabled if you try to edit such segments.  
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Problems fixed in Release 1.17.7 
 

 

|||| Web Interface 

 

◼ Reports 
 

||||||| Exporting XLZ files from a Review package which has a colon in its name, backing up the package or 

exporting it to MS Excel was not possible. An 'Invalid filename' error was generated instead. 

When you tried to export XLZ files from a Review package which has a colon (:) in its name, backup 

the package or export it to MS Excel, no result was created. An ‘Invalid filename´ error was 

generated instead. 

This was fixed in Release 1.17.7. 

 

 

|||| Filters 

 

◼ DOCX Filter 
 

||||||| Back converting an XLZ to DOCX created a corrupted file when you used an LMX with the option 

includeSource="true" for back conversion. 

Back converted DOCX file was corrupted and could not be opened correctly in MS Word when back 

conversion used the tag2docx JSON API with the following settings: 

▪ The source DOCX was included into the XLZ file 

▪ The source file was passed in input 

▪ An LMX with the option includeSource="true" was passed for the DOCX filter 

 
This was fixed in Release 1.17.7. 
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|||| Online Review Client 

 

◼ User Interface 
 

|||||| When you previewed a file by using the Both option, the text in the preview was not wrapped properly. 

When you previewed a file by using the Both (source and target) option, the text was not wrapped in 

the preview properly. 

This was fixed in Release 1.17.7. 

 

|||||| While you were using the Advanced User Interface with Internet Explorer (9, 10, or 11), the cursor 

appeared when you clicked on the ‘Import’ of Import from Excel. 

When you were using the Advanced User Interface with Internet Explorer (9, 10, or 11), the cursor 

appeared when you clicked on the ‘Import’ of Import from Excel, although the cursor should not be 

visible on the Import button  

This was fixed in Release 1.17.7. 

 

|||||| When you opened the Simplified User Interface the browser tab name contained “waiting for…” 

although the page was fully loaded. 

When you opened the Online Review Simplified User Interface, the browser tab name contained the 

text “waiting for…” although the page was already fully loaded.  

This was fixed in Release 1.17.7. 

 

|||||| Review package with colon in the name generates an 'Invalid filename' error when exporting XLZ files, 

doing a package backup or exporting to MS Excel. 

When you opened the Online Review Simplified User Interface, the browser tab name contained the 

text “waiting for…” even though the page was already fully loaded. 

This was fixed in Release 1.17.7.  

 

|||||| In the Simplified user interface, the Filter panel did not close in the Preview view by clicking on the 

underlying text view. 

If you opened the Filter panel while the Preview view of the Simplified user interface was open, you 

could not close it by clicking on the view, although the panel should close if you click on the user 

interface anywhere outside the Filter panel. 

This was fixed in Release 1.17.7. 
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◼ Export and Import 
 

|||||| Export to MS Excel failed for a Review Package if the 'Vendor Name' for the package was defined. 

If you modified the review package settings in the Web Interface by inserting data to the Vendor Name 

field, after launching the Online Review client, Export to Excel failed. The following error message was 

displayed instead in the Task Wait window: 

Note: Multiple QA model properties found for the project  

(Code: ACVEX10) 

This was fixed in Release 1.17.7. 

 

|||||| Import from MS Excel to a Review Package failed if the 'Vendor Name' setting for the package was 

defined. 

If you modified the review package settings in the Web Interface by inserting data to the Vendor Name 

field after exporting the package to MS Excel, after launching the Online Review client, Import from 

MS Excel failed. The following error message was displayed instead in the Task Wait window: 

Note: Multiple QA model properties found for the project  

(Code: ACVEX10) 

This was fixed in Release 1.17.7. 

 

 

|||| Microsoft Word Plug-in 

 

◼ XLIFF 2.0 Converter 
 

||||||| Converting an XLIFF 2.0 file which includes an apostrophe created an XLZ file which XLIFF Editor could 

not open. 

Converting an ANSI encoded XLIFF 2.0 file with no XML header, which included an apostrophe, 

created a not well-formed XLZ file, which XLIFF Editor could not open. 

This was fixed in Release 1.17.7. 
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|||| XLIFF Editor 

 

◼ User Interface 

 

|||| An error message was displayed when you closed a file in the Grid User Interface mode by using the x 

button.  

XLIFF Editor displayed the following error message on the XLIFF Editor Status bar when you closed a 

file in Grid User Interface mode by clicking the x button next to the document name: 

 

This was fixed in Release 1.17.7. 

 

|||| In the Grid UI view a non-breaking space was not displayed as a non-breaking space in the main grid 

pane, only in the upper translation pane.  

In the XLIFF Editor Grid User Interface, a non-breaking space was not displayed as a non-breaking 

space character in the main grid pane, but only in the upper Translation pane. 

This was fixed in Release 1.17.7.  

 

|||| You could not insert a custom tag into the target field of an XLZ file converted from XLIFF 2.0.  

You could not insert a custom tag in XLIFF Editor to the target field of an XLZ file converted from 

XLIFF 2.0. 

This was fixed in Release 1.17.7. 
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New in Translation Workspace Release 1.17.6 
Translation Workspace Release 1.17.6 includes the following new features and enhancements. 

 

|||| Filters  

 

◼ MIF Filter 
 

||||||| You can now use the MIF filter for converting MIF 2015 files saved with FrameMaker 2015 Release (FM 

13). 

The previous releases did not prepare MIF2015 files and warned that these files are not supported. 

You can now with the Translation Workspace MIF Filter convert MIF2015 files saved with FrameMaker 

2015 Release (FM 13). 

This conversion should however be used with care as it has not yet been tested thoroughly. 

Please note the following: 

▪ The MathML objects (new since MIF 12) are not supported and are lost in back converted 

documents. 

▪ Changes marked in MIF files with Change Bars are accepted prior to conversion. 

 

◼ XLIFF 2.0 Filter 
 

||||||| The XLIFF 2.0 converter now supports the XLIFF 2.0 Metadata module. 

The XLIFF 2.0 converter now supports the XLIFF 2.0 Metadata module.  

The XLIFF 2.0 metadata information available in the original file is extracted into the TW XLIFF 1.2 

format which supports the metadata. The back conversion creates a valid XLIFF 2.0 file containing the 

preserved metadata module. 

 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| Loading entries from large files while scrolling was improved. 

Loading entries while scrolling large files (containing about 1000 entries) was improved. 

 

◼ Preview 
 

|||||| An improved preview functionality for text file formats was implemented to the Online Review. 
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In previous releases, the text file formats were back converted and saved as HTML and not rendered 

optimally for most text formats. 

The preview of text file formats in the Online Review was improved to render the preview faithful to 

the original source file layout.  

 

|||| XLIFF Editor 

 

◼ User Interface 

 

|||| The XLIFF 2.0 metadata is now viewable in the XLIFF Editor while a segment is open.  

XLIFF Editor now displays the XLIFF 2.0 metadata while a segment is open on the user interface. The 

metadata is displayed on all user interfaces, on the Information panel below the main view, (in which 

the Alt Trans, Notes, Context, and Prop Group information is displayed). 

The Category, Type, and Value metadata information is displayed, each in its own column: 
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Problems fixed in Release 1.17.6 
 

 

|||| Web Interface 

 

◼ Online Review 
 

||||||| The Online Review menu did not display the Advanced option. 

After login to Translation Workspace Web UI and selecting a review package, the Online Review menu 

did not always display the Advanced command. Only Classic and Simplified commands were available 

in the menu. 

Refreshing the page displayed also the Advanced command in the menu. 

This was fixed in Release 1.17.6. 

 

 

|||| Filters  

 

◼ XLIFF 2.0 Filter 
 

||||||| Batch conversion from XLZ to XLIFF 2.0 sometimes generated a corrupted XLIFF 2.0 file. 

While you batch converted XLZ files to XLIFF 2.0, sometimes the conversion created randomly an 

XLIFF file which was not valid, containing also all the logoport namespace. 

Back converting only, the specific file created a valid XLIFF 2.0 file. 

This was fixed in Release 1.17.6. 

 

||||||| Converting an XLIFF 2.0 file with a <mrk> element containing an embedded inline element resulted in 

an XLZ file with invalid XLIFF 1.2. 

Converting an XLIFF 2.0 file containing a <mrk> element embedding a <pc> element to TW XLZ 

format resulted in an invalid XLIFF 1.2 file. 

This was fixed in Release 1.17.6.  

 

||||||| Conversion to XLZ preserved extra XML whitespace in the source and the target segments in the XLZ 

file. 

Unnecessary XML whitespace was preserved in the source and target segments in a TW XLZ file 

generated by the conversion. 

This was fixed in Release 1.17.6.  
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|||| Online Review Client 

 

◼ User Interface 
 

|||||| While using the Advanced User Interface with Internet Explorer 9, you could add more than 4000 

characters into a Suggested Translation and more than 2000 characters into a Comment. 

While using the Advanced User Interface with Internet Explorer 9, you were not prevented from adding 

more than 4000 characters into one Suggested Translation and more than 2000 characters into one 

Comment, although such restrictions should apply. 

This was fixed in Release 1.17.6. 

 

|||||| While using the Advanced User Interface with Internet Explorer 11, you could open the Select File dialog 

by clicking the disabled Import from Excel button. 

Although the Import from Excel button should not trigger any function while disabled, while using the 

Advanced User Interface with Internet Explorer, the Select File dialog was displayed when you clicked 

the disabled button. 

This was fixed in Release 1.17.6. 

 

|||||| While using the Advanced User Interface with Firefox 38.0.1, a Comment text including no space 

characters was not displayed correctly. 

While you used the Advanced User Interface with Firefox 38.0.1, Comments including no space 

characters were not correctly displayed. 

This was fixed in Release 1.17.6. 

 

|||||| While using the Classic and Advanced User Interface with Edge browser, the Import from MS Excel 

functionality did not work. 

While you used the Classic and the Advanced User Interface with Edge browser, the Import from MS 

Excel did not import the changes made in MS Excel into the Review Package. 

After the import, the Advanced User Interface displayed the “Cannot upload the file” warning. 

This was fixed in Release 1.17.6. 

 

|||||| While using the Advanced User Interface with Internet Explorer 9, the Import from MS Excel 

functionality did not work properly. 

While you used the Advanced User Interface with Internet Explorer 9, the Import from MS Excel did not 

import the changes made in MS Excel into the Review Package, but displayed instead and error 

message saying: 

Cannot upload the file 

This was fixed in Release 1.17.6. 
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|||||| In the Advanced User Interface, the Revision History view was still displayed although you had 

navigated to another page. 

After enabling the Set Category and Severity setting in the Advanced User Interface, if you navigated to the 

Review view, clicked View Revision History and then navigated to some other page, selected a different 

file or just pressed backspace, the Revision History view was still displayed. 

The Glossary behaved the same way. 

This was fixed in Release 1.17.6.  

 

|||||| On Android devices, the Glossary results in the Simplifed and Advanced User Interfaces were displayed 

improperly inside the Glossary panel. 

On Android devices, the Glossary results in the Simplifed and the Advanced User Interface were 

displayed improperly one below the other inside the Glossary panel, although the Segment name, 

Translation and the Glossary name should be displayed adjacent in a row. 

This was fixed in Release 1.17.6. 

 

 

◼ Preview 
 

|||||| The In context preview did not work properly in the Advanced and Simplified User Interfaces for an XML 

file that contains the XSL file declaration in the XML. 

When you previewed an XLZ file converted from an XML file which contains the XSL declaration in the 

Advanced and Simplified user interfaces, the preview in context did now work properly, although the 

XSL file was uploaded as a context file into the Review Package. 

This was fixed in Release 1.17.6. 

 

 

◼ Comments 
 

|||||| In the Comments the word wrapping was not performed at the word level. 

In the Comments the word wrapping was not performed at the word level, which sometimes cut words 

in half. 

This was fixed in Release 1.17.6. 
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|||| XLIFF Editor 

 

◼ User Interface 

 

|||| The user prompt behavior was confusing, when you opened an XLIFF 2.0 file from a folder in which an 

XLIFF 1.2 file already exists.  

When you opened an XLIFF 2.0 file from a folder in which an XLIFF 1.2 file already exists, XLIFF 

Editor first correctly asked if you want to overwrite the existing XLZ file. After selecting No in the 

dialog, a Translation Workspace Error dialog was unexpectedly displayed with the message: 

A target file with same name already exists in same folder. 

This was fixed in Release 1.17.6. 
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New in Translation Workspace Release 1.17.5 
Translation Workspace Release 1.17.5 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ User Interface 
 

|||||| The Online Review client menu now lists also an Advanced UI option. 

The Online Review button in the Web Interface displaying a menu for the different 

Online Review Client user interfaces now displays also an Advanced UI option. 

 

Selecting Advanced displays the advanced version of the Package summary 

page. 

 

 

The Advanced command in the menu is disabled when no review package is selected on the Web 

Interface Tree menu on the left pane. 

 

||||||| There is now available an option to select on the Online Review Client UI to Enable or Disable exporting 

to and importing from MS Excel. 

An option to select for enabling or disabling exporting to and importing from MS Excel format was 

implemented on the Online Review Client all user interfaces. 

In the Package Properties tab there is a new checkbox option Allow Excel Export/Import below the Force 

Terminology Display option.  
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The option is enabled by default when creating a new package and for all existing packages. 

 

||||||| The MS Excel Export and Import functionalities are now optionally available on the Classic Online Review 

Client user interface. 

The MS Excel Export and Import functionalities are now optionally available on the Online Review 

Client Classic user interface. 

When the option Allow Excel Export/Import is enabled on the review package settings, the functionality 

to export a review package to MS Excel and to import from MS Excel is accessible on the UI. The 

export and import using the APIs is possible. 

When the option Allow Excel Export/Import is disabled on the review package settings, the functionality 

to export a review package to MS Excel and to import from MS Excel is hidden on the UI. The export 

and import using the APIs is not possible. 

On the Online Review Client Classic user interface, under the review package tree, when selecting a 

review package and performing a right click, a new menu command Import from MS Excel is available 

below the existing Export to MS Excel menu command. 

 

When the function is launched, a dialog box is displays for choosing the .xlsx file to import. 

▪ MS Excel .xslx files are filtered by the open dialog 

▪ Any other file format is rejected 

▪ If import is performed successfully, the content is refreshed accordingly on the UI. 

 

◼ Import from MS Excel 
 

||||||| You can now import back into a review package the MS Excel export. 

In previous releases you could export the content of a review package into an Excel file. 

Now you can import back into the review package the Excel file after it has been reviewed. 

A sanity check is performed before the import to confirm that the Excel export file corresponds to the 

selected review package and is a valid export file. 

During an import, the following fields are updated: 

▪ The Suggested Translation is imported into the new Suggested Translation comment created 

for the new Simplified UI. It does not overwrite the target text 

▪ The Comments are added as new comments for the segment 

▪ The Category field is updated for the corresponding segment 

▪ The Severity field is updated for the corresponding segment 

Username of the user performing the import and the import timestamp are used as metadata for the 

history. Import performed cross aliases uses the tenancy name instead. 
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During the import: 

▪ If the Suggested Translation and Comments field are empty on the Excel file, no empty 

comment is created in the review package for this segment, no history (revision) is created 

(potential category/severity values are not registered) 

▪ If a comment or a suggested translation is added to a segment, the segment status is 

changed to Revised automatically (which generates a new revision). The comment and the 

suggested revision is added to this new revision with the Revised status 

If for any reason, the import cannot be performed, error with explanation for the problems is returned 

to the user and the whole import is canceled (partial import is not performed). 

 

||||||| A sanity check is performed before the MS Excel file import. 

A sanity check is performed before the MS Excel file import to confirm that the Excel export file 

corresponds to the selected review package and is a valid export file. 

If the sanity check fails, the import is canceled, and an error message returned to the end user with 

details on the following issue(s). 

▪ Whether the file is a valid Excel (.xlsx) file or not 

▪ Package (ID, files, languages, segment Ids, segments source/target) does not match with the 

selected review package and the review package export. 

▪ Any change in the locked parts of the MS Excel export compared to the exported data 

(change in content, location, number of cells, etc.) 

▪ Pick list values are not valid 

▪ A change on the QA model. 
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|||| XLIFF Editor 

 

◼ User Interface 

 

|||| You can now select text on the Grid UI table view of the XLIFF Editor.  

As in the Classic UI and the Inline UI, a user can now select text passages on the Grid UI. 

All possible actions performed on the selected text (concordance search, term search, etc.) work the 

same way as in the Inline and Classic UI. 

 

|||| Context menu functionality was implemented to the Grid UI of the XLIFF Editor.  

As in the Classic UI and the Inline UI, a user can now open 

a context menu in the Grid UI with a right-click. 

Using the grid UI preforming a right-click inside an open 

segment displays the following context menu. 

 

 

When you right-click on the segment table view, the 

following context menu is displayed: 

▪ Copy Source Text copies the source text of the activated 

segments. 

▪ Copy Target Text copies the target text of the activated 

segments. 

▪ Copy Source and Target Text copies the source and target text of the selected segments in the 

segment table view, with the segment markers and the match percent. 

▪ Select All [Ctrl+A] selects all text inside the open document. 

Context Menu items are enabled and disabled the same way as within the Inline UI and the Classic UI 

context menus. 

You can also select several rows as a non-continuous area by Ctrl-clicking or a continuous area by 

Shift-clicking. 
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◼ File Conversions 

 

|||| XLIFF 2.0 files are now converted to Translation Workspace XLZ when you open the files in the XLIFF 

Editor.  

In previous releases, an error was returned when you tried to open XLIFF 2.0 files in XLIFF Editor. 

Users had to convert the files using TW Tools first. 

As for the other converters (SDLXLIFF and Idiom), users can now have the XLIFF 2.0 files converted 

to TW XLZ format when opening the XLIFF 2.0 files in the XLIFF Editor. 

When an XLIFF 2.0 file is opened in the XLIFF Editor using drag and drop or with the File > Open 

function: 

1. The XLIFF 2.0 file is automatically converted to TW XLZ in the background and saved at the 

same path as the source XLIFF 2.0 file. XLZ file similar as the one generated using the XLIFF 

2.0 converter of TW Tools. 

2. The generated TW XLZ file is opened in the XLIFF Editor. 
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Problems fixed in Release 1.17.5 
 

|||| Filters  

 

◼ XLIFF 2.0 Filter 
 

||||||| Conversion of an XLIFF 2.0 file containing escaped CDATA strings resulted in malformed unusable XLZ. 

Converting an XLIFF 2.0 file with escaped CDATA resulted in a malformed XLZ file, which was 

unusable. TW Tools displayed an error message of the CDATA section while analyzing the file.  

This was fixed in Release 1.17.5. 

 

||||||| Conversion to XLZ preserved extra XML whitespace in the source and the target segments in the XLZ 

file. 

Unnecessary XML whitespace was preserved in the source and target segments in a TW XLZ file 

generated by the conversion. 

This was fixed in Release 1.17.5. 

 

|||| Online Review Client 

 

◼ Review Editor 
 

||||||| The vertical scroll bar position of the Simplified UI is not displayed consistently in a bi-directional file 

preview. 

While previewing a bi-directional file in the Simplified user interface, the vertical scroll bar position was 

not displayed consistently. 

In Chrome and Firefox, the scroll bar was displayed on the right side, but in Internet Explorer it was 

displayed on the left side. 

This was fixed in Release 1.17.5. 
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New in Translation Workspace Release 1.17.4 
Translation Workspace Release 1.17.4 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ User Interface 
 

||||||| The Online Review client is now opened from a menu, which lists two Online Review versions. 

The Online Review button in the Web Interface used in 

previous versions to open the Online Review client now 

opens a menu, which lists three different Online Review 

versions to choose from: 

Selecting Classic opens the version of the Online Review 

client familiar from previous releases. 

Selecting Simplified opens the simplified version of the Package summary page. 

 

 

The Simplified command in the menu is disabled when no review package is selected on the Web 

Interface Tree menu on the left. 

When launching the OR classic UI with a review package selected on the TW Web Interface the 

Online Review client is opened with the selected review package. 
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||||||| The Online Review Classic version now supports the new JSON comment structure. 

The Online Review Classic version now supports the new JSON comment structure. The suggested 

translation and comment are distinguished with prefix labels. 

  

 

||||||| Online Review report now supports the new JSON comment structure. 

The Review Report now handles the new JSON formatted comments. The suggested translation and 

comment are distinguished with labels. 

 

||||||| You can see all comments in the History view in the Segment Editor and copy the comment text. 

The reviewer can now see all comments in the History view in the Segment Editor and copy the 

comment text to the clipboard. 

All the comments and suggested translation comments are displayed on the Revision panel of the 

Segment Editor (with a label informing whether it is a comment or a suggested translation), associated 

to the correct Revision. You can select the text of the comments by using the mouse. 
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◼ Export to Excel 
 

||||||| The Package Excel Export file was modified. 

The MS Excel package export file was modified in the following ways. 

1. The name of the Proposed Target column was changed to Suggested Translation. 

2. The Status column is now locked and its values defined during export cannot be changed. 

3. Two new columns, Category and Severity, have been created, which are empty after the export. A 

drop-down list is available for each of these two columns listing the categories and severities 

defined for the review package (these values can vary from one package to another as they are 

customizable by importing a QA model into a review package).  

These fields contain the value "none" by default when exporting the Excel report. You can then 

use values from the pick list. You cannot empty the cell. 

4. The order of the columns in the MS Export files is as follows: 

Source 
Lang 

Target 
Lang 

File 
Name 

Segment 
ID 

Source Target Suggested 
Translation 

Comments Category Severity Status 

 

 
 



July 1, 2015  Translation Workspace Release Notes 

July 1, 2015 Copyright Lionbridge, Inc. 2016 162 

New in Translation Workspace Release 1.17.3 
Translation Workspace Release 1.17.3 includes the following new features and enhancements. 

 

|||| Web Interface 

 

◼ Translation Memory Management 
 

||||||| The<bpt> and <ept> tags are now supported as such (and not as <ph>) when you import TMX files 

generated by tools listed as trusted. 

In previous releases, when you imported to a translation memory TMX data not created by Translation 

Workspace, the <bpt> and <ept> markup was treated as <ph> tags, as the paired-tag information 

coming from another system was considered potentially unreliable. Some information was thereby 

lost, possibly affecting tag substitution. 

During the import, the TMX files are now checked for whether they are trusted or not. If the TMX is 

trusted, the <bpt> and <ept> tags are preserved and no longer converted to <ph> tags. The id 

relationship between those tags is also preserved. 

While importing TMX 1.4 files not created by Translation Workspace the files are handled like TMX 

generated by TW. 

An error is returned if any problem is detected during the import. 

 

|||| Online Review Client 

 

◼ Preview 
 

||||||| The OOXML preview was updated in the Online Review client to support HTML and PDF preview 

rendered by an open office library. 

You can now preview the XLZ files created from MS Word and MS Excel source files in HTML preview 

and the XLZ files created from MS PowerPoint source files in PDF preview. 

In the Online Review client, if the XLZ files (from source OOXML formats) have the source file 

embedded, when user requests a preview, it displays an HTML or a PDF file as a rendered version of 

the MS Office file generated by an open office library. 

In the Online Review client, if the XLZ files (from source OOXML formats) have the source file 

embedded, when user requests a preview: 

▪ The XLZ files is back converted using the embedded source document  

▪ The generated final document is converted to HTML or PDF format using an open office 

library 

▪ The HTML or PDF file is displayed in the browser 

If any problem occurs during the back conversion or in generating the HTML file, an explicit error 

message is displayed to the end user and the XSL/HTML or PDF preview is displayed. 

An error message is displayed (or returned): 



July 1, 2015  Translation Workspace Release Notes 

July 1, 2015 Copyright Lionbridge, Inc. 2016 163 

▪ If there is any problem during the back conversion 

▪ If the file cannot be opened in an associated application 

▪ If back conversion fails 

You can generate a new preview although a previous preview file has not been closed. 

 
 

|||| XLIFF Editor 

 

◼ User Interface 
 

||||||| A new tabulated Grid UI mode was added into the XLIFF Editor user interface, with the source and 

target text side by side.  
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You can now translate in a tabulated view in the XLIFF Editor, with the source and target text side by 

side. It displays a table with 3 columns: 

▪ The source text 

▪ The percentage match of the match retrieved from the TM 

▪ The target text 

The Target Segment Editor and the proposed TM match are displayed above the Grid UI view, the 

same way as in the XLIFF Editor Classic UI. 

If you select Source view in the View menu, only the Source and Match value columns are displayed. 

▪ If you select Target view in the View menu, only the Target and the Match value columns are 

displayed. 

▪ If you select Both in the View menu, all three columns (Source, Match value, and Target) are 

displayed. 

All the existing actions and functions work as they work on the Classic UI and the Inline UI. 

In the XLIFF Editor View menu, there is 

a new menu option allowing you to select 

between the three existing user 

interfaces: 

▪ Inline UI 

▪ Grid UI 

▪ Classic UI 

The Inline user interface is selected by 

default when installing the XLIFF Editor. 

The selected UI is stored and re-used 

from one session to another. 

You can use the buttons and menus for 

selecting the display of the context (View > Document view > Context) in the Grid UI. 

Note: The changes tracking is disabled in the Grid UI. 

 

||||||| You can now hide the Insert special characters toolbar in the XLIFF Editor.  

You can now hide or display the Insert special characters toolbar in the XLIFF Editor by selecting 

Enable the Special Characters toolbar or Disable the Special Characters toolbar in the View menu. 

The value of this option is stored in the XLIFF Editor settings and preserved from one session to 

another. 

The toolbar is displayed by default. 
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Problems Fixed in Release 1.17.3: 
 

|||| Web Interface and Server 

 

◼ JSON API 
 

||||||| The Auto select did not work for the text2tag API command if the input file was a zip file.41322 

The auto-select feature of the text filter did not work with the text2tag JSON API when the input file 

was a zip file. The parsing resulted in leaving everything in default profile style (pain text). 

This was fixed in Release 1.17.3. 

 

 

|||| Filters  

 

◼ IDML Filter 
 

||||||| Colors for some IDML elements were changed during back conversion.41035 

During the back conversion to IDML format the color for some IDML elements was changed. 

This was fixed in Release 1.17.3. 

 

||||||| Sometimes a file back converted to IDML did not open in InDesign due to the 'less than' character (<) 

not being converted to an entity.41105 

After back conversion to IDML format the IDML file sometimes did not open in InDesign, because the 

less than character (<) was not back converted to an entity (&lt;). 

The problem occurred only when the < character had a format different to the preceding and following 

text, or when the character existed alone. 

The problem did not occur with the other XML reserved characters (&, >, or "). 

This was fixed in Release 1.17.3. 
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|||| Online Review Client 

 

◼ Search and Replace 
 

||||||| The ‘Replace operation cannot be undone’ warning dialog was displayed although the 'Replace in the 

source segment' option was enabled. 

The warning about the Replace operation cannot be undone was displayed when the Find in source segment 

option was enabled although it should not be displayed when the option is enabled, because 

replacement in the source is not allowed. The Replace button should be also grayed out. 

This was fixed in Release 1.17.3. 

 

||||||| The “Replace” button was not disabled although the search was not performed on a specific text. 

If you inserted a text string into the Replace field but leaved the Search field empty, the Replace button 

was not disabled, although it should be, and a warning was displayed asking for confirmation when 

user initiated the Replace operation. 

This was fixed in Release 1.17.3. 

 

||||||| The Bi-directional text in the search results table was not rendered correctly. 

The Bi-directional text (Arabic) in the search results table was not rendered correctly from right to left. 

This was fixed in Release 1.17.3. 
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New in Translation Workspace Release 1.17.2 
Translation Workspace Release 1.17.2 includes the following new features and enhancements. 

 

|||| Online Review Client 

 

◼ Search and Replace 
 

||||||| You can now perform global search and global replace in the Online Review. 

In previous releases, you could not search 

or replace content in the Table View of 

segments directly. 

Now you can search and replace text in 

segments for the current file or all the files 

in a package. 

You can search in the source (unchecked 

by default), or in the target (checked by 

default), or in both, source and target. 

You can also enable the following options 

(disabled by default) for the search: 

Match case for case-sensitive search 

Match whole word(s) for searching for a 

string with whole words (a part of a word is 

not considered as a match) 

Match whole segment for searching for a 

complete segment match 

Ignore tags in segments for allowing tags and 

placeholders to exist in the matches even 

when the search string does not contain 

any (disables the Include tag content 

checkbox) 

Include tag content for including tag content 

(as plain text) in the search (disables the 

Ignore tags in segments checkbox) 

The search results are displayed in a new 

Search results window on the Tools pane with 

the following additional information: 

▪ The number of found occurrences 

▪ The list of found segments containing the searched text (the searched text is highlighted in the 

source and, or, target segment) 

▪ Clicking on a listed item causes the main panel to display the corresponding segment in the 

right page 
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You can also change the status and the category of the search results items and add comments to 

them. 

Performing replacement 

A user with required rights can perform a replacement with the string provided in the Replace with field. 

▪ The replacement is performed on the current search results, target text only 

▪ Replaced text will not be re-searched for additional replacement 

▪ Replacement is blocked if the files include unsaved segments (a dialog asks the user to save 

segments first, which she can perform directly from the dialog) 

▪ Auto-save does not happen during or interfere with the replace operation 

▪ Tags are not supported in replacement text (replacement field is a plain text field) 

▪ The replace functionality is blocked ("Replace All" button disabled) and a message is displayed 

informing the user, if at least one of the following options has been used for the search: Find in 

source segments, Ignore tags, or Include tag content 

▪ Before any replacement is performed, a message is displayed warning the user that the replace 
operation cannot be undone:  

  
 

During the replacement operation: 

▪ Information is displayed on how many segments have been modified and how many 

replacements have been performed 

▪ All the changes are saved automatically, and the user interface is refreshed accordingly 

▪ A new revision with the changed target is created for each modified segment (using correct 

username and date & time) 
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|||| XLIFF Editor 

 

◼ Preview 
 

||||||| XLIFF Editor preview now supports previewing XLZ files converted from MS Office documents in MS 

Office applications. 

You can now preview the XLZ files created from source OOXML files (MS Word, MS PowerPoint and 

MS Excel) in the corresponding MS Office tool. 

 

In the XLIFF Editor View > Preview Settings dialog, when the Use Associated Application option is selected 

and a user requests a preview: 

▪ The XLZ files is back converted using the embedded source document  

▪ The generated final document is opened in the associated application for the MS Office file 

type (Word, PowerPoint, or Excel) 

An error message is displayed (or returned), 

▪ If there is any problem during the back conversion 

▪ If the file cannot be opened in an associated application 

▪ If back conversion fails 

You can generate a new preview although a previous preview file has not been closed. 
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Problems Fixed in Release 1.17.2: 

 

 

|||| Online Review Client 

 

◼ MS Excel Export 
 

||||||| Sometimes Chrome Browser displayed a Blank Task Wait window, when Excel Export was performed in 

the Online Review Client for a Review package containing more than 1,048,576 segments. 

Chrome Browser could display a Blank Task Wait window without a link to save or open the export file, 

when Excel Export was performed the in Online Review Client for a Review package containing more 

than 1,048,576 segments. 

This was fixed in Release 1.17.2. 

 

◼ String Length Check 
 

||||||| The real-time value for "Cur Width" was sometimes not correctly updated. 

When opening and closing square brackets were added first and then numbers inserted between them 

into a target segment, the updated real time Cur Width did not display a correct value for the segment 

length, as the numbers between the brackets were not included in the count. 

This was fixed in Release 1.17.2. 

 

◼ Preview in Context 
 

||||||| Files in ZIP packages with backslash as the file path separator did not work in the “XML in context 

preview”. 

The Online Review client could not use context files imported in ZIP packages with backslash as the 

file path separator. 

This was fixed in Release 1.17.2. 
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|||| XLIFF Editor 

 

◼ Plugins 
 

||||||| Converting an SDLXLIFF file to XLZ and back could add carriage returns into the file. 

Converting an SDLXLIFF file to XLZ and back could add extra carriage returns into the final file. 

This was fixed in Release 1.17.2. 

 

||||||| Sometimes opening an SDLXLIFF file in SDL Studio failed after back conversion from XLZ. 

Sometimes an SDLXLIFF file back converted from XLZ could not be opened in SDL Studio. 

This was fixed in Release 1.17.2. 
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New in Translation Workspace Release 1.17.1 
Translation Workspace Release 1.17.1 includes the following new features and enhancements. 

 

 

|||| Web Interface 

 

◼ User Interface 
 

||||||| The TAUS page was removed from the Translation Workspace Web Interface. 

The TAUS feature was deprecated and the link to the TAUS page was removed from the Web 

Interface. 

 
 

 

|||| Online Review Client 

 

◼ User Interface 
 

||||||| Online Review segment editor now checks the string length of the target segment while it is edited. 

When you are editing a target segment in the Online Review client, the information on the number of 

characters in the target segment (the internal text is not counted) is now displayed and updated real 

time. 

The length of the target string is checked when closing the segment editor and a ”Translation 

length limit exceeded” alert is displayed if the text is longer than what is defined in the file as the 

Max width for the <trans-unit>. 

 

||||||| The Online Review page called by Freeway was updated with the latest logo and color. 

The Online Review client launched via Freeway was updated to display the latest Freeway logo and 

coloring. 
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|||| TW Tools 

 

◼ User Interface 
 

||||||| You can now set the last used TM and Language pair to be auto-selected when connecting to 

Translation Workspace. 

You can now use in all the Login dialogs of the TW Tools and the Word Client two new options with 

check-boxes, the Use last TM option and the Use last language pair option, which are unchecked by 

default.  

 If you check Use last TM, the last used TM is auto-selected and the TM selection screen is not 

displayed (except if the TM no longer exists or if you no longer have permission for the TM, or 

if TM selection fails for any other reason). 

 If you check Use last language pair, the language pair is auto-selected if it exists for the 

previously selected TM; otherwise the Language Selection dialog is displayed. 

What you select for the check-boxes (checked/unchecked) persists from a session to another. 

The login procedure still prompts you to select the possible attribute set. 

 
 

 

|||| XLIFF Editor 

 

◼ User Interface 
 

||||||| You can now set the last used TM and Language pair to be auto-selected when connecting to 

Translation Workspace. 

You can now use in all the Login dialogs of the XLIFF Editor two new options with check-boxes, the 

Use last TM option and the Use Last Language Pair option, which are unchecked by default.  

 If you check Use last TM, the last used TM is auto-selected and the TM selection screen is not 

displayed (except if the TM no longer exists or if you no longer have permission for the TM, or 

if TM selection fails for any other reason). 

 If you check Use Last Language Pair, the language pair is auto-selected if it exists for the 

previously selected TM; else the Language Selection dialog is displayed. 

What you select for the check-boxes (checked/unchecked) persists from a session to another. 

The login procedure still prompts you to select the possible attribute set. 
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◼ Editing 
 

||||||| You can now insert special characters as plain text into segments by using a toolbar. 

A new toolbar is available in the XLIFF Editor with buttons that allow to insert the following 

characters/signs: 

Copyright Em Dash « » 

Registered En Dash " " 

Trade mark Non-breaking hyphen „ “ 

Degree Non-breaking space Ellipsis 

 

 

The three pairs of quotes are inserted around the selected text, if something is selected in the target 

segment, or at the both sides of the cursor’s location in the target segment. Other characters replace 

any selected character string. 

The list of characters that can be added using the Edit > Insert Special Characters was updated to 

include the characters in the toolbar. 

The new Special characters actions are available under the Special Chars Actions section of the 

Keyboard Accelerator Editor, which can be opened by selecting Tools > Preference > Accelerator settings. 
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Problems Fixed in Release 1.17.1: 

 

|||| Web Interface 

 

◼ User Interface 
 

||||||| In Internet Explorer 9, the 'Select Transformation File' dialog was not displayed when you clicked on the 

XML Preview Option button. 

In Internet Explorer 9, the Select Transformation File dialog does not open when clicking on the 

XML Preview Option button. 

The problem occurred both, while compatibility mode was enabled and while it was disabled on 

Internet Explorer 9, but not while using other supported versions of Internet Explorer or other 

supported browsers. 

The function was replaced with a platform independent approach using parameter passing. 

This was fixed in Release 1.17.1. 

 

 

|||| Online Review Client 

 

◼ MS Excel Export 
 

||||||| An error was displayed when you opened an Excel file containing more than 1,048,576 segments. 

After generating an Excel export of a Review Package with review files containing segments more 

than 1,048,576 segments opening the generated XLSX file in MS Excel a blank Task List window was 

displayed, although the link for saving or opening the file should be displayed in the Task Wait window. 

When the file was successfully downloaded from the TW Web Interface > Task List, an error was 

displayed when you tried to open the Excel file. 

This was fixed in Release 1.17.1. 

 

||||||| The Review Package name was not included in the name of the downloaded MS Excel file. 

After an Alias was published from a Review Package and the Alias was subscribed to on the same or 

a different server, the name of the MS Excel file exported from the Alias did not contain the name of 

the exported Review Package. 

This was fixed in Release 1.17.1.



April 2, 2015  Translation Workspace Release Notes 

April 2, 2015 Copyright Lionbridge, Inc. 2016 176 

New in Translation Workspace Release 1.17 
Translation Workspace Release 1.17 includes the following new features and enhancements. 

 

 

Exporting to MS Excel 
 

You can now export the content of all the files from a review package into an Excel file. 

 Exporting the content from all the files in a review package into an Excel XLSX file was enabled. 

On the Online Review client, in the Packages tree, right-clicking a 

review package displays a new context menu with the command 

Export to MS Excel. 

Launching the function generates an MS Excel XLSX file with the 

content of all the files from the package extracted into the same 

sheet of the MS Excel file. The export file includes the following 

information set into separate columns: 

 

Source Lang Target Lang File Name Segment ID 

Source Target Proposed Target Status 

Comments    

 

 
 

Tags inside segments are displayed as numbered red placeholders. 
 

Note:  The Review Package XLSX export file supports maximum 1,048,576 segments. 
 

The generated XLSX file can be opened with MS Excel 2007, 2010 and 2013. 
 

 

Settings 
 

The setting for the number of segments displayed per page is now stored and re-used on the 

Online Review client. 

 In previous releases the number of segments 

displayed per page was always set to 15 in the 

Online Review client when the client was 

launched. 

The value set by the user for the setting is now 

stored and used from one session to another. 

  

Online Review Client 
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Problems Fixed in Release 1.17 
The following problems found in Translation Workspace were fixed in Release 1.17: 

 

 

“Export Selected” did not export multiple files from a Review Package. 

 If you selected in Manage > Review Files tab multiple files in a Review Package and clicked Export Selected, 

only one file was exported from the Review Package, although all selected files should be exported. 

This was fixed in Release 1.17. 
 

 

  

File Handling 
 

Removing multiple selected files from a Review Package failed. 

 Selecting several files in a Review Package and clicking Remove removed only the last of the selected 

files from the package. 

This was fixed in Release 1.17. 
 

 

Preview 
 

A deleted image was displayed in the Online Review preview. 

 After an image file previously uploaded to the context folder was deleted from the folder, the preview 

still displayed the image in the preview report. 

This was fixed in Release 1.17. 
 

 

  

File handling 
 

An error was displayed when you tried to edit and save a file which was earlier added into a review 

package with Internet Explorer. 

 Adding an XLZ file into a review package with Internet Explorer, opening the added file locally in XLIFF 

Editor, editing it and giving a Save command, caused an “Error of permission denied” message 

being displayed in XLIFF Editor. 

Logout from TW Web UI resulted in getting the XLZ file deleted. 

This was fixed in Release 1.17. 
 

 

  

Web UI and Server 

Online Review Client 

XLIFF Editor 
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Preview 
 

The InDesign PDF preview failed if a previously generated PDF file was opened. 

 In XLIFF Editor, the InDesign PDF preview failed (reverting to the default HTML preview) if a previously 

generated PDF preview from the same XLZ file was still open. (The problem does not occur in the Online 

Review client). 

This was fixed in Release 1.17. 
 

 

Split and Merge 
 

Splitting an XLZ file converted from a SDL Worldserver XLIFF file did not result in all files being 

restored. 

 Splitting an XLZ file converted from an SDL Worldserver XLIFF file did not create a file for each file node 

in the XLZ if the original SDL Worldserver file included file nodes without content. 

The Split operation now creates an XLZ file also for each empty file node included in the file to be split. 

This was fixed in Release 1.17. 
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New in Translation Workspace Release 1.16.9 
Translation Workspace Release 1.16.9 includes the following new features and enhancements. 

 

 

Preview in Context 
 

You can now preview XML files in context with the Online Review client. 

 The preview of XML files in context with the Online Review client was enabled. 

When the (source or target) preview is initiated in the Online Review client for a source XML file with a 

transformation file and context files existing for the file and the review package, the preview is displayed 

in context transformed as defined in the XSLT and with the necessary context files (e.g. images). 

A timeout is applied for the preview. In case of an error, a message is displayed, as well as if the 

specified XSL file does not exist. 

If the XML in-context preview fails, the default preview is displayed, along with a message stating that 

the XML preview cannot be performed. 
 

Note: A missing graphic is not an error. 
 

On the Files panel of the Online Review client, a new Transformation File column was added, displaying 

the path and name of the transformation file selected for an XLZ file. 

The column is 

displayed when at 

least one 

transformation file 

is set for one of 

the XLZ files in the 

package. 

When you open a 

review package in 

the Online Review client, if at least one of the XLZ files in the package has a transformation file linked to 

it, the transformation file (path+name) is displayed on the Review Files panel. 
 

You can now add context files into Online Review packages. 

 Importing images and other context files into a review package was implemented. 

A new tab was added onto the TW Web Interface Manage > Context Files tab of a review package. 

Permissions for adding and 

deleting files in a review 

package allow you add and 

remove context files in and 

from a package. 

Clicking Add on the Manage tab 

displays a dialog in which you 

can select a single file or a ZIP 

package to be uploaded as the 

context files. Clicking Remove 

All deletes the context files 

from the package, after the 

user has confirmed the 

procedure. 
 

You can now link a transformation file (XSL) to XLZ file(s) in a review. 

Online Review Client 
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 To enable the preview of XML files in context with the Online Review client, you can now link a 

transformation file (XSL) imported as context file to XLZ file(s) from a review package. 

On the TW web UI, on the Manage > Review files tab available for the Review Package, a new XML Preview 

Option button was added. 

The button is grayed out if no XLZ files are selected. It is accessible while at least one XLZ file is selected. 

Clicking the XML Preview Option displays a dialog 

where you can select a transformation file (XSL 

or XSLT) from a list of the XSL and XSLT files in 

the context folder of the selected review 

package. 

When a user has selected the transformation file 

and clicks on Select, the file is added into a new 

column on the Review Files tab (see the screen 

capture above) for all the selected files. 

The relative path and name of the selected 

transformation file is displayed in a new column 

for the selected XLZ files. 
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Problems Fixed in Release 1.16.9 
The following problems found in Translation Workspace were fixed in Release 1.16.9: 

 

 

 

Forward conversion 
 

Forward conversion through JSON API did not take into account the TM setting “Include internally 

formatted tags at start and end of phrases in segments” being unchecked.  
 

When you used the Forward convert JSON API, the value of the TW Web Interface TM settings option 

Include internally formatted tags at start and end of phrases in segments was not taken into account during 

conversion. 

Conversion was always performed as if the option was enabled, even when the option was disabled on the 

TM settings. 

This was fixed in Release 1.16.9. 
 

 

IDML Filter 
 

Some graphics were not displayed in the IDML file PDF preview.  
 

Some graphics were not displayed in the PDF generated from the IDML preview in XLIFF Editor and in 

Online Review Client. 

The preview was however correctly displayed when you opened the manually back converted IDML file in 

InDesign and generated the PDF locally from InDesign. 

This was fixed in Release 1.16.9. 
 

 

XLIFF 2.0 to XLZ Conversion 
 

XLIFF 2.0 to XLZ Conversion did not fail for an XLIFF 2.0 file with a group without an id.  
 

XLIFF 2.0 to XLZ conversion converted an XLIFF 2.0 file to XLZ although the back conversion of the same 

unmodified XLZ file failed displaying an error message: 

Group with no id attribute. 

The XLIFF 2.0 conversion to XLZ now fails with the same error message for a file with a missing group ID 

attribute. 

This was fixed in Release 1.16.9. 
 

XLIFF 2.0 to XLZ Conversion did not fail for a file with a segment with other than exactly one source 

element.  
 

XLIFF 2.0 to XLZ conversion converted an XLIFF 2.0 file to XLZ although the back conversion of the same 

unmodified XLZ file failed displaying an error message: 

Multiple sources in TU 1. 

The conversion to XLZ now fails with the same error message for a file with segment with other than 

exactly one source element. 

This was fixed in Release 1.16.9. 
 

 

 

Filters 
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Context Matching Data 
 

When Allow Connection Optimization is checked in XLIFF Editor configurations, an error message 

was displayed even for segments with a valid CRC if one segment in the file contained an invalid 

CRC. 

 The following error message was displayed for all segments inside the file although only one segment in 

the file had an invalid CRC: 

Context attribute for segment is not a number. 

Only those segments having an invalid CRC should display an error message and segments having a 

valid CRC should not display errors when the Connection Optimization feature is checked in the client 

configurations. 

This was fixed in Release 1.16.9. 
 

Preview 
 

Preview in XLIFF Editor displayed an error message for an XLZ file converted with the IDML Filter 

Simple preview option checked. 

 Previewing an XLZ file converted with the IDML Filter Simple preview option checked displayed an error 

message: 

Cannot generate PDF preview, reverted to use HTML. 

IDML files converted to XLZ for the Simple preview should never generate a PDF preview but a HTML 

preview only. 

This was fixed in Release 1.16.9. 
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New in Translation Workspace Release 1.16.8 
Translation Workspace Release 1.16.8 includes the following new features and enhancements. 

 

 

Context Matching 
 

Support for segment Context Match CRC value (ID match) was added into the XLIFF file format. 

 A new XLIFF file element/attribute (metadata container) now informs whether the file contains the 

segment Context Match attribute value. 

When a Context Match CRC element exists in an XLZ Translation Unit, its value is used as the Context 

Match CRC instead of the Context Match CRC based on surrounding segments. 

The Context Match CRC should be a 32Bits Integer. If it does not match the criteria, an error message is 

generated for all batch functions. 

TM Store batch functions store the CRC value into the TM NBH (Context Match) attribute. 

TM Lookup batch functions use the CRC value to identify a context match. 

▪ The segment calculated Context Match CRC and TM match NBH attribute are compared and 

a 101% match is provided when they are found identical. 

▪ A segment with an identical Context Match CRC value as a previously stored segment in the 

TM is provided with a 101% match by Pre-translation and Analysis. 

For XLZ Translation Units without any Context Match CRC value, the Context Match NBH value is calculated 

based on surrounding segments. 
 

Warning:  A segment with the CRC value set to “0” in the XLIFF Editor is saved to the TM without any NBH 
attribute. When retrieved, the TM provides the segment as a 100 % match. 

 

 

 

XLIFF 2.0 to XLZ Filter 
 

A new XLIFF 2.0 to XLZ Filter was implemented for converting XLIFF 2.0 files to XLZ format.  
 

You can now convert XLIFF 2.0 files to XLZ (LIOX XLIFF 1.2) and back to XLIFF 2.0 with the XLIFF 2.0 to 

XLZ and XLZ back to XLIFF 2.0 functions available as a separate TW Tools. 

Both conversions can also be performed by using two new JSON API commands. 

Byte-comparing the back converted file with the original XLIFF 2.0 file does not work. Even if no other 

changes exist, the <xliff> element of the back converted file contains the new attribute 

'xmlns:liox1.2="urn:logoport:xliffeditor:xliff-extras:2.0"'. 
 

IDML Filter 
 

The IDML Filter now contains a new option for enabling InDesign file previews.  
 

DLL UI was updated with a new option to use the Internal InDesign process for preview. Preview 

configuration information is stored into a metadata file (the same which is used for the Ibrams preview) 

embedded into the XLZ file. 
 

  

Web UI and Server 
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Context Matching Data 
 

Support for segment Context Match CRC value (ID match) was added into XLIFF Editor.  

 XLIFF Editor now supports the new segment Context Match CRC attribute, for which a value can be 

defined by the user, for example by using a script. 

The Context Match CRC should be a 32Bits Integer. If it does not match the criteria, an error message is 

generated for all batch functions. 

TM Store interactive and batch functions store the CRC value into the TM NBH (Context Match) attribute. 

TM Lookup interactive and batch functions use the CRC value to identify a context match. 

▪ The segment calculated Context Match CRC and TM match NBH attribute are compared 

and a 101% match is produced when found identical. 

▪ A segment with an identical Context Match CRC value as a previously stored segment is 

provided as a 101% match by Pre-translation and Analysis. 

For XLZ Translation Units without any Context Match CRC value, the Context Match NBH value is 

calculated based on surrounding segments.  
 

Warning:  A segment with the CRC value set to “0” in the XLIFF Editor is saved to the TM without any NBH 
attribute. When retrieved, the TM provides the segment as a 100 % match. 

 
 

File Formats Support 
 

Support for XLZ files converted from XLIFF 2.0 was added to XLIFF Editor.  

 XLIFF Editor now supports the XLZ files converted from XLIFF 2.0 file format. 

▪ You can open and edit the target in the XLIFF Editor and save the changes to the XLZ file. 

▪ You can edit tags in XLZ files converted from XLIFF 2.0 file format by inserting, updating and 

deleting internal tags. 

▪ You can use Notes and Annotations in XLZ files converted from XLIFF 2.0 file format. 

QA validation is performed during backward conversion for XLZ files. 
 

The 'Shrink / Expand Segment' functions are deactivated for XLIFF files created using the XLIFF 2.0 

to XLZ converter.  

 XLIFF Editor Expand Segment and Shrink Segment functions are deactivated under the Translation menu 

for XLIFF files generated using the XLIFF 2.0 to XLZ converter. 

When you open a segment in an XLZ file created using the XLIFF 2.0 converter, the Expand Segment and 

Shrink Segment functions in the Translation menu are deactivated and unusable. 
 

File Preview 
 

XLIFF Editor now supports previewing from IDML to XLZ converted files in PDF format.  

 You can now preview XLZ files converted from IDML in XLIFF Editor in PDF format. 

The same preview functionality is available also in the Online Review Client. 
 

 

Problems Fixed in Release 1.16.8 
No problems found in Translation Workspace were fixed in Release 1.16.8.

XLIFF Editor 
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New in Translation Workspace Release 1.16.7 
Translation Workspace Release 1.16.7 includes the following new features and enhancements. 

 

 

 

 

Languages Support 
 

Support for one new language was added. 

 Translation Workspace (the server and the clients) now supports the following language: 
 

TW Name TW Code 

French (International) fr-xn 
 

 

 

 

 

 

 

Status Information 
 

A new Completed-Removed file review status value was added to the Online Review. 

 A new Completed-Removed file status is available on the Online Review File status drop down list, as the 

last value of the status values list. 
 

 

The file review status indicated in the Online Review client is now included in the XLZ file export. 

 When exporting XLZ files from Online Review package, the file review status value as defined in the 

Online Review client is included in the exported XLZ file. 
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Problems Fixed in Release 1.16.7 
The following problems found in Translation Workspace were fixed in Release 1.16.7: 

 

 

 

 

User Interface 
 

The Online Review Automatic Term Search did not complete for a term when a segment on the 

second or a further page was opened. 

 The Online Review Automatic Term Search did not complete for a matching term available in the 

glossary when a segment on the second or a further page was opened. 

This was fixed in Release 1.16.7. 
 

The Online Review Main panel was not refreshed after auto-save if the segment editor dialog was 

opened. 

 When the auto-save was performed in the Online Review while the segment editor dialog was opened, 

the main panel of the Online Review client was not refreshed. The "modified" icon was not displayed for 

changed segments that were auto-saved. 

This was fixed in Release 1.16.7. 
 

 

 

 

Online Review Client 
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New in Translation Workspace Release 1.16.6 
Translation Workspace Release 1.16.6 includes the following new features and enhancements. 

 

 

 

System Requirements 
 

The Translation Workspace system requirements were updated. 

 The latest system requirements for Translation Workspace are as follows: 

Translation Workspace Web Interface 

The supported browsers for the Translation Workspace Web interface are Internet Explorer versions 9 

and higher; Firefox version (latest); Chrome version (latest). 

Microsoft Word Client Plug-in 

The Microsoft Word Plug-in is compatible with: 

▪ Microsoft Word 2007 / 2010 (32 bits) / 2013 (32 bits) 

▪ Microsoft Windows 7 (32 and 64 bits) / Windows 8 (32 and 64 bits) 

XLIFF Editor 

The XLIFF Editor is compatible with: 

▪ Microsoft Windows 7 (32 and 64 bits) / Windows 8 (32 and 64 bits) 
 

 

 

Languages Support 
 

Support for three new languages was added. 

 Translation Workspace (the server and the clients) now supports the following languages: 
 

TW Name TW Code 

Haitian Creole ht 

Kurdish, Northern (Kurmanji) kmr 

Kurdish, Central (Sorani) ckb 
 

 

 

 

Reporting 
 

The Online Review reports now display Bidi texts correctly. 

 The Bidi texts are now correctly displayed in the Translation Workspace Online Review reports as in the 

Online Review Client. 
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A "File Status" column was added into the Online Review Report. 

 The status information for each file is now displayed in the Online Review Report, in the new File Status 

field. 

The File Status value can be one of the following:  

 New 

 In-Progress 

 Revised 

 Completed-Approved 

 Completed-Rejected 
 

 

 

 

 

 

User Interface 
 

The Online Review Client now supports bidirectional target languages correctly in edit mode. 

 The Online Review Client now supports bidirectional target languages correctly in edit mode. 

On the target panel of the Segment Edit dialog, the existing text or input text is now: 

 correctly aligned 

 correctly rendered for the LTR and RTL parts 

 internal tags are displayed in the correct order 

 with correct cursor movement for RTL and LTR texts 

Once saved, the translated text is correctly displayed everywhere on the Online Review interface. 

The modified bidirectional texts are in the same way also supported in the XLZ files generated after 

review. 

The comments are always aligned to the right on the main panel of the Online Review Client, regardless 

of the text direction. 
 

 

Online Review Client 
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New in Translation Workspace Release 1.16.5 
Translation Workspace Release 1.16.5 includes the following new features and enhancements. 

 

 

 

Languages Support 
 

Support for six new languages was added. 

 Translation Workspace (the server and the clients) now supports the following six languages: 
 

TW Name TW Code 

Arabic (Gulf) ar-xg 

Greek (Cyprus) el-cy 

French (Africa) fr-02 

French (West and Central Africa) fr-11 

Russian (Belarus) ru-by 

Russian (International) ru-xn 
 

Greek was renamed as Greek (Greece). 
 

 

 

 

 

User Interface 
 

The Online Review Client main panel contents can now be displayed in a 'Simple' view. 

 A View button was added between the Save and 

Details buttons on the Online Review Client toolbar 

allowing the users to select the desired view. This 

button allows selecting between a Simple and a Full 

(default) view. 

In the Full view, all the columns are displayed by 

default. 

In the Simple view, only the following columns are displayed by default. 

 ID 

 Modified 

 Source 

 Target 

 Add Comment 

For both views, a user can manually change the list of columns to be displayed, but the selection is 

preserved across sessions only when the Full mode is selected. 

The Simple view displays only the default columns (listed above), even when in a previous session 

manual changes were made to the columns configuration. 
 

Web UI and Server 
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New in Translation Workspace Release 1.16.4 
Translation Workspace Release 1.16.4 includes the following new features and enhancements. 

 

 

 

Languages Support 
 

Support for two new languages has been added. 

 Translation Workspace (the server and the clients) now supports the following two languages: 
 

TW Name TW Code 

K'iche' quc 

Punjabi (Pakistan) Pnb  
 

Punjabi was renamed as Punjabi (India). 
 

 

User Interface 
 

The Object ID is now displayed for each object (Workgroup, TM, Glossary, and Review package). 

 The Translation 

Workspace Web UI 

now displays the 

Object ID for each 

Workgroup, 

Translation Memory, 

Glossary, and Review 

package.  

This information is 

displayed for all 

users in a new non-

editable field, on the 

Properties tab of 

each object, below 

the Name field. 
 

 

The asset creation timestamp is now displayed for each object (Workgroup, TM, Glossary, and 

Review package). 
 The Translation Workspace Web UI now displays the asset creation timestamp (Creation Date: <date in 

GMT>) for each Workgroup, Translation Memory, Glossary, and Review package. 

This information is displayed for all users in a new non-editable field, on the Properties tab of each object, 

below the Object ID field. 

For Alias objects the Alias Subscription date and time is displayed as the creation timestamp 
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User Interface 
 

The Online Review Client was migrated to the latest version of ExtJS. 

 The Online Review Client was migrated to the latest version of ExtJS.  
 

Auto-save functionality was added to the Online Review client. 

 To prevent users from losing changes they have made when a timeout occurs, auto-save functionality 

was added to the Online Review Client. 

Auto-save saves the changes made in the Online Review Client every 5 minutes, if no manual save has 

been performed. 

A message is displayed in the interface informing the user for an auto-save being in progress. 

During an Auto-save, all changes are saved the same way as by manually clicking the Save button. 

 Changes on the Edit dialog are not saved with the auto-save functionality. 

 In case of conflict, all changes except any conflicted segments are saved. 

When changing pages, you are prompted to save or discard all changes on the current page. 
 

In the Online Review Client the string length limitation is now displayed for each translation unit 

having limitation defined in the source XLZ file. 

 When the maxwidth attribute (maxwidth=" xx") is set for a <trans-unit> in the XLZ file, the value of 

the maxwidth parameter is now displayed on the Online Review Client. 

On the main page, a new Max width column is displayed (by default, just after the Target column) only 

for files having the maxwidth attribute defined for a <trans-unit>. On the Edit dialog the information 

is displayed, only when defined, under the Target text. 

This feature is not available for sub-segmented files. 
 

 

  

Online Review Client 
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Problems Fixed in Release 1.16.4 
The following problems found in Translation Workspace were fixed in Release 1.16.4: 

 

 

 

 

QA Check 
 

Sometimes the Length checker reported an error for segment group element with maxwidth attribute 

containing one trans-unit child. 

 When the segment/group length check was enabled in XLIFF Editor and you opened a segment 

containing a group element with maxwidth attribute, XLIFF Editor reported an error on the status bar:  

'FileNode' object has no attribute 'localName'. 

Storing a translation for the segment was not possible. 

This was fixed in Release 1.16.4. 
 

 

Sometimes the Length checker reported an error for segment group element with maxwidth attribute 

containing one trans-unit child (after initially not reporting an issue). 

 When the QA checks were all enabled and you opened the first segment in a file and entered a 

translation, no errors were displayed and everything worked as should. 

After continuing to translate the next 4 segments interactively and then selecting the first segment 

again, XLIFF Editor reported a warning on exceeding the group length limit on the first segment. 

This was fixed in Release 1.16.4. 
 

 

Sometimes the Length checker displayed invalid error information on the status bar. 

 When the segment/group length check was enabled in XLIFF Editor, the Length check error messages 

on the status bar could be unreliable and even conflicting for the same segment depending on when 

the segment was clicked. 

This was fixed in Release 1.16.4. 
 

 

 

XLIFF Editor 
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New in Translation Workspace Release 1.16.3 
Translation Workspace Release 1.16.3 includes the following new features and enhancements. 

 

 

 

Languages Support 
 

Support for two new languages was added. 

 Translation Workspace (server and clients) now supports the following two languages: 
 

TW Name TW Code 

Bhili bhb 

Tulu tcy 
 

 

 

Online Review Report 
 

The segment TM Match percent is now available for each modified segment in the Online Review 

report (XML & HTML logs). 
 In previous releases, the Review Report contained no information on the TM category per changed 

segment. 

The TM match percentage for each modified segment is now extracted in the Online Review reports (XML 

and HTML formats). 

On the XML format, information was added as a new TM_Match attribute of the <segment> node. The 

HTML log displays the information in a new TM Match column between the existing segment ID and the 

Source Text. 

 

 

 

 

MIF Filter 
 

You can now use the MIF filter for converting MIF12 files saved with FrameMaker 12. 
 

The previous releases did not prepare MIF12 files and warned that these files are not supported. 

You can now convert with the Translation Workspace MIF Filter MIF12 files saved with FrameMaker 12.  

This conversion should however be used with care as it has not yet been tested thoroughly. 

Please note the following know issues and limitations: 

▪ The MathML objects (new in MIF 12) are not supported, and are lost in back converted 

documents 

▪ Changes marked in MIF files with Change Bars are accepted prior to conversion. 
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User Interface 
 

The updated (modified) segments are now marked with a specific icon in the user interface. 

 The updated (modified) segments are now marked with a specific icon in the Online Review Client user 

interface. The icon is located in a new column, between the segment ID and the Source column. 

 

The new icon is displayed, in the following situations: 

▪ when you open a file with at least one segment matching the 'modified' criteria 

▪ when you save the changes and a segment becomes modified/updated based on criteria 

below 

A segment is considered as updated (modified), if: 

▪ the target text, the category, or the severity of the segment has been modified, or 

▪ a comment has been added to the segment 

Note: A segment is not considered as updated if only the status is changed. 

 
 

The column header and the tooltips for action button columns are now displayed. 

 Headers were added for the Edit Segment, Add Comment, and Undo Segment Changes action button 

items in the Columns menu which you can use to check the columns to be displayed in the user 

interface. Each button name is now displayed on the column header above the button. 

The user interface now displays a tooltip on mouse over for each action button icon. 
 

 

Batch Approve 
 

The Batch Approve function of approving all segments in the current file is now supported by the 

JSON API. 

 Now the Batch Approve function, by which you can approve all the segments with a New or Pre-approved 

status in the entire current file, is supported by the Translation Workspace JSON API. 
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Problems Fixed in Release 1.16.3 
The following problems found in Translation Workspace were fixed in Release 1.16.3: 

 

 

 

 

TM management 
 

Sometimes the import of a TMX 1.4 file added <bpt> tags with invalid ID to segments. 

 Sometimes while importing a TMX 1.4 file to a TM, Translation Workspace replaced tags inside segments 

with <bpt> tags which did not have unique IDs, although they should. 

This was fixed in Release 1.16.3. 
 

 

 

 

 

Interactive translation 
 

Sometimes interactive translation introduced extra <ph> tags into fuzzy match segments. 

 When LXE was used for interactive translation, sometimes extra <ph> tags were added to segments 

which included an ending TMX tag immediately followed by an opening TMX tag. 

This was fixed in Release 1.16.3. 
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New in Translation Workspace Release 1.16.2 
Translation Workspace Release 1.16.2 includes the following new features and enhancements. 

 

 

 

QA Check 
 

You can now choose whether the internal text is included in the Segment length character counts. 

 In previous releases, the QA Check > Segment length check included the internal text (<tags>, text) in 

the target segment character counts. 

A new option was added to the Segment length QA Check to allow selecting whether the internal text is 

to be excluded from or included in the target segment character counts.  

 

Checking the Count text in internal option in the Segment length check configuration, sets the QA Check 

to include the internal tags and text in the target segment character counts. When the option is not 

checked, the internal tags and texts are not counted in the segment length. 

The string length check is performed when the maxwidth attribute has a value in the <trans-unit> node: 

▪ when selecting a segment in the document view 

▪ when translating a segment in interactive mode 

▪ when closing a segment after translation 

▪ when running the QA Tool 
 

The Segment length check can now calculate the <group> element string length. 

 The QA Check > Segment length check, in previous releases working only on <trans-unit> level, has been 

enhanced to enable calculating the <group> string length, across all translation units in the group 

element. 

XLIFF Editor 
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Checking the Ignore inter-segment spaces option in the Segment length check configuration, sets the QA 

Check to exclude the inter-segment spaces from the group element character counts. When the option 

is not checked, the inter-segment spaces are included in the group element character counts. 

Checking the Ignore skeleton (external) content option in the Segment length check configuration, sets 

the QA Check to exclude the external skeleton content from the group element character counts. When 

the option is not checked, the external skeleton content is included in the group element character 

counts. 

The string length check is performed for the group element when the maxwidth attribute has a value in 

the <group> node: 

▪ when selecting a segment in the document view 

▪ when translating a segment in interactive mode 

▪ when closing a segment after translation 

▪ when running the QA Tool 
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Preview 
 

The Batch Approve function now approves all segments in the current file. 

 In previous versions the Batch Approve function allowed you to approve segments with a New or Pre-

approved status only in the current view or page. 

Now, by clicking the Batch Approve button, you can approve all the segments with a New or Pre-

approved status in the entire current file. All changes in the segments are saved. 

Online Review client asks for your confirmation for the approval. 

 

 Clicking No closes the dialog without modifying the status of the segments. 

 Clicking Yes changes the status of all the unchanged segments having a New or Pre-approved 

status in the file to Approved. 

 Changes are also automatically saved, prior the Batch Approval 
 

 

Problems Fixed in Release 1.16.2 
The following problems found in Translation Workspace were fixed in Release 1.16.2: 

 

 

 

AutoTerminology 
 

 

 

 

 

 

DOCX and XLSX Filter 
 

Language tags stripped from XLSX and DOCX diagrams - Error on opening back converted XLSX Files. 
 

Sometimes after back-conversion, the language tags for runs in XLSX and DOCX diagrams were set to an 

empty string. 

After translation the language tags were incorrectly set to the source language. The back converted Excel 

2007 XLSX files did not open in Excel 2007 (no error appeared on Excel 2010 or Excel 2013). 

This was fixed in Release 1.16.2. 
 

Processing AutoTerminology CJK search caused a server error. 

 Sometimes CJK auto terminology lookup caused a server error. In both cases this was a grid look up. 

Additionally, both appeared to have lost communication with the CJK Tokenizer. 

This was fixed in Release 1.16.2. 

Online Review Client 

Terminology 
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SDLXliff plugin 
 

SDLXliff conversion to XLZ failed due to HTML numeric character references (&#x1F; &#x1E; ...). 

 Conversion of SDLXliff files to XLZ failed due to HTML numerical character references (&#x1F;, &#x1E; 

...) displaying an error message: 
 

<class ‘Ft.Xml.ReaderException’> In urn:bogus:dummy, line 228, column 3313: 

reference to invalid character number 
 

This was fixed in Release 1.16.2. 
 

 

Interactive translation 
 

Sometimes, during interactive translation, a warning on MSVCP110.DLL was displayed. 

 Sometimes, while completing interactive translation, XLIFF Editor 2.13.2 displayed a warning: 

 

The program can’t start because MSVCP110.dll is missing from your computer.  
Try reinstalling the program to fix this problem. 

 

The issue appeared also when using the command Translate to next non 100% match. 

This was fixed in Release 1.16.2. 
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New in Translation Workspace Release 1.16 
Translation Workspace Release 1.16 includes the following new features and enhancements. 

 

 

 

DOCX Filter 
 

The text from the '\t' instruction of an Index entry is now extracted for translation. 
 

In previous releases, the Index entry Text instructions in DOCX files were extracted for translation. Now 

also the texts from the ‘\t’ instructions of the Index entries are extracted for translation during conversion 

to RTF and XLZ. 

The translation is available on the final document after the update of the Table of index. 
 

 

 

 

 

Preview 
 

You can now preview files converted to XLZ from IDML files containing specific preview information. 

 XLIFF Editor Preview feature has been enhanced to support previewing files converted from IDML files 

containing specific preview information. 

The preview is displayed in PDF format, with pictures when available on a specific server.  
 

 

 

 

 

Preview 
 

You can now preview files converted to XLZ from IDML files containing iBrams preview 

information. 

 Online Review Client Preview feature has been enhanced to support previewing files converted from 

IDML files containing specific preview information. 

The preview is displayed in PDF format, with pictures when available on a specific server. 
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Problems Fixed in Release 1.16 
The following problems found in Translation Workspace were fixed in Release 1.16: 

 

 

 

DOCX Filter 
 

Sometimes additional characters were added to the hyperlink texts in back converted DOCX files. 
 

Sometimes extra characters were left to the DOCX file hyperlink texts after back conversion to DOCX from 

RTF and XLZ. 

The issue was related to the Field properties: Hyperlink to paragraph, and the numbers of paragraphs in 

relative context. The problem was also related to the number of the Fields in the file. 

This was fixed in Release 1.16. 
 

Back converting files with bookmark references resulted in DOCX files not opening in Word. 
 

Some files did not open after back conversion to DOCX from RTF and XLZ. An error message was 

displayed instead: 

 

The issue was related to the Field properties: Hyperlink to paragraph, and the numbers of paragraphs in 

relative context. The problem was also related to the number of the Fields in the file. 

This was fixed in Release 1.16. 
 

Spaces were missing before and after the right-to-left directional text, and the order of the brackets was 

incorrect in the back converted DOCX with bidirectional translation. 
 

Sometimes, although the brackets and spaces displayed correctly in the translated RTF and XLZ, spaces 

before and after the right-to-left directional text were missing and the order of the brackets was incorrect 

in the back converted DOCX with bidirectional translation. 

This was fixed in Release 1.16. 
 

 

 

DOCX Filter and PPTX Filter 
 

 

Parenthesis were incorrectly handled in back converted PPTX and DOCX files of BiDi RTF and XLZ. 
 

Sometimes, in the back converted DOCX and PPTX with bidirectional translations, parenthesis were 

incorrectly handled. 

This was fixed in Release 1.16. 
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Dash was placed in wrong position after back conversion to BiDi languages. 
 

Sometimes, in the back converted DOCX and PPTX with bidirectional translations, dash characters were in 

incorrect places. 

This was fixed in Release 1.16. 
 

Comma+Space sequence was inversed in the back converted PPTX and DOCX files of BiDi RTF and XLZ. 
 

Sometimes, in the back converted DOCX and PPTX with bidirectional translations, the sequence 

Comma+Space was wrongly converted to sequence Space+Comma. 

This was fixed in Release 1.16. 
 

 

 

 

 

SDLXliff plugin 
 

Sometimes the back conversion from XLZ to SDLXliff was not successful. 

 Sometimes the back conversion of XLZ files to SDLXliff was not successful. An error message was 

displayed instead: 
 

qualifiedName must be non-null unicode or UTF-8 string 
 

This was fixed in Release 1.16. 
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New in Translation Workspace Release 1.15.9 
Translation Workspace Release 1.15.9 includes the following new features and enhancements. 

 

 

 

 

Alias Notifications 
 

You can now populate the Source Asset Name in the Alias token e-mail notifications. 

 The name of the source asset (TM, Glossary or Review Package) used for the aliasing can now be 

optionally populated directly in the alias e-mail notification: 

 A new option Include Source TM Name was added on the Publish New Translation Memory Alias 

dialog (unchecked by default). 

 A new option Include Source Glossary Name was added on the Publish New Glossary Alias dialog 

(unchecked by default). 

 A new option Include Source Review Package Name was added on the Publish New Review Package 

Alias dialog (unchecked by default). 

When the option is checked, the alias e-mail notification includes the name of the source asset selected 

for the alias creation. 
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Penalization 
 

New penalization options are available in Translation Memory settings. 

 You can now penalize the substituted strings in segments by enabling the new substitution penalization 

options in the TM settings. When the options are enabled, the placeables (tags, acronyms, and numbers) 

are penalized if those in the match provided by the TM differ, by content or by order, from those existing 

in the source segment of a document. 

 

You can also select to penalize missing tags, acronyms and numbers. There is now also a separate option 

for penalizing all moved placeables. 
 

 

Translation Workspace Problems Fixed in Release 1.15.9 
The following problems found in Translation Workspace were fixed in Release 1.15.9: 

 

 

 

Analysis 
 

Use Extended Mode outputs incorrect analysis results for Simplified and Traditional Chinese. 

 Running a wordcount while the Use Extended Mode option was enabled returned an incorrect analysis 

result for Simplified and Traditional Chinese. (The issue did not affect Japanese and Korean.) 

This was fixed in Release 1.15.9. 
 

 

 

 

AutoTerminology 
 

Some of Japanese terms were not found by AutoTerminology search. 

 Some of the Japanese terms were not found by the AutoTerminology, unless the Substring Match option 

was enabled. 

This was fixed in Release 1.15.9. 

Web UI and Server 
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HTML/XML Filter 
 

While the Remove Extra Spaces, Tabs and Carriage Returns option was enabled the conversion touched 

external non-translatable text. 
 

While the Remove Extra Spaces, Tabs and Carriage Returns option of the XML/HTML filter was enabled, 

the conversion made changes to text in the files set as Non-translatable and External by the Markup 

Language Assistant conversion profile. 

This was fixed in Release 1.15.9. 
 

The trailing slash in the tag inside the CDATA tags was removed by conversion while Ignore Namespaces 

was checked in the Markup Language Assistant. 
 

While both Convert HTML in CDATA and Ignore Namespaces options were enabled, and the original file 

contained a CDATA tag with only one self-enclosing tag (<tag/>), the trailing slash was removed by the 

conversion to RTF and XLZ. 

(While the Ignore Namespaces option was disabled, the conversion worked as should.) 

This was fixed in Release 1.15.9. 
 

 

 

 

 

 

File Preview 
 

Preview of custom XML with embedded style sheet reference was not possible in the XLIFF Editor. 

 Preview Current File in XLIFF Editor did not display the preview for a XLZ file converted from an XML file 

with an embedded stylesheet. An error message on failing to fetch the style sheet from the server was 

displayed instead, although in such cases the style sheet should be on the local computer. 

This was fixed in Release 1.15.9. 
 

 

 

 

 

Freeway Integration 
 

Save and Review action in TW Online Review for Freeway users fails to save outstanding 

modifications in review. 

 When changes were made to an Online Review package while accessing it from the Freeway and Save & 

finish review was selected, the changes made to the segments were not saved. 

This was fixed in Release 1.15.9. 
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New in Translation Workspace Release 1.15.8 
Translation Workspace Release 1.15.8 includes the following new features and enhancements. 

 

 

 

User management 
 

You can now hide users assigned on System (root) work group from the users list 

 You can now hide from the Users list the System level users which appear as users for all objects, as such 

users are not of interest when for example managing a work group branch. 

A toggle button has been added for hiding System users from the users list. 
 

 

Error messages 
 

The wording of error messages for Import and Export actions for Suspended Alias objects has been 

improved. 
 Consistent error message headers are now displayed for "TM Import Error" and "TM Export Error" 

messages for Suspended Alias objects. 

In the messages a "project" is now called a "TM" as the word "project" is also elsewhere called as "TM". 

As "TM Alias" refers to a child alias, while the current (and the parent) alias is suspended, "TM Alias" was 

renamed as "Alias TM" and "Glossary Alias" to "Alias Glossary". 

 

 

User Interface 
 

The name of the language previously spelled “Panjabi” is now spelled “Punjabi”. 

 The wording of the language name “Panjabi” was changed to “Punjabi”. 

 

A Refresh button has been added to the Workgroup tree. 

 You can now refresh the Workgroup tree by clicking the new Refresh button added to the Web Interface. 

 

The information on the Download page was modified. 

 The information on the support for Windows versions was updated. 

For Windows 7 the support for 32 and 64 bits is now mentioned. 

Windows 8 (32 and 64 bit) was added. 
 

Translation Workspace now supports Internet Explorer 9 and 10 native modes. 

 You can now use Translation Workspace Web Interface with Internet Explorer 9 and 10 native modes. 
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Output options 
 

The error handling for back conversion has been improved by implementing a new output option. 
 

A new Output option group with the option Include Source File (only for XLZ format) in it has been added 

to the MIF, DOCX, PPTX, XLSX, and IDML filters. 

The option is by default not checked. 

By selecting this option, you can include the source file within the XLZ file created during the conversion. 

This enables the back conversion to run without the original source file being available separately. 

During back conversion: 

▪ If the source document is provided (as input parameter in API or available at the same path as 

the XLZ file in the client), it is used. 

▪ If it is not provided, the embedded source file from the XLZ file is used, if it exists. 

▪ If no source file is provided and no source file is embedded in the XLZ, an error is returned. 
 

 

 

Translation Workspace Problems Fixed in Release 1.15.8 
The following problems found in Translation Workspace were fixed in Release 1.15.8: 

 

 

 

Reports 
 

Some browsers did not display the Wordcount report and the Online Review report properly 

 The Wordcount and Online Review XML reports did not display properly in some browsers. 

In Firefox and Chrome, the report failed to display, in Internet Explorer the report displayed only in IE7 

Compatibility mode. 

The Wordcount HTML report file was redesigned to now include the same information as the XML report. 

The XML report file is displayed in browsers without a style sheet for both the Wordcount and the Online 

Review reports. The HTML report for the Online Review report is now added to the zip file already 

containing the report in XML format. 

The HTML reports should now be used instead of XML report for web browser display. 

This has been fixed in Release 1.15.8. 
 

Extended characters entered in Online Review package information fields were not displayed 

correctly in Online Review reports (XML and HTML) 
 Extended characters entered in the Online Review package information fields were not displayed correctly 

in Online Review reports (XML and HTML). 

This has been fixed in Release 1.15.8. 
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Task handling 
 

The Task Wait dialog could not be opened after closing it by clicking the  button or by pressing the 

Esc key 
 After running an Analysis and closing the displayed Task Wait dialog by clicking the  button or by 

pressing the Esc key, running another Analysis, the Task Wait dialog is not displayed and the Analysis 

results are not displayed. 

The same happens also for other dialogs, for example for the Task Wait dialog after running a Restore of 

Review Package task. 

A listing of javascript errors is displayed instead. 

This has been fixed in Release 1.15.8. 
 

 

Alias handling 
 

Token email notes from the publishing tenant did not support NON-1252 code page characters 

 NON-1252 code page characters in the Notes from the publishing tenant section did not display correctly in 

the Token emails. 

This has been fixed in Release 1.15.8. 
 

 

TM Management 
 

Import of TMX 1.4 file with <bpt i="1"/> and <ept i="1"/> tags fails, reporting an invalid TMX 

structure  
 The Systran-generated TMX 1.4 text export files containing self-enclosed <bpt i="1"/> and <ept 

i="1"/> tags failed to import into Translation Workspace reporting the following error on the Web 

Interface Tasks tab: 

invalid TMX structure (Code: ACVEX10) 

This has been fixed in Release 1.15.8. 
 

Import of a TMX (1.4 and 1.4b) file failed when a space character was not included next to the word 

“header” in the <header> element 
 When there is no space after the word “header” in the <header> element of a TMX text export file, the 

TMX file was not imported to the Translation Workspace successfully. While importing started, Translation 

Workspace displayed an error message: 

invalid TMX structure (Code ACVEX10) 

This has been fixed in Release 1.15.8. 
 

Import of Systran generated TMX 1.4 file failed reporting invalid TMX structure (Code: ACVEX10) 

 A TMX 1.4 text export file (generated in Systran) could not be imported to the Translation Workspace. The 

following error message was displayed instead: 

invalid TMX structure (Code: ACVEX10) 

The file could be imported after the tag: <tmx version="1.4"> was moved to new line as below: 

<?xml version='1.0' encoding='UTF-8'?><!DOCTYPE tmx SYSTEM "tmx14.dtd" []> 

<tmx version="1.4"> 

This has been fixed in Release 1.15.8. 
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The TMX import did not handle line endings like spaces 

 The TMX import skipped the CR and the LF characters while reading the import file. 

This caused the line endings not being treated as separators in XML tags, for example when an attribute 

follows the tag in the next line, without other white spaces: <tag attribute=123>. 

Now line endings outside text content are replaced with spaces while reading from the source. 

Also, inside content, text runs were collated without spacing, such as when: 

line1 line2 line3 became 

line1line2line3 

Translation Workspace now inserts RTF \line breaks into the segment content to such places. 

This has been fixed in Release 1.15.8. 
 

Embedded TMX empty bpt, ept, and PH elements were not maintained during import of TMX 

exported from SDL Products 
 During import to a TM, when the TMX text file exported from SDL Products contained Embedded TMX 

type data (bpt, ept, and PH elements), the Embedded TMX type data was not imported. 

The imported segments in the TM included only the text without the tags with Embedded data. 

(The same TMX data exported from Trados 2007 was imported into Translation Workspace without data 

loss.) 

This has been fixed in Release 1.15.8. 
 

 

XML/HTML Filter 
 

Back converting to HTML instead of RESX and XAML. 
 

The XAML and the RESX files converted with the XML/HTML Filter to RTF and XLZ back converted to 

HTML instead of the original format. 

This has been fixed in Release 1.15.8 
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New in Translation Workspace Release 1.15.7 
Translation Workspace Release 1.15.7 includes the following new features and enhancements. 

 

 

 

Analysis 
 

The Analysis options now include a Use Track Changes Mode (XLZ files only) option for reporting 

information on the track changes segments. 
 The Web UI, TW Tools and Word Client Document Analysis options include now a Use Track Changes Mode 

(XLZ Files Only) option. When the option is checked, the Document Analysis Result dialog and the Analysis 

logs include additional columns with the number of segments and words corresponding to segments with 

track changes. The setting for this option is preserved between sessions. 

The option is not checked by default. 

 

When also Use Extended Mode is checked, the analysis reports the number of segments, number of 

characters and number of ideographs with tracked changes. 
 

 

Matching 
 

The 101% matches are now returned before 100% matches with a premium.  

 Translation Workspace now retrieves non-penalized 101% context matches (also from TMs in an alias 

chain) before 100% matches with a premium. This happens during analysis, interactive translation and 

pre-translation. 

101% matches with a premium are still retrieved before non-penalized 101% matches. 
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XML/HTML Filter 
 

While the Remove extra Spaces, Tabs and Carriage Returns (in text between tags) option was checked, the 

conversion to RTF and to XLZ replaced non-breaking spaces with normal spaces in the prepared file. 
 

While the Remove Extra Spaces, Tabs and Carriage Returns in text between tags option was checked in 

the Markup Language Assistant dialog, the conversion to RTF and to XLZ sometimes replaced non-breaking 

spaces with normal spaces in the resulting files. 

A new option Treat Non Breaking Spaces as Plain 

Space has been added to the Markup Language 

Assistant. When the option is checked, the 

conversion replaces the non-breaking spaces 

with plain spaces in the resulting files. The 

option is unchecked by default. 

However, while the Treat Non Breaking Spaces as Plain Space option and the Ignore Namespaces option 

are both checked in the Markup Language Assistant dialog, the conversion to RTF and XLZ does not replace 

the non-breaking spaces with normal space characters in text outside elements in the resulting files. 
 

 

DOCX Filter 
 

The chart object content is now automatically extracted for translation. 
 

The chart title and the chart axis title in the chart objects are now extracted for translation by forward 

conversion to RTF and to XLZ. 
 

 

PPTX Filter 
 

The chart object content is now automatically extracted for translation. 
 

The chart title and the chart axis title in the chart objects are now extracted for translation by conversion 

to RTF and to XLZ. 

The Set brake as external option in the Configure Filters dialog is not applied to the chart object texts. 
 

 

 

 

 

Auto-Terminology 
 

Auto-Terminology search is now enabled on segment selection. 

 In previous releases the auto-terminology was triggered only when a segment was opened for editing in 

the Online Review Client. 

Now the auto-terminology is displayed and refreshed by segment selection, even when the segment is 

not opened. 
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Translation Workspace Problems Fixed in Release 1.15.7 
The following problems found in Translation Workspace were fixed in Release 1.15.7: 

 

 

Document Conversion dialog 
 

The TM and the Source Language selectors were grayed out in the Document Conversion dialog when 

Translation Workspace XLIFF was set as the resulting file format in the Tag Style selector of the dialog. 
 

While Translation Workspace XLIFF was set as the resulting file format in the Tag Style selector of the 

Document Conversion dialog, the user was not allowed to select the TM used and the source language for 

preparation from the Document Conversion dialog as the selectors were grayed out. 

This has been fixed in Release 1.15.7. 
 

 

 

XML/HTML Filter 
 

Sometimes, while the Remove Extra Spaces, Tabs and Carriage Returns option was checked, the conversion 

to RTF and to XLZ touched the external non-translatable text. 
 

While the Remove Extra Spaces, Tabs and Carriage Returns option was checked in the Markup Language 

Assistant dialog, the conversion to RTF and to XLZ sometimes added some extra space characters and 

carriage return characters to the external non-translatable text in the resulting files. 

This has been fixed in Release 1.15.7. 
 

Users were not allowed to select the TM used for preparation from the Document Conversion dialog while 

Translation Workspace XLIFF was set as the resulting file format in the Tag Style selector. 
 

Users were not allowed to select the TM used for preparation from the Document Conversion dialog while 

Translation Workspace XLIFF was set as the resulting file format in the Tag Style selector. 

While the Remove extra Spaces, Tabs and Carriage Returns option was checked in the Markup Language 

Assistant dialog, the conversion to RTF and to XLZ sometimes added some extra space characters and 

carriage return characters to the external non-translatable text in the resulting files. 

This has been fixed in Release 1.15.7. 
 

 

 

XLSX Filter 
 

The Chart Title Color Formatting was removed by the back conversion to XLSX. 
 

While back converting files from RTF and from XLZ to XLSX the Chart Title Color Formatting was removed 

by the back conversion to XLSX. 

This has been fixed in Release 1.15.7. 
 

The breaks in the Chart Title and the Chart Axis Title texts were not extracted as tags (<br/>). 
 

While converting XLSX files to RTF and to XLZ, the Chart Title and the Chart Axis Title texts were not 

extracted as tags (<br/>). 

This has been fixed in Release 1.15.7. 
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File Preview 
 

Preview Current File was no longer working correctly in the XLIFF Editor. 

 Preview Current File in XLIFF Editor did not display correctly using the XSL file stored on the TW server. 

This was fixed in Release 1.15.7. 
 

 

New in Translation Workspace Release 1.15.6 
Translation Workspace Release 1.15.6 includes the following new features and enhancements. 

 

 

 

Languages Support 
 

Support for new languages was added. 

 Translation Workspace now supports the following languages: 
 

TW Name TW Code TW Name TW Code 

English (Cyprus) en-cy English (Pakistan) en-pk 

English (Egypt) en-eg English (Saudi Arabia) en-sa 

English (Gulf) en-xg English (Sri Lanka) en-lk 

English (Jordan) en-jo French (Algeria) fr-dz 

English (Lebanon) en-lb French (Tunisia) fr-tn 

English (Malta) en-mt Russian (Kazakhstan) ru-kz 

English (Nigeria) en-ng   
 

 

 

 

 

 

XLSX Filter 
 

The Sheet name in chart data range formula is now updated in the back converted XLSX file. 
 

The Sheet name in the chart data range formula is now updated in the XLSX file which has been back 

converted from RTF and XLZ. 
 

The Chart Title text and Chart Axis Title text is now extracted for translation. 
 

The text from Chart Title element and Chart Axis Title element is now extracted for translation while 

converting to RTF and to XLZ. Back conversion does not preserve formatting inside paragraphs. 
 

 

 

XLIFF Editor 
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IDML Preview 
 

The Preview feature now supports previewing files converted to XLZ from IDML files. 

 XLIFF Editor Preview feature has been enhanced to support previewing files converted from IDML files. 
 

Translation Workspace Problems Fixed in Release 1.15.6 
The following problems found in Translation Workspace were fixed in Release 1.15.6: 

 

 

 

TM Management 
 

All Status page fields and options in the Create a Translation Memory wizard were not displayed 

when selected for the first time on Chrome and Firefox. 
 All of the Status page fields and options did not display in Firefox and Chrome browsers when the wizard 

was run for the first time during a session. After closing the wizard and running it again, the fields and 

options were displayed as should. 

This has been fixed in Release 1.15.6. 

 

 

 

IDML Filter 
 

Sometimes an erroneous file was created by back-conversion to IDML. 
 

Back converted IDML failed to open and the file was reported as not well formed due to a malformed 

hyperlink text in the file. 

This has been fixed in Release 1.15.6. 
 

Sometimes the back converted IDML caused a software error in InDesign when the IDML file was prepared 

with Clean Formatting checked. 
 

For an IDML file prepared with the Clean Formatting option checked, the back converted IDML failed to 

open and a software error was caused in InDesign, when a <Br/> tag was inside the CharacterStyleRange 

element. 

This has been fixed in Release 1.15.6. 
 

 

XLSX Filter 
 

Sometimes the forward conversion of Excel 2010 XLSX files failed due to the error 'Unknown element: 

AlternateContent'. 
 

While converting an Excel 2010 XLSX file to XLZ or RTF the conversion failed and no file was created, due 

to the error Unknown element: AlternateContent. 

This has been fixed in Release 1.15.6. 
 

 

Instead of the Choice element in AlternateContent, the Fallback element is now extracted for translation. 
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While converting an Excel 2010 XLSX file to XLZ or RTF the conversion did not extract the Fallback 

element in the AlternateContent. The Choice element was extracted instead. 

This has been fixed in Release 1.15.6. 
 

 

 

 

Idiom Plugin 
 

Some Idiom attribute values were not correctly mapped to TW attribute values. 

 The Idiom translation_type attribute value “machine_translation” was recognized as meaning Machine 

Translation, and the Xliff state qualifier was set to “leveraged-mt” when converting from Idiom to 

Translation Workspace and the reverse was done when converting back to Idiom. 

As Idiom “machine_translation” corresponds to what Idiom considers “Auto-Translation”, which is 

what happens with segments containing no linguistically relevant content, such as pure tags, the correct 

attribute value for true Machine Translation is “machine_translation_mt”. 

The following Status / State-Qualifier are now mapped during the conversion and back conversion: 

▪ The “machine_translation_mt” (Idiom) is mapped with “leveraged-mt” (TW). 

▪ The machine_translation (Idiom) is mapped with “x-autotranslation” (TW). 

This has been fixed in Release 1.15.6. 
 

An error message was displayed while changing the translation for a segment including tracked changes 

and a tag. 

 XLIFF Editor displayed and error message while the translation for a segment including tracked changes 

and a tag was changed. 

This has been fixed in Release 1.15.6.. 
 

New in Translation Workspace Release 1.15.5 
Translation Workspace Release 1.15.5 does not include new features. 

Translation Workspace Problems Fixed in Release 1.15.5 
The following problems found in Translation Workspace were fixed in Release 1.15.5: 

 

 

 

Track Changes 
 

Revisions were created for non-track change files by the "Translate to Next Non 100% Match" operation 

when "Stop auto-translate for multi-revision segments" was checked previously. 

 When the Stop auto-translate for multi-revision segments option had been checked previously, the 

Translate to Next Non 100% Match operation created revisions to files for which the change tracking was 

not activated. 

The Revision history pane was also displayed for the target revisions in such files. 

This has been fixed in Release 1.15.5. 
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New in Translation Workspace Release 1.15.4 
Translation Workspace Release 1.15.4 includes the following new features. 

 

 

 

 

Metering 
 

The metering ratio for both Simplified and Traditional Chinese has been adjusted. 

 The metering ratio for both Simplified and Traditional Chinese has been changed to 1.4 characters per 

word. 

The wordcount analysis now provides more accurate information when Chinese is the source language. 
 

 

 

 

Lock & Propagate Frequent Segments 
 

An option to enable or disable tag replacement has been added to Lock Frequent Segments functionality. 

Currently the tag replacement is disabled. 
 

The Allow Tag Replacement option for enabling or disabling tag replacement has been added to the 

Word Client and TW Tools Lock Frequent Segments dialog. The tag replacement is Disabled by default 

and grayed out so that users cannot enable it. This will be changed in a future release. 

 

For segments to be identified as repetitions, the number, position and the contents of the tags should 

match. No tag substitution is performed during the locking process. 
 

Lock and Propagate Frequent Segments functionality can now also be run on XLF files. 
 

You can now run the Lock Frequent Segments operation and the Propagate Frequent Segments 

Operation also on XLF files. Previously only XLZ files were supported. 

You can include both XLF and XLZ format files simultaneously in a same Lock & Propagate run. 
 

 

 

 

 

Track Changes 
 

The tracked changes history is now displayed in the XLIFF Editor. 

 The tracked revisions history is now displayed in the XLIFF Editor segment view. You can view the history 

of all the changes implemented for the source and the target segment of a segment pair on a separate 

Revisions view below the Segment State Toolbar when Show Segment Information is checked in the 

View menu. 
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The Revisions view displays the <internal tags> as red. 

The State and the State Qualifier values are displayed for each target segment revision. 

 

 

Translation Workspace Problems Fixed in Release 1.15.4 
The following problems found in Translation Workspace were fixed in Release 1.15.4: 

 

  

Conversion of MS Office variant files (templates, macros, etc. with the DOCX Filter, the PPTX Filter, and the 

XLSX Filter did not work if the input file was a ZIP package. 
 

MS Office files with extensions other than .docx, .pptx, and .xslx were not supported by the JSON API 

when the input format was a ZIP package. Only .docx, .pptx, and .xslx files were converted. 

The following error was detected during conversion: 

No valid file found. 

This has been fixed in Release 1.15.4. 
 

 

DOCX Filter 
 

The Form field format was different in the back converted file if the option Extract FORM field was enabled 

during forward conversion. 
 

If the option Extract Form field was enabled during the forward conversion, the Form field format was 

incorrect in the back converted DOCX file. 

This has been fixed in Release 1.15.4. 
 

 

Lock & Propagate Frequent Segments 
 

Incorrect translation was placed by the Propagate process if the master segment translation had inserted 

an internal tag to the beginning of the text. 
 

The Propagate process inserted a part of the source text to the target segment if translating the master 

segment had inserted an internal tag to the beginning of the target text. 

This has been fixed in Release 1.15.4. 
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Track Changes 
 

The Concordance Search and the Terminology Search dialogs fail to open when no file is open in the 

XLIFF Editor. 

 When the concordance search or the terminology search was initiated while no file was open in the 

XLIFF Editor, the Concordance Search dialog and the Terminology Search dialog were not opened. 

This has been fixed in Release 1.15.4. 
 

Incremental IDs were assigned to paired tags (bpt/ept) when getting data from a TM. 

 When tags not existing in the source segment were added to the target segment during translation, 

properly paired tags were created in the XLIFF file, but when the segment was stored into the TM and 

retrieved back in interactive or pre-translation, the opening and closing tags had different IDs. 

This has been fixed in Release 1.15.4. 
 

Duplicate revision was created for every single keystroke made to the State or to the State-Qualifier 

value. 

 A new target revision was created for every single keystroke performed in either the State or the State-

Qualifier value combo-box. 

This has been fixed in Release 1.15.4. 
 

Additional target revision was created if the State or the State-Qualifier value was changed while 

segment was opened and closed. 

 A duplicate revision was created when a segment was opened and either the State or the State-Qualifier 

value was changed and the segment was closed. 

Changing the State and the State-Qualifier value from the Document view is no longer allowed. 

When a segment is opened to the segment view, a new revision is now created when the user commits 

or closes the segment. Last value(s) selected for the State and the State-Qualifier is used. If the user 

selects Cancel Changes and Close the Segment, changes made to the values are reverted. 

This has been fixed in Release 1.15.4. 
 

 

 

SDL XLIFF Converter 
 

One of the State values was mapped incorrectly after the conversion to XLZ. 

 Two State values in SDLXLIFF files were not converted according to the initial requirements. 

(No segment state=not translated) was converted with no State value. The correct value is 

“new”. 

("Draft" was and will be converted as "needs-review-translation". This has not been changed, 

as it is the correct value according to the revised requirements.) 

This has been fixed in Release 1.15.4. 
 

Conversion of SDLXLFF failed and reported the KeyError u’locked2’ exception. 

 Conversion SDLXLFF files failed and the XLIFF Editor log file reported the following exception: 

KeyError: u'locked2'. 

This happened when the input file <trans-unit> elements included many segments with 

id="lockedxxx" values. 

This has been fixed in Release 1.15.4. 
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Conversion of SDLXLFF failed due to missing <tag-defs> in the header section of the SDLXLIFF file. 

 While converting SDLXLFF files the conversion failed and the XLIFF Editor log file reported the following 

exception: 

Error: not correct number of tag defs nodes found:0 

This happened when tag-defs were missing in the header section of the SDLXLIFF file. 

This has been fixed in Release 1.15.4. 
 

Conversion of SDLXLFF failed due to a missing <sdl:rep> tag of the SDLXLIFF file and because the mid 

value differs from the segment ID, which includes a space. 

 While converting SDLXLFF files the conversion failed and the XLIFF Editor log file reported the following 

exception: 

Error: not correct number of tag defs nodes found:0 

This happened when a <sdl:rep> tag was missing in the header section of the SDLXLIFF file. 

Also, the file had different values for mid and the segment ID, because the segment ID includes a space 

character. 

This has been fixed in Release 1.15.4. 
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New in Translation Workspace Release 1.15.3 
Translation Workspace Release 1.15.3 includes the following new features. 

 

 

 

 

Support for Modern Standard Arabic (AR-XM) has been added. 

 Translation Workspace now supports Modern Standard Arabic (AR-XM). This new locale designation offers 

a way to avoid having to select country-specific locales which often lead to confusion or lost TM leverage. 
 

 

 

The DOCX Filter can now extract the text from text form fields for translation. 
 

The DOCX Filter can now extract for translation the text from the three different kinds of Form fields: 

FormText, FormCheckBox and FormDropDown. 

A separate Extract FORM field option has been added to the Text Extraction section of the DOCX Filter 

configuration. 
 

The DOCX Filter now extracts the text from MacroButton fields. 
 

The DOCX Filter now extracts for translation the text from the MacroButton fields. 

The new Extract MacroButton field option has been added to the DOCX Filter. When the option is 

checked, the MacroButton fields are extracted for translation. 
 

 

 

A PPTX Filter allows now extracting the notes for translation. 
 

The options in the PPTX Filter configuration have been reorganized and the option for extracting the 

notes for translation has been added. 

By checking the Extract notes (non-hidden) option only you can export the notes, without the slide 

contents, for translation.  
 

 

 

 

 

You can now copy the previous source content to the target while change tracking is enabled. 

 The Track Changes functionality in XLIFF Editor allows now copying the previous source segment, with no 

tracked changes, to the target segment. A button has been added to the Track Changes Toolbar for this 

function. 
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You can now accept all the tracked changes in all the target segments of a file with one command. 

 The Track Changes functionality in XLIFF Editor allows now accepting all tracked changes in all target 

segments of a file with one command. A button has been added to the Track Changes Toolbar and a 

command to the Track Changes Menu for this function. 
 

You can now reject all the tracked changes in all the target segments of a file with one command. 

 The Track Changes functionality in XLIFF Editor allows now rejecting all tracked changes in all target 

segments of a file with one command. A button has been added to the Track Changes Toolbar and a 

command to the Track Changes Menu for this function. 
 

 

Translation Workspace Problems Fixed in Release 1.15.3 
The following problems found in Translation Workspace were fixed in Release 1.15.3: 

 

 

 

 

 

 

 

 

Text from certain fields was not re-inserted during back conversion. 
 

Back conversion to DOCX did not insert all translated text to some combo box fields. 

This has been fixed in Release 1.15.3. 
 

 

 

A Checksum warning was displayed while saving the file after all track changes in the segment have 

been accepted or rejected. 

 When you had selected Accept All Changes or Reject All Changes after making tracked changes to a 

segment, selected Cancel changes and close segment (or pressed Esc) and then saved the file, a checksum 

warning was displayed.  

After Cancel changes and close segment was selected, the accepted or rejected data was displayed. 

If the segment was opened after the checksum warning was displayed, the "Untracked changes found 

in target." warning was displayed. 

This has been fixed in Release 1.15.3. 
 

 

Importing a MultiTerm XML file did not import multiple terms for a language to the same record. 

 Importing MultiTerm XML file content to a glossary added only one term per language into the same 

record, although several terms for a record existed per language in the MultiTerm XML import file. 

This has been fixed in Release 1.15.3. 
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New in Translation Workspace Release 1.15.2 
Translation Workspace Release 1.15.2 includes the following new features. 

 

Change-tracking is now supported in the XLZ files. 

 Translation Workspace now supports change-tracking in XLZ files. The Translation Workspace Xliff file 

format includes metadata allowing versioning and change-tracking on segments. 

New features using this capability have been added to the various TW components:  

▪ The DOCX filter for DOCX to XLZ conversion and back-conversion,  

▪ Client DLL for Pretranslation, and  

▪ XLIFF Editor for interactive translation and manipulation of the versioning information. 
 

 

 

Support for Internet Explorer 10 has been implemented. 

 Translation Workspace web interface now supports Internet Explorer 10 in Windows 7 and in Windows 8. 
 

 

 

  

 

 

 

  

Pretranslation of XLZ files with tracked changes is now supported. 

 The Translate Documents dialog in the TW Tools and the Word Client now supports pre-translating XLZ 

files which include tracked changes. 

The Translate all 100% matches dialog has two Track Changes (XLZ) options for handling the tracked changes 

in the source segments to be pre-translated. 

▪ Accepted (default option) bases the pre-translation on the final segment (as if all changes had 

been accepted). 

▪ Rejected bases the pretranslation on the original segment (as if all changes had been rejected) 

and the resulting segments are further handled as follows. 

• The match percent of the pretranslated segments is set to 0%. 

• Analysis identifies the segments as not translated and searches matches from the TM 

for the latest version of the source text. 

• In XLIFF Editor such segments have the “needs translation” state and they are 

highlighted in orange. 

When the Revision Tracking is Allowed, and the Track Changes are Enabled for a file, the tracked changes in 

the source and the target segments are retained. The changed translations are displayed as tracked 

changes, as are also the translations inserted to previously empty target segments. 
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The DOCX Filter now supports conversion of tracked changes in DOCX files to XLZ and back. 
 

While converting segmented or non-segmented DOCX files with tracked changes to XLZ you can now 

check the new Convert Tracked Changes (only for XLZ format) option to retain the tracked changes in the 

resulting XLZ file. 

   

While the option is checked, converting XLZ files with tracked changes back to DOCX converts the tracked 

changes in the XLZ files back to DOCX format, supported by MS Word (from version 2007 to 2013). 
 

 

 

Track Changes functionality has been implemented to Translation Workspace XLIFF Editor. 

 The new Track Changes functionality in XLIFF Editor allows using track changes in source and target 

segments of XLZ files. You can set XLIFF Editor to track changes that are made to the target segments 

while translating XLZ files. 

Tracked changes are formatted as blue underlined text for insertion and green strike through text for 

deletion in the XLZ files. When the whole segment or a group of segments has been tracked as an 

insertion in the original DOCX file, it is also displayed as a tracked insertion in the converted XLZ file, if 

the Convert Tracked Changes (only for XLZ format) option in the DOCX Filter has been checked while 

converting the DOCX file to XLZ. 

As in DOCX files, the changes include information which can be displayed. As you point at a changed 

text in a segment in the XLIFF Editor, a tooltip displays whether the change was an insertion or deletion, 

the user who made the change and the timestamp when the change was made. 
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Comments contained in the DOCX are displayed as normal text segments in XLZ, at the end of the 

document. 

While converting XLZ files with tracked changes back to any other file format than DOCX, the tracked 

changes are accepted by default. 
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Translation Workspace Problems Fixed in Release 1.15.2 
The following problems found in Translation Workspace were fixed in Release 1.15.2: 

 

 

 

 

 

 

 

  

 

 

 

 

 

Back conversion output only the last text node and any tags following it for CDATA. 
 

Back conversion to XML lost data in case the file included tags preceded by normal text in the “CDATA” 

section, and the filter option Convert HTML in CDATA was unchecked. 

This has been fixed in Release 1.15.2. 
 

 

Converting IDML files with the option Clean character formatting enabled caused an error in the server 

and the client. 
 

Converting IDML files containing a hyperlink with a <br> tag while the option Clean character 
formatting was checked in the filter caused a software error in the server or in the client. 

This has been fixed in Release 1.15.2. 
 

Sometimes back converting files with hyperlinks did not succeed or created a defective file. 
 

While the option Clean character formatting was not checked in the filter, RTF or XLZ file which included 

<pbreak/> tag in a hyperlink could not be back converted to IDML or the back conversion created a file 

which Adobe InDesign could not open. 

The </p> tag inside hyperlinks was replaced with the <pbreak/> tag and the closing hyperlink tag was 

displaced. 

This has been fixed in Release 1.15.2. 
 

Importing a TMX file to a Glossary kept on running causing a problem on the server. 

 Importing a TMX file (which is not supported) containing specific tags to a Glossary was not completed, 

which filled the tmp space on the server. 

This has been fixed in Release 1.15.2. 

The Lock Frequent Segments process caused a software error in the server and in the client. 

 The Lock Frequent Segments process caused a software error when a source segment had an empty 

placeholder at beginning, and no text content was before the placeholder. 

This has been fixed in Release 1.15.2. 
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New in Translation Workspace Release 1.14 
Translation Workspace Release 1.14 includes the following new features. 

 

 

 

 

Managing user identities is now performed outside Translation Workspace. 

 Managing user identities is now performed outside Translation Workspace.  

The central platform for identity management uses now MS Forefront Identity Manager to synchronize 

data to the different applications in the platform. 

From now on, the subscribers manage the user identities for their tenancies in GeoWorkz.com. 
 

Translation Workspace Problems Fixed in Release 1.14 
The following problems found in Translation Workspace were fixed in Release 1.14: 

 

 

  

 

 

  

Propagating Frequent Segments failed if translated master segment contained text outside paired tags 

while the source segment did not. 

 The propagation of some target segments which contained text outside paired tags failed. This occurred 

only if the source segment did not contain text outside the paired tags. 

If the source segment also contained text outside paired tags, the propagation was successful. 

This has been fixed in Release 1.14. 
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New in Translation Workspace Release 1.13 

Translation Workspace Release 1.13 includes the following new features. 
 

 

 

 

 

 

 

 

  

Real-time review package file status reporting has been added to Translation Workspace. 

 Functionality for reporting the status of online review packages has been 

implemented. Users can now select a Summary (by package) or a Detailed 

status report (by file) for selected review packages. 

 

 

The reports include the following information (the user can also select which ones are included): 

▪ Package name 

▪ File name (in detailed report) 

▪ Source language 

▪ Target language 

▪ New 

▪ In progress 

▪ Revised 

▪ Completed-Approved 

▪ Completed-Rejected 

▪ Total (in summary report) 

Users are able to select the report file format: XML, HTML, TXT (tabular), for download or e-mail. 

Users are also able to select the source and target language for the report. 
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Support for index marker texts that include more than 255 characters. 
 

The MIF filter has been enhanced to support index marker texts that include more than 255 characters for 

FrameMaker 8 and newer versions MIF files. 

During back conversion the index marker text limit is now checked depending on the MIF version. 

JSON API has also been updated to send Success = TRUE (and not FALSE as in previous releases) and a 

warning when the MIF file includes index markers with more than 255 characters. 
 

 

 

 

 

Extra space was added at the end of some hyperlinks during back conversion from RTF to DOCX. 
 

While converting RTF files back to DOCX, an extra space was added at the end of some hyperlinks. 

This has been fixed in Release 1.13. 
 

 

 

 

 

Login with Microsoft Word Plug-in no longer allows storing the server password. 
 

When using the Word Plug-in, login to Translation Workspace server no longer saves the password for 

further usage. The option “Allow Translation Workspace to store the password for 15 minutes” is no longer 

available in the Translation Workspace Server Login dialog. 

 

 

  

Support for the TBX-Basic ETSI (LISA) standard has been added. 

 Support for the TBX-Basic ETSI (LISA) standard glossary format has been added. 

You can now export TBX-Basic format files from Translation Workspace glossaries and import TBX-Basic 

glossary format files to Translation Workspace glossaries. 
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Translation Workspace Problems Fixed in Release 1.13 

The following problems found in Translation Workspace were fixed in release 1.13: 
 

 

 

 

The non-translatable part of DOCX index markers were removed during back conversion. 
 

During back conversion, TW was damaging index markers by removing the code available after the text 

part of the index marker. TW filter removed the code after quotation mark which closes the text field in 

the index marker. 

This has been fixed in Release 1.13. 
 

Sometimes translated text was not inserted correctly during back conversion. 
 

Back-converting a translated RTF or XLZ file to DOCX left some text parts of the DOCX in source language, 

if in the original DOCX text had been inserted into the TOC which had hyperlinked items. 

This has been fixed in Release 1.13. 
 

Sometimes the back converted DOCX file was corrupted and it could not be opened. 
 

Sometimes, due to the size of background and text fields in the DOCX document header, the DOCX file 

back converted from RTF and XLZ could not be opened in MS Word. 

This has been fixed in Release 1.13. 
 

Sometimes the back conversion failed due to a drawing embedded into a field. 
 

Sometimes, due to a drawing embedded into a field, the back conversion from RTF and XLZ to DOCX 

failed and the following error message was displayed: 

 p not read as expected!  

 Fail to build! 

This has been fixed in Release 1.13. 
 

After back conversion of file with an originally non-updated TOC, MS Word fails to open the file reporting 

that there are problems with the file. 
 

Sometimes, due to the TOC in the original DOCX not being up-to-date, the DOCX file back-converted 

from RTF or XLZ could not be opened in MS Word, and an “Unspecified error” was displayed. (The back-

converted DOCX worked as it should when the original DOCX file had an updated TOC.) 

This has been fixed in Release 1.13. 
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New in Translation Workspace Release 1.12.3 

Translation Workspace Release 1.12.3 does not include any new features. 
 

Translation Workspace Problems Fixed in Release 1.12.3 

The following problems found in Translation Workspace were fixed in release 1.12.3: 
 

 

 

 

 

 

 

 

 

 

Sometimes extra whitespace characters in text between two comments were not removed. 
 

Extra carriage returns, spaces and tabs were not removed between two comments althoug all the options 

were checked in the Remove Extra Spaces, Tabs and Carriage Returns section. 

This has been fixed in Release 1.12.3. 
 

 

 

Text from XMLElement nodes inside Tables or Cells was not extracted for translation. 
 

Texts from XMLElement nodes located in table cells were not extracted for translation by the IDM Filter to 

RTF and XLZ formats. 

This has been fixed in Release 1.12.3. 
 

Sometimes a software error was caused in MS Word when trying to restore configuration settings on the 

IDML tab. 
 

Clicking Restore on the IDML tab of the Document Conversion > Configure Filters dialog in the Word Client, 

caused a software error in MS Word. 

This has been fixed in Release 1.12.3. 
 

When option Clean character formatting was checked, forward conversion caused a software error in server, 

Word Client and TW Tools. 
 

A software error was sometimes caused in the server (by API) and in the Word Client and TW Tools by 

running the forward conversion when the Clear character formatting option had been checked on the 

IDML tab of the Configure Filters dialog. 

Files attached to email messages sent by TW CentOS server have extra brackets around them.. 

 When the TW Tools was used for running Wordcount Analysis and the Send Analysis Result as Email 

option had been checked in the Document Analysis dialog, the name of the analysis result attachment 

included extra brackets "{nosid.File_analysis.zip}". 

This has been fixed in Release 1.12.3. 
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This has been fixed in Release 1.12.3. 

 

 

 

Sometimes forward and back conversion failed due to a missing footnote. 
 

Sometimes, due to a footnote missing, the forward and the back conversion failed and the error “P tag 

not found. MIF file hasn't been fully parsed” was displayed. 

This has been fixed in Release 1.12.3. 
 

Sometimes a software error was caused when converting MIF files with change bars. 
 

When converting MIF files which included change bars, a software error could be caused in the MS Visual 

C++ Runtime Library. 

This has been fixed in Release 1.12.3. 
 

Line feeds in Variable definitions were not preserved in the back converted MIF document. 
 

Line feeds inside Variable definitions were removed when RTF and XLZ files were converted back to MIF, 

although the <hr/> tags in <Vartext> nodes were present in the tagged files. 

This has been fixed in Release 1.12.3. 
 

Sometimes back conversion did not fully parse MIF files due to a footnote not extracted in conversion. 
 

Sometimes back conversion of RTF and XLZ files failed and a localized MIF7 and a MIF9 file was not 

generated.  

Although nothing was reported in the Document Back Conversion dialog, an .err file was created, saying for 

example that a “Conditional text marker with id = 1 was not found. MIF file hasn't been fully 

parsed.” or that a “P tag not found. MIF file hasn't been fully parsed.” 

This happened due to a footnote not extracted by conversion to RTF and XLZ. 

This has been fixed in Release 1.12.3. 
 

Sometimes the generated RTF/XLZ was not valid due to a control character not extracted as a tag. 
 

Sometimes when MIF files were converted to XLZ using default options, the generated XLZ file did not 

open in the Xliff Editor and an error was displayed. 

When the same MIF files were converted to RTF, the RTF file was opened correctly but back conversion 

failed due to an invalid temp XML.  

Problem was caused by the control characters (\x11, \x13, \x15, ...) not being converted to RTF and XLZ 

files as tags. 

This has been fixed in Release 1.12.3. 
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New in Translation Workspace Release 1.12.2 

Translation Workspace Release 1.12.2 includes the following new features. 
 

 

 

 

  

Allow the MLA to remove extra whitespace in text parsed as non-translatable internal. 
 

MLA can now be set to remove extra whitespace characters from segments which are set as non-

translatable and formatted as LogoportMarkup (internal) segments by the LMX definition. 

The whitespace characters are removed even when a parent element is set in the LMX definition as not to 

be translated. This ensures that a translatable text segment will not be sub-segmented when it contains 

non-translatable inline elements (internal text), for example software strings which should not be 

translated. 
 

 

Translation Workspace Problems Fixed in Release 1.12.2 

The following problems found in Translation Workspace were fixed in release 1.12.2: 
 

 

 

 

 

 

 

 

 

 

 

 

 

Japanese source incorrect repetition. 

 In previous versions, different sentences in RTF and XLZ files with at least one of the following characters 

were falsely interpreted as repetitions: 

▪ 挿 

▪ マ 

▪ 図. 

This has been fixed in Release 1.12.2. 

Source language was not correctly set for TM Export to TMX format when selecting only one language 

pair and no separate file. 

 When exporting a TM in TMX 1.1 and 1.4b format by selecting 1 language pair and the option Use 

Separate File for each Language Pair was not checked, the source language was set to srclang="*all*" in 

the generated TMX file, although it should be the language code of the selected source language (i.e. 

srclang="EN-US") instead, whether Use Separate File for each Language Pair is checked or not. 

This has been fixed in Release 1.12.2. 
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Sometimes extra characters next to external tags were removed. 
 

Some extra carriage returns, spaces and tabs were removed when the option In Text between Tags was 

checked in the Remove Extra Spaces, Tabs and Carriage Returns section, although carriage returns, 

spaces, and tabs immediately after or before a LogoportDoNotTranslate (external) tag should not be 

removed by this function. 

The problem occured only if there was a LogoportMarkup (internal) tag immediately before and after 

the LogoportDoNotTranslate (external) tags. 

This has been fixed in Release 1.12.2. 
 

Sometimes carriage returns located immediately after internal tags were not removed. 
 

Some carriage returns located in text between LogoportMarkup (internal) tags were not removed 

although the option In Text between Tags was checked in the Remove Extra Spaces, Tabs and Carriage 

Returns section. 

This has been fixed in Release 1.12.2. 
 

Sometimes single and multiple whitespace characters between internal tags were removed. 
 

When the Remove Extra Spaces, Tabs and Carriage Returns section option In Text between Tags was not 

checked, single whitespace characters between two LogoportMarkup (internal) tags outside segments 

were removed if the other options in the remove extra whitespaces options were checked. 

For example, if you checked only carriage returns and tabs as to be removed, also spaces were removed. 

The same issue was detected for tabs and carriage returns. 

This has been fixed in Release 1.12.2. 
 

Sometimes some text was deleted from comments inside CDATA section. 
 

When the Convert HTML in CDATA option was checked in a MLA profile, if CDATA text in input files 

contained comments (starting with “<!--”), the comment text before its first “&“ character was deleted 

during conversion. 

When additionally the Ignore Namespaces option was checked in the ML profile, the text from the 

comments inside the CDATA was deleted before the last “&“ character during conversion. 

If the CDATA section contained some entity, for example "&test;" the whole entity was truncated during 

conversion when Ignore Namespaces option was checked. 

 

In some cases text was 

deleted during conversion 

when Ignore Namespaces 

option was checked because 

the CDATA section was not 

well-formed XML - there was 

no root element to hold the 

text. In such cases MLA now 

displays an error message. 

 

This has been fixed in Release 1.12.2. 
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New in Translation Workspace Release 1.12.1 

Translation Workspace Release 1.12.1 includes the following new features. 
 

 

 

 

 

Add support for Frame Maker 11. 
 

Support for Frame Maker 11 MIF files has been added to the MIF filter. 

 

 

 

Translation Workspace Problems Fixed in Release 1.12.1 

The following problems found in Translation Workspace were fixed in release 1.12.1: 
 

 

 

 

 

Exporting a TM with corrupted source segments caused a server error. 

 In previous releases, exporting a TM with corrupted data in the source segments could cause a server 

error. 

This has been fixed in Release 1.12.1 
 

 

 

Propagating Frequent Segments to some locked segments failed. 

 Some segments were considered as repetitions and locked during the Lock Frequent Segment process 

although the propagation to the segments failed. This occurred only to segments containing tags with the 

following characteristics: 

▪ There was a space before a tag in the master segment but a non-breaking space in the locked 

segment instead. 

▪ There was a space between normal text and a tag in the master segment but no space in the 

locked segment. 

▪ There was a space between two tags in the master segment but no space in the locked segment. 

This has been fixed in Release 1.12.1. 
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Sometimes DOCX filter failed in back conversion. 
 

When a field code contained a drawing object, converting XLZ and RTF files back to DOCX caused a back 

conversion error in Word client and TW Tools and created an error log file. 

This has been fixed in Release 1.12.1. 
 

 

Sometimes a software error was caused in XLSX filter while back converting an XLSX file. 
 

In some cases, when the character ‘&’ appeared in the header, back converting an XLSX file to XLZ and 

RTF file caused a back conversion error in Word client and TW Tools. 

Data checks and server error prevention for TM exports has been enhanced and information about bad 

segments is now reported during export. 

This has been fixed in Release 1.12.1. 
 

 

 

 

An incorrect number gets displayed in pagination. 

 In previous releases, the paging number did not match the number of pages displayed after the Show 

segments count was decreased below 100 and Apply Filters was clicked. 

This has been fixed in Release 1.12.1. 
 

New revision gets created even if user does not change the target. 

 In previous releases, sometimes when a segment was opened but nothing in it was changed, after OK 

was clicked, and Save was clicked on the Main pane, and additional revision was displayed for the 

segment. 

This happened only when the Online Review Client was used with Internet Explorer 9. 

This has been fixed in Release 1.12.1. 
 

QA Report XSLT incorrect summary table. 

 In previous releases, the summary table generated by the Online Review Report transformation file 

QAviewer.xsl was not correct. The number of errors per category was always 1. 

This has been fixed in Release 1.12.1. 
 

Date and time of the last update and user who did the update were not refreshed when saving a 

change. 

 After a user had revised a segment (in a review package created by another user), the Date and Time for 

the revised segment and name of the revising User were not displaying updated information unless the 

Refresh button was clicked, although other properties (Target, Category, Severity and Status) displayed as 

updated. 

This has been fixed in Release 1.12.1. 
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New in Translation Workspace Release 1.12 

Translation Workspace Release 1.12 includes the following new features. 
 

 

 

 

A functionality to lock and propagate frequent segments in XLIFF files has been added. 

 A functionality to lock and propagate frequent segments in XLZ files has been added to Translation 

Workspace. The new functions are available only from the Word Client and TW Tools. 

The repetitions of a segment in a batch of XLZ files except the first occurrence of the segment can be 

locked. 

A post-process step ensures that repetitions are propagated throughout the batch. All initially locked 

segments are auto-translated. 

Control for what is considered as a repetition has been added. Two criteria with numeric values can be 

used for this purpose: 

▪ Minimum Frequency: Only segments appearing “X” times or more are considered as 

repetitions. 

▪ Minimum Wordcount: Only segments containing “Y” words or more are considered as 

repetitions. 
 

 

Improve TM language selection UI. 

 New features were added to the Select Language to Add dialog: 

1. Three new columns, ISO code, 

Source, and Target, were added 

into the Select Language to Add 

dialog. 

2. If the user clicks on either Add 

Source Language or Add Target 

Language, the checked sign is 

displayed next to the language 

name. 

3. The user is now allowed to select 

multiple languages by pressing 

Ctrl+Shift (continuous selection 

from x to y) or Ctrl+Click 

(separate items) and add these 

languages in the TM’s languages 

lists. 
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Translation Workspace Problems Fixed in Release 1.12 

The following problems found in Translation Workspace were fixed in release 1.12: 
 

 

 

 

 

Leading slash in the only tag in CDATA caused a software error in MS Word during conversion with 

"Ignore Namespaces"=True checked in MLA. 
 

Checking Convert HTML in CDATA and Ignore Namespaces in MLA when the file to be converted contained 

the CDATA tag with only one tag, which started with slash (like "</br>") the file conversion caused a 

software error in MS Word. 

This has been fixed in Release 1.12. 
 

 

Inversed SmartTag tags in the segmented file caused during back conversion a software error in the Word 

client/TW Tools (and TW server via JSON API). 
 

Back converting XLZ files with inversed <smartTag> tags caused a back conversion software error in 

Word client and TW Tools (and TW server via JSON API). 

This has been fixed in Release 1.12. 
 

Smart Tag tags blocked importing the translation to source file during back conversion. 
 

The <smartTag> tags were partly blocking the successful import of the translation during back 

conversion. 

This has been fixed in Release 1.12. 
 

 

  

Filters

HTML/XML Filter

DOCX Filter
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New in Translation Workspace Release 1.11.3 

No new features are included in Translation Workspace Release 1.11.3. 
 

Translation Workspace Problems Fixed in Release 1.11.3 

The following problems found in Translation Workspace were fixed in release 1.11.3: 
 

 

 

Clicking Next on the pagination bar causes the pagination information displaying incorrectly. 

 If Next was clicked on the pagination bar, the pagination information on the pagination bar was 

displayed incorrectly. 

This has been fixed in Release 1.11.3. 
 

Segment changes are lost after segments status is set to a different status than pre-approved 

when implemented by a user who did not initially create the review package. 

 If a user who did not create the review package changed a segment status to something else than pre-

approved, without adding comments to the segment, the segment changes were lost. 

This has been fixed in Release 1.11.3. 
 

Segments revision history is incorrectly managed after the status of a segment has been changed 

by another user. 

 If a user who did not create the review package changed the status of a segment to some other than 

Pre-Approved and then the user who created the package changed the status to Pre-Approved, the 

revision history of the segment did not report all changes. 

This has been fixed in Release 1.11.3. 
 

On entering a comment, the target text gets reverted to other revision. 

 After saving additional text to the target of a segment without tags, reversing the segment and saving it 

to the prior state, entering a comment to the segment reversed the segment to the later revision with 

additional text in it. 

This has been fixed in Release 1.11.3. 
 

Paging is incorrect when a user tries to diminish the number of displayed pages. 

 When a smaller number than previously set was selected in the Show segments field menu and Apply 

Filter was clicked, the paging of the segments and browsing the segment pages did not work correctly. 

This has been fixed in Release 1.11.3. 
 

Online Review editor fails to save the reverted segment. 

 After using the Online Review segment editor to revert text from second revision to previous revision, it 

failed to save the same segment back to the second revision. 

This has been fixed in Release 1.11.3. 
 

 

  

Online Review client
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New in Translation Workspace Release 1.11 

Translation Workspace Release 1.11 includes the following new features. 
 

 

Web UI and Server 
 

Aliasing 

 Allow users to configure the aliasing duration at Alias creation. 

  The Alias creator is now allowed to specify (and later modify as needed) the lifespan of each Alias. As 

a first step in this deployment, all current Aliases are set to expire when inactive for 90 days. 

At the creation of an 

alias, the creator 

user is allowed to 

determine the 

lifespan of the alias 

using a calendar 

widget. Default 

setting is 90 days 

from the current 

date and the date 

can be set up to 1 

year maximum from 

the current date. The 

minimum setting is 

the current date. 

If any of the above-

mentioned options 

is selected, the 

published alias row 

will be highlighted in 

yellow when the 

lifespan date is a 

week ahead from 

the current date and 

finally in red when 

the lifespan date is 2 

days ahead from the 

current date. 

The Alias publisher will also be notified by e-mail 5 days before expiration date, so that he can 

extend the period of validity. The notification is sent to: 

1. The Publisher of the alias. 

2. If the Publisher does not exist, notification is sent to the asset contact. 

3. If none of the Publisher and Asset contact can be found, it is sent to the Tenant owner. 

A user in a tenancy with proper privileges is allowed to change the expiration date of an alias. In the 

published aliases list, for each published alias there is one new column added for the lifespan. This 

field can be edited by clicking the Alias Edit button. 

 Create a mandatory expiration date for alias tokens. 

  A user interface has been 

added to allow users to set 

a mandatory expiration 

date for alias token when 

generating a token. 
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An option has been included allowing to send a notification email that the token is about to expire. 

The notification is sent 5 days before the expiration date. 

The notification is sent to: 

1. The Publisher of the alias. 

2. If the Publisher does not exist, notification is sent to the asset contact. 

3. If none of the Publisher and Asset contacts can be found, it is sent to the Tenant owner. 

This feature impacts the duration or lifespan of the alias token only, not of the alias. 
 

 

Client DLL 
 

Interactive translation 

 A warning is displayed if a user accepts a fuzzy match without updating the translation. 

  A warning is presented in Word client and XLIFF Editor when a fuzzy match is accepted without edit 

during interactive translation so that the user does not inadvertently commit an inexact match to the 

memory. 

The warning popup message reads: 

Warning: No edit made to a fuzzy match! Do you really want to accept the 
unchanged translation from a different source segment? 

The user can select to proceed or cancel the operation. If the user selects to cancel, she is returned to 

the segment in the document. 

The Warning mode is optional and TM specific. The option Display warning if fuzzy match is accepted 

without editing can be activated in TM Settings on the Properties > Advanced tab in the Translation 

Workspace Web interface. 

The option is checked by default in all new TMs and TMs created before this feature was introduced. 

Penalized 100% matches are excluded (without warning): 

1. Those 100% matches coming from a penalized background TM link. 

2. Those 100% matches penalized due to multiple 100% matches. 

 

 

Filters  
 

General 

 Change default output of conversion in the Document Conversion dialog. 

 

 
The default output Tag Style setting in the Document Conversion 

dialog has been changed from Translation Workspace RTF to 

Translation Workspace XLIFF. 
 

 

 

XLIFF Editor 
 

Filters 

 Support for SDL XLIFF file format has been added. 

  Support for SDL XLIFF file format (.sdlxliff) has been added to XLIFF Editor. 

XLIFF Editor can convert the SDL XLIFF files to XLZ and back to SDL XLIFF after localization. 

You can either open an SDL XLIFF document directly with XLIFF Editor or use the SDL XLIFF Converter, 

which can be opened from the Tools menu. 

Currently the converter supports only pre-segmented SDL XLIFF files. 
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Segment Filters 

 Support for filtering External segments in XLZ files has been added. 

  XLIFF Editor segment filters include a new option External which can be used to filter External 

segments included in the XLZ files by some of the conversion filters. 

Such External segments cannot be edited, are not accounted in the wordcounts, and they are 

excluded by batch operations. 
 

 

Online Review client 
 Functionality has been added to allow users filter for segments with specific metadata. 

  In previous releases, users could not filter data with specific metadata criteria, for example to view 

all segments the user has revised. 

A filtering toolbar has been added to the Online Review client where you can select filtering on 

the following fields: 

• Match percent 

• Status 

• Category 

• Severity 

• Comments 

• Changes 

 

  Each labeled field has an operator selector; some have also a value input. There is an initial list box 

with All and Any options to display segments matching any of the active filters or only segments 

matching all the filters in use. 

The state of filtering is retained between sessions for the user. 

On the main Online Review toolbar, two new action buttons have been added Show Filters and Apply 

Filters. 

• Show Filters displays or hides the Filters Toolbar. 

• Apply Filters is another toggle button allowing applying or clearing the Filters. 
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Translation Workspace Problems Fixed in Release 1.11 

The following problems found in Translation Workspace were fixed in release 1.11: 
 

Web UI and Server 
 

Analysis 

 

Analysis with Penalize multiple 100% matches option does not account background TMs. 

  In previous releases, when Penalize multiple 100% matches option was selected in the advanced TM 

settings, and a search found multiple matches for the same segment the penalty was applied only 

for matches coming from the foreground TM. 

This has been fixed in Release 1.11. 
 

 

Filters  

 

General 

 ZIP corrupted after XML to XLZ conversion. 

  In previous releases, when converting a large number of XML files into XLZ using the converter, the 

returned zip package could get corrupted. 

This has been fixed in Release 1.11. 
 

DOCX Filter 

 Back conversion fails if document contains the “w14:srgbCls” class object. 

 

 
In previous releases, back conversion of a RTF and XLZ file converted from a Word 2010 DOCX file 

sometimes failed with an error message  

Fatal Error: Xerces SAX2XMLReader::parseNext() reads nothing! 

Problem was caused by the run property "w14:props3d", which has color description for extrusion 

and contour using "srgbClr". 

This has been fixed in Release 1.11. 
 

PPTX Filter 

 After back-conversion of PPTX file the file fails to open in MS PowerPoint and reports error that PowerPoint 

found a problem with the content. 

 

 
In previous releases, sometimes a back to PPTX converted RTF or XLZ file did not open in MS 

PowerPoint and PowerPoint reported finding a problem with the content, offering to repair the 

problem. When repaired, the file opened well without any traceable loss of data. 

The problem was caused by the zlib package compressor. 

This has been fixed in Release 1.11. 
 

IDML Filter 

 The Clean character formatting option does not work well with XML Elements. 

  In previous releases, if the Clean character formatting option was checked in the IDML filter, an extra 

paragraph mark was inserted in back converted files and the paragraph mark was excluded from the 

end of xml elements. 

When the Clean character formatting option was not checked, one xml element was missing in the 

back converted file, most of the "lionbridgeuntranslatable" text had style changed to "normal" and 

the hyperlink that was at the end of first xml element was missing. 

This has been fixed in Release 1.11. 
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New in Translation Workspace Release 1.10 

Translation Workspace Release 1.10 includes the following new features. 
 

 

Web UI and Server 
 

Aliasing 

 Email format of outbound mail when user is sent a Token should be updated to Highlight "Notes from the 

publishing tenant" section. 

  Email format of outbound mail when user is sent a Token has been updated to highlight “Notes from 

the publishing tenant” section. 

 “Add Language” option removed from default options when publishing an asset Alias. 

  The “Add Language” option is no longer checked by default in the Publish New Translation Memory 

Alias dialog when a new asset Alias is created. 
 

Reporting 

 Capture and record asset configuration changes for access by designated users. 

  An Audit Trail mechanism has been created for capturing and reporting the essential aspects of 

Translation Workspace asset configuration in a tenancy and its possible changes during projects. 

The information is available for designated users (tenancy admin, asset owner or a user with the new 

AUDIT_TRAIL_SHOW permission). 

The changes to the following information about each asset shall be retained: 

1. Everything under the "Properties/Advanced" and "Properties/Segmentation Rules" tabs of 

the TM-all changes committed via the "Save" button. 

2. Modifications under the "Manage/Background Links" tab: Add/remove/edit background TM 

or glossary links or penalties/premiums (including the "search only" attribute). 

3. For every record, a timestamp is noted (year/month/date/time) and the user which 

performed the action. Whether the action was performed via API, is noted as well. 

4. The above information is maintained for the duration of asset existence. 

There is a user interface in the Translation Workspace Web Interface within each tenancy available to 

all credentialed users allowing them to query all of the above for a desired time period and export 

the results of the query into an XML file. 



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 244 

 

 

The owner of an asset can select whether an email is sent to her reporting any changes made to the 

asset. This report includes all the changes committed since the previous reporting period. 

As time goes on, the grid in Manage > Audit Trail grows displaying more and more modifications 

done to the asset. Once asset is permanently deleted, the audit information is deleted from the 

system. 

 Enhancements to the wordcount report. 

  Enhancements to the wordcount report have been made giving customers more insight into their 

tenancy's word count usage. 

1. “Repetitions” have been removed from the usage report, as this category is preproduction 

specific. 

2. Fuzzy match category headers have been modified and “No match” category has been 

added. 

3. New columns have been added: 

▪ Action (auto-translation or interactive) 

▪ Metered words 

▪ Type (RTF versus XLIFF process) 

▪ Ideograph: number of ideograph characters (for CCJK) 

4. Headers are included in Translation Workspace Report export. 

5. XLIFF versus RTF oriented processing is included in the report. 
 

 

TM Management 

 

Additional options for TMs Export. 

  Enhancements have been made to the options and ease of use of the TM export feature. 

1. A checkbox has been added optionally allowing the multi-language TMs to be exported as 

separate per language pair files (all included in a single zip file created by the export), 

including the language pair names in the file names. 

2. You can now multi-select and multi-deselect language pairs in the export screen by 

pressing Shift while clicking the language pairs and select or unselect individual language 

pairs by pressing Ctrl while clicking the language pairs. You can also use the Select All and 

Clear Selections Buttons. 
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3. When the Export tab is opened or Refresh is clicked, all the language pairs are selected by 

default. 

4. If you clear all language pair selections, when the option Use Separate File for each 

Language Pair is not checked, only TM settings will be exported when Start TM Export is 

clicked. If you click Select All, all language pairs will be exported when the export is 

performed. 

 
 

 

 

 

User Interface 

 

MT TMs now have an own icon in the object tree. 

  A new TM icon with a MT overlay has been created for the object tree display to distinguish MT TMs. 
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Filters  
 

 

DOCX Filter 

 Add two options for skipping extra formatting (spacing, kerning, etc.) and Complex Script & Asian Fonts. 

 

 
Two options have been added into the filter configuration dialogs of the DOCX filters, and the filter 

settings LMX file, under the new Formatting section. 

 

When enabled, the Clean Font Formatting option (enabled by default), causes tags corresponding to 

extra font formatting information not to be extracted for translation: 

• Spacing information 

• Scale information 

• Kerning information 

• Position information 

• Complex case with different formatting 

When enabled, the Clean Complex Script and Asian Text Font option (disabled by default), causes 

complex script tags and Asian font tags not to be extracted for translation. 

This option should not be selected if complex script or Asian font is in use in the document. 

Information not extracted during forward conversion is also not included in the back converted 

document. 
 

 

IDML Filter 

 Add support for Adobe CS4/CS5 interchange format InDesign Markup (IDML). 

 

 
A new parser has been created to support the conversion of (Adobe InDesign CS4/CS5) InDesign 

Markup (IDML) format files to RTF and XLZ for localization and back to IDML format. 
 

 

TEXT Filter 

 Minimize amount of technical info displayed after conversion in case wrong encoding is specified in the 

configuration (LMX). 

 

 
Only one error message about failing initialization and encoding not recognized is displayed, when 

wrong encoding is specified in the TEXT filter settings (LMX) and text files conversion is started. 



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 247 

 

 Options for removing extra spaces, tabs and carriage returns inside internal text and in translatable text has 

been made available in TEXT Filter. 

 

 The following two groups including selectors for removing extra spaces, tabs and carriage returns 

during parsing has been added to the TEXT Filter. 

• Remove Inside Internal, where extra spaces, extra tabs, and extra carriage-return characters 

can be selected to be removed from the text marked as internal style text during parsing. 

• Remove in Translatable Text, where extra spaces, extra tabs, and extra carriage-return 

characters can be selected to be removed from the translatable text during parsing. 

 Applying Delimiter rules with identical start and end delimiter. 

 

 In Delimiter rules, delimiters are not a part of the matching segment. 

However, if the delimiter rule has an identical start and end delimiter, when two consecutive text 

strings share a delimiter in the text, the rule is applied only to the first text string. 
 

 

XLIFF Editor 
 

Fileset Browser 

 Filesets can be created with a custom file name. 

  Filesets are created with standard name "_fileset.xfs" by default and only one fileset could be 

created in a directory. 

A custom fileset name field is now displayed while the fileset is created. The filesets list displays the 

parent directory and the fileset name. It displays also the full fileset path in a tooltip while pointed. 

 Improved handling of source and target languages in Filesets. 

  The functioning of the two language columns in the Fileset Browser has been enhanced. 

1. The data (source and target languages) are now populated at fileset opening. You no 

longer need to open a file to get this information refreshed in the columns. 

2. The data (source and target languages) are now populated at fileset creation, as is done to 

other statistics (segment and word counts). 

3. The data (source and target languages) are now stored for future use, as is done to other 

statistics (segment and word counts). 
 

Filters 

 Add IDML Support to XLIFF Editor. 

  The IDML filter support has been added to XLIFF Editor. 

IDML files can be converted to XLIFF, backconverted to IDML and previewed in XLIFF Editor. 
 

Interactive translation 

 Add an option for Displaying / Not displaying translation coming from the TM into the segment information 

field. 

  The option Show Translation from the TM has been added in the Translation menu which allows to 

display/not display the TM target of the match in the segment information field, even if the TM 

target is identical to the current target already in the segment. 
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Translation Workspace Problems Fixed in Release 1.10 

The following problems found in Translation Workspace were fixed in release 1.10: 
 

Web UI and Server 
 

Session Handling 

 

Make client session properly survive across restarts. 

  Client sessions are stored to database, but some bugs prevented them from being reused across 

server restarts. 

This affected the persistent task queue and client interactions.  

This has been fixed in Release 1.10. 
 

TM Management 

 

While adding XLZ files to TM, the context matching attribute is added for each segment even if the 

context matching option is not selected in the TM. 

  When Context Matching was disabled in the TM settings and XLZ files were cleaned to TM or 

segments added to the TM with XLIFF Editor, all segments were added to the TM with the context 

matching attribute (NBH). 

This has been fixed in Release 1.10. 

 

Overwriting Existing Translations in TM not working as expected during TM Import. 

  While the Overwrite option in Existing Translations in TM settings for the Import TM operation was 

selected, the Translation Units with identical source segments were all stored into the TM, although 

only the last imported Translation Unit should be stored. 

This has been fixed in Release 1.10. 
 

 

Filters  
 

HTML/XML Filter 

 Back conversion of XLZ files fails to use selected “Decimal/Hexadecimal” representation for entities. 

 

 
In previous releases, while back-converting XLZ files, entities to be back converted as Decimals or 

Hexadecimals (as per the profile setting) were back converted as ”default” entities instead. 

This has been fixed in Release 1.10. 

 Some tags are deleted when converting XSL files. 

 

 In previous releases, converting XSL files with default LMX settings to RTF or XLZ via TW Tools 

resulted in deleting some tags (such as <xsl:choose>, or </xsl:when>) from the prepared RTF file, 

although no error message was displayed during conversion, back-conversion, and QA check. 

This has been fixed in Release 1.10. 

 Remove Extra Spaces > In Text Between Tags works incorrectly for RoboHelp tags. 
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 In previous releases, when Remove Extra Spaces > In Text Between Tags was checked in Markup 

Language Assistant, single spaces between text and RoboHelp tags (for example: text <?rh..>) were 

removed causing the back-converted text displaying incorrectly in the browser. 

This has been fixed in Release 1.10. 

 Remove Extra Spaces, Tabs, and Carriage Returns options: non-breaking spaces need to be managed the same 

way as ordinary spaces. 

 

 In previous releases, if you used the Remove extra spaces, tabs and carriage returns options, non-

breaking spaces were not recognized as spaces and extra non breaking spaces thus were not 

deleted. 

That prevented also removing extra carriage returns from between non breaking spaces. 

This has been fixed in Release 1.10. 

 Wrong HTML value for the SINGLE LOW 9 QUOTATION MARK (sbquo) entity. 

 

 In previous versions, both the LEFT SINGLE QUOTATION MARK (&lsquo;) and the SINGLE LOW-9 

QUOTATION MARK (&sbquo;) had the same HTML decimal value (8216), although the correct value 

of the &sbquo; entity is 8218. 

This has been fixed in Release 1.10. 
 

MIF Filter 

 Texts in Master Pages are in some cases not extracted from FrameMaker 9.0 file. 

 

 
In previous releases, in some cases, text in Master Pages was not extracted for translation from MIF 9 

files when the MIF 9 files were converted to RTF or XLZ. 

This has been fixed in Release 1.10. 

 In some condition, layout of the back converted file is not correct (text on the wrong page). 

 

 In previous releases the layout of the back converted MIF document was incorrect, because the 

conversion to RTF and XLZ extracted some text from a page under an incorrect <page name=…> 

tag under particular condition (Textrect inside a Xref). 

This has been fixed in Release 1.10. 

 Reserved XML character ‘&’ appearing in page tag attribute is not encoded to an entity during forward 

conversion (blocks the back conversion to MIF). 

 

 In previous releases, the reserved XML character ‘&’ appearing in page tag attribute was not 

converted to an &amp; entity during conversion to RTF and XLZ. 

Back conversion to MIF failed and an error message was returned: 

Failed to preprocess XML 

Preprocessing failed. 

This has been fixed in Release 1.10. 
 Index marker semicolon wrongly interpreted during conversion to RTF and XLZ. 

 

 In previous releases, the semicolon at the end of the &amp; entity inside the index marker text was 

erroneously treated as a lower level index marker, resulting in split index marker segments with 

content locked from translation in RTF and XLZ. 

This has been fixed in Release 1.10. 

 Table content is not always extracted from the files. 

 

 In previous releases, converting MIF files to RTF using TW Tools sometimes did not extract text 

inside tables for translation. 

This has been fixed in Release 1.10. 

 Some XRef footnotes are corrupted after back conversion. 

 

 In previous releases, XRef footnotes were corrupted after back conversion to MIF7 format in files re-

saved using Frame Maker 9 or Frame Maker 10, which have different DFNoteLabels. 

This has been fixed in Release 1.10. 

 Cross-reference (XRef) missing some text after back conversion. 
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 In previous releases, some text could be missing from the cross-references in the back-converted 

MIF files. 

This has been fixed in Release 1.10. 

 Sometimes the back-converted MIF file contained only the source segments and no localized segments. 

 

 In previous releases, sometimes the back-converted MIF files contained only the source segments. 

This has been fixed in Release 1.10. 
 

 

 

 

 

 

 

PPTX Filter 

 Some translated text is not inserted during back conversion. 

 

 
In previous releases, sometimes after back-converting a translated RTF or XLZ file to PPTX, almost all 

of the text was not inserted into the back converted PPTX file. 

This has been fixed in Release 1.10. 
 

 

TEXT Filter 

 Conversion to RTF generates line feeds instead of paragraph marks. 

  In previous releases, converting a text file into RTF using the TEXT filter a line feed (\line) was 

generated instead of a paragraph mark (\par). 

This has been fixed in Release 1.10. 

 Overlapping problem when applying sibling rules. 

  In previous releases, a text area claimed by the first sibling rule was intruded by a later sibling rule, 

although a following sibling rule should have no access to the claimed matched areas but should 

apply only to the remaining unclaimed text. 

This has been fixed in Release 1.10. 

 Extra empty lines are introduced to tagged file and back-converted file. 

  In previous releases, extra empty lines were added to tagged file and back-converted file. 

This was caused by using LF (Line Feed) character for regular expression (regexp1="\*\r"). Instead of 

writing an internal LF and a normal CR, a paragraph mark should be written. 

This has been fixed in Release 1.10. 

 Moved profile loses focus after “Move up” and “Move down”. 

  In previous releases, the selected profile on Configure Filters dialog TEXT tab was no longer 

selected after it was moved with Move Up or Move Down command. 

This has been fixed in Release 1.10. 

 Some regular expressions could lead to MS Word to hang. 

  In previous releases, regular expressions "\n", "\D", "\W" could lead to Word hanging during convert 

and a software error. 

This has been fixed in Release 1.10. 

 Drag and drop of files into the Regular Expressions panel should be disabled. 

  In previous releases, it was possible to drag and drop files (XML, INI, etc.) into the Regular 

Expressions panel of the Text Filter Profile Edit dialog, which caused a fault in the Word Plug-in and 

TW Tools when dragging and dropping XML files, or many empty rules was added when dragging 

and dropping Trados.ini files. 

This has been fixed in Release 1.10. 

 Consecutive paragraph marks at the end of files are removed in case some profile has been selected. 
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  In previous releases, when a TEXT Filter profile was manually selected (auto-select profile was not 

used) consecutive paragraph marks (\para) at the end of files were deleted during conversion to RTF 

or XLZ. 

This has been fixed in Release 1.10. 
 

 

Microsoft Word Plug-in 

 Opening a segment via an aliased TM sometimes fails with HTTP errors and block further interactive translation.  

 

 
In previous releases, opening of segment via an aliased TM resulted sometimes in error “invalid HTTP 

status” followed by “operation is not supported on alias”. Further interactive translation in the open 

file could cause concatenation of source and target segment into one source segment. 

This has been fixed in Release 1.10. 
 

Analysis 

 Wrong repetitions count in analysis when attribute for filtering selected.  

  When attributes for filtering were selected the amount of repetition was not accurate in the word 

count analysis. Fewer repetitions were counted. 

This has been fixed in Release 1.10. 
 

Word Plug-in Installer 

 WorkspaceForWord.dotm is not installed in the \OFFICE14 folder if Word Plug-in is installed with For All Users 

option for Word 2010.  

  In previous versions, the Translation Workspace menu was not found in Word 2010 after the TW 

Word Plug-in had been installed with For All Users option to a Windows system with MS Word 2010. 

WorkspaceForWord.dotm was not installed into the C:\Program Files\Microsoft Office\ 

Office14\STARTUP folder. 

This has been fixed in Release 1.10. 
 

 

XLIFF Editor 

 Saving an XLF file which contains a sub segmented segment was not possible. 

  In previous releases, trying to save an XLF file which contains a sub-segmented segment resulted in 

a red bar displayed in the status bar without any error messages, but the file was not saved.  

This has been fixed in Release 1.10. 

 LXE Checker for INX - Update warning for text outside CF-tags. 

  In previous releases, when closing segments with new converted INX files QA-tools verification 

looking for old CF-tags, an error dialog with heading “Text outside “cf” tags in INX …” was displayed 

when closing a segment with CF tags. 

The error message has been reformulated as Text outside tags in INX ("*.inx.xlz"). The QA check 

setting has been defaulted with the <cf> tag + severity = warning. Users are allowed to add other 

tags, or possibly remove the <cf> tag which was added by default. 

This has been fixed in Release 1.10. 

 Incorrect error messages when file path is long. 

  In previous releases, in the Batch operations dialog the error message window displays full file 

path, which does not fit onto screen (see attached screenshot). 

This has been fixed in Release 1.10. 

 

Concordance Search 

 Term target was not left-aligned. 
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  In previous releases, the target segment of long terms in Concordance Search results was not left 

aligned but placed right under the source with same indent. This made difficult to recognize which 

is the source segment and which is the target. 

This has been fixed in Release 1.10. 

 It was possible to delete segments from background TMs. 

  In previous releases, it was possible to delete segments retrieved from background TMs in the 

Concordance Search window. 

This has been fixed in Release 1.10. 
 

Fileset Browser 

 Statistics were not refreshed in case a missed file was added to file set directory and opened. 

  In previous releases, if a file included in a file set was removed from the file set directory, the file set 

was opened, and another file named as the missing file was returned to the file set directory, the 

status of the missed file was changed to "Open" but statistics of the removed file were displayed. 

This has been fixed in Release 1.10. 
 

Idiom Converter 

 Drag and drop of Idiom files into the plugin dialog is no longer possible. 

  In previous releases, files dragged and dropped into the Idiom XLIFF Converter dialog were not added 

to the Idiom XLIFF Converter files list. 

Files could only be added by using the Add button of the Idiom XLIFF Converter dialog. 

This has been fixed in Release 1.10. 
 

Terminology Handling 

 Different numbers of lines between terms from Glossary and from TM. 

  In previous releases, different numbers of new lines separated term search results from Glossary and 

from TM. There were two break lines after found term from background TM and one line after 

found term from glossary. 

This has been fixed in Release 1.10. 

 Terms were not separated in Group by Glossary/TM view. 

  In previous releases, terms were not separated by a line brake in the Group by Glossary/TM view. 

This has been fixed in Release 1.10. 
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New in Translation Workspace Release 1.9 

Translation Workspace Release 1.9 includes the following new features. 

 

Web UI and Server 

 

Analysis TM is stored to the server RAM. 

  The Analysis batch function with Analysis TM enabled now stores the temporary Analysis TM into 

the server RAM instead of the hard disk. This improves the performance of the analysis function. 

Temporary analysis TM is no longer available to end-users. The option Clear Analysis TM is no more 

available and reusing a previous Analysis TM is not possible. 
 

 

Client DLL 
 The Clear Analysis TM option is no longer available in the Analysis dialog of Word Client and TM Tools. 

  Temporary analysis TM is no longer available to end-users. 

The Clear Analysis TM option is no longer available in the Analysis dialog and reusing a previous 

Analysis TM is not possible. 
 

 

Microsoft Word Plug-in 

 Extract Footnotes conversion has been added to MS Word Plug-in.  

 

 
Footnotes and endnotes included in Word documents can now be extracted for translation with the 

Extract Footnotes conversion, which works in MS Word Plug-in (Current Document and Documents 

menu) and in TW Tools (Conversion tasks). The forward conversion inserts at the end of the 

converted file a section with the extracted footnotes as normal translatable text, stored into the TM 

by interactive translation and cleanup. 

Cleanup restores the footnotes and endnotes to the original footnote format. There is also an 

option for conversion to segmented bilingual Translation Workspace format and Trados format with 

restored footnotes. 

Extract Footnotes can be run on bilingual Translation Workspace and Trados RTF files with footnotes 

in sub-segments. 
 

 

XLIFF Editor 

 The Clear Analysis TM option is no longer available in the Analysis dialog.  

  Temporary analysis TM is no more available to end-users. 

The Clear Analysis TM option is no longer available in the Analysis dialog and reusing a previous 

Analysis TM is not possible. 

 

Translation Workspace Problems Fixed in Release 1.9 

No fixes have been included in Release 1.9. 
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New in Translation Workspace Release 1.8 

Translation Workspace Release 1.8 includes the following new features. 

 

  Brief Description Full Description 

W
eb

 U
I &

 Server 

A
n

a
ly

sis 

A new match type "Machine 

Translated" has been added 

to the analysis logs.  

For the new MT match category for analysis to work, a new TM-level 

attribute, "Contents are Machine Translations”, has been added. (This 

differs from segment-level attributes, and the current client functionality 

which relies on segment-level attribute (Origin=MT!) or username (MT!) has 

not been changed). 

 

The analysis proceeds as usual, but segment and wordcounts for matches 

provided by any TMs with the MT attribute set are reported in the new 

MachineTrans match category of the log. 

Total:              1 files 
Date:               2011-12-14 16:25:08 UTC 
Project:            mtfg 
Language direction: en-us > sv-se 
 
Match Types   Segments        Words      Percent 
Translated         691         3148         99.8 

Context Match        0            0            0 
Repetitions          0            0            0 
Format Change        0            0            0 
100%                 0            0            0 
95% - 99%            0            0            0 
85% - 94%            0            0            0 
75% - 84%            0            0            0 
50% - 74%            0            0            0 
Machine Trans        1            3          0.1 
No Match             1            3          0.1 
Total              693         3154          100 
Chars/word        4.82 
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  Brief Description Full Description 

 

 Information about which files 

can be added for Analysis in 

Web Interface.  

There was no message informing the user in the Web Interface which kinds 

of files could be analyzed with the Web Interface Analyze function. 

The following tip was added to the Analyze tab: 

The server expects files to be analyzed in one of these formats: 

RTF, XLIFF, XLF and XLZ. 

You may choose an uncompressed as well as a zipped file. Because the file 

is transmitted on the internet, a zipped file proceeds much faster. If the ZIP 

file includes several files, they are consecutively analyzed. 

Note that the ZIP file can only contain files of the same format. 

 A
sse

t M
a
n

a
g

e
m

e
n

t 

The asset tagging subject is 

populated by the Domain 

value by default.  

In previous versions the Subject field on the Asset Tagging tab did not reset 

itself to the current value of the Domain when a Domain value was selected. 

This has been changed so that the Subject field resets it to the current 

Domain value. 

 

Users can export Asset 

Retrieval Search Results data. 

Export function has been implemented for outputting the results of an Asset 

Retrieval Search into a text file with tab separated values. The output option 

is provided with the following column headings from the Search Results 

dialog: 

Id, Asset Name, Project Name, Manager Name,  

Workgroup, Company, Division. 

The Id is the TM/Glossary ID as it is used internally on the server. 

The search result file can be downloaded by clicking Download on the Web 

Interface Asset Retrieval tab. 

 

Every launch of Download action replaces the previously created file on the 

server. In this way user will have access to download only of last result. 

The Export file is named "asset_retrieval_result.txt". 
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  Brief Description Full Description 

 L
a
n

g
u

a
g

e
s S

u
p

p
o

rt 

Several languages have been 

added to the supported 

languages. Some languages 

have been renamed. 

  

The following additions and changes have been made to the supported 

languages: 

• Bosnian [bs] has been renamed as Bosnian Latin [bs] and Bosnian 

Cyrillic [bsc] has been added. 

• Papiamento (Aruba), Papiamento (Bonaire, Saint Eustatius and 

Saba) and Papiamento (Curacao) have been added as separate 

languages and Papiamento no longer exists. Papiamento (Curacao) 

[pap-CW] is treated as the new default Papiamento language 

code. (For example, if you import a TM with just “pap” as the 

language code, the code will be converted to “pap-CW”.) 

• Support for the following new languages has been added: Arabic 

(Israel), Dari, English (Indonesian), English (Other), and Finnish 

(Sweden). 

• Support for two Inuktitut language variants has been added. 

• Serbian has been renamed to Serbian - Cyrillic and it has now 

three variants. Three Serbian - Latin variants have been added. 

New and changed languages and language codes: 

Code Language Name Previously 

ar-IL Arabic (Israel) - 

bsc Bosnian - Cyrillic - 

bs Bosnian - Latin [bs] Bosnian 

prs-AF Dari - 

en-ID English (Indonesia) - 

en-XO English (Other) - 

fi-SE Finnish (Sweden) - 

iu Inuktitut - Syllabic [iu] Inuktitut 

ikt Inuktitut - Latin - 

pap-AW Papiamento (Aruba) - 

pap-BQ 
Papiamento (Bonaire, Saint Eustatius 

and Saba) 
- 

pap-CW Papiamento (Curacao) Default [pap] Papiamento 

sr-RS Serbian - Cyrillic (Serbia) [sr-RS] Serbian (Serbia) 

sr-ME Serbian - Cyrillic (Montenegro) 
[sr-ME] Serbian 

(Montenegro) 

sr-BA 
Serbian - Cyrillic (Bosnia and 

Herzegovina) 

- 

srl-RS Serbian - Latin (Serbia) - 

srl-ME Serbian - Latin (Montenegro) - 

srl-BA 
Serbian - Latin (Bosnia and 

Herzegovina) 

- 
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  Brief Description Full Description 

 U
se

r In
te

rfa
c
e
 

Add warning for Internet 

Explorer 6  

Some parts of the Translation Workspace user interface are not displayed 

well in Internet Explorer 6. A warning is now displayed when Translation 

Workspace is opened in Internet Explorer 6. The warning message says:  

You are currently using a browser that may not provide optimum 

Translation Workspace user experience. We recommend that you 

update your browser to a later version.  

The warning is displayed after a successful login. Translation Workspace 

maintenance messages are displayed on top of the Internet Explorer 6 

warning. The user needs to close the maintenance message to be able to 

see the warning. 

 

 

  Brief Description Full Description 

Filters
 

IN
X

 a
n

d
 M

IF
 F

ilte
rs 

Support for the Add 

Intersegment Space option 

and the Delete option has 

been added to INX and MIF 

filters. 

The Release 1.2 added an option to the Cleanup and Back Convert 

functions for adding space in between segments for files translated from 

Chinese, Korean, and Japanese. 

MIF and INX parsers (and the related API functions) have been updated to 

support this new option. 

The Add Intersegment Space option applies only for back conversion of 

CJK as source languages into none-CJK target languages files. It does not 

apply for three other language combinations: CJK to CJK, none-CJK to 

none-CJK, and none-CJK to CJK. 

 

 

  Brief Description Full Description 

Client D
LL 

T
a
sk

 M
a
n

a
g

e
m

e
n

t 

Task queue restart notified on 

client side when the server 

has restarted.  

The client interfaces (Word Plug-in, TW Tools, and XLIFF Editor) display a 

notification about task restart when the server has restarted while one of 

the following processes was ongoing in the client before the server restart: 

• Analysis 

• Pre-translation 

• Clean up 

• Import 

The client continues updating task process information after server restart. 

This applies for ongoing tasks and in queue tasks for which the processing 

had not started before the server restart. 

 U
se

r In
te

rfa
c
e
 

Only Required Characters 

option set as default in 

Document Back Convert.  

As ASCII with entities are far more uncommon than non-coded files the 

option Only Required characters (Depending on Codepage) has been set as 

the default option in the Document Back Convert dialog.  

In the same dialog the default value of the Default Codepage field has been 

set to Unicode (UTF-8) [utf-8], which is currently the most common 

encoding. 

  

The Export Mode options in 

the Export Translation Memory 

Data dialog have been divided 

to two groups.  

In previous versions the button selector groups, and check box groups of 

the Export Translation Memory Data dialog options were under one Export 

Mode title.  

Button selectors for export formats are now listed under a separate Export 

Format title, and the export mode check boxes under a separate Export 

Mode title. 
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Inter-segments checkbox 

groups have been replaced 

with button selector lists.  

Current Inter-Segment spaces settings checkbox selectors in Word Client 

and TW Tools Document Back Conversion and Document Cleanup dialogs have 

been replaced with a similar button selector group as is in XLIFF Editor Batch 

Operations Back Convert tab. 

 

 

  Brief Description Full Description 

XLIFF Editor 

A
sse

t M
a
n

a
g

e
m

e
n

t 

Adjustments to support the 

new MT TM type.  

The new MT TMs are a TM subtype similar to unknown segment TMs, 

using a modified search algorithm which provides only 100% and 101% 

matches. These TMs should not be selectable as (foreground) working 

TMs for interactive translation. Usage for other functions like import, 

export, and analysis, for example, is not restricted. 

The Xliff editor architecture does not enable distinguishing selection of 

batches from selection for Translation. Only one TM can be selected 

application wide. Because of this the MT TMs are now filtered out from 

direct usage with XLIFF Editor. With the help of TW Tools users can run 

batch functions with the MT TMs. 

 B
a
tc

h
 O

p
e
ra

tio
n

s
 

Support retry and polling 

across server restarts for 

batch operations.  

If a TW server restarts, the server keeps all queued tasks and restarts the 

tasks which were running before the restart. 

In previous releases the clients did not support this feature. Server 

connection error messages were displayed, or it appeared as if the tasks 

were lost. 

XLIFF Editor now displays a dialog which notifies the user that the server 

connection has been lost and that it is trying to re-establish the 

connection. The dialog indicates how long ago the connection was lost 

and when the next retry will occur. The dialog allows the user to cancel 

the retrying and abort the operation. 

Translation Workspace tries to re-login the disconnected session. If the 

server returns any error, re-establishing the connection is aborted. 

Currently this new feature works in XLIFF Editor for the Analysis operation 

only. 

 

 

  



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 259 

 

Translation Workspace Problems Fixed in Release 1.8 

The following problems found in Translation Workspace were fixed in release 1.8: 

 

  Brief Description Full Description 

W
eb

 U
I &

 Server 

A
n

a
ly

sis 

When the option Penalize 

multiple 100% matches was 

checked, the Analysis was not 

accurate if multiple target 

languages was selected.  

While fixing Analysis issues as part of v1.4.6 Milestone, the search algorithm 

was changed in a way which caused the "Penalize multiple 100% matches" 

option to affect the output and generate inaccurate numbers in the 100%, 

98% and Repetitions sections. 

This had been previously fixed for single language only. In the Release 1.8 

the fix has been applied to the Multiple Target Languages option. 

This has been fixed in Release 1.8. 

 

Only RTF files could be 

analyzed.  

Only RTF files could be analyzed with the web interface Analyze command.  

The web interface Analysis function can now be performed to RTF, XLZ, 

XLIFF, XLF files, which can also be included in a ZIP package. 

This has been fixed in Release 1.8. 

A
sse

t M
a
n

a
g

e
m

e
n

t 

Search results for Content 

Creator column in the Asset 

Retrieval Results were not 

displayed.  

The information in the Content Creator column in the Asset Retrieval Results 

was not displayed.  

This has been fixed in Release 1.8. 

TMX 1.4b with self-closing 

header tag (<header/> was 

not supported (internal tags 

not recognized).  

When a TMX 1.4b file with a self-closing <header /> tag was imported to a 

TM, Markup tags inside <ph> elements were not recognized as Markup 

tags. 

This has been fixed in Release 1.8. 

 

Term corruption may occur in 

some cases.  

Glossary terms could be corrupted when a new term was added with Arabic 

as the source language in the Web Interface. Each time the record was 

edited and saved, the Arabic term was shortened by one character.  

This has been fixed in Release 1.8. 

L
o

g
in

 

Password containing 

extended characters not 

working through DLL/Word 

client/Web UI.  

A user password which contains extended characters did not work in Word 

Plug-in and Web Interface, although the same password worked in XLIFF 

Editor.  

The password field control was changed from Edit Text to Rich Edit control 

which accepts a wide range of characters and stores them as UTF8.  

This has been fixed in Release 1.8. 

S
e
g

m
e
n
ta

tio
n
 

Abbreviations with uppercase 

cannot be removed.  

After an abbreviations list file (TXT) had been imported to a TM, 

abbreviations with uppercase characters could not be removed from the 

Abbreviations list in the TM Web interface Segmentation Rules tab. Only 

abbreviations with lowercase could be removed.  

This has been fixed in Release 1.8. 
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  Brief Description Full Description 

S
e
a
rc

h
 E

n
g

in
e
 

Fuzzy match provided for 

segment which includes 

internal tag is unexpectedly 

high.  

When a TM provided a fuzzy match for a segment in RTF and XLZ files with 

one or more internal tags, the match percent was unexpectedly high. 

There were two bugs in the algorithm which calculates the found words 

percentage. 

1. If the matching text contained repeated words, they were counted 

multiple times, which resulted in an incorrect high percentage.  

2. The algorithm incorrectly compared scripted words with tag 

replacement placeholder characters against those without such 

characters.  

As a result, the percentage was incorrectly low but appeared as correct from 

end user's perspective. 

This has been fixed in Release 1.8. 

R
o

le
s &

 P
e
rm

issio
n

s 

Permissions no longer 

available once removed for 

the Admin Role by the tenant 

admin.  

When a Tenant Administrator removed any assigned System or Object 

permissions from her role via the Role Management and logged out from 

the Translation Workspace web server, the permissions were no longer in 

the Available Permissions list after logging in. The removed permissions 

could not be added afterwards to the Tenant Administrator role. 

A Recover tenant admin function available to super users (in System 

Management) has been added. 

Besides checking that the "Admin" role exists and that is has all tenant 

permissions, the function also checks that the current tenant owner has this 

role as his object permission on the "system" workgroup on the server in 

which the call is executed. 

For support purposes a Check tenant admin function has been added, which 

tests and reports if there is a problem in this area and that a recovery would 

likely be successful. 

If the tenant owner does not have the tenant admin default role it is now 

checked whether the tenant admin role exists, and the owner is given that 

role and then verified that the role has all permissions. If the default tenant 

admin role does not exist, it is created and assigned to the tenant owner.  

This has been fixed in Release 1.8. 

U
se

r M
a
n

a
g

e
m

e
n

t 

Separate by user/server in 

Simultaneous 

login/concurrent computers 

token file.  

The Simultaneous concurrent computers login token file is unique for the 

local windows user, but "shared" for all servers and Translation Workspace 

user logins by the same windows user. 

It needs to be tracked for which server/user the token is used, otherwise a 

user could lock her out when for example switching tenancies.  

This has been fixed in Release 1.8. 

The Creator User of 

Translation Units stored by 

interactive translation and 

cleanup was not displayed 

after the user had been 

deleted from the server.  

After a user with a specific user name had been deleted from a Translation 

Workspace server, the Creator User for the Translation Units created by that 

user during interactive translation or via cleanup was no longer displayed. 

The Creator User of imported segments was displayed correctly. 

This has been fixed in Release 1.8. 
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  Brief Description Full Description 

U
se

r In
te

rfa
c
e
 

In the Glossary > Import tab the 

target language list contained 

only the variants for the 

selected source language.  

When a source language to a Glossary was selected in the Web Interface on 

the Glossary > Import tab by typing the first letters of the language and then 

selecting it, clicking Add All for the target languages added only the variant 

languages of the source language to the Target Languages list. 

When a source language without variants was selected the same way, 

clicking Add All for the target languages added only languages with the 

same first letter to the Target Languages list. 

This has been fixed in Release 1.8. 

 

  Brief Description Full Description 

Filters
 

G
e
n

e
ra

l 

Inter-segment spaces options 

were not working for back 

conversion to HTML with 

DLL.  

The Document Back Conversion dialog options Delete Inter-Segment Spaces 

and Add Inter-Segment Spaces were not functional for the DLL HTML 

Filter Back conversion. No space was added or removed when the 

corresponding options were enabled. 

This has been fixed in Release 1.8. 

  

Selecting Macedonian as the 

source language when 

converting files to RTF set 

source segments in 

generated file as Malay 

Malaysia.  

When Macedonian was selected as the source language in the TM, files 

converted to RTF had Malay Malaysia as the language setting in the 

source segments.  

This has been fixed in Release 1.8. 

 D
O

C
X

 F
ilte

r 

MS Word fails to open the 

back converted file because 

of footnoteReference 

escaping.  

When the internal <footnotereference> tag included a text attribute 

and its value, problems were caused in the back converted DOCX file.  

This has been fixed in Release 1.8. 

 

Back conversion failed with 

error when smart tag and 

hyperlink were inverted in 

the translation.  

Back conversion with Word Plug-in, TW Tools, and XLIFF Editor to DOCX 

from a translated RTF or XLZ failed with the following error:  

”smartTag not read as expected! Fail to build.”  

The problem was caused by issues with the inverted tagging due to the 

language's grammar. The file was well-formed and there were no missing 

or closing tags. The tag was only differently posited within the sentence.  

This has been fixed in Release 1.8. 

 IN
X

 F
ilte

r 
MS Word and TW Tools 

could crash during INX 

conversion to RTF and to 

XLZ.  

Using dll v2.98, MS Word and TW Tools could crash when converting 

some INX files to RTF/XLZ format. 

This has been fixed in Release 1.8. 
 

An <index> tag added 

during conversion of the INX 

file.  

When an INX file was converted to RTF or XLZ, an <index> tag was 

added to the end of the file instead of the </document> tag. The RTF 

and XLZ files could not be converted back to INX. 

The error message “Failed to parse the input file” was displayed. 

This has been fixed in Release 1.8. 

  

Closing PIDX tag removed 

during back conversion.  

During RTF and XLZ file back conversion to INX, when the Only Required 

Characters option was checked in the Document Back Conversion dialog, the 

</pidx> tags were removed from the INX file by the parser, and InDesign 

could not open the INX file. 

This has been fixed in Release 1.8. 

  

Some “cflo” text not 

extracted for translation.  

INX filter failed to extract some “cflo” text for translation. 

This has been fixed in Release 1.8. 
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Non-breaking space entity 

incorrectly back converted.  

The non-breaking space entity was not processed correctly by the back-

conversion to INX, which caused the text following it to be interpreted as 

symbol font text by InDesign.  

This has been fixed in Release 1.8. 

 M
IF

 F
ilte

r 

Color names in <TextLine> 

tag are corrupted when back 

converted.  

The color names which were inside a <TextLine> element tag were not 

properly back converted and displayed in Frame Maker. 

In MIF7 format the color names comply with a code page definition and 

were back converted properly. 

Custom color names with non-ASCII characters (e.g., Å, Ä, and Ö), were 

also corrupted in back conversion, because UTF8 characters were read as 

ASCII characters. 

This has been fixed in Release 1.8. 

  

The <RunaroundType 

Contour> tag blocked 

conversion to RTF/XLZ.  

MIF files which included a <RunaroundType Contour> tag could not be 

converted to RTF and XLZ by the MIF filter.  

This has been fixed in Release 1.8. 

  

User-defined variables in the 

MIF file are not extracted in 

the converted RTF and XLZ 

file.  

The variable definition texts from user-defined variables were not 

extracted from the MIF files to RTF and XLZ for translation.  

(The variable names are never extracted for translation.)  

This has been fixed in Release 1.8. 

 M
L
A

 

Space after empty attribute 

value was wrongly deleted 

when using the 'Remove 

extra spaces... inside tags and 

between attributes' function.  

An XML file with an empty attribute value confltr="" was not correctly 

converted if the Remove Extra Spaces, Tabs and Carriage Returns > Inside 

Tags and Between Attributes option was checked in MLA.  

The space character after the empty confltr="" value was deleted. 

This has been fixed in Release 1.8. 

  

Remove Extra Sapces, CRs 

and tabs option: Extra 

characters were removed.  

When ML files were converted to RTF or XLZ, some extra carriage returns, 

space and tabs just after or before an external tag were removed if the 

Remove Extra Spaces, Tabs and Carriage Returns > In Text between Tags 

option was checked in MLA.  

This has been fixed in Release 1.8. 

  

Part of the HTML file content 

was deleted or modified in 

the generated RTF and XLZ.  

When a HTML file was converted with default MLA settings to RTF or XLZ, 

a part of the original content related to a javascript script was not 

included and the reference to the javascript (.js) file was inaccurately 

modified.  

This has been fixed in Release 1.8. 

  

Changing the order of 

profiles via the “Move down” 

only the names of the 

profiles were changed, not 

the content.  

When the Move down was clicked in Configure Filters dialog XML/HTML tab 

to adjust the order of the profiles, only the profile names changed places 

in the list, but the content of each profile stayed at the same place in the 

list of profiles.  

This has been fixed in Release 1.8. 

  

XML conversion to RTF 

removed spaces between 

double quotes and backslash.  

Even when no options for Remove Extra spaces, Tabs and Carriage 

Returns are checked, converting XML to RTF removes the space character 

between double quotes and a backslash character, as happens to the 

space character in <nonEntry nonText="" />.  

This has been fixed in Release 1.8. 

 P
P

T
X

 F
ilte

r 

Notes-section of hidden 

slides was extracted while 

hidden slides extract was set 

to false.  

Notes from hidden slides in a PPTX file were converted for translation 

when the Extract notes option was checked but the Extract hidden slides 

option was not checked on the PPTX tab of the Configure Filters dialog.  

This has been fixed in Release 1.8. 



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 263 

 

 X
L
S
X

 F
ilte

r 

Superscript/Subscript 

formatting was lost in the 

back converted file.  

When an RTF or XLZ file was converted back to XLSX the superscript and 

the subscript formatting of the text was lost.  

This has been fixed in Release 1.8. 

 

Text in auto shapes in a 

hidden sheet is extracted.  

The auto shape texts from hidden sheets in XLSX files were extracted for 

translation, although the Extract hidden sheets option was not checked 

on the XLSX tab of the Configure Filters dialog, when XLSX files were 

converted for translation to RTF and XLZ.  

This has been fixed in Release 1.8. 

 

  Brief Description Full Description 

Client D
LL 

A
n

a
ly

sis 

Loss of context matches (fail 

to 100%) when analyzing and 

pre-translating XLZ files via 

the DLL compared to the 

XLIFF Editor.  

Although the analysis results for XLZ files should be identical whatever the 

tool used, analyzing XLZ files with Word Pug-in and TW Tools returned less 

context matches than analyzing with XLIFF Editor. The 101% matches were 

lowered to 100% matches.  

The same happened when XLZ files were processed with the Translate All 

100%-matches function. Less 101% matches were translated via Word Plug-

in and TW Tools than via XLIFF Editor.  

This has been fixed in Release 1.8. 

  Unsupported operation 

during analyzing in extended 

mode.  

The message “An unsupported operation was attempted” was displayed 

instead of the Document Analysis Result dialog when Translation Workspace 

was used with MS Word 2003 in Windows XP, running the Document > 

Analyze function with Use Extended mode, Use Analysis TM, and Clear 

Analysis TM options checked, and Analyze was clicked several times without 

closing the Document Analysis dialog.  

This has been fixed in Release 1.8. 

  

Repetitions were reported as 

fuzzy matches in Analysis 

results (when the TM 

contained a 100/101 match 

from the file being analyzed).  

The Analysis function in TW Tools and XLIFF Editor could report Repetitions 

falsely as 95-99% Matches. This happened to both RTF and XLZ files and 

whether the Use Analysis TM option was checked or not.  

This has been fixed in Release 1.8. 

 A
sse

t m
a
n

a
g

e
m

e
n

t 

Export of Frequent Segments 

from unknowns TM 

impossible from Client.  

Exporting translation memory data from a TM which was created by the 

Unknown Segments Analysis function was possible only from the Web 

Interface, not from Word Plug-in and TW Tools using the Export Translation 

Memory Data function. 

This was caused by the fact that languages could not be selected for the TM 

in the client interfaces. 

This has been fixed in Release 1.8. 

 C
o

n
c
o

rd
a
n

c
e
 S

e
a
rc

h
 

An incorrect message 

appeared when opening the 

Concordance Search window.  

The "missing query source" error message appeared in the bottom pane 

of the Concordance Search window when the Concordance Search window 

was opened by clicking the Concordance button in the client interface.  

This has been fixed in Release 1.8. 
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 P
re

v
ie

w
 

Color scheme for standard 

colors was not correct  

The text colors used when previewing RTF files converted from XLSX files 

were incorrectly mapped for the standard colors. The preview of RTF files 

converted from XLSX displayed other text colors than the ones used in the 

original XLSX file. 

This has been fixed in Release 1.8. 

 X
L
Z

 F
ile

s H
a
n

d
lin

g
 

Prevent crash in some cases 

with multi <file> XLZ files.  

When an XLZ file with a valid skeleton was processed after an XLZ file with 

an empty, unnamed, or non-existing skeleton, the code could use already 

freed objects. 

Any operation on one of the XLZ files which ran on a server (e.g., an 

Analysis), could cause a client to crash. If you ran the same operation with 

another server, the client stayed stable. 

This is now prevented by properly setting the pointers to NULL after 

deleting the objects.  

This has been fixed in Release 1.8. 

 

  Brief Description Full Description 

M
icro

so
ft W

o
rd

 P
lu

g-in
 

C
le

a
n

u
p

 

No default extension set for 

log files in cleanup dialog.  

The default extension was not set for the log file in the Document Cleanup 

dialog. When Browse… was clicked in the Document Cleanup dialog and 

Files of Type was clicked in the displayed Open dialog the Files of Type 

field menu was empty, although “.txt” is the default log extension. 

This has been fixed in Release 1.8. 

C
o

n
fig

u
ra

tio
n

 

Users have the ability to add 

non numerical data to Client 

Configuration.  

It was possible to enter non-numerical data in the Word Plug-in Client 

Configuration dialog Minimum Match Percentage, Matches in Concordance, 

and Minimum Match Percentage in Concordance fields, although only 

numerical data should be allowed to be entered.  

Although you could paste non-numerical values into the mentioned fields, 

a batch reading such values did not fail (for example Analysis). 

Disconnecting and reconnecting removed any trailing non-numerical 

characters from the dialog fields.  

This has been fixed in Release 1.8. 

P
re

tra
n

sla
tio

n
 

Context calculation 

difference on non-latin1 

characters resulted in 

Pretranslation giving 101% 

matches instead of 100% 

matches.  

XLZ files can be pre-translated with XLIFF Editor and Word Plug-in. For 

several segments 101% matches were set in Word Client, while these 

matches should be 100% matches as in XLIFF Editor pre-translation and 

interactive translation. 

This was caused by differences in context calculations by the client DLL 

and by XLIFF Editor. 

This has been fixed in Release 1.8. 

 With Prefetch enabled, 

options related to context 

match are not hidden even if 

options are disabled on the 

TM properties.  

While Context matching and Include only context matches in batch 

translation options were not checked in the TM Properties > Advanced tab 

and Allow Connection Optimization was not checked in the Word Plug-in 

Client Configuration dialog, the Lock 101% Matches option and the 

Translate Only 101% Matches option were not displayed in the Word 

Plug-in Translate Documents dialog. 

This was due to user switching form a TM to another and not selecting 

languages from the new TM, resulting in the option check boxes 

remaining in the state of the previous TM. 

When the user clicks the TM... button in Document > Translate Documents 

dialog and selects the TM but clicks Cancel in the Language Selection dialog, 

the information about the previous TM is now preserved, and switched 

back to when the language selection is canceled. 

This has been fixed in Release 1.8. 
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Fix to file path and extension 

for current DOC and DOCX 

files.  

Editing a DOC or DOCX file in Word and selecting Current Document > 

Convert RTF to TTX caused the current document to be saved temporarily 

as RTF in the Temp folder with the .rtf extension appended to .doc or 

.docx. 

Consequently, after conversion, the resulting .xlz file was created in the 

Temp folder with “.xlz” appended to “.doc” or “.docx”. 

This differed from how the files added separately to the Convert RTF to 

TTX dialog were handled. 

Editing a DOC or DOCX file in Word and selecting Current Document -> 

Convert RTF to TTX now causes the current document to be saved 

temporarily as RTF in the same directory as the original DOC/DOCX. The 

temporary RTF file is deleted after the conversion, as before. 

The “.rtf” extension now replaces the “.doc”/”.docx” extension. The final 

TTX file is created in the same directory as the original DOC/DOCX with 

the “.ttx” extension replacing the “.doc”/”.docx” extension. 

This has been fixed in Release 1.8. 

T
M

 M
a
n

a
g

e
m

e
n

t 

Error message was displayed 

when a TM without 

languages was exported.  

Although no error messages should be displayed when a TM without any 

language settings is exported, while such a TM was exported from the 

Word Plug-in, the error message "The parameter is incorrect" was 

displayed. 

This has been fixed in Release 1.8. 

The Search function in the 

TM Editor works incorrectly 

for invalid source or target.  

The TM Maintenance Editor displays incorrect search results on the Search 

tab when a source or target language not existing in the TM was specified 

manually on the Search Options tab. 

This has been fixed in Release 1.8. 

 

 

  Brief Description Full Description 

XLIFF Editor 

L
a
n

g
u

a
g

e
s su

p
p

o
rt 

Languages added and 

updated for TW 1.8 have 

been added and updated in 

the Target Language list.  

Languages added and updated for the TW 1.8 release have been added 

and updated in the target language list in the Xliff Editor. 

This has been fixed in Release 1.8. 

 S
c
rip

t su
p

p
o

rt 

Circular import chain 

prevented importing 

modules.  

The module transolution.xliffeditor.formatters could not be imported as 

there was a long circular cycle up to 

transolution.xliffeditor.document.tu.tu_ subsegmentate. 

This broke user scripts, especially since it is now used by the logoport 

client. Quick fix to users is to import 

transolution.xliffeditor.document.tu.tu_ subsegmentate before other 

modules including formatters.  

This has been fixed in Release 1.8. 



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 266 

 

  Brief Description Full Description 

  

Stand along scripts got 

exception from stat collector 

code on logout.  

Traceback due to missing member in the class being referenced.  

Logout  

lpc request logout {'seq': 3, 'proto': 399} None  

lpc request DONE!  

Traceback (most recent call last):  

File "lxepython.py", line 60, in <module>  

File "C:\Users\USERNAME\Documents\MBS\Translation 
Workspace\Scripts\NAV\iped_analyse.py", line 108, in <module>  

lp.logout()  

File "transolution\logoport\pyclient\logoport.pyc", line 311, in logout 

File "transolution\logoport\pyclient\lpstats.pyc", line 47, in 
stop_gathering 

File "transolution\logoport\pyclient\logoport.pyc", line 476, in 
upload_statistics  

AttributeError?: 'Logoport' object has no attribute 'logged_in'. 

This has been fixed in Release 1.8. 

 

 

  Brief Description Full Description 

O
n

lin
e R

eview
 clien

t 

P
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v
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Preview of large docx/xml 

file in Online review failed.  

Previewing large from DOCX and XML converted bilingual RTF and XLZ 

files failed in Online Review, displaying either an HTTP 404 error and an 

empty page (in Internet Explorer) or just displaying an empty page (in 

Firefox).  

There was a hard-coded value (100k) in the code which caused automatic 

compression of output/target file once its size exceeded the threshold. 

The condition to compress depending on file size has been removed. 

The filename is now picked from the right place.  

Now the converter creates a zip only if multiple output files exist or the 

user explicitly requests it. 

This has been fixed in Release 1.8. 
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New in Translation Workspace Release 1.7.2 

Translation Workspace Release 1.7.2 includes the following new features. 

 

 Brief Description Full Description 

XLIFF Editor 

Formatting of internal tags 

in concordance searches 

has been enhanced.  

The internal tags in concordance searches are now formatted with 

LogoportMarkup style and displayed in red when the segment is copied 

into the target field of the editor. 

Remember the last Analysis 

result file path in the Batch 

operations Analyze tab.  

In previous versions the last Result File path in the Batch operations 

Analyze tab was emptied after the Analysis was performed. The path 

had to be set each time before performing the Analysis. 

If Result File button was clicked after the path had been set, Select 

Result File dialog was displayed with the default path (Program 

Files/Lionbridge/Translation Workspace XLIFF Editor). 

XLIFF Editor now remembers the last Result File path in the Batch 

operations Analyze tab. 

 
The only language pair in 

the TM is selected by 

default, when selecting the 

TM. 

 

In previous versions, when a user logged to a TM with only one source 

and one target language, unless she selected a source and a target 

language, XLIFF Editor displayed a pop-up message "You have to select 

a source and target language". 

Now these languages are selected by default, as in TW Tools and Word 

Client. 

 
Unnecessary items removed 

from Translation 

Workspace login dialog.  

The Minimize and Maximize buttons in Translation Workspace login 

dialog have been deleted as unnecessary. 

 
Concordance matches 

coming from Markup tags 

are no longer highlighted.  

In previous versions, in the Concordance Search window the matches 

from Markup tags were highlighted. 

Concordance matches from Markup tags are no longer highlighted. 

 
Save and Open dialogs 

now use the standard UI 

module.  

In previous versions there were many places in LXE code, where standard 

dialogs like Save and Open did not use the same UI module. 

All standard dialogs now use one module which is applied everywhere it 

is possible. 

 
Alphabetical sorting of 

Sections list in the Edit 

Special Characters List dialog 

is enabled.  

In previous versions the Sections list in the Edit Special Characters List 

dialog was sorted by the Unicode-value-intervals. 

Now you can sort the Sections list both by Unicode-value-intervals and 

alphabetically by names of the sections. 

 
Columns added to display 

Source and Target 

languages of each file in a 

file set.  

Columns which display Source and Target language information for each 

file in a file set have been implemented in File Set Browser. The columns 

can optionally be displayed or hidden. 

You need to open the file to refresh its information. 

 
"Translation units" renamed 

to "Segments" in the Show 

possible problems form.  

In previous versions, the Possible problems summary dialog for 

unsupported third party XLIFF files displayed information about 

"Translation units" instead of "Segments". 

Now the dialog displays information about “Segments”. 

 
Idiom plugin - add support 

for Worldserver 10.  

Idiom plugin now supports also Idiom xlf and xlz files which have been 

created with Worldserver 10. 
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Translation Workspace Problems Fixed in Release 1.7.2 

The following problems found in Translation Workspace were fixed in release 1.7.2: 

 

 Brief Description Full Description 

XLIFF Editor 

Languages added to 

Translation Workspace in 

Release 1.7 were not displayed 

in the Target languages list in 

XLIFF Editor.  

 

XLIFF Editor did not display in the Target Language list languages 

which were added to Translation Workspace in Release 1.7 Those 

languages could not be set as target languages. Translating into for 

example Uzbek (Arabic) using the Xliff Editor was not possible.  

Following languages were added and updated for TW 1.7 Release.  

• Uzbek (Arabic) - uza --> new  

• Uzbek (Cyrillic) - uz --> was Uzbek before  

• Uzbek (Latin) - uzl --> new  

These languages were added and updated into the Xliff Editor 

Language Selection dialog. 

This has been fixed in Release 1.7.2. 

 

Add txt extension to the 

Autotext mapping file on save.  

In previous versions the Tools > Preferences > Autotext mapping 

settings file was saved without any extension. 

The Autotext mapping settings file is now saved with the default .txt 

extension. 

This has been fixed in Release 1.7.2. 

 

Start menu folder is not 

deleted when both clients 

were consequently installed 

and uninstalled.  

XLIFF Editor Uninstaller did not check whether the “Translation 

Workspace” Start menu folder was empty or not and did not delete 

the empty folder (no TW clients were installed). 

XLIFF Editor Uninstaller now deletes the “Translation Workspace” 

folder in Start menu when the folder is empty. 

This has been fixed in Release 1.7.2. 

 

All files and folders were not 

removed by the Uninstaller.  

When XLIFF Editor was uninstalled, a number of files and folders 

were not removed. 

This has been fixed in Release 1.7.2. 

 

Found result highlighting 

doubles to next letters in 

Concordance Search.  

In Concordance Search the highlighting of results extended to the 

following word after the found match. 

The number of highlighted letters was doubled. If searched word was 

5 letters long the next 5 letters were also highlighted. 

This has been fixed in Release 1.7.2. 

 

The Select TM list gets out of 

sync if TM name with spaces 

only exist in result set.  

When the Select TM dialog found a TM which name included only 

spaces on the server the TM listing did no longer display all TMs as it 

should. Some TMs were not listed, and some were misrepresented. 

This has been fixed in Release 1.7.2. 

 

The Concordance search 

results are not highlighted if 

the Search field string contains 

extra space at the end.  

When an extra space was inserted to the end of the searched 

segment in the Search field, the matches in the Concordance Search 

results were not highlighted. 

This has been fixed in Release 1.7.2. 

 

Capitalizing the options in the 

Tools > Preferences the same 

way.  

The first letter of some words in the Tools > Preferences menu 

commands was not capitalized: 

▪ Bidi Cursor Movement 

▪ Program Language 

▪ Warn if XLIFF File is Unsupported 
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 Brief Description Full Description 

This has been fixed in Release 1.7.2. 

 

Delete Confirmation dialog 

for a long segment is not fully 

displayed on the screen.  

When deleting a long segment from the Concordance Search results 

the Confirmation dialog for deletion did not fit on the screen. Part of 

the segment text and OK and Cancel buttons were left out. 

This has been fixed in Release 1.7.2. 

 

LXE Changes file extension and 

resaves XLIFF files to 

.XLIFF.XLF.  

When an XLIFF file with extension “.XLIFF” was saved with the File > 

Save As command, the “.XLF” extension was appended to the 

filename after the “.XLIFF” extension. 

This has been fixed in Release 1.7.2. 

 

Missing space in Status bar 

error message.  

Space was missing between the two sentences in the XLIFF Editor 

Status bar error message about missing Translation Word Plug-in. 

The error message is displayed if Translation Workspace Word client 

has not been installed before a file calling a filter from the 

Logoport.dll is dragged and dropped onto the XLIFF Editor window. 

This has been fixed in Release 1.7.2. 

 

Open file dialog in Idiom to 

TW XLZ converter uses only 

“*.xlf” file mask, while Idiom 

files can be in both “.xlf” and 

“.xlz” formats.  

When Idiom XLIFF to Translation Workspace XLZ was checked in the 

Tools > Idiom XLIFF Converter... and Add was clicked, the Open… dialog 

used only the “*.xlf” file mask, although Idiom files can have both 

“*.xlf” and “*.xlz” extensions. 

The XLZ files could be added only by selecting All files as the file 

mask. 

This has been fixed in Release 1.7.2. 

 

Error message is displayed in 

Idiom Converter when Run 

Conversion is clicked while files 

have "Done" status.  

When the user clicked Run Conversion in the Tools > Idiom XLIFF 

Converter... dialog while some of the files added to the dialog 

already had "Done" status, an error message was displayed. 

Previously added files did no longer exist but had already been 

renamed to .bak files. 

The error message was displayed for example when the user 

accidentally clicked Run Conversion twice. 

This has been fixed in Release 1.7.2. 

 

“'NoneType' object has not 

attribute 'data'” message 

displayed in File Set Browser 

and in an individual file when 

QA Check is run.  

When QA Check was run for a File Set including a partially translated 

XLZ file, the attributes of the object could not be verified and the 

status bar displayed an error message “'NoneType' object has not 

attribute 'data'”. 

This has been fixed in Release 1.7.2. 
 

Nested Tags in OOXXM (MS 

Office files) and INX QA check 

Tool Tip missing reference to 

“.xlsx.xlz”.  

The tooltip for the Nested tags in OOXML (MS Office files) and INX 

option in the QA Check Configuration dialog did not mention “xlsx.xlz” 

in the file name endings list. 

This has been fixed in Release 1.7.2. 

 

Select TM dialog list only 

displays one TM when 

two/several exist with the 

same name.  

When TMs with identical names existed on the same server (in 

different Workgroups) only one of them (the one inside the 

workgroup created most recently) was displayed in the Select TM 

dialog list. 

The database id is now appended to the TM name in the list view for 

TMs with identical names. 

Instead of the List view, it is recommendable to use the Tree view of 

the Select TM dialog. 

This has been fixed in Release 1.7.2. 
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 Brief Description Full Description 

 

"Connecting to Logoport" 

message displayed when 

closing LXE.  

While connection to the Translation Workspace server was active and 

XLIFF Editor was quitted, the Connecting to Translation Workspace 

dialog with the message “Connecting to Translation Workspace, 

please wait…” was displayed while LXE was quitting. 

This has been fixed in Release 1.7.2. 

 

Wrong message is displayed in 

the status bar when selecting 

one of the two options in Tools 
> Preferences > Bidi cursor 

movement.  

The Bidi cursor movement mode LXE switched to was described as 

opposite by the status bar messages. When the mode was switched 

in Tools > Preferences > Bidi cursor movement to Visual, the message 

said it changed to Logical and vice versa. 

This has been fixed in Release 1.7.2. 

 

Unable to run pyclient 

modules in standalone mode.  

The pyclient modules could not be run in standalone mode. 

A program error was displayed instead, saying:  

"Unable to find CancelException?". 

This has been fixed in Release 1.7.2. 

 

Remove multi-concordance 

support.  

The multi-concordance was removed from the server some time ago 

and LXE switched to provide the search only function instead.  

The left-over code in the concordance system to issue 'multiconc' 

requests has been removed. 

This has been fixed in Release 1.7.2. 
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New in Translation Workspace Release 1.7.1 

Translation Workspace Release 1.7.1 was dedicated to bug fixes. No new features were added. 

Translation Workspace Problems Fixed in Release 1.7.1 

The following problems found in Translation Workspace were fixed in release 1.7.1: 

 

 Brief Description Full Description 

W
eb

 U
I &

 Server 

Maintaining Glossary content 

with Internet Explorer 9 in the 

Glossary Search tab resulted 

in a blank page when the 

page was refreshed. 

Internet Explorer 9 users may have experienced the following issue, 

when maintaining Glossary content within the Glossary Search tab. 

Refreshing the page content by clicking More, Submit, or Cancel in the 

New Record view resulted in displaying a blank page. 

 

This has been fixed in Release 1.7.1. 

 

 

 Brief Description Full Description 

Client D
LL 

Deleting and Updating the 

same segment in two TM 

Maintenance Editor sessions 

could cause a server error. 

Using TM Maintenance Editor in one user’s session (in Word Plug-in or 

in TW Tools) to delete a segment while it was open for editing in another 

user’s session and then closing the Segment Editor dialog by clicking 

Store and close in the second session could cause a server error in 

Translation Workspace.  

 

This has been fixed in the Release 1.7.1.  
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New in Translation Workspace Release 1.7 

Translation Workspace Release 1.7 includes the following new features. 

 

General Brief Description Full Description 

Term
in

o
lo

gy
 

Support for languages with 

relatively complex word break 

rules (Asian) in Auto-Terminology 

search has been added (currently a 

beta version). 

Auto-terminology was not working properly for languages which 

have relatively complex word break rules. The term search algorithm 

has been improved to support languages needing specific word 

segmentation. This is now available with Auto-terminology and 

Manual Search with Substring Match option unchecked. 

The languages and scripts where simply one space cannot be 

detected as a word separator include: 

• Chinese 

• Japanese 

• Korean (old traditional) 

• Thai 

• Lao 

• Ge'ez script (in Ethiopian and other languages in the region) 

Currently, searching a compound term does not return the 

compound term in the Glossary to the Auto-terminology window, but 

its constituent terms. 

When the Substring Match option is checked, searching a compound 

term returns the compound term but not its constituent terms. 

 

 

Filters Brief Description Full Description 
D

O
C

X
 filter

 
Alternate Content handling for 

MS Word 2010 documents. 

In previous versions the DOCX filter did not fold all alternate content 

in MS Word files. Now text in objects like Text boxes and WordArt, 

which in Word 2010 are wrapped under alternate content, is 

extracted. 

Text in TC field codes is extracted 

for translation. 

In previous versions the text from TC field codes was not extracted 

for translation. 

A table of content can be generated from the table entry fields (TC 

fields) existing in a document. 

Text in TC fields is now extracted for translation. 

 

 

 

 

 

 Brief Description Full Description W
eb

 U
I &

 

Server 

Internet Explorer 9 is supported. Previous versions did not support MS Internet Explorer 9 in native 

mode and forced IE 9 to IE 8 compatibility mode. 

Translation Workspace 1.7 supports MS Internet Explorer 9. Internet 

Explorer 9 is no longer forced to IE 8 compatibility mode. 

See also the known issue about maintaining Glossary content with 

Internet Explorer 9 in the Known Issues and Limitations section Error! 

Bookmark not defined.. 
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 Brief Description Full Description 

M
S W

ord Plug-in
 

TM Edit can be launched from 

the Concordance search window. 

The users can now launch the Translation Memory Editor from within 

the concordance search results. 

In the Concordance Search window you can click the new Edit button to 

launch the segment editor window, edit the selected segment with 

corrections and then return to the Concordance Search window. 

 

Improvements to Auto-

Terminology results display. 

The AutoTerminology window has been enhanced to allow the user to 

group the search results with following alternative criteria: 

 

Sort by Rank: 

• Group = rank (relevance ratio) in descending order. 

▪ Terms inside a group (having same rank) are sorted 

by premium and penalty (from highest premium to 

highest penalty). 

Group by Glossary/TM: 

• Group = TM/Glossary name sorted by premium and penalty 

(from highest premium to highest penalty). Terms with same 

penalty are sorted alphabetically. 

▪ Terms inside a group are sorted by rank. 

Group by Source: 

• Group = source text sorted alphabetically. 

▪ Terms inside a group are sorted by rank. 
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Improvements to Concordance 

search results display. 

The Concordance search window has been enhanced to allow the user 

to group the search results as follows: 

 

Sort by Rank: 

• Group = rank (relevance ratio) in descending order. 

▪ Segments inside a group (having same rank) are 

sorted by penalty (from highest premium to 

highest penalty). 

Group by TM: 

• Group = TM name sorted by premium and penalty (from 

highest premium to highest penalty). Segments with same 

penalty are sorted alphabetically. 

▪ Segments inside a group are sorted by rank. 

Group by Source: 

• Group = source text sorted alphabetically. 

▪ Segments inside a group are sorted by rank. 
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 Brief Description Full Description XLIFF Editor 

Reject connects from LXE if 

version of the client is too old. 

The server now rejects connection from a too old XLIFF Editor client. 

Only current and previous version of the client is allowed. 

Improvements to Auto-

Terminology results display. 

The AutoTerminology window has been enhanced to allow the user to 

group the search results with following alternative criteria: 

 

Sort by Rank: 

• Group = rank (relevance ratio) in descending order. 

▪ Terms inside a group (having same rank) are sorted by 

premium and penalty (from highest premium to 

highest penalty). 

Group by Glossary/TM: 

• Group = TM/Glossary name sorted by premium and penalty 

(from highest premium to highest penalty). Terms with same 

penalty are sorted alphabetically. 

▪ Terms inside a group are sorted by rank. 

Group by Source: 

• Group = source text sorted alphabetically. 

▪ Terms inside a group are sorted by rank. 
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Improvements to Concordance 

search results display. 

The Concordance search window has been enhanced to allow the user 

to group the search results as follows: 

 

Sort by Rank: 

• Group = rank (relevance ratio) in descending order. 

▪ Segments inside a group (having same rank) are sorted 

by penalty (from highest premium to highest penalty). 

Group by TM: 

• Group = TM name sorted by premium and penalty (from 

highest premium to highest penalty). Segments with same 

penalty are sorted alphabetically. 

▪ Segments inside a group are sorted by rank. 

Group by Source: 

• Group = source text sorted alphabetically. 

▪ Segments inside a group are sorted by rank. 

 

 

Translation Workspace Problems Fixed in Release 1.7 

The following problems found in Translation Workspace were fixed in release 1.7: 

 

 Brief Description Full Description 

W
eb

 U
I &

 Server
 

Support for Latin and Arabic 

variants of Uzbek added. 

In previous versions Translation Workspace supported only the Cyrillic 

variant of Uzbek (language code uz). Uzbek has also Latin and Arabic 

variants. 

Support for Latin and Arabic versions was added. The language code for 

the Latin version is uzl, and for the Arabic version uza. 

The Translation Workspace language codes are saved also into TM 

export files. To re-import export files into other TM tools, you need to 

search and replace the language codes for those supported by other TM 

tools.  

While importing Translation Memory data exported from other TM tools, 

segments with uz-lt language code are saved as uzl and segments with 

uz-cy language code as uz into the Translation Workspace TM. 

The TAUS page content did 

not show up in Internet 

Explorer. 

When the user clicked TAUS in the Resources menu of the Translation 

Workspace Web interface and logged in to the TAUS system, where she 

clicked the Allow button, a blank page was displayed instead of three 

tabs. 

This has been fixed in Release 1.7. 
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 Brief Description Full Description 

Disabling cookies in the 

Internet Explorer generated a 

JavaScript error when the user 

opened the TAUS tab. 

When Block All Cookies was set in IE Tools > Internet Options > Privacy, 

a JavaScript error was displayed when the user opened the TAUS tab 

after login into Translation Workspace Web interface. 

The problem was resolved by updating server code. 

Note: Working with the TAUS TAB requires that the user enables cookies 

in the web browser. 

This has been fixed in Release 1.7. 

 

 Brief Description Full Description 

Client D
LL 

Matches coming from Search 

Only Background TMs were 

displayed in Auto 

Terminology window after 

the AutoTerm window was 

opened second time, but not 

when it was opened the first 

time. 

If the user connected with Connection Optimization active, during 

interactive translation the Search only matches were displayed in 

AutoTerm window not on first open, but on second. (When a 

Background glossary was attached as a search only glossary.) 

To trigger the Term Search and the appearing of the AutoTerm window 

required that an extra glossary was connected to the TM without Search 

only enabled.  

This has been fixed in Release 1.7. 

 

Filters Brief Description Full Description 

DOCX 

Filter 

Back conversion of a specific 

DOCX file resulted in the 

converted file failing to open 

in MS Word. 

MS Word could not open a back-converted DOCX file but displayed an 

error message about a non-matching name in the element end tag.  

The issue was related to a text passage which has a field code inside a 

text passage. 

This has been fixed in Release 1.7. 

Text Boxes were not extracted 

during conversion of Word 

2010 DOCX to XLZ/RTF 

While DOCX files created in Word 2010 were converted to XLZ or RTF 

format, the text appearing in text boxes was omitted. 

This has been fixed in Release 1.7. 

 WordArt element is shown 

incorrectly in MS Word 2010 

after back conversion to 

DOCX. 

WordArt effect formatting was lost on part of WordArt text in MS Word 

2010 after back conversion of files to DOCX format.  

This has been fixed in Release 1.7. 

HTML / 

XML 

Filter 

Conversion of HTML file with 

embedded JavaScript calls 

resulted in generating corrupt 

RTF and XLZ. 

After conversion of a HTML file to RTF or XLZ the files contain corrupt 

segments which should be be left outside segments.  

The created XLZ will not back convert to HTML.  

The problem was caused by the script processing failure in the JavaScript 

parser, when processing scripts which include an empty space between 

opening and closing script tags: 

<script type="text/javascript" src="../common_js/effects/prototype.js"> </script> 

The problem has been fixed in Release 1.7. 

 Saving an old LMX crashed 

MS Word with a runtime 

error. 

Loading and trying to save an LMX which includes only HTML/XML 

configurations from previous TW version crashed MS Word with a 

runtime error. 

This has been fixed in Release 1.7. 

 Parsing of xml file including a 

HREF tag including a “?” 

character results in data being 

After converting XML to XLZ or RTF with MLA, the HREF tag, which 

included a "?" character was set as translatable, and some content was 

removed from the file. 
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removed from prepared TW 

file. 

This has been fixed in Release 1.7. 

 Character set meta data value 

was wrongly duplicated in 

back converted HTML file 

when the charset attribute 

value begun with a double 

quote. 

The charset meta tag value was been wrongly duplicated when an RTF 

file was back converted to a HTML file (charset=utf-8"utf-8"). 

This happened when the value of the charset attribute started with a 

double quote. 

This has been fixed in Release 1.7. 

 Content of CDATA section 

defined in Markup style is lost 

in a generated XLZ file. 

When converting an ML file to XLZ, text from CDATA section set in 

Markup style was lost in the resulting XLZ file. When converting to RTF 

the CDATA section was correctly managed in the resulting RTF file.  

Problem did not occur if the CDATA inside the <CONTEXT> node was 

set in DoNotTranslate style or default style instead of Markup style.  

This has been fixed in Release 1.7. 

PPTX 

Filter 

Back converted PPTX file was 

corrupted.  

Back Converted PPTX file opened with a message asking for Repair. 

PowerPoint Repair function worked with Office 2010 but produced an 

empty slide with Office 2007. 

The problem was caused by an erroneous font code for East-Asian font 

(es instead of ea). 

This has been fixed in Release 1.7. 

 

 Brief Description Full Description 

M
S W

ord Plug-in 

Segments containing text in 

Markup styles were not pre-

translated when input RTF 

files were passed as a ZIP 

package. 

When using the Word Plug-in API, providing the RTF files for pre-

translation packaged in a ZIP file, resulted that in all the segments 

containing text in Markup format were not translated. 

Support for RTF files is also available in the XLIFF Editor API. 

This has been fixed in Release 1.7. 

HTML Preview did not handle 

files with xml declaration. 

Until now there was no possibility to use HTML Preview when the file to 

be previewed contained the declaration 

<?xml version="1.0" encoding="utf-8"?>. 

This has been fixed in Release 1.7. 
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New in Translation Workspace Release 1.6 

Translation Workspace Release 1.6 includes the following new features. 

 
Compo- 
nent Enhancement Description 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Split and Merge large 
XLIFF files. 

XLIFF Editor now has an in-built plug-in (Tools menu), which can be 
used for splitting large XLIFF files and merging the files back to one 
file. 

You can split 
any large XLZ 
file to smaller 
files, if the XLZ 
file has been 
created by the 
Translation 
Workspace 
conversion 
filters or the 
XLIFF Editor 
Idiom plug-in. 

You can also 
split XLZ files 
that are partly 
or fully 
translated. The 
files to be 
merged can 
also be partly or fully segmented XLZ files. 

Splitting can be performed by using three different options:  

• Split by the number of words. 

• Split per segment count. 

• Split to separate files (for XLZ files converted and combined 
from multiple Idiom XLIFF files) 

There is also an option to keep segments not separated by any 
external content together in the same file. 

Lock/Unlock segments 
plug-in to XLIFF Editor. 

The Lock/Unlock Segments plug-in functionality has been added 
(Translation > Lock Selected Segments [Ctrl+Alt+L]; Unlock Selected 
Segments [Ctrl+Alt+U). With the help of this feature, you can lock and 
unlock the selected segment pairs. 

Locking sets the state of the selected segments to translate=no. 

QA check warns if there 
are double spaces. 

A new QA check was added into the XLIFF Editor, which warns if the 
translated segment contains double spaces. Combinations of 
<SPACE>, <TAB>, <HARDSPACE>, <LINEFEED> and so on trigger the 
QA warning. 

If a passage of three or more whitespaces is found, no warning is 
displayed. For example <SPACE><SPACE><LINEFEED> does not 
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Compo- 
nent Enhancement Description 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

generate a warning. This allows for example using multiple spaces for 
indentation. 

XLIFF Editor keeps 
during the session the 
last position of the 
Spell Check dialog. 

In previous versions, the Spell check dialog reverted back to the 
default position on the display after closing the dialog and re-opening 
it. 

XLIFF Editor now remembers the position of the Spell check dialog 
during the current session. 

Analysis result dialog 
was not displayed 
when no Analysis log 
path was set in XLIFF 
Editor. 

In previous versions, the analysis result dialog was displayed in XLIFF 
Editor only if the user had set a log file (path) into the Result File field 
(whether the Use Analysis TM option was set or not). 

The result is now displayed always when analysis is run, even if no log 
file path has been entered to the Result File field. 

Link to GeoWorkz 
support form in XLIFF 
Editor About dialog. 

A link was added into the XLIFF Editor About dialog to the GeoWorkz 
support form (http://www.geoworkz.com/Support/Default.aspx). 

XLIFF Editor detects if 
CAPS LOCK is on when 
Login dialog is open and 
displays a warning. 

Until now XLIFF Editor did not warn when CAPS LOCK was on while 
the Login dialog was open. 

CAPS LOCK warning message functionality was added to the Login 
dialog. 

XLIFF Editor TM 
selection dialog now 
has options for tree 
view and flat view. 

 

In previous versions, the Select TM dialog in XLIFF Editor listed all TMs 
in a flat view, which made it hard to find the correct TM. It was also 
very slow for users with a lot of access rights in a tenancy with many 
projects. 

An optional tree view similar to the Web UI was added to the Select 
TM dialog. 
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Compo- 
nent Enhancement Description 

 

“Zero width space” and 
“Soft hyphen” 
character displayed in 
XLIFF Editor. 

In previous versions, nothing indicated the hidden break characters 
"zero width space" (\U200B) and "soft hyphen" (\U00AD) when the 
whitespace characters were displayed in XLIFF Editor. 

Now, when Show Whitespace is selected, a vertical line is displayed 
for "zero width space" and "soft hyphens" indicating the hidden break 
characters. 

Possibility to clear all 
tags in target segment 
in XLIFF Editor. 

In previous versions, when a match from TM was linguistically good 
but contained a lot of tag differences, there was no easy way to 
manage the tags in XLIFF Editor. 

Functionality to clear all tags has now been added. With the Tags > 
Clear All Tags command you can remove all tags from the open target 
segment. Special tags used for highlighting or marking something 
within a segment are not removed. 

XLIFF Editor now 
supports “creation 
user” and “update 
user” and timestamp 
alt-trans metadata of 
Idiom XLIFF files. 

In previous versions, the Idiom XLIFF conversion utility did not 
preserve “creation user” and “update user” attributes (and associated 
timestamps) on alt-trans elements in Idiom XLIFF. 

The Idiom XLIFF conversion utility was modified to read segment 
“creation user”, “update user” and timestamp information in the alt-
trans elements coming from Idiom XLIFF. 

XLIFF Editor was modified to support displaying of segment “creation 
user” and “update user” and timestamp information on alt-trans 
segments extracted from Idiom XLIFF. 

Improve "Get Current 
Tag" to work the same 
way as "Insert Tag" 
operation in XLIFF 
Editor. 

In previous versions, if you tried to insert or rearrange tags using the 
normal tag action "Get Current Tag" (same method as in MS Word 
client) you just got an exception if the tag already existed in the 
target. 

Now XLIFF Editor works the same way as when you insert tags using 
tag IDs (Alt+number). XLIFF Editor asks if it should create a new copy 
of the tag or move the existing tags. 

XLIFF Editor Batch Find 
and Replace dialog. 

In previous versions, the four text fields in the Batch Find and Replace 
dialog (Path, File Mask, Find, and Replace) were only editable text 
fields, not containing the latest entries used in them.  

There was also no easy way to move to the results frame to select 
one of the occurrences. While in that frame the user pressed Enter, 
the operation restarted. 

Path, File mask, Find, and Replace text fields now remember 20 
previously typed phrases. 

Pressing Enter in Path, File mask, and Find entries start searching 
process, pressing Enter in Replace entry starts replacing process. 
Pressing Enter inside results frame works as mouse double clicking. 

Pressing Ctrl+Enter while in any field moves keyboard focus into 
results frame. 
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Translation Workspace Problems Fixed in Release 1.6 

The following problems found in Translation Workspace were fixed in release 1.6: 

 Brief Description Full Description 

 

 

When a segment contained only 
variables or numbers, 
Translation Workspace provided 
wrong 100% matches.  

In previous releases, if segment contained only variables or 
numbers Translation Workspace provided wrong 100% 
matches. 

This has been fixed in release 1.6. 

Locale was not considered for 
the linked Glossaries. 

In previous releases, for example when you had a French 
(France) glossary linked to a French (Canada) TM, terms in 
French (France) were displayed in the Autoterminology 
window. 

This has been fixed in Release 1.6. 

Chinese Terms were corrupt in 
auto-terminology window when 
Terms offered were different 
than language pair being 
translated. 

Due to previously mentioned defect (Locale was not 
considered for the linked Glossaries), when a user selected a 
language pair for which no glossary linked to the TM 
contained the languages specific locale, but a similar locale 
did exist in a linked glossary, terms were offered for use. 

This has been fixed in Release 1.6. 

 

 
 

 

 

 

 

 

 

 

 
 

Upgrading/installing the TW 
Word Client in some cases could 
crash the installer. 

In some cases, the Word Plug-in installer crashed during the 
installation process. It was not even possible to successfully 
run the de-installation via the Control Panel, because 
Setup/Uninstall stopped working while running. 

Since the installer was still using the old install.dll, a message 
about the de-installation failing was displayed. It is ok to 
choose "Close Application" and then continue to install the 
new version. Later un-installs / re-installs or upgrades work 
without problem. 

This has been fixed in Release 1.6. 

Auto-substituted segments were 
extracted by the Unknown 
segments analysis function. 

In previous releases, the export of the unknown segments 

did not reflect the analysis result. Auto-substituted segments 

did not appear in the Repetition category in the analysis 

report but were exported as unknown segments. 

This has been fixed in Release 1.6. 

MS Word plug-in upgrade 

process did not warn users who 

have MS Word set as their 

default e-mail editor to close all 

the MS Word instances when 

completing upgrade process. 

In computers with MS Office 2003, and Outlook as the 
default email application with MS Word set as the e-mail 
editor, the Translation Workspace Word client upgrade 
process halted and displayed an error message saying that 
the process cannot replace the file “Workspaceforword.dot” 
because it is being used by another process. 

This problem does not occur with MS Office 2007 and 2010. 

This issue was caused by MS Word 2003 being open in the 
background, while Outlook was open. Also some other 
situations could cause the error message to be displayed:  

• User was running MS Word interactively.  
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 Brief Description Full Description 

 
 

• A document with embedded MS Word document was 
open for editing (e.g., Excel table with inserted MS Word 
document).  

The installer now checks if Word is running and displays a 
warning suggesting that MS Word or any email application 
which may use Word as an editor should be closed.  

The following message will be displayed: "Setup has detected 
that Microsoft Word is currently running. Please close all 
Microsoft Word instances then click OK to continue or Cancel 
to exit. (If you are using Microsoft Word as your email editor, 
please close all email clients)". 

Translation Workspace skipped 
or segmented incorrectly during 
interactive translation of certain 
segments in Word 2007. 

In previous releases, segmenting the files in Word 2007 
worked inconsistently. 

Word client skipped segments in file and jumped to next 
segment, segmented incorrectly, or skipped all segments. 

This has been fixed in Release 1.6. 

 

 
 

RTF/XLZ generated from INX files 
was not valid and prevented 
correct back conversion in case 
of empty note. 

In previous releases, back conversion of RTF/XLZ files 
converted from INX files failed and no localized INX was 
generated.  

Because the Note element did not have an ending tag 
</Note> in the RTF/XLZ, no XML file was generated during 
back conversion.  

This has been fixed in Release 1.6. 

Translated Index Marker text 
was not inserted into the back 
converted INX file. 

The text was correctly extracted for translation after 
conversion of the INX to RTF/XLZ, but it was not re-
integrated in the INX file after the back conversion. 

Index marker text in the back converted file did not contain 
the translation, but the source text. 

This has been fixed in Release 1.6. 

Analysis result was not displayed 
if the log file path contained the 
‘&’ character. 

If you launched an analysis and selected a path for a log 
which name contained the ‘&’ character, the analysis result 
was not displayed, although the log file was correctly created 
on the computer. 

This has been fixed in Release 1.6. 

 

The error message was too big 
when large amount of files was 
added to the TTX/XLZ converter 
dialog. 

When a large amount of incorrect files was added, the error 
message tried to display all file names, thus not fully fitting 
into screen. The error message "The following files had the 
wrong extension and could not be added" did not fit in the 
window.  

This has been fixed in Release 1.6. 

Exception appeared if you tried 
to convert XLZ to DOCX or PPTX 
format using Save Target 
command. 

In a previous release, XLIFF Editor gave an error message, 
which said "Converter Exception: Translation Workspace XLZ 
to PPTX (or DOCX) conversion failed” when you tried to save 
the XLZ file with the Save Target command.  

This has been fixed in Release 1.6. 
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 Brief Description Full Description 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The error message was too big 

when large number of files was 

added to the TTX/XLZ converter 

dialog.  

When a large number of incorrect files was added, the error 
message tried to display all file names, thus not fully fitting 
into screen. The error message "The following files had the 
wrong extension and could not be added" did not fit in the 
window. 

This has been fixed in Release 1.6. 

XLIFF to TMX conversion and 
storage was broken (wrong tag 
id). 

When you inserted new custom pair tags into a target 
segment during translation with XLIFF Editor, properly paired 
tags were created in the XLIFF file, but when you stored the 
segment into the TM the pair tag was wrongly converted 
from XLIFF to TMX. 

The stored start (bpt) and end tag (ept) did not have the 
same IDs. 

This could generate issues, for example, when exporting the 
TM to TMX format, all paired tags present in target segment 
but not in source segment were converted to isolated tags.  

This has been fixed in Release 1.6. 

Back conversion of Idiom XLF file 
which includes expanded 
segments resulted in “breaking” 
source segment tagging. 

Back-conversion of XLZ files that were originally converted 
from idiom XLF files and include expanded segments, 
resulted in files that had corrupt source segment tagging. 
Reopening the files in XLIFF Editor revealed the defective 
segments, where tags were represented by numerical inside 
brackets.  

This has been fixed in Release 1.6. 

Active Document was not 
highlighted if cursor focus was 
not set on the File Set Browser. 

When the files were open in a file set including several files, 
setting the focus on the translation pane, and then clicking 
Select Active Document in the File Set Browser, the active 
file was not highlighted. 

A custom arrow now indicates the active file.  

This has been fixed in Release 1.6. 

The "Open" and "Cancel" 
buttons were in a wrong order in 
the Open File Set... dialog. 

The “Open” button was on the right side of the “Cancel” 
button in the Open File Set… dialog of the File Set Browser. 

The places of the buttons were swapped. Now the "Open" 
button is on the left side of the "Cancel" button. 

It was possible to uninstall XLIFF 

Editor while it is open. 

It was possible using Control Panel or Start Menu to run the 

XLIFF Editor un-install process and thus remove the XLIFF 

Editor while it was open. Only a confirmation message was 

displayed. 

This has been fixed in Release 1.6. 

The XLIFF Editor installer option 

"Create a Quick launch icon" has 

no effect in Windows 7. 

When "Create a Quick launch icon" option is selected in the 

XLIFF Editor installer, no quick launch icon is created in MS 

Windows 7. 
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 Brief Description Full Description 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

The icon is installed in the Quick Launch folder: 

C:\Users\[user]\AppData\Roaming\Microsoft\Internet 

Explorer\Quick Launch 

However, the Quick Launch shortcuts feature has been 

permanently disabled in Windows 7 by an update. 

For a workaround, the user can manually select to add the 
Quick Launch folder to the Taskbar as a New Toolbar, and all 
the Quick Launch icons of the folder are displayed in it. 

1. Right-click on the Windows Taskbar.  
2. Select Toolbars > New toolbar... in the pop-up 

menu.  
3. New Toolbar - Choose a folder dialog opens.  
4. Browse to your Quick Launch folder (replace [user] 

with your username):  
C:\Users\[user]\AppData\Roaming\Microsoft\Interne
t Explorer\Quick Launch 

5. Click Select Folder at the bottom of the dialog. 
6. Quick Launch Toolbar appears in the Taskbar. 

The mandatory update could be 

rejected. 

If you canceled the mandatory update, you could continue 

working with the old version for the XLIFF Editor. 

Starting with TW release 1.6 the mandatory update of XLIFF 
Editor can no longer be rejected. 

Context value calculation for 

extended characters was not the 

same as in Server, Word Plug-in, 

and TW Tools. 

If source language translation units contained extended 

characters (characters outside windows-1252 code page) the 

XLIFF Editor context value differed from the corresponding 

value in Word Client and Server. 

XLIFF Editor now generates exactly same context values as 
the other implementations. 

Invalid link on About dialog. Clicking the link http://translate.translationworkspace.com 

on About Translation Workspace Xliff Editor dialog did not 

open the target page. 

Now the dialog includes two links. One pointing to 
Geoworkz.com home page and the other to (Geoworkz.com) 
Translation Workspace support page. 

Terminology window stayed on 
top when corresponding options 
were disabled 

When "Dock terminology window" and "Always on top" 

(Translation Workspace > Terminology) were deactivated, 

and focus was changed from Terminology window to main 

LXE window, the Terminology window still stayed on top. 

The "Always on top" option is now temporarily removed 
from Translation Workspace > Terminology menu, because it 
does not work under MS Windows while using current GTK+. 

http://translate.translationworkspace.com/
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 Brief Description Full Description 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

Two different translation 
functions used the same icon. 

The same icon was used for both "Store, Close and Open 

Next Segment" and "Store, Close and Open Next 

Untranslated" commands.  

The icon used in the Word plug-in for "Store, Close and Open 
Next Untranslated " command is now used also in XLIFF 
Editor. 

Columns were not resizable in 
some dialogs. 

Columns were not resizable in some XLIFF Editor dialogs, for 

example in Tools > TTX/XLZ Converter, LCL/XLZ Converter or 

Idiom XLIFF Converter. 

This was inconvenient to users, if for example the added file 

had a long path or status columns were resized due to error. 

Resizable columns were implemented to the mentioned 
dialogs. 

Shortkeys Ctrl + → and Ctrl + 
Shift + → behave differently 
from standard Word 
functionality 

In previous versions, using Ctrl + → and Ctrl + Shift + → to 

jump to next word, cursor jumped to current word's end 

before a space in front of the next word, instead of start of 

next word (as in Office applications). 

Now this feature works as in MS Office applications. 

"This is deprecated and will go 
away" error message in some 
cases displayed in MS Word spell 
checker. 

The following error message was displayed when launching 

the MS Word spell check in LXE: "this is deprecated and will 

go away". The problem was caused by the pygen cache. 

Cleaning the pygen cache is now included in the XLIFF Editor. 

Sorting by ID field in QA Check 
dialog did not work 

Sorting by ID (the first column) in the QA Check results after a 

QA check run on a file with some differences in tags did not 

work. 

This has been fixed in Release 1.6. 

It was impossible to configure 
ALT-BACKSPACE as a keyboard 
accelerator. 

It was not possible to set ALT-BACKSPACE as an accelerator 

to an action in Tools > Preferences > Accelerator settings. 

The accelerator was reset to the previous key-combination 

instead. 

This has been fixed in Release 1.6. 

Enabled/disabled QA checks 

were not updated on startup. 

The QA check configuration dialog needed to be opened 

once for every session to apply the active checks settings, 

although the QA check settings user has previously made 

should be applied when the editor is started.  

This has been fixed in Release 1.6. 

Urdu was missing from the list of 
languages marked as RTL. 

Urdu is an RTL language, but it (lang code "ur") was missing 

from the list used by XLIFF Editor that marks it as such.  

Entry for "ur" was added to the bi-directional languages list. 
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The Clipboard content was 
replaced by the concordance 
search text content. 

When there was some text in the Clipboard and Alt+Up was 

used on a passage of text in LXE for concordance search, the 

Clipboard content was replaced by the searched text 

passage. 

XLIFF Editor no longer saves to clipboard the search string for 
concordance searches or terminology searches. 

Pasted multiline text was not 
truncated in the Search and 
Replace fields. 

When copying and pasting multiline strings into the search 

(and replace) dialog (Ctrl+F / Ctrl+H) newline characters (\n) 

were not visible to the user and they were searched or 

replaced without the user being aware, which caused 

mistakes and errors. For example, a common issue was 

copying and pasting from an MS Excel cell, which by default 

includes a trailing space. 

Now the newline and the text after it are truncated (left out) 

when text is pasted into the Search or Replace fields. When 

the pasted string begins with a newline character, the string 

is not truncated. 

Opening XLIFF files without TW 
DLL installed generated a 
warning message. 

Using XLIFF Editor without having installed the (Word/Tools) 

client DLL and opening an XLZ file, triggered the following 

warning about a missing conversion filter: The Translation 

Workspace Word client needs to be installed to use this XLIFF 

conversion filter. Please install it and try again. 

This warning should appear only when files being opened are 

not in XLIFF Editor XLZ format but for example in XML. 

This has been fixed in Release 1.6. 

XLIFF Editor fails to open when 

XLIFF Editor help has been 

opened. 

After opening the XLIFF Editor Help from the Help menu, 

quitting the XLIFF Editor and attempting to re-launch it, the 

Help had to be closed before the XLIFF Editor was re-

launched. 

This has been fixed in Release 1.6. 
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New in Translation Workspace Release 1.5.1 

Translation Workspace Release 1.5.1 includes the following new features. 

 

Enhancement Description 

MIF Filter option added for 
controlling whether Text Insets 
are translatable. 

We have added a new MIF filter option "TextInset Translatable" to 
configure whether MIF Text Insets should be set as translatable or 
non-translatable. This option is in the Text Extraction section of the 
Configure Filters dialog MIF tab.  

The default value is TRUE. If the option is missing (for example, you 
are using an old .lmx file) the default value is also TRUE. 

In the TagML format, Text Insets are enclosed in the starting <ti/> 
and ending <tie/> elements. 

When set as non-translatable the Text Inset text will appear in 
LogoportDoNotTranslate style. 

MIF file back conversion now 
captures language information. 

When a MIF file is back converted from Translation Workspace RTF, 
the resulting MIF file will now contain the Text proofing Language 
attribute. 

Translation Workspace Problems Fixed in Release 1.5.1 

The following problems found in Translation Workspace were fixed in release 1.5.1: 

Compo- 
nent 

Brief Description Full Description 

Microsoft 

Word Client 

Replacement issue when the part 
to be replaced is surrounded by 
Unicode escaped text.  

In previous releases, if text was surrounded by a 
Unicode escape character (for example, \u1234)), the 
target segment might contain errors in numbering and 
garbage characters after pre-translation. This could be 
seen after cleanup of RTF files, especially in Farsi, 
Czech, Polish, Greek, Romanian and Russian, and 
depended on the regional settings of the machine 
where the RTF segment was stored. 

The problem is solved by exporting the segments, 
which removes the Unicode escape formatting, and 
then importing them, resulting in correctly translated 
segments. The problem occurs only for Translation 
Workspace RTF format, not for Translation Workspace 
XLIFF. 

Middle dot character no longer 

corrupted in double-byte font (for 

example, MS Mincho). 

In previous releases, when you opened a segment that 
contained a dot character in the middle of the segment 
for double-byte fonts like MS Mincho, the dot was 
replaced by a question mark in the target segment. 
This has been fixed in Release 1.5.1.  

MIF Filter MIF V7 files saved from 
FrameMaker 7.2b128 no longer 
cause Word or the Translation 
Workspace conversion tool to 
crash. 

In previous releases, when you converted a MIF V7 file 
saved from FrameMaker 7.2b128, the conversion tool 
sometimes caused Word or the Translation Workspace 
filter tool to crash. This has been fixed in Release 1.5.1. 
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Compo- 
nent 

Brief Description Full Description 

MIF formatting is no longer lost in 
back conversion. 

In previous releases, some of the text formatting code 

could be missing from the MIF file after back 

conversion. This has been fixed in Release 1.5.1. 

MIF Stretch value is no longer 
inconsistent in back-converted 
file.  

In previous releases, the Stretch value of a text 
element in a back-converted MIF file was not 
consistently the same as the value in the original 
FrameMaker/MIF file. This has been fixed in Release 
1.5.1. 

Back conversion is no longer 
blocked by wrongly interpreted 
XML reserved characters like '&' in 
MIF style name. 

In previous releases, for some files, back conversion 
was stopped with the following error: "Failed to 
preprocess XML. Preprocessing failed." 

This happened with some MIF files containing a style 
name or variable using XML reserved characters. This 
has been fixed in Release 1.5.1. XML reserved 
character are escaped. 

Note: See the Filters and File Formats in Translation 
Workspace guide (accessed via Resources > Help 
in the Translation Workspace Web interface 
toolbar) to know how to mark text as 
untranslatable in FrameMaker. 

Footnotes text is now extracted 
for translation and back 
conversion failures. 

In previous releases, for some files, Footnote text was 
not extracted for translation and the back conversion 
failed with the error "P tag not found. MIF file hasn't 
been fully parsed." This occurred especially when 
unused reference pages contained footnotes. This has 
been fixed in Release 1.5.1. 

Back conversion of some MIF files 
no longer results in accented 
characters being corrupted for 
various MIF Tags. 

In previous releases, back conversion of some MIF files 
resulted in accented characters being corrupted for 
various MIF Tags. This occurred because some UTF-8 
encoded source MIF files (version 8.0 or later) were 
wrongly detected as ANSI and had an extra UTF-8 
encoding applied during back conversion. This has 
been fixed in Release 1.5.1. 

Cross references are now always 
displayed in the back converted 
file when viewed in FrameMaker. 

In previous releases, some cross references were not 
handled properly and didn't display in the back 
converted MIF file. This has been fixed in Release 1.5.1. 

For MIF v7 and earlier, non-ASCII 
characters in Catalog tag names 
are no longer corrupted during 
back conversion. 

In previous releases, when translating from Japanese 
to English, after back conversion to MIF, the catalog 
tags that used non-ASCII characters (for example, 
Japanese color catalog tag name) were corrupted. 

This has been fixed in Release 1.5.1. Non-ASCII 
characters are converted to the corresponding 
Hexadecimal representation. 

You no longer get the error: 
"Found hypertext marker without 

In previous releases, for some files, back conversion 
was stopped with following error: "Found hypertext 
marker without paragraph." 
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Compo- 
nent 

Brief Description Full Description 

paragraph" during back 
conversion. 

This happened when non-used Master Pages contained 
hyperlink. This has been fixed in Release 1.5.1. 

Text formatting is no longer lost in 

back conversion. 

In previous releases, for some files, part of the 
character formatting information was lost in back 
conversion. This was the case for character formats like 
Background Color, Locked, Outline, Pair Kern, and so 
on. This has been fixed in Release 1.5.1. 

Variable Definitions are now 

always extracted for translation. 

In previous releases, Translation Workspace extracted 
for translation only the MIF variables used in the 
document. Variable appearing inside the Table 
element were wrongly not identified as being used and 
were not extracted. This has been fixed in Release 
1.5.1. 

The back conversion error file 

(.ERR) is no longer encoded in 

UTF-8 without BOM. 

In previous releases, the back conversion error file 
(.ERR) was encoded in UTF-8 without BOM. Now error 
files (.ERR) are encoded in UTF-8 with BOM. 

 

New in Translation Workspace Release 1.5 

Translation Workspace Release 1.5 included the following new features. 

 

Enhancement Description 

Reporting UI updated The user interface for reports generated from the Reports tab in the 
Web interface toolbar has been updated to conform to the layout of 
other Translation Workspace components. The new UI looks like this: 

 

You can now access the Reports tab by selecting a TM, right-clicking, 
and clicking Open Report from Here. The UI now looks like this: 
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Enhancement Description 

 

This new UI has the following changes: 

• Paging support and a “border” layout 

• A toolbar with 3 buttons to Show Report, Download Report, or 
Send Report 

• A grid layout to show report results, separating the Grand Total 
and detailed rows 

•  A Tenancy column  

• Workgroup, TM selection control for easier object selection 
 

Converters added for RTF to XLZ 
and XLZ to RTF 

A converter has been added (Convert RTF to XLZ) for converting a 
tagged RTF file to XLIFF, and a back-converter (Convert XLZ to RTF) has 
been added that regenerates the tagged RTF. This is intended only for 
“tagged” RTF files that contain plain text plus portions of text marked 
up with the internal and external styles. The converter does not handle 
any other Word formatting or Word constructs. 

Translation Workspace RTF to XLZ Conversion 

The Translation Workspace RTF to XLZ Conversion dialog is accessed 
from the Conversion tasks area of the Translation Workspace Tools or 
via Convert RTF to XLZ in the Documents or Current Document menu 
in the Word Plug-in ribbon. 
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Enhancement Description 

This converter 
supports only un-
translated, un-
segmented 
tagged RTF. It 
only recognizes 
Normal, Internal 
and External 
text. It does not 
run a strip 
tagged RTF 
before the 
operation, but 
the process will 
strip any extra 
formatting or 

styling. 

Translation Workspace XLZ to RTF Conversion 

The Translation Workspace XLZ to RTF Conversion dialog is accessed 
from the Conversion tasks area of the Translation Workspace Tools or 
via Convert XLZ to RTF in the Documents menu in the Word Plug-in 
ribbon. 

This converter 
operates on a 
single file XLZ file 
with a skeleton 
that has a target 
language set. It 
will not work 
with arbitrary 
XLIFF files or 
multi-file merged 
XLIFF files. It has 
the same 
requirements in 
this regard as 
back conversion 
generally. 

The filter 
supports un-translated, partially translated, or fully translated files. 
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Translation Workspace Problems Fixed in Release 1.5 

The following problems found in Translation Workspace were fixed in release 1.5: 

Component Brief Description Full Description 

Web Interface 

 

Reviews of aliased Review Packages 
after alias has been suspended no 
longer get Incorrect Error message 
"obj.result is null." 

In previous releases, the Error message when 
accessing aliased Review Packages after the alias 
has been suspended got the Error message 
"obj.result is null." This message was inconsistent 
with other error messages for Suspended objects. 

This has been fixed in Release 1.5. When a user 
tries to view the files in an aliased Review Package 
that has been suspended, the correct error 
message "This alias is suspended or revoked" is 
now displayed. 

Lengthy Published Alias List no 
longer gets “Script stack space 
exhausted” message. 

In previous releases, a great number of aliases 
caused a "Script stack quota is exhausted" error 
message to appear in the Published Alias List and 
set the browser to a non-responsive state. 

Pagination has been added to all three alias lists 
(Published aliases, Subscribed aliases, and Object 
level Alias list) to resolve this problem. 

Analysis run from the Web 
interface for nonstandard locales 
no longer returns incorrect 
Language Codes in Analysis reports. 

In previous releases, when nonstandard Language 
Locales were set as the Target in the TM, for 
example Spanish (Mexico), and a word count was 
run for some files via the Web interface, incorrect 
language codes were returned. 

This has been fixed in Release 1.5. 

Background TM and Glossary 
configuration is now imported. 

In previous release, background TM and glossary 
links with any penalty were not updated when 
doing an import of a TM using the Import 
Background TM and Glossary Configuration 
option. For each penalty there was the same 
result—the TM’s and Glossary’s penalty and 
premium were not updated. 

This has been fixed in Release 1.5. 

For a TM Import, user roles are 
now imported when the Import TM 
Settings option is not selected. 

In previous releases, when both the Import TM 
Settings and Import User Settings were selected 
in the Import tab, the user's roles were imported 
correctly. But if only the Import User Settings 
option was selected, the user's role was empty 
after the import. 

This has been fixed in Release 1.5. 

The TM Statistics Remove All 
button is now grayed out if the TM 
does not contain any segments. 

In previous releases, while connected to a TM with 
no content (no segments), in the TM Statistics 
page, the Remove All button was not grayed out, 
like the Remove button was. 

This has been fixed in Release 1.5. 
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Component Brief Description Full Description 

The Delete object (TM) 
confirmation dialog no longer has 
mixture of fonts. 

In previous releases, the Delete object dialog 
displayed in Firefox and IE after the Delete TM 
command was given included text in two different 
fonts. 

This has been fixed in Release 1.5. 

Show in Tree button in the 
Subscribed Alias List tab is no 
longer always in the Active state. 
 

The Show in Tree button on the Subscribed Alias 
List tab should be active while an item is selected 
in the table, and inactive when no item has been 
selected. In previous releases, this button was 
always active. 

This has been fixed in Release 1.5. 

Microsoft 
Word Plug-in 
and Word 
Client Tools 

In document analysis, a missing 
result file is indicated with an error 
message. 

In previous releases, if the result file was manually 
deleted and the Clear Result File button was 
clicked in the Document Analysis dialog, no 
message reported that the file was missing. This 
has been fixed in Release 1.5.  

Cursor problem fixed for creation 
of User-defined entities. 

In previous releases, when you were creating a 
User-defined entity, if you clicked “Move right” or 
“Move left” (“->” or “<-“), the cursor could move 
beyond the row and the entered word 
disappeared, with no message. Rather than 
moving to another row, you now get a message 
saying, “Press Insert button to create an entity.” 

Unknown segments analysis in XLZ 
and TMX format no longer returns 
useless message on success. 

In previous release, the TMX and XLZ Unknown 
segment analysis returned a useless notification 
message on success. That message has been 
removed in Release 1.5. 

PPTX Filter PPTX XLZ Back-conversion of 
double-byte language with active 
Add Inter-segment Space is now 
working. 

In previous releases, the back-conversion of an XLZ 
file pre-translated from or to a double-byte 
character set language failed when the file was 
cleaned with a TM in which Japanese (or Chinese) 
was selected as source, English (EN-US) as target, 
and when Add Inter-segment Space was set to 
active. A separate error file was created. 

This has been fixed in Release 1.5. 

TM Editor A Background TM coming from 
another workgroup is no longer 
listed as many times it is used as 
background TM. 

In previous releases, If you added a background 
link from, say TM_A in Workgroup_1 for both 
TM_B and TM_C in Workgroup_1, the 
Maintenance Editor listed TM_A twice in 
Workgroup_1. This has been fixed in Release 1.5. 

Fixed in 
Release 1.4.6 

In the Word Client, the XML 
Analysis log is now always cleared 
before generation of new one.  

In releases before Release 1.4.6, when a user ran 
several analysis reports on the same TM, with 
different log file names, if the output log format 
selected was XML (or ZIP), the second log file 
sometimes contained information from the first 
analysis. This was fixed in Release 1.4.6.  
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Component Brief Description Full Description 

The XML Analysis log generated 
when requesting a ZIP file as 
output format with the option Use 
Analysis TM disabled is now 
correct. 

In releases before Release 1.4.6, if you ran an 
analysis report with User Analysis TM set to No 
and Clear Analysis TM set to Yes, the report would 
be different for XML vs. ZIP output. There were 
two problems with the ZIP output: (1) the Total 
Batch count differed from the results in the other 
columns, and (2) the User Analysis TM results 
were shown, even though the User Analysis TM 
option was disabled. This was fixed in Release 
1.4.6. 

The XML Analysis log is no longer 
wrongly encoded. 

In Release 1.4, prior to Release 1.4.6, the XML 
reports from analysis erroneously used PLAIN 
encoding instead of UTF-8. If the report contained 
filenames with extended characters such as Latin-
1 characters like åäöüñ and so on, the file was 
treated as invalid XML since these characters were 
emitted without encoding. This was fixed in 
Release 1.4.6. 

The XLIFF Editor analysis no longer 
wrongly returns context matches 
when the Context match option 
was disabled on the TM settings. 

Prior to Release 1.4.6, if Context Matching was 
disabled for a TM, an analysis report run from the 
XLIFF Editor could still show context matches. This 
was fixed in Release 1.4.6. 
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New in Translation Workspace Release 1.4 

Translation Workspace Release 1.4 included the following new features. 

Web Interface and Server 

Enhancement Description 

Expanded control of removing 
terms from languages 

In the Manage tab for a selected glossary, you can now select and 
Remove the terms of specific languages or use the Remove All button 
to remove the terms of all languages at once. 

Search Only option for 
background linked assets  

In previous releases, all background-linked assets were always 
searched automatically whenever a segment was opened for 
interactive translation in one of the translation clients. This could lead 
to long search times or “noisy” autoterminology results when 
numerous resources were background-linked. In addition to the 
background linking previously available (used for auto-lookup 
matching), a new way of linking "search only" background assets is 
now provided. When you specify that a background asset is Search 
Only (in the Add as background TM or Add as background glossary 
dialog) the asset is not searched automatically when a segment is 
opened, but only when a separate search is initiated manually 
(Concordance search for TMs, term search for glossaries). 

The alias user does not need to have the Use as Background Link 
permission to be able to link "search only" assets to an alias. The 
amount of "search only" background links per TM is unlimited.  

The Concordance search function is changed accordingly. The Search 
Other button has been removed from the Concordance Search dialog. 
Previously, this button caused all TMs in the workgroup to be 
searched. Instead, now that you have direct control of extended 
searching via the new background link option, all linked background 
TMs are searched when the Concordance search is initiated. 

Ability to re-send the  
Activation e-mail 

Users may not always receive their activation emails, for a variety of 
reasons. We now provide a way to re-send an activation email to a 
user in the User Management area where you create users: 

• We added a new column for user lists displaying an hourglass icon 
for the accounts awaiting activation.  

• In the Edit User dialog, we added a Send Activation Email button 
visible only for activated accounts not yet activated.  
 

If the admin clicks the button, the activation email is sent to the user. 
Note that this changes the activation token, making all previous 
activation links invalid. 

Use of attributes now allowed 
with aliased assets  

In previous releases, it was possible to use attributes only in original 
assets, not in aliased assets. This limited the value of attributes for 
subscribers.  

Now, two ways of using the attribute|value settings of the original TM 
are enabled for Alias TMs:  

• Forcing all the users of the Alias TM to use a specific attribute 
setting for filtering and/or storage of the translation units. 
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Enhancement Description 

• Allowing the Alias TM users to select from pre-defined Attribute 
Sets when they start using the Alias TM.  

The leverage filtering based on attributes is functional with Alias TMs, 
as is the storing of attributes|values into the Alias TM. 

Managing attributes (creation of attributes|values, and defining 
Attribute Sets) is not allowed for Alias TM use. That is, you still cannot 
create attributes on an alias TM via the TM Maintenance Editor, and 
you cannot access the Attribute Configuration dialog. 

You can now run analysis with and 
without the analysis TM in one 
operation 

In previous releases, a separate word count task was run for Analysis 
with and without analysis TM. Both analyses can now be run in the 
same server task, and the system generates both output logs in one 
pass, keeping track of two sets of information. This reduces the load 
on the server, and the processing time needed.  

When generating an analysis for multiple target languages in one run, 
the analysis TM and the internal repetition list are now only created 
once, not one for every language. This boosts the performance, 
especially for multiple languages. 

You can also specify that either type of analysis is performed 
separately. 

You can now add an email column 
in the asset-level Published 
Aliases list  

Previously, the Alias ID and Alias Permissions were the only optional 
columns in the Published Aliases list for an asset (these optional 
columns are not displayed by default but can be enabled for display by 
the user). 

We have now added an option to display the email to which the alias 
token was sent. The email address is a useful piece of information in 
relation to the currently selected asset, since it is more difficult to get 
the email from the tenancy-level Published Aliases list. 

Search engine optimization Previously, the algorithm that computes the search plan did not check 
if the TM had segments for the specified language direction. The local 
search performed this check for every segment (and will keep doing 
so), but that was wasteful when the search plan contained TMs with 
only language directions other than those specified. These 
unnecessary searches have been eliminated. 

 

Word Plug-in and Tools 

Enhancement Description 

You can now run analysis with and 
without the analysis TM in one 
operation 

In previous releases, a separate word count task was run for Analysis 
with and without analysis TM. Both analyses can now be run in the 
same server task, and the system generates both output logs in one 
pass, keeping track of two sets of information. This reduces the load 
on the server, and the processing time needed.  
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Enhancement Description 

When generating an analysis for multiple target languages in one run, 
the analysis TM and the internal repetition list are now only created 
once, not one for every language. This boosts the performance, 
especially for multiple languages.  

 

You can also specify that either type of analysis is performed 
separately. 

Full support for the Office 2010 
new objects in our office filters 
(DOCX, PPTX, XLSX) 

We now support, in our forward and back conversion filters, the new 
features that were put into Microsoft Office 2010, including the 
following: 

• <AlternateContent>, a mechanism in Office Open XML to define 
storage of a series of alternative representations of content. 

• PowerPoint 2010 extensions to the PPTX Open XML File Format. 

• Excel 2010 Slicers, which are visual controls that allow quick and 
easy data filtering in an interactive way. 

 

Translation Workspace Problems Fixed in Release 1.4 

The following problems found in Translation Workspace were fixed in release 1.4: 

Component Brief Description Full Description 

Web Interface 

and Server 

TM attributes are now displayed if 

the segment comes from a 

background TM linked to the main 

TM. 

In previous releases, TM attributes were not 
displayed in search results if the segments came 
from a background TM linked to the original TM. 
Attributes were displayed correctly if the segment 
came from the original TM that was aliased. This 
problem occurred when aliasing was done on the 
same server or cross server. It has been fixed in 
release 1.4. 

“Missing email address” message 

no longer incorrectly issued. 

In Release 1.3.3, Translation Workspace subscribers 
sometimes received unexpected mail stating 
"Translation Workspace Server: Missing email 
address for project owner." The problem occurred 
with the temporary Analysis TM created for 
Prefetch/Connection optimization. This is now 
fixed. 

Microsoft 

Word Plug-in 

and Translation 

Workspace 

Tools 

Improvement of the handling of 

spaces when converting Chinese 

and Japanese to European 

Languages (during back 

conversion and cleanup)  

In previous releases, when converting Chinese and 
Japanese to European, we were adding an extra 
space after each segment. In Release 1.4, during 
cleanup or back conversion, spaces are added only 
between two segments when an opening tag 
segment is just after the previous closing one (for 
example, :-)(-:). 
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Component Brief Description Full Description 

Back-converted DoNotTranslate 
text is no longer in the wrong 
order in Hebrew and Arabic 
translations.  

In back converted DOCX files in Arabic or Hebrew, 
sometimes text in DoNotTranslate style was not 
displayed in the correct order. This is now fixed. 

To have the correct rendering for Microsoft Word, 

you need to have: 

• Hebrew or Arabic languages defined under the 
Choose Editing Languages section of the MS 
Office Language Preferences tool, or 

• A Hebrew or Arabic keyboard defined on the 
machine, or 

• Regional settings set to Arabic or Hebrew on 
the machine  

Back-converted LTR Latin text is 

no longer in the wrong order in 

Hebrew and Arabic translations. 

In back converted DOCX files in Arabic or Hebrew, 
Latin text inside of bidirectional segments was not 
displayed in the correct order. This is now fixed. 

To have the correct rendering for Microsoft Word, 

you need to have: 

• Hebrew or Arabic languages defined under the 

Choose Editing Languages section of the MS 

Office Language Preferences tool, or 

• A Hebrew or Arabic keyboard defined on the 
machine, or 

• Regional settings set to Arabic or Hebrew on 
the machine  

During back conversion of 

translated Hebrew or Arabic files, 

cursor movement is now correct 

for Latin text in the back 

converted DOCX.  

In back converted DOCX files in Arabic or Hebrew, 
cursor movement within Latin text was not correct. 
This is now fixed. 

To have the correct rendering for Microsoft Word, 
you need to have: 

• Hebrew or Arabic languages defined under the 

Choose Editing Languages section of the MS 

Office Language Preferences tool, or 

• A Hebrew or Arabic keyboard defined on the 
machine, or 

• Regional settings set to Arabic or Hebrew on 
the machine  

Back convert error with Word file 
where equation text is embedded 
in the sentence, causing the Word  
DOCX file not to open, no longer 
occurs. 

In previous releases, when you had text embedded 
in an equation in a DOCX file, you got an error 
causing the file to not open. A math equation is now 
considered as an untranslatable object, which is 
folded and round-tripped correctly. 
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Component Brief Description Full Description 

Special characters are now better 

handled by the Text filter. 

A text file containing special characters, for example 
characters Å Ä Ö, and saved as codepage ANSI 1252 
from Windows Notepad, was not processed 
correctly while using a Text filter LMX configuration 
file that was missing a codepage specification or 
with cp1252 set. This has been fixed in Release 1.4. 

Extension is no longer erased in 

Text Filter Profile Edit dialog. 

When a new Text filter profile was created, and the 
Text Filter Profile Edit dialog was closed by clicking 
OK, but the filter configuration was not saved 
before the Text Filter Profile Edit dialog was 
reopened by clicking Edit in the Configure Filters 
dialog, the previously defined extension in the 
Extensions field was erased. This has been fixed in 
Release 1.4. 

Sibling rules no longer incorrectly 

apply to the prior sibling rule in 

the Text Filter. 

 

In the Text Filter, the sibling rules should be applied 
in order, from first to last. The first rule applies to 
the whole text, from which matched text areas are 
claimed, where only the child rules of the first 
sibling can have access. 

The second sibling rule should have no access to the 
claimed matched areas; it should apply only to the 
remaining unclaimed text. However, in previous 
releases, a second sibling rule was able to intrude 
into the text area claimed by the first rule. This 
overlapping has been fixed in Release 1.4. 

Both Clients For alias TMs, attributes are now 
displayed if the segment comes 
from a background TM linked to 
the main TM. 

In previous releases, TM attributes were not 
displayed in search results if the segments came 
from a background TM linked to the original TM. 
Attributes were displayed correctly if the segment 
came from the original TM that was aliased. This 
problem occurred when aliasing was done on the 
same server or cross server. It has been fixed in 
release 1.4. 

Pretranslation 
via “Translate 
Documents” 
dialog  

Pretranslation of an ES-ES > ZH-CN 
language pair in XLZ files via the 
Translate Documents dialog no 
longer results in pre-translated 
segments without the target 
content. 

In previous release, when you used the Translate 
Documents dialog to pretranslate an XLZ file 
containing the ES-ES > ZH-CN language pair, when 
the source document was auto-detected as UTF-8 
encoded, the resulting target segments were 
empty. This has been fixed in Release 1.4. 

 

Translation Workspace Release 1.3.3 

License Management 

Release 1.3.3 introduced the new Translation Workspace automatic license management model. 
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In previous releases, a subscriber had to manually move licenses from one system user to another, which was a 
time-consuming process, even for organizations with only 10 licenses and 20 users. The system now provides 
an automated assignment of Floating licenses as users login—and the automatic release of licenses with 
logout, in addition to the ability to assign specific users Fixed, or persistent, licenses.  

An admin can assign “Fixed” licenses to users in the Administration > License Management tab. These Fixed 
licenses stay assigned to the user until the admin manually removes them from the "Licensed users" list. Users 
that do not have a Fixed license will get a "Floating" license assigned to them when they login if there are 
licenses available. This license will be assigned to the user for the duration of their session (plus a 15-minute 
period after the session ends, during which only that user can login again with that license). 

If a user logs in, but is denied access because there are no licenses available, they can either wait until a license 
frees up (either by a Floating license user logging out or by an admin removing one of the Fixed licenses), or 
their subscriber can purchase additional licenses at www.geoworkz.com, which become available immediately. 
Note that the subscription user always has a license assigned, which cannot be removed. 

Automatic license assignment applies to logins at both www.geoworkz.com and Translation Workspace (either 
to translate.translationworkspace.com directly, or from the Translation Workspace clients). 

Multiple concurrent logins (which are permitted, but from no more than two client machines) consume only 
one license. 

In the Administration > License Management tab, the admin can search to view a list of users without licenses, 
and move them to the list of licensed users. This list indicates whether the licenses are used as Fixed (key icon) 
or Floating (people icon). It also indicates how many licenses the tenancy has, and how many of these are 
available now.  

The admin cannot manually remove a Floating license. If the admin wants to free up a Floating license, since 
Floating licenses cannot be manually removed, the admin could see from the list of users with licenses which 
users have Floating licenses, and could tell a user to log out, freeing up the license. Alternatively, the admin 
could inform the GeoWorkz subscriber (who might be the same user) that more licenses are needed, and the 
subscriber user could purchase additional licenses. 

Login Restriction 

When a licensed user with the same set of login credentials is already logged into the system from clients on 

two computers, the system now prevents the next concurrent login attempt from a client on a third computer, 

and returns an error message— “You exceeded the number of computers allowed for connecting to Translation 

workspace.” 

There is no limit on the number of concurrent connections you can make from a single computer. You can 

concurrently connect to the server, on a single computer, for example, from the Word Plug-in, the Translation 

Workspace Tools dialogs, and the XLIFF Editor.  

New in Translation Workspace Release 1.3 

The following enhancements to Translation Workspace were made in Release 1.3: 

 

http://www.geoworkz.com/
http://www.geoworkz.com/
http://translate.translationworkspace.com/
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XLIFF Editor 

Enhancement Description 

Machine Translated segment 
handling 

We improved support for recognizing machine translations and set 
correct status for them in batch translate mode: 

• We added the detection of MT segments during pretranslation of 
XLIFF files by create user (<CrU>MT!) name and by origin attribute 
(Origin=MT!). For such segments the state qualifier XLIFF attribute 
is set to "leveraged-mt". 

• The XLIFF Editor now recognize as MT segments the segments 
coming from the TM having the attribute Origin=MT! (in addition 
to segment having Cru=MT!). 

• The XLIFF Editor now recognizes XLIFF segment with 
state_qualifier=leverage-mt as Machine Translation segments. 

Batch Find and Replace We have improved the Batch Find and Replace functionality in the 
XLIFF Editor: 

• You can now run a search from both source and target segments. 
The advanced frame now supports "conditions," allowing you to 
set up additional conditions that source/target/notes must match. 

• The user interface now defaults to search in open documents 
instead of files. Batch Find and Replace now reorders the Search 
options for File search to be more intuitive. It was easy to make 
the wrong selection and search for files when you wanted to 
search in open documents. We rearranged the order to be: 

o Current file set 
o All open documents 
o Current document 
o Search for files 

• The "Search For Files"-specific options are now hidden when 
“Search For Files” is not selected. 

• There is now an option to "Ignore tags" when searching, so all 
linguistic phrases gets matched when only tags differ. This way 
linguistic consistency is easier to maintain. 

 

Web Interface and Clients 

Enhancement Description 

Outage information has been 
added for both current and known 
future outages  

We have added the following outage notices: 

• When you login to the Translation Workspace Web interface or 
connect to the server from a client, you will receive a notification 
of upcoming maintenance outages, including the time and 
duration of the upcoming outage. 

• When you login to the Translation Workspace Web interface or 
connect to the server from a client during an outage, you will 
receive a notification that Translation Workspace is currently 
unavailable due to maintenance. This notification will include the 
expected duration, if known, of the outage. 
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Enhancement Description 

Job queue management In Release 1.3, we have modified job (batch tasks) queue 
management, improving the dispatch of server resources between 
users. We now limit the number of running tasks per user. The default 
limit is set to two tasks. 

 

Translation Workspace Problems Fixed in Release 1.3 

The following problems found in Translation Workspace were fixed in release 1.3: 

Component Brief Description Full Description 

Web Interface 

and Server 

Alias token email Message area is 

now consistently formatted. 

In Release 1.2.1, the email message sent when 

publishing a new TM alias was not formatted in 

the same way the Message area of the Publish 

Alias dialog was formatted. Even if carriage returns 

were used to delineate information in the dialog 

Message field, the text in the resulting email 

became a long unformatted text string, without 

separate lines. This has been fixed in Release 1.3. 

Publish Object Alias window now 

always appears immediately when 

you click Create in the Publish New 

Translation Memory Alias dialog. 

In Release 1.2.1, when publishing an alias, after 

you clicked Create, the Published Object Alias 

window did not always open. After 20 minutes, 

the Publish New Translation Memory Alias dialog 

was still active, and you did not know that tokens 

had been already sent. Because of this, users click 

again and again on the Create button, and a lot of 

tokens are sent for the same TMs to vendors. This 

has been fixed in Release 1.3. 

Published aliases now display 

without error for all tenancies. 

In Release 1.2.1, for some tenancies the list of all 

published aliases didn’t display and showed 

instead the error message “Expected.” This has 

been fixed in Release 1.3. 

All Asset Tagging field contents are 

now copied correctly to the new 

TM from the original with the Copy 

Settings function. 

In Release 1.2.1, there was a problem when you 

used the Copy Settings function to copy Asset 

Tagging field contents to another asset. The 

contents of Company Name and Division fields 

were not copied, although they should be copied. 

The contents of Approval and Status fields were 

copied, although they should not be copied. This 

has been fixed in Release 1.3. 
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Component Brief Description Full Description 

Analysis 100% matches are no longer 

counted as 99% matches after 

number substitution in some cases. 

In Release 1.2.1, in some cases segments 

containing digits that require substitution were 

counted as 99% matches when they should have 

been 100%. This has been fixed in Release 1.3. 

Analysis and 

Pre-translation 

Segment delimiter “colon” is now 

correctly handled. 

In Release 1.2.1, analysis and pre-translation did 

not handle the colon segment delimiter correctly. 

Matches that should have been 100% were 

improperly handled and expected 100% matches 

with colon delimiters failed to get pre-translated.  

See also Segmentation changes below. 

Microsoft 

Word Plug-in 

and Translation 

Workspace 

Tools 

The Document Conversion dialog 

now warns you when you try to 

convert a TTX file to Translation 

Workspace XLIFF. 

In Release 1.2.1, if you converted a TTX file to 

“Translation Workspace XLIFF” via the Translation 

Workspace Document Conversion dialog, it 

created an RTF file, even though the file extension 

was .xlz. This has been fixed in Release 1.3. The 

Document Conversion dialog now warns you “TTX 

conversion to XLZ is not supported in this client. 

Do the conversion with Translation workspace 

XLIFF Editor instead. (Make sure to Pre-segment 

your TTX file first.)” 

Back conversion of XLZ files created 

from PPTX files and including a 

double-byte language now works 

when the Add Intersegment Space 

option is checked. 

In Release 1.2.1, back-converting XLZ files with a 

double-byte language as the source or the target 

failed when the Add Intersegment Space option 

was checked in the Document Back Conversion 

dialog. This is fixed in Release 1.3.. 

Back conversion of XLZ/RTF 

converted from MIF no longer fails 

resulting in Index text length error. 

In Release 1.2.1, when back-converting from MIF 

files created XLZ/RTF files including text in 

languages with no 1252 codepage characters, the 

files did not convert back and an error message 

was displayed: “Index text length exceeds limit of 

255 symbols. Problematic text is + Hex Characters. 

This has been fixed in Release 1.3. Now we 

perform the conversion even if an index is too long 

and we generate a .err file containing warning 

with information on the index exceeding max 

length. 
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Component Brief Description Full Description 

Interactive translation for text with 

tags no longer does not give the 

correct match result. 

In Release 1.2.1, interactive translation did not 

give the correct match result for a segment with 

text separated by tags if the spacing differed from 

the (correct) match in the TM. This has been fixed 

in Release 1.3. 

The Markup Language Assistant no 

longer outputs all non-Latin1 

characters as Unicode escape 

sequences. 

In Release 1.2.1, when writing documents in RTF, 

the Markup Language Assistant outputted all non-

Latin1 characters as Unicode escape sequences, 

even if the source language set for the document 

indicated the use of another codepage (for 

example, Cyrillic) in which the characters could be 

expressed without Unicode escaping. 

 

This has been fixed in Release 1.3 so, that in the 

RTF output the Markup Language Assistant always 

uses the font variant with the same codepage as 

the source language, and not Latin1 as fixed 

default.  

Problems importing Trados.ini files 

have been fixed. 

In Release 1.2.1, trying to import a Trados.ini file in 

the Markup Language Assistant caused Microsoft 

Word and the Translation Workspace Tools to 

crash. This has been fixed in Release 1.3. 

Segmentation Incorrect segmentation of XLZ files 

with the colon stop character no 

longer occurs. We now stop in all 

cases after a colon. 

In Release 1.2.1, after the pattern 

colon<space><lower case character>, we did not 

segment after the colon in XLZ files. This was not 

consistent with our Microsoft Word client and 

batch functions (analysis, pre-translation), which 

stop in all cases after a colon. This has been fixed 

in Release 1.3. 

The Microsoft Word client 

segmenter no longer stops after 

<stop character> in the following 

pattern: <stop 

character><space><lower case 

character>. 

In Release 1.2.1, the pattern <stop 

character><space><lower case character> caused 

segmenting after the <stop character> in the 

Microsoft Word client during interactive 

translation (except for the colon character, as 

described in the entry above). This has been fixed 

in Release 1.3. 

Segmentation is no longer caused 

by a dot followed by non-breaking 

space in XLZ files.  

In Release 1.2.1, the pattern <stop 

character><non-breaking space> caused 

segmenting after the <stop character> in XLZ files. 

This has been fixed in Release 1.3.  
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Component Brief Description Full Description 

Microsoft 

Office 2010 

compatibility 

Back conversion of XLSX files is 

updated to support Office 2010. 

In Release 1.2.1, opening back-converted XLSX 

files in Excel 2010 resulted in a broken file. If you 

then used Microsoft's recovery and clicked Yes, all 

shared strings were lost in the repaired file. This 

has been fixed in Release 1.3. 

We fixed a display issue with the 

connect/disconnect toolbar button. 

In Release 1.2.1, the connect/disconnect toolbar 

button was not displayed properly. This has been 

fixed in Release 1.3. 

An error message is no longer 

displayed when opening Microsoft 

Word 2010 by double clicking on a 

.doc/.docx/.rtf file. 

In Release 1.2.1, when the Microsoft Word Plug-in 

was installed, Microsoft Word 2010 generated a 

VBA error when opening Microsoft Word 2010 by 

double clicking a .doc/.docx/.rtf file. This has been 

fixed in Release 1.3. 

 

New in Translation Workspace Release 1.2.1 

Translation Workspace Release 1.2.1 was dedicated to bug fixes. No new features were added. 

Translation Workspace Problems Fixed in Release 1.2.1 

The following problems found in Translation Workspace were fixed in release 1.2.1: 

Component Brief Description Full Description 

Web Interface 

and Server 

RTF font and style information in 

the background TM is no longer 

incorrectly mapped to the aliased 

foreground TM by Translation 

Workspace, where it caused 

corruption in the target segments 

in both interactive translation and 

pretranslation.  

In Release 1.2, in certain circumstances matches 

from background TMs on an alias contained 

corrupt characters. This mainly affected 

translating (or pretranslating) to languages written 

in non-Latin scripts, such as Chinese, Japanese, 

Korean, Thai, Cyrillic, Greek, Hebrew, Arabic and 

Indic languages. It occurred in cases where RTF 

font or style information in the background TM 

was not correctly mapped to the aliased 

foreground TM by Translation Workspace.  

 

This has been fixed in Release 1.2.1. 

You no longer must have 

“Subscribe to alias” permission for 

all three object types (TMs, 

glossaries, and review packages) to 

subscribe to an alias of one object 

type. 

In Release 1.2, if you did not have “subscribe” 

permissions to all three object types 

(TM_ALIAS_SUBSCRIBE, GLOSS_ALIAS_SUBSCRIBE, 

REVIEW_ALIAS_SUBSCRIBE), you could not 

subscribe to the type for which you did have 

permission. For example, if you had only 
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Component Brief Description Full Description 

TM_ALIAS_SUBSCRIBE permission, you could not 

subscribe to a TM alias. 

 

This has been fixed in Release 1.2.1. You now need 

only the permission for the object type to which 

you are subscribing.  

You can now copy objects (review 

packages and TMs) without losing 

the background links in the copy. 

In Release 1.2, if you copied an object that had a 

background link, the link did not come over in the 

copy. This has been fixed in Release 1.2.1. 

The TAUS integration has several 

improvements.  

The following improvements have been made to 

the TAUS integration (available from the toolbar at 

Resources > TAUS): 

• In Release 1.2, you could encounter problems 

if you did one of the following: 

o Clicked Allow after clicking Proceed to 

TAUS. Now you see the three tabs instead 

of a blank page. 

o Clicked All Uploads on the Uploads tab. 

You no longer get a "Server error" 

message. 

• In addition, the Redirecting to TAUS server 

message has been clarified. 

Microsoft 

Word Plug-in 

and Translation 

Workspace 

Tools 

Incorrect Target language codes 

are no longer ignored in the 

Document Analysis dialog. 

In Release 1.2, users could insert (write or paste) 

incorrect language codes to the Target Languages 

field in the Document Analysis dialog. In Release 

1.2.1, these erroneous language codes are 

detected, and no erroneous language codes are 

included in the analysis log. An erroneous 

language code in the Target Languages field is now 

corrected in the analysis log to the nearest 

matching correct language.  

Analysis results are no longer 

inconsistent across multiple runs. 

In Release 1.2, if you ran Analysis multiple times 

with the same file(s) without closing the analysis 

dialog, you might get different results in some 

cases. This is now fixed, and the analysis result 

does not vary when analyzing the same files. 

101% matches are no longer 

returned as 100% match in the case 

In Release 1.2, with a certain TM configuration and 

a background TM linked with a premium > 0, 

context matches were returned as 100% matches 

in some cases. Changing the premium to 0, or to a 
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Component Brief Description Full Description 

where a background TM has a 

premium. 

penalty retrieved 101% matches correctly. This has 

been fixed, and the 101% matches are now 

correctly retrieved. 

While translating with an Aliased 

TM, the autoterminology window 

now displays the global attributes 

and target language attributes of a 

term coming from a Glossary linked 

to the original TM. 

In Release 1.2, glossary target language attributes 

were not displayed from an aliased TM. In Release 

1.2.1, while translating with an Aliased TM, the 

autoterminology window now displays the global 

attributes and target language attributes of a term 

coming from a Glossary linked to the original TM. 

While translating with an Aliased 

TM, the autoterminology window 

no longer displays terms having the 

status value "Rejected," coming 

from the Glossary linked to an 

aliased TM.  

 In Release 1.2, rejected terms were incorrectly 

displayed on the auto-terminology window from 

glossaries connected on an alias TM (but not when 

connected on the main TM). This has been fixed in 

Release 1.2.1. Rejected terms in glossaries linked 

from aliased TMs no longer display in the 

Autoterminology window. 

The Add Inter-Segment Space 

checkbox in the Document Back 

Conversion dialog and Document 

Cleanup dialog is now unchecked 

automatically when the original 

language setting is changed from 

Chinese or Japanese to some other 

language, like English. 

In Release 1.2, the Add Inter-Segment Space 

checkbox in the Document Back Conversion dialog 

and Document Cleanup dialog was not unchecked 

automatically when the original language setting 

was changed from Chinese or Japanese to some 

other language, like English. 

 

This has been fixed in Release 1.2.1.  

Traditional Chinese characters with 

“\” as the trail byte are now 

correctly handled in Concordance 

searches. 

In Release 1.2, in the Concordance Search window 

of the Word Plug-in, traditional Chinese characters 

with “\” as the trail byte were not correctly 

managed. If you entered such a word in the 

Concordance Search window, and hit Enter, the 

word in the search box changed to another word. 

However, the search result in the Concordance 

window was correct. 

 

Chinese characters with “\” as the trailing byte are 

now correctly handled. Note that the provided 

characters should only be correctly displayed with 

correct Font and Source language specified:  

• SimSun font for Chinese (China) source  

• PMingLiU font for Chinese (Taiwan) source  
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Component Brief Description Full Description 

TM 

Maintenance 

Editor 

Using the Edit segment context 

menu command on the last line of 

Search results in the TM 

Maintenance Editor no longer 

crashes Microsoft Word or displays 

error messages. 

In Release 1.2, using the Edit segment command 

in the TM Maintenance Editor dialog, when the 

cursor was on the last (empty) line of the Search 

results list, caused the Word client to crash or 

display an error message. 

 

This has been fixed in Release 1.2.1. When you 

click the last line it now opens the last segment. 

XLSX Filter The XLSX Filter no longer crashes 

during back conversion when the 

file to be converted is filtered with 

the Excel 2010 “Slicer” feature. 

In Release1.2, back conversion with the XLSX Filter 

crashed when the file to be converted included a 

pivot table filtered with the new Slicer feature of 

Excel 2010. This has been fixed in Release 1.2.1 

and the filter does not crash anymore; however, 

the Excel 2010 Slicer feature is not currently fully 

supported. The back-converted file might not work 

fully in Excel 2010. To get more information about 

these Excel features, click here. 

 

New in Translation Workspace Release 1.2 

The following enhancements to Translation Workspace were made in release 1.2: 

Web Interface and Server Enhancements 

Enhancement Description 

Performance improvement In Release 1.2, we improved database access speed by more intensive 
usage of memory cache. This result in better response time of the Web 
UI actions. 
 
We improved the management of tenancy data access (resulting in a 
lower number of database queries). This improves cross-tenancy 
communication. 
 
We improved inter-server communication, adding multiple internal 
queues in one of the inter-server communications components to 
resolve an issue where low priority requests could block high priority 
requests. This should improve interactive TM lookup speed across 
aliases when under high load. 
  
We significantly reduced the amount of queries sent to the 
administrative database server. 
  
We reduced the amount of data sent to the logging server during 

normal operation. This allows the administrator to choose what level 

http://blogs.msdn.com/b/excel/archive/2009/09/23/easy-and-even-fun-data-exploration-introducing-excel-2010-slicers.aspx
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Enhancement Description 

of log messages to store in the database. By default we no longer send 

debugging messages. 

Task queue throughput and 
management has been improved. 

The task queue (for tasks like analysis reports, imports/exports, 
pretranslate, cleanup, generate an online review report, and unknown 
segment analysis) has been made more efficient, with fewer backlogs. 

You can now select multiple 
aliases for simultaneous 
revocation. 

In Translation Workspace 1.1, you could only revoke one alias at a 
time. Now, when you view the Published Alias List, you can select 
multiple aliases and click Revoke.  

You can now select multiple 
members of an object for 
simultaneous removal. 

In Translation Workspace 1.1, you could only remove one member at a 
time from an object (workgroup or asset). Now, when you view the 
Members list, you can select multiple users and click Remove.  

You can now delete a specific 
language from a TM configuration. 

In Translation Workspace 1.1, you could only remove all unused 
languages from a TM. Now you can select one or more particular 
languages for removal, Using the Languages > Remove Selected 
Languages button. 

You can now search by language 
on the Asset Retrieval page. 

On the Asset Retrieval page, you can now search by language and 
language pair in glossaries and TMs. You can specify source, target or 
source and target languages as search criteria.  

You can now search by volume of 
TUs and terms in the Asset 
Retrieval page. 

When searching for tagged assets, you can now specify both a 
minimum and maximum number of TUs (for TMs) or terms (for 
glossaries).  

You can now access your private 
TAUS TM repositories from 
Translation Workspace. 

Via the new Resources > TAUS menu pick, you can access your private 
TAUS TMs that reside outside of the Translation Workspace server. 
You can search, download, and upload your TAUS TMX files from the 
Translation Workspace interface. 

There is now a limit on the size of 
an import into a TM. 

Translation Workspace now sets a limit on the number of segments 
per language pair direction that you can import into a TM. If you try to 
import a file that exceeds this limit, you will get a message saying "TM 
size limit reached." This limit applies to TM size as the result of an 
import, and does not apply to TM size resulting from interactive 
translation or cleanup. 

All language select fields now 

have auto-complete. 

We have added auto-complete to the following language select lists: 

• Glossary Import Target language (Glossary > Import tab)  

• TM Export Source/Target languages (TM > Export tab)  

• TM Analyze Source language (TM > Analyse tab)  

• TM Search Source/Target languages (TM > Search tab 

Word Plug-in 

Enhancement Description 

Text filter added to Markup 
Language Assistant. 

Translation Workspace can now generate tagged files (RTF / XLIFF) 
from text files in different formats using tagging rules provided in 
special configuration files. These rules are defined in a filter profile for 
every different input format by means of tree of Regular Expressions. 
This feature is accessed via the new TEXT tab in the Configure Filters 
dialog. 
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Enhancement Description 

Back conversion and Cleanup It's now possible to insert spaces between segments into the target file 
during back convert and cleanup. This is useful when translating from 
some East Asian languages into languages that use space as 
separators. 

Translation Workspace Tools 

Enhancement Description 

Text filter added to Markup 
Language Assistant. 

Translation Workspace can now generate tagged files (RTF / XLIFF) 
from text files in different formats using tagging rules provided in 
special configuration files. These rules are defined in a filter profile for 
every different input format by means of tree of Regular Expressions. 
This feature is accessed via the new TEXT tab in the Configure Filters 
dialog. 

Back conversion and Cleanup It's now possible to insert spaces between segments into the target file 
during back convert and cleanup. This is useful when translating from 
some East Asian languages into languages that use space as 
separators. 

XLIFF Editor 

Enhancement Description 

Toggle case It's now possible to toggle the case of selected text. To do so, use the 
new "Toggle Case" option in the Edit menu. 

Back conversion and Cleanup It's now possible to insert spaces between segments into the target file 
during back convert and cleanup. This is useful when translating from 
some East Asian languages into languages that use space as 
separators. 

Online Review Client 

Enhancement Description 

File Preview added for both 
source and target content. 

You can now preview the rendered state of the file you are reviewing 
in the Online Review Client. Preview > Preview Source and Preview > 
Preview Target are available in the Online Review Client toolbar. 
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Translation Workspace Problems Fixed in Release 1.2 

The following problems found in Translation Workspace were fixed in release 1.2: 



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 313 

 

Component Brief Description Full Description 

Web Interface Aliases now preserve all the 
advanced settings of the original 
TM. 

In Release 1.1, some advanced settings of the 
original TM were not preserved in the Aliased TM. 
“Include only context matches in batch 
translations” and “Automatically correct differing 
formatting to default style definitions” were not 
preserved. 
 
This has been fixed in Release 1.2. 

In Asset Retrieval, if two of your 
three search parameters are out-
of-range dates, you no longer get 
the misleading message “At least 3 
parameters required for search.” 

In Release 1.1, if you entered dates outside of the 
accepted UNIX date range (less than 01.01.1970 or 
more than 01.01.2038), the error message was “At 
least 3 parameters required for search.” In Release 
1.2, Translation Workspace compresses the date 
range to the largest acceptable range and 
proceeds. 

In Asset Tagging, you no longer can 
type free-form text into the 
Domain and Subject area field. 

In Release 1.1, you could type free-form text into 
the Domain and Subject area fields for TM 
metadata, and you did not get an error message, 
though what you typed in did not persist when 
you went to other parts of the UI. In Release 1.2, 
when you start typing, it auto-completes potential 
selections, and the fields are drop-down lists. 

Company names added to the 
Company List for Asset Tagging no 
longer generate “Unknown 
company” error. 

In Release 1.1, sometimes when you added a 
company to your Company List via Administration 
> Tagging Management, when you then went to a 
TM and selected the Properties > Asset Tagging 
tab and clicked Save, then Refresh, you got the 
message “Error saving the asset tagging. Unknown 
company.” This has been fixed in Release 1.2.  

“Subscribing to an Alias” link on 
Welcome page now goes directly to 
the “Subscribing to an Alias” 
section of the Asset Aliasing topic. 

In Release 1.1, clicking the “Subscribing to an 
Alias” link on Welcome page went to the 
“Publishing an Alias” section of the Asset Aliasing 
topic. Now it goes directly to the “Subscribing to 
an Alias” section. 

When you select multiple aliases 
and click Unsubscribe, all of the 
selected aliases are now 
unsubscribed.  

In Release 1.1, when you selected multiple aliases 
and clicked Unsubscribe, only one of the aliases 
was unsubscribed. Now all of the selected aliases 
are unsubscribed. 

You no longer remove an assigned 
member of an object when 
selecting its inherited instance. 

In Release 1.1, if you selected for removal an 
inherited member (user1 grayed out), the same 
assigned member (user1) was removed. Now, 
removing an inherited member does not impact 
the same active member of the object. 

You can now view the XML analysis 
report. 

In Release 1.1, when you tried to view the XML 
version of the document analysis report, you 
might get the message “The XML page cannot be 
displayed.” This has been fixed in Release 1.2. 
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Microsoft 
Word Plug-in 
and Translation 
Workspace 
Tools 

You no longer must click Cancel 
twice to cancel when you are 
connecting to the server. 

In Release 1.1, if you were performing operations 
like Current Document > QA Tools, Document > 
Strip Tagged RTF, and so on, the first time you 
clicked Cancel, the login screen displayed. You 
needed to click Cancel again to close the form. 
This has been fixed in Release 1.2. 

Contents of the results file from the 
Document Cleanup dialog no 
longer contains paths to temp files, 
rather than to the actual DOC files. 

In Release 1.1, if you inserted a path and filename 
for a results file in the Document Cleanup dialog, 
it returned paths to temp files, rather than to the 
actual DOC files. This has been fixed in Release 1.2. 

“Unknown user or wrong 
password" message no longer 
displays on valid relogin.  

In Release 1.1, if you checked the "Allow 
Translation Workspace to store the password for 
15 minutes" checkbox in the login screen from the 
client, then logged out and tried to login again 
within 15 minutes, you got the message 
“Unknown user or wrong password." This has 
been fixed in Release 1.2. 

You now get a correct message 
when you delete a file that is 
currently in a Document 
Conversion, Document Back 
Conversion, Document Analysis, or 
similar dialog.  

In Release 1.1, if you added a file to a Document 
Conversion, Document Back Conversion, 
Document Analysis, or similar dialog, then deleted 
that file from disk, you got no error message when 
you tried to perform a file operation in the dialog. 
This has been fixed in Release 1.2. 

SGML files are now found in Add 
Files browser in Document 
Conversion dialog. 

In Release 1.1, if you clicked Add Files in the 
Document Conversion dialog, files with the .sgml 
extension would not be presented for selection in 
the file browser. This has been fixed in Release 
1.2. 

Chat input box no longer restricts 
you to 20 characters. 

In Release 1.1, the Chat input box restricted you to 
20 characters, making it impossible to enter a 
username of more than 20 characters. In Release 
1.2, the input box allows 40 characters, the limit 
for usernames. 

XLIFF Editor Files containing nesting of groups 
no longer miss some segments in 
Analysis, Pretranslation, and Add to 
TM operations. 

In Release 1.1, if you had files that contained 
nesting of groups, processing in some cases would 
end early and not include all segments in Analysis, 
Pretranslation, and Add to TM operations. This has 
been corrected in Release 1.2. 

You now can open files if your 
Word client version is 2.88 or older. 

In Release 1.1, if you had Translation Workspace 
Word client version 2.88 or older installed, it was 
not possible to open any files with the XLIFF 
Editor. This is now fixed. 

You now can perform Batch Find 
and Replace if the file path contains 
non-ASCII characters. 

In Release 1.1, Batch Find and Replace was not 
possible if path contained non-ASCII characters. 
This is now fixed. 
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You now can perform Auto 
Translate in Batch operations when 
the XLIFF has TUs containing only 
whitespace that are set to 
translatable. 

In Release 1.1, if the XLIFF file contained 
translation units that were set as translatable and 
contained only whitespace, an error was given and 
the auto translation of the file was halted. 
Remaining files in the batch auto translated after 
such a file could result in misaligned translations. 
This is now Fixed. 

INX Filter InDesign text “on path” is now 
correctly exported for translation.  

In Release 1.1, if you had an INX file that included 
text “on path,” that text was not presented for 
translation after conversion I the Markup 
Language Assistant, and was incorrectly aligned in 
the back conversion. This has been corrected in 
Release 1.2. 

When opening the back converted 
INX file, the style (font, size, color) 
for some text is no longer lost 

In Release 1.1, in some cases, when you back 
converted an INX file and opened the back 
converted file, the paragraph style (font, size, 
color) for some text was lost. This has been 
corrected in Release 1.2. 

PPTX Filters Back convert for PPTX files 
containing “AlternateContent” no 
longer gives “Run property for 
"xxxx" is out of range” error. 

In Release 1.1, when you tried to back convert 
some specific (containing AlternateContent) 
Tagged PPTX, the back converted PPTX file 
opened, but with an error message saying that 
some slides were corrupted and replaced with 
blank slides. This has been corrected in Release 
1.2. 

Right-to-Left (RTL) text is now 
correctly aligned after PPTX back 
conversion. 

In Release 1.1, when you back converted a PPTX 
file with RTL text like Arabic, the text was rendered 
left-to-right. This has been corrected in Release 
1.2. 

 



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 316 

 

New in Translation Workspace Release 1.1 

The following enhancements to Translation Workspace were made in release 1.1: 

Web Interface and Server Enhancements 

Enhancement Description 

Client Download page The client download page (Resources > Download from Web interface 
toolbar) has been modified to use the stylesheet of the other pages. 
The Word client and XLIFF Editor release notes are now included in 
these release notes that you are reading, which is now linked to from 
the Download page. 

Subscribing to an Alias link on 
Welcome page 

For quick access to the documentation for how to subscribe to an alias, 
a link to the Asset Aliasing help topic, in which subscribing is described, 
has been added to the Translation Workspace Web interface landing 
page—the Welcome page.  

Asset Tagging You can now tag your TMs and glossaries with metadata that can be 
used to search for appropriate assets. For details, see the “Asset 
Tagging” topic in the Web interface help system. 
 
The Asset Tagging tab is available on the Properties tab for a TM or 
glossary. There is also a wizard for asset tagging during asset creation. 
  

Note:  Depending on your plan type, asset tagging might be mandatory. If 
it is mandatory, you will have to tag the mandatory fields during 
project creation before you can click the Create button to create 
the new asset. 

Asset Retrieval You can now use the Asset Retrieval feature, available from the Asset 
Retrieval tab on the toolbar, to search for assets that have been 
tagged with metadata such as project information, content type, and 
status. You can also search on administrative fields like asset name, 
creation date, change date, and change user. For details, see the 
“Asset Retrieval” topic in the Web interface help system. 

Asset Tagging permissions Two Admin permissions for showing and modifying the settings of 
one’s tenancy have been added to the Administration > Role 
Management system permissions list.  

Asset Tagging company list The ability to create a company list from which to select for your asset 
tagging has been added to the Administration > Tagging Management 
page of the Web interface toolbar. For instructions on adding a 
company list, see the “Populating the Company List” section of the 
“Asset Tagging” topic in the Web interface help system. 

TM and Glossary creation wizards To accommodate that tenancies of certain plans will have mandatory 
asset tagging, the TM and glossary creation process has added a 
wizard in which you can tag the asset during the creation process. If 
asset tagging is mandatory for your tenancy, you will not be able to 
click Create to create the asset until you have tagged the mandatory 
fields. For a description of the TM creation wizard, see the “Creating a 
New Translation Memory” topic of the Web interface help system. For 
the glossary creation wizard, see the “Creating a Glossary” topic. 
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Enhancement Description 

Asset Aliasing – Send tokens When you publish an alias, the Email field now supports an auto-
complete functionality with a pick-list from already typed emails, 
making it easier to send tokens to existing suppliers.  

Asset Aliasing – Control of re-
aliasing 

An alias permission has been added (Allow Re-publish) that allows you 
to control whether the alias you publish can be re-aliased by the 
recipient. 

Asset Aliasing – Control of 
whether names of background 
links are shown 

An alias permission has been added (Show name of background links) 
that allows you to control whether the names of background links to 
the asset you are aliasing are shown to alias users. By default, they 
cannot see the actual name of the background link; instead, they see 
the alias name for all matches, whether they come from a background 
link or from the alias. 

Asset Aliasing – Customize token 
email Subject line 

When you publish an alias, you can now customize the Subject line 
that the recipient will see in the email. 

Word count analysis – Extended 
mode 

A Use Extended Mode option has been added to the Analyse Options 
on the Analyse tab when you run an analysis report, for use with 
languages using ideographs. In extended mode, Translation Workspace 
calculates the following statistics: 
• Segments – Number of segments 
• Words – Number of words (always 0 for Chinese, Japanese, and Thai. 
Korean uses space so its words are counted properly in extended 
mode. 
• Characters – Number of non-whitespace, non-modifier characters 
• Ideographs – Number of ideographic characters 
• Metered Words – Same as words for most languages except for 
Chinese, Japanese, Korean and Thai where it is number of “characters 
/ factor”  

 

Word Plug-in 

Enhancement Description 

Word count analysis – Extended 
mode 

A Use Extended Mode option has been added to the Document 
Analysis dialog when you run an analysis report, for use with 
languages using ideographs. In extended mode, Translation Workspace 
calculates the following statistics: 
• Segments – Number of segments 
• Words – Number of words (always 0 for Chinese, Japanese, and Thai. 
Korean uses space so its words are counted properly in extended 
mode. 
• Characters – Number of non-whitespace, non-modifier characters 
• Ideographs – Number of ideographic characters 
• Metered Words – Same as words for most languages except for 
Chinese, Japanese, Korean and Thai where it is number of “characters 
/ factor”  

New “None” option in Back 
Convert dialog 

With this new option, no characters are escaped to entities. 
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Enhancement Description 

Characters outside the selected code page are not escaped to entities. 
They are replaced by the character “?”. 
Also none of the XML/HTML special characters like "<" are escaped. 

 

XLIFF Editor 

Enhancement Description 

New icons in toolbar and menus Icons for Run QA Check, Spell Check, and Batch Find and Replace have 
been added to the XLIFF Editor toolbar and to the Tools menu. 

File Set Browser plug-in A new plug-in (File Set Browser) can be enabled in the Tools menu. 
The File Set Browser lists files you are working on and their status, to 
allow for easy navigation and status overview. For details see the “File 
Set Browser” section of the “Tools Menu” topic in the XLIFF Editor help 
system. 

QA Check for spacing differences A new QA check (Tools > QA Check Configuration > Format Checks > 
Leading/Trailing White Space) has been added that identifies spacing 
differences (between the source and target segments) surrounding 
Tags. 
Another QA check (Tools > QA Check Configuration > Format Checks > 
White Space Surrounding Placeholders) has been added for 
identifying if the leading and trailing spaces in source and translations 
are not the same. 

Batch Search & Replace option A new Current File Set option has been added under the Xliff Batch 
Find and Replace window allows you to search and replace on the files 
from an opened File Set package. 

Word count analysis – Extended 
mode 

A Use Extended Mode option has been added to the Batch Operations 
> Analyze tab, when you run an analysis report, for use with languages 
using ideographs. In extended mode, Translation Workspace calculates 
the following statistics: 
• Segments – Number of segments 
• Words – Number of words (always 0 for Chinese, Japanese, and Thai. 
Korean uses space so its words are counted properly in extended 
mode. 
• Characters – Number of non-whitespace, non-modifier characters 
• Ideographs – Number of ideographic characters 
• Metered Words – Same as words for most languages except for 
Chinese, Japanese, Korean and Thai where it is number of “characters 
/ factor”  

Chat Double bytes languages are now supported in the Chat function. 

Translation Workspace Tools 

Enhancement Description 

Word count analysis – Extended 
mode 

A Use Extended Mode option has been added to the Document 
Analysis dialog, when you run an analysis report, for use with 
languages using ideographs. In extended mode, Translation Workspace 
calculates the following statistics: 
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Enhancement Description 

• Segments – Number of segments 
• Words – Number of words (always 0 for Chinese, Japanese, and Thai. 
Korean uses space so its words are counted properly in extended 
mode. 
• Characters – Number of non-whitespace, non-modifier characters 
• Ideographs – Number of ideographic characters 
• Metered Words – Same as words for most languages except for 
Chinese, Japanese, Korean and Thai where it is number of “characters 
/ factor”  

New “None” option in Back 
Convert dialog 

With this new option, no characters are escaped to entities. 
Characters outside the selected code page are not escaped to entities. 
They are replaced by the character “?”. 
Also none of the XML/HTML special characters like "<" are escaped. 
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Translation Workspace Problems Fixed in Release 1.1 

The following problems found in Translation Workspace were fixed in release 1.1: 

Component Brief Description Full Description 

Web interface 

 

  

Object tree now refreshes after you 
subscribe to an alias. 

In Release 1.0.3, the object tree did not refresh 
when you subscribed to an alias. You had to 
manually click Refresh. Now the object tree is 
automatically refreshed. 

Subscriber now sees message when 
an alias has been revoked. 

In Release 1.0.3, if the publisher of an alias 
revoked the alias, subscribers could still try to 
access the aliased object. Now, when the 
subscriber tries to access the object, a message 
displays saying "The alias is suspended or 
revoked." 

You are no longer unable to add a 
user as a member of an object due 
to default role assignment. 

In Release 1.0.3, in some cases it was impossible 
for a user to add as an object member anyone 
whose System Permission Role was higher than 
the assigner’s current Object Role. You would get 
the error “Adding the user with the selected role 
would lead to privilege escalation.” This has been 
fixed in Release 1.1. 

The Role Management “Rename 
Role” button is no longer available 
before selecting any Role. 

In Release 1.0.3, the “Rename Role” button was 
available before you actually selected a role. This 
has been fixed in Release 1.1. The button doesn’t 
appear until you have selected a role. 

Segments without author's name 
can now be exported. 

In Release 1.0.3, if you tried to export a segment 
that was missing the author’s name, the export 
would fail as "undefined.” This has been fixed in 
Release 1.1. 

When a language pair is removed, 
the metadata applying to other 
language pairs is no longer 
removed. 

In Release 1.0.3, if you assigned Quality ratings to 
different language pairs, then removed one of the 
language pairs, the rating was removed from all 
the language pairs. Now the ratings for the pairs 
that have not be removed are retained. 

 Translation Workspace no longer 
incorrectly detects an alias search 
loop that prevented you from 
linking a TM in some cases. 

In Release 1.0.3, in certain cases, Translation 
Workspace incorrectly detected a potential Alias 
search loop when adding background links to a 
TM, and generated the error message "This link 
would create a cyclic dependency and cannot be 
established." This has been fixed in Release 1.1. 

Words translated via a cross-server 
alias TM are now available when 
running a report on the aliased TM. 

In Release 1.0.3, the reporting feature providing 
statistics on translation progress was not taking 
into account word translated through a cross 
server alias. This has been fixed I Release 1.1. 

The Create New button in the 
object tree is now clickable 

In Release 1.0.3, to open the Create New menu 
button in the object tree in the navigation pane, 
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Component Brief Description Full Description 

you had to click the small down arrow of the 
menu. You can now click anywhere on the button. 

Online Review 

Client 

Column alignment display issues 
have been fixed for Firefox versions 
3 and 3.5. 

In Release 1.0.3, if you resized the Category, 
Severity, or Status columns, you encountered 
column alignment problems. This has been fixed in 
Release 1.1. 

You no longer get a misleading 
message if you login to Online 
Review Client after your tenancy 
has been suspended. 

In Release 1.0.3, if your tenancy has been 
suspended and you try to login when accessing the 
Online Review Client, you got the message “tenant 
not active on this server.” The message now says 
"This tenancy is suspended, please check with 
your administrator or contact support for more 
information.” 

Microsoft 

Word Plug-in 

Error message now displays when 
an incorrect TTX file is dragged into 
the Convert dialog. 

In Release 1.0.3, if you dragged an incorrect TTX 
file into the Convert dialog, the file appeared in 
the dialog but could not be converted. In Release 
1.1, when you try to drag an incorrect TTX file into 
the dialog, you get a message indicated that you 
should use the Convert TTX to RTF dialog. 

Microsoft 

Word Plug-in 

and Translation 

Workspace 

Tools 

TM Export dialog now is sized 
better for long TM names. 

In Release 1.0.3, if the filename of the TM you are 
exporting is long, the end of it was truncated in 
the display. This has been fixed in Release 1.1. 

Tab order for Document Cleanup 
dialog has been corrected. 

In Release 1.0.3, if you tabbed from the Add Files 
button in the Document Cleanup dialog, the focus 
went to the Cancel button. This has been fixed in 
Release 1.1. The tab sequence now goes from top-
to-bottom, left-to-right through the options. 

In the Document Analysis dialog, 
the default focus has been changed 
from the Done to the Analyse 
button. 

In Release 1.0.3, the default focus of the 
Document Analysis dialog was the Done button. It 
has been changed to the Analyse button. 

In the Document Cleanup dialog, 
the Delete Inter-segment Spaces 
option is no longer incorrectly reset 
to false after certain actions. 

In Release 1.0.3, in the Document Cleanup dialog, 
the Delete Inter-segment Spaces option was 
incorrectly reset to off after certain actions. This 
has been fixed in Release 1.1. 

Confirmation prompt now displays 
in TM Maintenance Editor for 
Replace function.  

In Release 1.0.3, because by default the “Replace 
<Source/Target> with” with field is blank, 
searched words were "deleted" by a user who 
clicked one of these replace buttons. In Release 
1.1, users are first prompted to confirm whether 
they want to do this. 

Filters MIF Filter: Conversion of certain 
structured MIF Version 9 files no 
longer crashes the client. 

In Release 1.0.3, conversion of a structured MIF 
Version 9 sometimes caused the client to crash. 
This has been fixed in Release 1.1. 
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Component Brief Description Full Description 

Master pages are now extracted 
from Structured MIF files. 

In Release 1.0.3, for Structured MIF (Version 9) 
files, text from the Master Page was not extracted 
for translation. This has been fixed in Release 1.1. 

For the MIF Filter, the error 
message generated in back 
conversion if the translated Index 
text exceeds the 255 characters 
limit has been improved. 

In Release 1.0.3, when an index entry exceeded 
the 255 character limit, no diagnostic information 
was supplied. Now, text describing the problem 
has been provided for reference in the error log. 

XLSX Preview The preview for XLSX files is much 

quicker. 

In Release 1.0.3, it took a long time for the 

preview to display for XLSX files. The preview is 

much quicker in this release. 

PPTX Preview Wingdings now display in preview. In Release 1.0.3, when you previewed a PPTX file, 

none of the Microsoft Wingdings displayed. This 

has been fixed in this release. 

Right-to-Left 

rendering in 

Back Convert  

DOCX, PPTX, and XLSX files for RTL 

languages now render correctly 

when back converted. 

In Release 1.0.3, when you ran Back Convert on 

DOCX, PPTX, and XLSX files that render from right-

to-left, they rendered left-to-right. This has been 

fixed in this release.  

HTML files for RTL languages now 

render correctly when back 

converted. 

In Release 1.0.3, when you ran Back Convert on 

HTML files that render from right-to-left, they 

rendered left-to-right. This has been fixed in this 

release.  

XLSX Filter back conversion no 
longer fails when sheet contains 
hidden data. 

In Release 1.0.3, when hidden text in an XLSX file 
contained special XML characters, back conversion 
failed. This has been fixed in Release 1.1. 

DOCX Filter no longer fails in back 
conversion when file has complex 
embedded text boxes. 

In Release 1.0.3, back conversion of DOCX files 
with complex embedded text boxes failed with a 
DLL return value of -8 and an error log with “Run 
out of paragraph.” This has been fixed in Release 
1.1. 

Terminology Auto and manual client 
terminology lookup no longer fails 
in certain cases. 

In Release 1.0.3, the terminology look-up might 
fail in two cases 

• If a TM was used as a dictionary and the 
initially found segment contained RTF code, it 
usually did not return the match. 

• Short (<3) character terms that are not Latin-1 
might not be searched for at all. 

This has been fixed in Release 1.1.  

Chat Double-byte Chat support has been 
added.  

In Release 1.0.3, if you typed double-byte 
language characters in the message input field, the 
text was garbled when submitted. This has been 
fixed in Release 1.1. 
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New in Translation Workspace Release 1.0.2 

Informational messages can now be displayed in the Translation Workspace clients login. If we need to inform 

you about new releases or issues, we can include them in a message that displays when you connect to the 

server from the Microsoft Word Plug-in, Translation Workspace Tools, or XLIFF Editor 

Translation Workspace Problems Fixed in Release 1.0.2 

The following problems found in Translation Workspace were fixed in release 1.0.2: 

Component Brief Description Full Description 

Handling of 

Chinese, 

Japanese, and 

Korean 

 

Manual term search and 
Autoterminology for separate 
words is now handled well. 

• In Translation Workspace release 1.0.1, manual 
term search was not working for CCJK as the 
source language with the Word client. The 
search input field in the search dialog box did 
not support CCJK. This has been fixed in Release 
1.0.2. 

• In Release 1.0.1, Autoterminology was not 
working for separate words in a segment for 
CCJK as source due to a minor codepage 
conversion problem. This has been fixed in 
Release 1.0.2. 

Web interface Error message no longer displays 

when you select the parent 

workgroup and copy TM settings. 

In Release 1.0.1, if you selected the same parent 

workgroup as the TM whose settings you want to 

copy, you got an error message. You can now 

always copy a TM (with just the settings of the 

original) when you select the parent workgroup. 

You no longer get an error message 

when you try to view or edit a 

background link for some TMs.  

In Release 1.0.1, some background links remained 

visible after the object was deleted. If you tried to 

view or edit this background link, you got an error 

message. This problem has been fixed in Release 

1.0.2. 

Response time is no longer slow 

when an object has many users 

assigned. 

In Release 1.0.1, if an object had many users 

assigned to it, the Translation Workspace Web 

interface had slow responsiveness. This has been 

fixed in Release 1.0.2. 

Country and US State do not 

display properly in User 

information. 

In some cases when displaying the Edit User dialog 

that shows the user information, the Country and 

US state fields showed the country code instead of 

the full name. This has been fixed in Release 1.0.2. 

Users can no longer start to create 

objects without the requisite 

permissions. 

In Release 1.0.1, users without the “Create” 

permission could begin to create TMs, glossaries, 

and review packages. They could fill in information 

like name and description. Only when they then 

clicked the Create button would they get an error 
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Component Brief Description Full Description 

message. The message that they do not have the 

requisite permissions is now displayed at the start. 

“Expected ‘}’" error message no 

longer displayed when assigning 

users to objects. 

In Release 1.0.1, if you tried to add a corrupted user 

name or role to an object in the User Assignment 

pane, you got the error “Expected ‘}’". This has 

been fixed in Release 1.0.2. 

XLIFF Editor Rendering of Japanese is no longer 
slow. 

In Release 1.0.1, the rendering of Japanese could be 
slow. This has been fixed in Release 1.0.2. 

Right to left source language now 

displays correctly. 

In Release 1.0.1, if the source language was a right 

to left language, it did not display correctly in the 

Document View and an index error was displayed 

when copying source into target segment. This has 

been fixed in Release 1.0.2.. 

Extra space no longer inserted by 

the “Auto text” feature.  

In Release 1.0.1, when you inserted a phrase using 

the "Auto text" feature, a space was inserted at the 

end if the inserted phrase but not shown until 

segment was closed. This has been fixed in Release 

1.0.2. 

Microsoft 

Word Plug-in 

1 or 2 character consonants were 
incorrectly recognized as an 
acronym when followed by tags. 
This affected the leveraging 
substitution engine, which 
provided a fuzzy match instead of 
100% in certain cases. 

In Release 1.0.1, if you stored a segment with 1 or 2 
character consonants, immediately followed by 
tags, then deleted the tags from a source segment 
and tried to get a match from the TM, you got a 
fuzzy match without any explanation. This has been 
fixed in Release 1.0.2. You now get a 100% match. 

Reports Reports now show the full 

hierarchy of the workgroup path in 

the Workgroup column. 

In Release 1.0.1, the Workgroup column of a report 

run from the Reports tab of the Translation 

Workspace Web interface toolbar showed only the 

workgroup name. Now it shows the full workgroup 

path.  

Segmentation 

Engine 

Thai source text is now segmented 

the same in the Microsoft Word 

Plug-in for pre-translation and 

interactive translations.  

There are no longer differences in the way Thai 

source text is segmented during pre-translation and 

interactive translation. In Release 1.0.1, in the 

Microsoft Word Plug-in, interactive segmentation 

might wrongly split sentences for Thai. 

Segmentation handling for 

abbreviations in XLIFF output is no 

longer different from the Microsoft 

Word Plug-in. 

In Release 1.0.1, abbreviations were segmented 

differently in the XLIFF filter output than in the 

Microsoft Word Plug-in. For example, in an XLZ file, 

a new segment started after "e.g.". This 

inconsistency has been fixed in Release 1.0.2. 
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Component Brief Description Full Description 

Country list The list of countries has been 

synchronized with ISO 3166. 

In Release 1.0.1, some countries were out of 
synchronization with the ISO 3166 list. This has 
been fixed in Release 1.0.2. These countries 
included: 

• The language code for Serbian has been 
changed from "sr-cs" to "sr-rs". 

• The language Portuguese (East Timor) with the 
language code "pt-et" has been replaced by 
language Portuguese(Timor-Leste) with the 
language code "pt-tl". 

• We added "Serbian Montenegro" with language 
code "sr-me". 
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Translation Workspace Problems Fixed in Release 1.0.1 

The following problems found in Translation Workspace were fixed in release 1.0.1: 

Component Brief Description Full Description 

Web interface Session timeout - Incorrect error no 

longer appears after timeout 

In Release 1.0, if you tried to publish an alias after 

leaving a session idle for more than 2 hours, the 

error message "No Logoport Client version 

detected. This is a protocol 

error.%5200e03c6be7137f%" might appear. This 

has been fixed in Release 1.0.1. 

TM Search and Restore Review 

Package - Border of edit box was 

not visible 

In Release 1.0, if you were using Internet Explorer 7, 

the bottom border of the TM Search text field might 

not be visible. Similarly, the top border of the Select 

File box of the Restore Review Package from Backup 

dialog might not be visible. This has been fixed in 

Release 1.0.1. 

Login page: Pressing Enter to select 

auto complete suggestion triggered 

an invalid login 

In Release 1.0, if you logged into your tenancy with 

different credentials, and your browser had saved 

your login information, you might select one of the 

suggestions using the Enter key. This would trigger 

a login before the correct value is set, resulting in 

an error. This has been fixed in Release 1.0.1. 

Note:  Auto-complete is not working for Internet 
Explorer 6, 7, and 8. 

Session time out, Pressing OK didn't 

put you to login page 

In Release 1.0, if your session timed out, you got an 

error message when you tried to perform any 

actions. When you pressed OK to clear the error, 

you were not sent to the login page – you remained 

on the current page, but couldn’t perform any 

actions. This has been fixed in Release 1.0.1. 

When restoring a Review Package, 

the object tree should refresh 

automatically, but didn’t. 

In Release 1.0, when restoring a Review package, a 

refresh of the object tree should occur 

automatically, but instead the user needed to 

refresh the tree manually to see the new object. 

This has been fixed in Release 1.0.1. 

Wrong permission check for 

Workgroup_list 

When the WORKGROUP_LIST permission was 

assigned to a user we were wrongly testing the 

GLOSS_LIST permission instead. This has been fixed 

in Release 1.0.1. 

Microsoft 

Word Plug-in 

Opening chat immediately 

following a concordance search 

might crash Word. 

In Release 1.0, if you performed a concordance 

search and immediately thereafter opened a chat 
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Component Brief Description Full Description 

session, Word might crash. This has been fixed in 

Release 1.0.1. 

DOCX Filter: Text marked with 

“Markup” internal style might 

wrongly be extracted in 

DoNotTranslate style. 

In some cases, text marked in “Markup” style in the 

source DOCX file is extracted in “DoNotTranslate” 

style in the RTF file, thus causes segmentation 

issues. This has been fixed in Release 1.0.1. 

DOCX Filter: Back conversion of 

some particular file generated a 

fatal error. 

When back converting some particular DOCX 

prepared file you got a Fatal Error from the parser 

due to overlapped attribute name. This has been 

fixed in Release 1.0.1. 

Translation 

Workspace 

Tools and 

Microsoft 

Word Plug-in 

When performing cleanup on both 

XLZ and RTF files simultaneously, 

unexpected results could occur. 

In Release 1.0, if you tried to clean both types of 

files at the same time, segments from the file type 

last added to the cleanup dialog would not be 

added to the TM. If added last, result files and .bak 

files for RTF files would not be generated, and 

cleaned XLZ files would have a 0 byte size. This has 

been fixed in Release 1.0.1. 

 

Training and Documentation 
Please take advantage of the downloadable and streaming self-training materials and the instructor-

led courses listed in the Training & Tutorials page of the Support tab at http://www.geoworkz.com. The 

self-training materials include Flash demos of many of the more sophisticated procedures in the 

Translation Workspace Web interface, XLIFF Editor, Microsoft Word Plug-in, and Translation 

Workspace Tools.  

You will also find there, on the Documentation page (and at Resources > Help in the Translation 

Workspace Web interface), help systems for the Web interface, the Microsoft Word Plug-in, the XLIFF 

Editor, the Translation Workspace Tools, and the Online Review Client. Each of these help systems 

has a Table of Contents, an index, and search facilities for quickly finding solutions to your questions. 

The Documentation pages also have guides for filters and file format handling and for migration and 

interoperability with other CAT tools like SDL Trados and Idiom WorldServer. 

Updates to the Documentation Sets for Release 1.16.6 after Release 1.16.5 
In addition to documenting the new features for Release 1.16.6, the following improvements were 

made to the documentation set: 

▪ All helps are now output with a HTML5 skin. 

Updates to the Documentation Sets for Release 1.16.3 after Release 1.16.2 
In addition to documenting the new features for Release 1.16.3, the following improvements were 

made to the documentation set: 

▪ Starting from Release 1.16.3, improvements for guides and online helps are listed in the 

New and Updated topic of each guide and help and only improvements not mentioned in 

those documents are mentioned here. 

http://logosvn.corpnet.liox.org:8000/logoport/wiki/DoNotTranslate
http://www.geoworkz.com/
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Updates to the Documentation Sets for Release 1.16.2 after Release 1.16 
In addition to documenting the new features for Release 1.16.2, the following improvements were 

made to the documentation set: 

▪ Improvements for online helps are listed in the New and Updated topic of each help. 

Updates to the Documentation Sets for Release 1.16 after Release 1.15.9 
In addition to documenting the new features for Release 1.16, the following improvements were made 

to the documentation set: 

▪ Improvements for online helps are listed in the New and Updated topic of each help. 

Updates to the Documentation Sets for Release 1.15.9 after Release 1.15.8 
In addition to documenting the new features for Release 1.15.9, the following improvements were 

made to the documentation set: 

▪ Improvements for online helps are listed in the New and Updated topic of each help.  

Updates to the Documentation Sets for Release 1.15.8 after Release 1.15.7 
In addition to documenting the new features for Release 1.15.8, the following improvements were 

made to the documentation set: 

▪ No other improvements were made. 

Updates to the Documentation Sets for Release 1.15.7 after Release 1.15.6 
In addition to documenting the new features for Release 1.15.7, the following improvements were 

made to the documentation set: 

▪ No other improvements were made. 

Updates to the Documentation Sets for Release 1.15.6 after Release 1.15.5 
In addition to documenting the new features for Release 1.15.6, the following improvements were 

made to the documentation set: 

▪ The Lock and Propagate Frequent Segments topic in the Word Client Help and the TW 

Tools Help was updated. 

▪ A passage on handling tags was added to the Translating Files with Track Changes topic in 

the XLIFF Editor Help. 

▪ The Online Review Client Help layout was enhanced with the new style sheet. Two topics, 

Finding Information in the Help System and New and Updated were added. 

▪ Minor layout updates were made to the Guide to Migrating Linguistic Assets and to the 

Project Engineer Reference Guide. 

Updates to the Documentation Sets for Release 1.15.5 after Release 1.15.4 
In addition to documenting the new features for Release 1.15.5, the following improvements were 

made to the documentation set: 

▪ No additional updates were made. 

Updates to the Documentation Sets for Release 1.15.4 after Release 1.15.3 
In addition to documenting the new features for Release 1.15.4, the following improvements were 

made to the documentation set: 
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▪ Descriptions of two penalties, the Penalty for differing formatting and the Penalty for tag 

replacement have been added to the Web Interface Help topic Configuring a Translation 

Memory. 

Updates to the Documentation Sets for Release 1.15.3 after Release 1.15.2 
In addition to documenting the new features for Release 1.15.3, the following improvements were 

made to the documentation set: 

▪ No additional updates have been made to the documentation set. 

Updates to the Documentation Sets for Release 1.15.2 after Release 1.14 
In addition to documenting the new features for Release 1.15.2, the following improvements were 

made to the documentation set: 

▪ The layout of the Word Plug-in help, the TW Tools help, and the XLIFF Editor help has 

been modified. The topics, paragraphs, and passages added to the newest help version are 

now highlighted, as also are the edited passages. 

▪ The DOCX Filter topic of the Project Engineer Reference Guide has been updated, by 

including information on handling files with tracked changes. 

Updates to the Documentation Sets for Release 1.14 after Release 1.13 
In addition to documenting the new features for Release 1.14, the following improvements were made 

to the documentation set: 

▪ The layout of the Guide to Migration and Interoperability and the Project Engineer 

Reference Guide has been updated. 

▪ The XLSX Filter topic of the Project Engineer Reference Guide has been updated, 

especially the “Specifying an Excluded Range” section. 

Updates to the Documentation Sets for Release 1.13 after Release 1.12.3 

In addition to documenting the new features for Release 1.13, the following improvements were made to the 

documentation set: 

• The New and Updated topic was added to the Web Interface help. 

• The “Displaying the User Interface” subtopic was added to the Introduction to Translation Workspace 
topic of the Web Interface help. 

• Minor corrections were made to some topics of the Web Interface help. 

• The XLSX Filter topic of the Word Client help and the TW Tools help was updated, especially the 
“Specifying an Excluded Range” section. 

Updates to the Documentation Sets for Release 1.12.2 after Release 1.12.1 

In addition to documenting the new features for Release 1.12.2, the following improvements were made to the 

documentation set: 

• Propagate process results description has been reformulated in the Word Client Help, the TW Tools 
Help and the Filters and File Formats Guide (propagated repetitions stay locked). 

• Description of the Connection Optimization and Prefetch features has been reformulated in the Word 
Client Help and XLIFF Editor Help (3. External or internal matches above the default 30% threshold are 
stored into the prefetch database). 
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Updates to the Documentation Sets for Release 1.12.1 after Release 1.12 

In addition to documenting the new features for Release 1.12.1, the following improvements were made to the 

documentation set: 

• A New and Updated topic, which lists the additions and changes made to the help, has been added to 
the Word Client Help and the TW Tools Help. 

• A separate topic with a detailed description of the Connection optimization and Prefetch features has 
been added to the Word Client Help and the XLIFF Editor Help. 

• The single quotes were removed from the example in the description for how to define a range of cells 
that contain non-translatable text in the XLSX Filter topic of the Word Client Help and the TW Tools 
Help. 

Updates to the Documentation Sets for Release 1.12 after Release 1.11 

In addition to documenting the new features for Release 1.12, the following improvements were made to the 

documentation set: 

• A note about Change Bars not being supported by the MIF Filter has been added to the Word Plug-in 
Help and TW Tools Help “MIF Filter” topic. 

• The screenshot for the Advanced tab of the Translation Memory Properties view in the “Creating a New 
Translation Memory” topic of the Web Interface Help has been updated. 

• “The 100% matches penalized due to attribute penalties” was added to the without warning penalized 
100% percent matches list in the “Configuring a Translation Memory” topic of the Web Interface Help. 

• The statements about the -1% penalized 101% matches have been updated in the Web Interface Help 
topic “Analyze Documents”, in the Word Client Help and the TW Tools Help topic “Types of Matches”, 
and in the XLIFF Editor Help topic “Translating”. 

• The “Known Limitations” subtopic has been added to the “IDML Filter” topic in the Word Client Help. 

Updates to the Documentation Sets for Release 1.11.3 after Release 1.11 

In addition to documenting the new features for Release 1.11.3, no other improvements were made to the 

documentation set. 

Updates to the Documentation Sets for Release 1.11 after Release 1.10 

In addition to documenting the new features for Release 1.10, the following improvements were made to the 

documentation set: 

• The Guide to Migrating Linguistic Assets has been updated. 

Updates to the Documentation Sets for Release 1.10 after Release 1.9 

In addition to documenting the new features for Release 1.10, the following improvements were made to the 

documentation set: 

• The Project Engineer Reference Guide (Files and Formats in Translation Workspace) has been updated. 

Updates to the Documentation Sets for Release 1.9 after Release 1.8 

In addition to documenting the new features for Release 1.9, the following improvements were made to the 

documentation set: 

• Most screenshots in the helps taken in Win XP have been replaced with screenshots taken in Win 7. 
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Updates to the Documentation Sets for Release 1.8 after Release 1.7.2 

In addition to documenting the new features for Release 1.8, the following improvements were made to the 

documentation set: 

• Added section Assigning Keyboard Shortcuts to Translation Workspace Commands to the Word Plug-in 
Help “Translation Submenu” topic. 

Updates to the Documentation Sets for Release 1.7.2 after Release 1.7.1 

In addition to documenting the new features for Release 1.7.2, the following improvements were made to the 

documentation set: 

• The XLIFF Editor help has been reorganized. The descriptions of different features have been taken 
from the different menu topics and saved to separate topics inside the “Preparing Files”, “Translating” 
and “Post-Processing” main topics. 

Updates to the Documentation Sets for Release 1.7.1 after Release 1.7 

In addition to documenting the new features for Release 1.7.1, the following improvements were made to the 

documentation set: 

• The description of the Import Translation Memory Data dialog option Send Import Results in Email was 
added to the Word Plug-in Help “Import Translation Memory Data” topic. 

• The Leverage from Glossary section in the “Translate/Leverage from TM and Glossary” topic of the 
Word Plug-in Help was updated. 

Updates to the Documentation Sets for Release 1.7 after Release 1.6 

In addition to documenting the new features for Release 1.7, the following improvements were made to the 

documentation set: 

• The layout of the Release Notes and the Filters and File Formats (Project Engineer and Translators 
Reference) guide was updated. 

• The Release Notes were divided to two documents, one for the current release and one for all the 
previous releases.  

• The GLOSS_SEGMENT_DELETE object permission was added to the Object permissions table on the 
Web Interface Help “Roles” topic. 

• Descriptions for missing commands were added to the XLIFF Editor Help “Edit Menu” topic. 

• The description on how to delete a QA Model in the Web Interface Help “Manage QA Models” topic 
was updated. 

• A workaround was added on how to avoid double quotes while creating a tabulated text file from an 
Excel sheet to the Web Interface Help “Import Formats for Glossaries” topic. 

Updates to the Documentation Sets for Release 1.6 after Release 1.5 

In addition to documenting the new features for Release 1.6, the following improvements were made to the 

documentation set: 

• Added more information of the Unknown Segments Analysis functionality in the Word Client help and 
the Translation Workspace Tools help. 

• The layout of all helps was updated. 

Updates to the Documentation Sets for Release 1.5 after Release 1.4 

In addition to documenting the new features for Release 1.5, the following improvements were made to the 

documentation set: 



December 9, 2014  Translation Workspace Release Notes 

 

December 9, 2014 Copyright Lionbridge, Inc. 2014 332 

 

• Added section entitled “Using the Penalize multiple 100% matches Option” to “Configuring a 
Translation Memory” topic in the Web interface help. 

• Added explanations of the options in the “Segmentation Rules” section of the “Configuring a 
Translation Memory” topic in the Web Interface help. 

• Added more explanation of the Expand/Shrink segments functionality in the Word Client help. 

• Added a new Icons topic to the Web interface help system listing and describing the icons used in the 
Web interface.  

• The XLIFF Editor help system Installation topic now lists both the XP and Windows 7 paths into which 
files are installed. 

• Added new "Match Prioritization and Premiums/Penalties" section in Word Client and XLIFF Editor help 
systems. 

• Added a new topic on the different search techniques (Match search, Concordance search, 
AutoTerminology search) to Web interface help system.  

Updates to the Documentation Set for Release 1.4 after Release 1.3 

In addition to documenting the Translation Workspace Release 1.4 new features, the following improvements 

were made to the documentation set after Translation Workspace Release 1.3: 

• Added sections to Installation topic in the Web interface help and XLIFF Editor help describing issues of 
synchronizing the two clients and troubleshooting and fixing installation problems. 

• Added instructions to DOCX filters topics in the Word Client help and Translation Workspace help for 
setting up bidirectional text handling on your Windows computer. 

• Added home landing pages to all five help systems. 

Updates to the Documentation Set for Release 1.3 after Release 1.2 

In addition to documenting the Translation Workspace Release 1.3 new features, the following improvements 

were made to the documentation set after Translation Workspace Release 1.2: 

• Improved the description of the "Repair" feature in the “Current Documents” topic of the Word client 
help. 

• Updated the Guide to Migration and Interoperability: Working with Trados and Idiom WorldServer 
Projects in Translation Workspace. 

• Reworked screenshots presentation in the “Glossary Maintenance” topic in the Web interface help. 

• Added Microsoft 2010 (32 bits) to the supported versions in the “Installation” topic of the Word client 
help. 

• Added note in the “Document Cleanup” topic that you can use the Document Cleanup dialog to add 
the TUs from a TMX file to the selected TM. If the TMX file was created in Translation Workspace and 
contains context matches, those context matches will be captured in the TM. If the TMX file was 
generated from another tool, like SDL Trados, no context match values will be created.  

Updates to the Documentation Set for Release 1.2 after Release 1.1 

In addition to documenting the Translation Workspace Release 1.2 and GeoWorkz Release 1.2 new features, 

the following improvements were made to the documentation set after Release 1.1: 

• New section in Word Plug-in help “Open Segment” topic entitled “Edits Made Outside of the Segment 
View.” This explains that you can use the Word “Search and Replace” feature outside of the segment 
you have open, and store your replacements of translations to the TM with the “Clean to Target 
Language” command (if the “Store Translations to TM” option is checked.) 

• Added a note in the “Tags Submenu” topic of the Word Client help and in the “Handling Tags” topic of 
the XLIFF Editor help about how files converted from DOCX, PPTX, XLSX, INX, or MIF will have “TagML” 
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tags inserted during the conversion, and that you can find a description of each tag, for each format, in 
the Filters and File Formats in Translation Workspace guide.  

• Updates to the Asset Aliasing topic in the Web interface help. 

• Added a topic called “Working with Aliased Assets” to both the Word client help and the XLIFF Editor 
help. 

• Replaced the language codes table in the Language Codes topic with the ISO table in the Web interface 
help. 

• Corrected the description of the “Allow Multiple” option for TM import in the Web interface help. 

• Added notes about how the Confidential and Quality options are used in the Asset Tagging topic in the 
Web interface help. 

• Improved topics on the Configure Filters and Markup Language Assistant dialogs in the Word Client 
help, the Translation Workspace Tools help, and the Filters and File Formats in Translation Workspace 
reference guide. 

• Added a note in the Managing Users topic (in the Web interface help) that a subscriber user cannot 
change user information in Translation Workspace, but only in GeoWorkz. 

• Removed asterisks indicating "Not available yet" from several system and object permissions in the 
Roles topic in the Web Interface. 

Contacting Technical Support 
There is a wealth of training, documentation, and answers to frequently asked questions in the Support area at 

www.GeoWorkz.com.  

If you need more help, to contact the Support staff for Translation Workspace issues, login to 

www.GeoWorkz.com with the credentials you use to login to Translation Workspace and submit a Support 

Request ticket at Support > Submit a Support Request. 

 

http://www.geoworkz.com/
http://www.geoworkz.com/

